PREFACE

PREFACE

Thank you for purchasing the GP Screen Editor Software, "GP-PRO/PB Il for
Windows Ver. 6.3" for use with Pro-face’s GP series programmable operator
interfaces.

Please read this manual carefully in order to use this software properly, and be
sure to keep this manual handy for future reference.

o ———————————————— — — — — — — — — — — — —

(1) The copyrights to all programs and manuals included in the GP-PRO/PB
111 for Windows Ver. 6.3 (hereinafter referred to as "this product™) are
reserved by the Digital Electronics Corporation. Digital grants the use of
this product to its users as described in the "Software Operating License
Conditions" documentation, included with this product's CD-ROM. Any
actions violating the above-mentioned conditions are prohibited by both
Japanese and foreign regulations.

(2) The contents of this manual have been thoroughly inspected. However, if
you should find any errors or omissions in this manual, please inform your
local GP representative of your findings.

(3) Regardless ofarticle (2), the Digital Electronics Corporation shall not be
held responsible for any damages or third party claims resulting from the
use of this product.

(4) Differences may occur between the descriptions found in this manual and
the actual functioning of this product. Therefore, the latest information on
this product is provided in data files (i.e. Readme.txt files, etc. ) and in
separate documents. Please consult these sources as well as this manual
prior to using the product.

(5) Eventhough the information contained in and displayed by this product may
be related to intangible or intellectual properties of the Digital Electronics
Corporation or third parties, the Digital Electronics Corporation shall not
warrant or grant the use of said properties to any users and/or other third
parties.

(6) The specifications set out in this manual are for overseas products only. As
aresult, some differences may exist between the specifications given here
and for those of the identical Japanese product. Digital Electronics Corpo-
ration accepts no liability for issues related to the intellectual property rights
of third parties or any issues related to the use of the information contained
in or displayed by this product.

—_———,——,———e—e————_——_——_——— — — — ——_——— — —_— .- - _-— .- —_— —_— —_——_——_——_—— —
—_—————_——————_——_— .- .- .- .- .- .- .- - .- - -_-—-——_—-—_——_—-Ee—-—-E .- -§Ee—-m—mE—-—m§E-m—mEe—-mmEe—-—E—- mE t——mEC——_-m—mECp——_m—mEC—_—Fp(—

— e e e e ———— e

© Copyright 2003 Digital Electronics Corporation. All rights reserved.
Digital Electronics Corporation, September 2003

For the rights to trademarks and trade names, see “TRADEMARK RIGHTS”.
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TRADEMARK RIGHTS

TRADEMARK RIGHTS

All company or product names used in this manual are the trade names, trade-
marks (including registered trademarks), or service marks of their respective
companies.

This product omits individual descriptions of each of these rights.

Trademark / Trade Name Right Holder

Microsoft, MS, MS-DOS, Windows,
Windows 95, Windows 98, Windows
Me, Windows NT, Windows 2000, Microsoft Corporation, USA
Windows XP, Windows Explorer,
Microsoft Excel

Intel, Pentium Intel Corporation, USA

Digital Electronics Corporation
Pro-face . .

(in Japan and other countries)
Ethermet Western Digital Electric Corporation,

USA

International Business Machines

IBM, VGA, IBM Compatible Corporation (IBM), USA

The following terms differ from the above mentioned formal trade names and

trademarks.

Term used in this manual Formal Trade Name or Trademark
Windows 95 Microsoft® Windows®95 Operating System
Windows 98 Microsoft® Windows®98 Operating System
Windows Me Microsoft® Windows®Me Operating System
Windows NT Microsoft® Windows NT® Operating System
Windows 2000 Microsoft® Windows® 2000 Operating System
Windows XP Microsoft® Windows®XP Operating System
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LIST OF SUPPORTED MODELS

LIST OF SUPPORTED MODELS

The GP-PRO/PBIII for Windows Ver. 6.3 functions and settings available will
vary, depending on the model of GP used. Use the following table to identify your
GP.

B List of GP Series Products

. Product
Series Model GP Type
Name yp
SPHTOL GPH70-LGIL-24V oPHTOL
. GPHT0-LGA1-24VP
GP-H70 series
GP-H70S CPH7O-SC11-24v GPH70S
GPHT0-SC41-24VP
GP270-LG1L-24V
GP-270L GPZ70-LG2L-24VP GP270L
. GP270-LG31-24V
GP-210 series GP270.5C 1104V
GP-270S GPZ70-SC21-24VP GP270S
GP270-SC31-24V
GP370-LG1L24V
GP370-LG21-24VP
GP-370L —— GP370L
) GP370-LG41-24VP
GP-370 series GP370-SC 1124V
GP370-SC21-24VP
GP-370S S GP-370S
GP370-SC41-24VP
GPAT0EGIL
GP-470 series GP-470E GP470-EG21-24VP GP470
GP70 series GP470-EG31-24V
GP570-LG1L-24V
GP-570L T GP570L
GP570-3C11
GP-570S GP570-SC21-24VP
. GP570-SC31-24V
GP-570 series GP570-TC 1L GP570
GP-570T GP570-TC21-24VP
GP570-TC31-24V
GP-57J5 GP57J-5C11
GP-570VM GP570-TV1L GP570VM
GP-571 series GP-571T GP571-TC11 GP571T
GP6755 GP675-SC11
GP-675 series GP675-TC11 GP675
GP-675T GPG75-TCA1-24VP
GP-870 series GP-870VM GP870-PVIL GP870VM
GP-37W2 series GP-37W2B GP37W2-BGAL24V CPTTWD
GP-377L CPSTTLGLL24v GP377L
) GP377T-LGAL-24V
GP-377 series
g GP377-SCIL-24V J—
GP377-SCAL-24V
- GP377R-TC1L-24V
GP-377R series GP-377RT CPTRICALN GP377R
GP-477R series GP-47TRE GP477R-EGI1 GPATTR
) GP4TTR-EGAL-24VP
GP77R series
GPSTTRS GP577R-SC11
GP-577R series CP577R-SCAL-24VP GP577R
JEp— GP577R-TC1L
GP577R-TCAL-24VP
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LIST OF SUPPORTED MODELS

. Product
Series Model GP Type
Name P
GP-2301H series GP-2301HL GP2301H-LG41-24V GP2301HL
GP2000H
series GP-2301HS GP2301H-SC41-24V GP2301HS
GP-2401H series GP-2401HT GP2401H-TC41-24V GP2401H
GP-2300L GP2300-LG41-24V GP2300C
GP-2300 series GP-2300S GP2300-SC41-24V GP2300S
GP-2300T GP2300-TC41-24V GP2300
GP-2301L GP2301-LG41-24V GP2301L
GP-2301 series GP-2301S GP2301-SC41-24V GP2301S
GP-2301T GP2301-TC41-24V GP2301
GP-2400 series GP-2400T GP2400-TCAT-24V GP2400
GP-2401 series GP-2401T GP2401-TC41-24V GP2401
GP2000 GP-2500L GP2500-LG41-24V GP2500C
series GP-2500 series GP-25008 GP2500-SC41-24V GP2500S
GP-2500T CP2500-TC11 GP2500
GP2500-TC41-24V
GP-2501L GP2501-LG41-24V GP2501L
. GP-2501S GP2501-SC11 GP2501S
GP-2501 series GP-2501T GPZ501-TCIT GPZ501
) GP2600-TC11
GP-2600 series GP-2600T CPI600-TCALIoAV GP2600
GP-2601 series GP-2601T GP2601-TC11 GP2601
B List of GLC Series Products
. Product
Series Model GP Type
Name yp
. ) GLC100L GLC100-LG41-24V GLC100L
GLC100 series |GLC100 series
GLC100S GLC100-SC41-24V GLC100S
GLC300 series |GLC300 series GLC300T GLC300-TC41-24V GLC300T
. GLC2300L GLC2300-LG41-24V GLC2300L
GLC2300 series
) GLS2300T GLC2300-TC41-24V GLC2300
GLC2000 series
GLC2400 series  |GLC2400T GLC2400-TC41-24V GLC2400
GLC2600 series |GLC2600T GLC2600-TC41-24V GLC2600

B List of Supported STs

Series Product name Model GP Type
ST400 ST400-AG41-24V ST400

ST400

series ST401 ST401-AG41-24V ST401
ST402 ST402-AG41-24V ST402

B List of Supported Factory Gateway

Product name Model GP Type
Factory Gateway FGW-SE41-24V Factory Gateway FGW-SE

G

ote: 10 use the GPWeb and GPViewer functions with the Factory Gateway, you
2] mMmust have GPPRO/PB 111 C-Package02 or later installed.
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NEW FEATURES OF VERSION 6.1

NEW FEATURES OF VERSION 6.1

New features of GPPRO/PBIII for Windows Ver. 6.1 include the CSV Data
Transfer function, CSV Data Display function, and File Manager Display function.
This section briefly describes each function and lists the GP Series units that
support that function.

<All GP Series>
@ Parts Palette

The parts are displayed within a palette on the Screen Editor. Simply drag an item
from the Parts Palette and drop it at the desired location on the screen.

1.3.1 Screen Editor Item Names and Functions

@ Address Conversion when changing the PLC

When the PLC type is changed, a conversion pattern can be specified for the
available device of the destination PLC. The addresses belonging to the specified
pattern can be converted in one operation. The conversion pattern can be edited
and appended.

4.2.7 Changing Your Project’s Device/PLC Type and
Addresses

¥ Address Conversion with Global Cross Reference
The desired addresses can be converted via the global cross reference.
2.9.7 Cross Reference List

@ Extended Function of Keypad Input Display

These new features provide K-tag settings (except for “Arithmetic Operation”)
and a Pop-up Keypad interlock.

2.1.14 Keypad Display, Tag Reference Manual 2.12 K-
tag (Key Input)

@ Extended Function of Numeric Displays
The display style of the N-tag can be specified with a Numeric Display Part.

2.1.21 Numeric Displays

@Project Backup Function

When a Project file is saved, the backup data of the most recently saved Project
file is saved in a backup file (*.bak).

4.2.2 Backing up Project Files
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NEW FEATURES OF VERSION 6.1

<GP377/GP77R/GP2000 Series>

@ Extended Function of Message Display

Index text can be used as the character strings displayed on the Message Dis-
plays. Two or more lines of messages can be displayed with this function.

2.1.22 Message Display, 4.6 Table Editor Character
Strings

<GP2000 Series>

& CSV Data Transfer Function

A specific data-transferring CSV file (ZR*****,CSV) on the CF Card can be
transferred from the CF Card directly to the PLC (filing), and from the PLC
directly to the CF Card (logging). The data transfer method can be selected as
either automatic transfer (using the Control Word Address) or manual transfer
(performed with the touch panel). The Data Transfer Display is used with manual
transfer. The Data Transfer Display is useful for searching files because the file
names of the data-transferring CSV file (ZR*****.CSV) can be displayed in a
list.

2.1.18 Data Transfer Display, Tag Reference Manual 4.4
CSV Data Transfer Function

The selected file can be viewed, edited and printed when this function is used
together with the CSV Display.

2.1.19 CSV Display, Tag Reference Manual 4.5 CSV
Data Display Function

€ CSV Data Display Function

The CSV file on the CF Card can be displayed, edited, and printed with the CSV
Display. Set up the CSV Data Display along with the File Manager Display or
Data Transfer Display.

2.1.19 CSV Display, Tag Reference Manual 4.5 CSV
Data Display Function

@ File Manager Display Function

The structure of folders and files on the CF Card can be displayed in a list with
the File Manager Display. When this function is used together with the CSV
Display, the selected file can be viewed, edited and printed.

SOOI 2.1.20 File Manager Display, Tag Reference Manual 4.6
File Manager Display Function

@ Extended S10 Script Feature

This programming feature is dedicated to communication between the GP and the
I/O device connected to the extended S10 (Extended serial interface) built into
the GP.

This function is supported only by the GP2000 Series units with built-in Extended
SIO (GP2300/2400/2500/2600 Series). This function uses the Extended SIO
Script Protocol that is added to this series.
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NEW FEATURES OF VERSION 6.1

SOOI 2.7 Extended SI1O Script, Tag Reference Manual 3.2
Extended SI10 Script

@ GLC Ladder Monitor Function
The logic programs in the GLC can be displayed on the GLC screen.
This function is supported only by the GLC-2400/2600 Series.
Pro-Control Editor Ver. 4.1 User's Manual

@ SRAM Auto Backup Function

Backups of the GP's SRAM data (data on the GP) can be made to the CF Card.
The Control Word Address is used to trigger this function.

Tag Reference Manual, 4.7.9 Making a Backup of
Backup SRAM

@ Extended Function of Trend Graphs
The trend graph functions are extended as follows:
« Data backup and previous data can be displayed.
* Up to 40 trend lines can be displayed, including data sampling.
2.1.12 Trend Graphs, Tag Reference Manual 2.31 Trend
Graph Display
@ Extended Scaleable Text and Display Size

The Character Size for text and part labels as well as the display size for tags and
loading marks can be selected from integers 1 through 8.

2.2.9 Text, Tag Reference Manual 2.1.3 Setting Param-
eters

B New PLC Protocol
» Fenwal Controls of Japan: AL Series Temperature Controller

e Omron: SYSMAC-C Series (CQM1H-CPU51/CQM1H-CPUG61) (For 1:n
connection)

» Keyence: KV-700 Series (Direct connection with CPU)

» Rockwell (Allen-Bradley): ControlLogix 5000 Series

* Siemens: S7-200/300/400 Series (Direct connection with MPI port)
« JT Engineering: JE-70 Series Analyzer

» Meidensha: UNISEQUE Series (Ethernet connection)

* Yasukawa Electric: G7/F7 Series and VS mini \VV7/J7 Series Inverter Variable
Speed

Device/PLC Connection Manual
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NEW FEATURES OF VERSION 6.2

NEW FEATURES OF VERSION 6.2

The upgrade from GP-PRO/PB |11 for Windows Ver. 6.1 to Ver. 6.2 adds the
following features. These include new functions such as the D-Script/Extend SIO
Script’s CF Card File Operation function, extended trend graph functions, and
monochrome LCD (eight levels of gray) support. This section briefly describes each
function and provides a list of the GP Series units that support each function.

<All GP Series>

@ Comparison of the project file (.prw) displayed on the GP screen and the file
selected with the PC

When the project file (.prw) selected with the PC is transferred to the GP, the
transferred file and the file on the GP screen are compared and any differences
are reported.

7.3.1 GP Internal Screen Data Information BCompare List

@ Transfer mode setting
Transfer modes can be selected in the [Transfer] dialog box.

You can select whether to prepare and execute the transfer simultaneously to
reduce the transfer time, or to complete the preparation and check errors before
executing the transfer.

7.2.1 Transferring Setting

@ Protection of project files

The selected project file (.prw) can be fully protected so that it can be opened
and edited only with a password.

4.2.9 Protect Setting

@ Background color selection for bar/pie/half pie graph Parts and G-tags
(available with GP-377, GP77R and GP2000 Series)
The background color of a graph can be selected during color setting of G-tags
and bar/pie/half pie graph parts.

2.1.7 Bar Graphs, 2.1.8 Pie Graphs, 2.1.9 Half Pie
Graphs, Tag Reference Manual 2.8 Graph Display <G-tag>

<GP2000 Series monochrome LCD model only>

€@ Monochrome eight-level gray-scale display
Parts and images can be displayed on the GP screen in monochrome (eight levels
of gray). JPEG images of GP screens can also be captured and saved to a CF
Card (screen hard copy). With a GP-2300L, GP-2500L or GP-2501L, screen
data can be printed out in monochrome as well.

2.1 Parts MSelecting Colors and 6.1 Menu Setting
Items: GP Setup #Initial Screen Settings €Tag Reference Manual
4.11.3 Monochrome (eight levels of gray) mode
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NEW FEATURES OF VERSION 6.2

<GP2000 Series only>
€ Extended trend graph function
The following new functions have been added to the "Block Display" trend graph.

« Thedisplay range (display width of graph data) can be designated indirectly.
Also, magnification and reduction of display is possible.

« Atrend graph can be displayed with dots or with a combination of dots and
lines.

 You candisplay assistant lines (upper-lower limit lines, standard value line) for
the X or Y axes. Assistant line positions can be designated either directly or
indirectly.

2.1.12 Trend Graphs, Tag Reference Manual 2.31 Trend
Graph Display

€ CSV data transfer function: Condition name search and transfer

When a condition name (product number, etc.) is entered in the GP's LS Area or
the device address of the connected device with a bar code reader or other
device, a search is made for CSV files matching the name. Any matching CSV
files found are automatically transferred from the CF Card to the connected
device according to the transfer condition.

Tag Reference Manual 4.4 CSV Data Display Function

€ New functions for D-Script

New functions are added for use with D-Script, global D-Script, and extended
SIO Script.

« "CFfile operation™ statements

These can be used for files in a CF Card such as "File Write", "File Read" and
"FileList".
« "Printer port operation” statement

Outputs the number of bytes of data, specified with the "Printer port output”
function, from the printer port.

Tag Reference Manual 3.1 D-Script/Global D-Script, 3.2
Extended S10 Script

@ Serial I/F Switch function

The communication program used by the Serial I/F (COML1) and the Extended
Serial I/F (COMZ2) can be changed. In order to use RS-422 with Serial 1/F
(COML1), amulti-drop connection with the external device (using the Extended
SIO Script’s Protocol) is possible. Communication via the Serial I/F (COM1)
using the Extended S10 Script’s Protocol is possible even for a GP2000 Series
unit that does not have an Extended Serial I/F (COM2).

4.2.8 Changing Extended SI10O Type
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NEW FEATURES OF VERSION 6.2

@ Conversion from a backup file (.mem) to a project file (.prw)

The GP backup file (.mem) created with the CF Memory Loader Tool of the GP-
PRO/PB 111 can be converted into a project file (.prw).

10.6.6 Creating a PRW file

4 CF Memory Loader Tool: Downloading multiple projects

When the CF Memory Loader Tool is activated, a backup file (*.mem) can be
specified for uploading /downloading multiple projects from/to the GP unit;
Changing the GP unit’s data no longer requires data to be sent many times from
the GP-PRO/PBIII. It can be done using a single CF Card. Also, the details of
the selected CF Card can be listed; and files can be copied, deleted or renamed.

10.7 CF Memory Loader Tool

@ 7-segment display

Numerical values for the keypad, numeric, date and time displays can be indi-
cated with a 7-segment display.

2.1.14 Keypad Display, 2.1.21 Numeric Displays,
2.1.23 Date Displays, 2.1.24 Time Displays

@ Support for Epson PM series and Epson Stylus series printers (except GP-
2301H/GP-2401H/GP-2301 Series units)

Now compatible with Epson PM/Stylus Series (6-color) and Epson Stylus Series
(4-color) printers.

6.1 Menu Setting Items: GP Setup €1/0 Settings, 6.2
Printer Type

B New PLC Protocols
« Hitachi Industrial Equipment Systems: HIDIC H series (Ethernet connection)

« Rockwell (Allen Bradley): SLC500 series (Ethernet connection)
¢ RKC Instrument: CB/REX-F/LE100 series RKC protocol

« Shimaden: SR253/SR90/SR80/MR13/FP93/SD16/EM70 series
Additional information on each protocol
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NEW FEATURES OF VERSION 6.3

NEW FEATURES OF VERSION 6.3

The upgrade from GP-PRO/PB |11 for Windows Ver. 6.2 to Ver. 6.3 adds the
following features. These include new functions such as support for the new ST
unit, security features, time schedules and others.

B New ST Series unit Compatibility
Unit Models: ST400/ST401/ST402

ST Series units have a variety of new features and usage restrictions. For more
information,

GENERAL GP RESTRICTIONS, 2.11 Creating ST
Series Screen

<All GP Series>

@ Selectable copy direction for multiple copy feature.

When copying multiple objects or images in the Editor screen, any of 8 copy
directions can be selected, as well as the arrangement and position of the copies.

2.4.7 Duplicate

@ Extended Font Sizes

When selecting a text string, Part label or Tag's character size, 6 x 10 dot, 8 x 13
dot, and 13 x 23 dot sizes are available. (Except for CSV displays and Logging
settings) These fonts are available only for single-byte numbers and symbols. If
these settings are used with double-byte characters, the display may no appear as
expected.

2.2.9 Text

& Half-2 Byte Character (Only Chinese, Taiwanese and Korean OS)

When displaying a 2-byte font (Chinese, Taiwanese or Korean), if the character
size (Font Size) setting is set to "half", 2-byte character is compressed vertically to
display as a half-height 2-byte character.

This feature can be used with Text strings, Bit Switches, Word Switches, Function
@\ Switches, Toggle Switches, 4-State Switches, Lamps and Message Displays.

XNote: This function is not available with GP-270 Series units.

2]

<GP-377/GP77R/GP2000 Series >
@ Index Text Centering Arrangement (inside of box)

When using index text in a Text or Message Display, depending on the number of
characters and rows used, this text will be centered within a single box/border.

4.6.3 Entering Settings via the Screen Editor
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NEW FEATURES OF VERSION 6.3

< ST Series only>

@ Security

Security levels can now be assigned to individual Base or Window screens. Asa
result, when changing or calling up a new screen, password entry is required.
Security levels are from 0 to 15, where a screen requiring the highest level of
security would be designated as Level 15.

2.11.3 Security Feature

& Time Schedule

This feature allows a designated time schedule (day and time) to be started viaa
Bit/Word set, or a Bit reset. If the Filing data (recipe) or D-Script feature control
addresses are set for this feature, that feature can be activated/performed at the
designated start time (or finish time). Settings can be for less than one day, or can
span 2 days or more (within a week).

2.11.7 Time Schedule

€ OFFLINE Language Switching

A simple push of a key allows you to change the display language used for your
ST unit from Japanese to English, or vice versa. No need to send a new system
program to your ST unit.

ST Series User Manual

B New PLC Protocol
* Yaskawa Electric MP2300 Series (Ethernet connection)
* Keyence KZ Series
* Mitsubishi Electric FX Series (Direct CPU and I:n Link Protocol)
* Chino Temperature Controller LT, JU Series

Device/PLC Connection Manual
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HOW TO USE THIS MANUAL

HOW TO USE THIS MANUAL

B Structure of the Manual CD-ROM

The "Operation Manual” is the first of four manuals for this product and explains
how to use the "GP-PRO/PB |11 for Windows Ver. 6.3" software (hereinafter
referred to as "this product™). Please refer to all of the manuals named below
when using this product. These manuals can be found as PDF files in your
“Manual CD-ROM” (CD #2).

In addition to these manuals, data files containing supplemental information on
updated functions are also provided.To read these additional data files, click on
the [Start] button in your Windows OS main screen and select the

[Programs] — [Pro-face] - [ProPB3 C-Package] menu. Then, click on the [Read
Me] selection.

For detailed information about GP series products, please refer to each GP's
"User Manual”. (Optionally available)

Operation Manual |Describes this products operation procedures and all

vol.1 (this manual) standard functions. (provided as PDF data)

Tag Reference Describes the function of and detailed settings for all
Vol. 2 Manual GP-PRO/PBIII Tags. (provided as PDF data)

_ Describes this product's pre-made Parts and symbols.

Vol. 3 Parts List (provided as PDF data)

Device/PLC Describes the methods for connecting the GP to
Vol. 4 |Connection supported devices from other manufacturers.

Manual (provided as PDF data)

Screen Data Layout Sheets are useful for designing tag address settings, etc. and
example sheets are installed as part of the GP-PRO/PBIII for Windows standard
installation.

The following two layout sheets, "Device Allocation Table" and "*"Tag Layout
Sheet", are in Microsoft Excel format and are located in the PDF Manual CD-
ROM.

The following folder and file names are used.

Folder Name File Name Contents
Pro-face\ DevicelE.xls | Device Allocation Table
propbwin\sheet TAG1EXIs

TAG2EXIs Tag Layout Sheet
TAG3E.xIs
TAGA4EXIs

For information on the use of Microsoft Excel, please refer to the Excel
software's User Manual.

B Designation of Supported Models

The functions and settings supported by each model may vary depending on the
supported models. In this manual, explanations given are based on the variation of
the “Series” and “Product name” described in the “List of Supported Models”.
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B Chapter Breakdown

This manual contains 12 chapters and an appendix.
The following is a general description of each chapter:

€ CHAPTER 1: FUNDAMENTALS OF GP-PRO/PB 111 FOR WINDOWS
This chapter describes GP-PRO/PBIII usage from start to finish. Also explains
the overall structure of the GP-PRO/PBIII Project Manager and Screen Editor
areas.

€4 CHAPTER 2: CREATING BASE SCREENS
This chapter describes the basic operations and terminology used for drawing
functions, such as “Part”, “Tag”, “Library”, and “D-Script”.

& CHAPTER 3: DRAWING APPLICATIONS: CREATING and USING
SCREENS
This chapter describes the procedures for creating and using various screens,
suchasthe M, T, K, X, I and V screens, which enable you to create high-quality
images and provide advanced-level functionality.

€& CHAPTER 4: SCREEN AND PROJECT MANAGEMENT
This chapter describes the procedures for editing and saving created screens and
project files, and information management procedure.

€ CHAPTER 5: CREATING AND EDITING ALARMS
This chapter describes the alarm creating and editing procedures.

& CHAPTER 6: GP INITIAL AND SYSTEM SETTINGS
This chapter describes the initial setup procedure required to use a GP series
display unit.

¢ CHAPTER 7: TRANSFERRING DATA

This chapter describes the procedure for sending created screens to a GP series
display unit.

4 CHAPTER 8: SIMULATION
This chapter describes the procedures for simulating the operation between a GP
series panel and a PLC.

€ CHAPTER 9: PRINTING
This chapter describes the procedure for printing created screens.

& CHAPTER 10: ADVANCED FEATURES
This chapter describes the procedures for using GP-PRO/PBIII’s advanced
functions such as sound output, filing data (recipe), CSV data transfer function,
logging functions, and CF Card usage. For the detailed information, refer to
\Volume 3, Tag Reference Manual.

4 CHAPTER 11: PROJECT MANAGER HIERARCHICAL DISPLAY
This chapter describes the procedures for using the Project Manager in hierarchi-
cal display mode.

& CHAPTER 12: DATA COMPATIBILITY
This chapter describes the procedure for converting existing screens created with
older generation screen editor software (e.g. GP-PRO, GP-PRO II, GP-PRO
I11, Parts Box) with GP-PRO/PB 111 for Windows.
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€ APPENDIX
* Error Messages
Lists the error messages that will be displayed during operation of this product.

* Troubleshooting
Provides problem diagnosis and suggests solutions for errors and software
operation problems.

» Address Conversion Tables
Lists the addresses available for each manufacturer’s supported models.

* Software Trouble Report

If a software problem persists, even after using the Troubleshooting section, write
down information about the problem using this sheet and send it by fax to your
local Pro-face support center.
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MANUAL SYMBOLS AND TERMINOLOGY

16

This manual uses the following symbols and terminology.

If you have any questions about the contents of this manual, please contact your
local GP distributor.

Also, If you have any question about your personal computer or Windows, please
contact your PC distributor or manufacturer.

B Safety Symbols and Terms

This manual uses the following symbols and terms to identify important informa-
tion related to the correct and safe operation of this product.

Symbol Description
Indicates a potentially hazardous situation that could result in serious injury
or death.
WARNING
Indicates a potentially hazardous situation that could result in minor injury or
equipment damage.
CAUTION
; Indicates a potentially damaging action or dangerous situation that could
! result in abnormal equipment operation or data loss.
Important
72\ | Indicates instructions or procedures that must be performed to ensure
Careful! | correct product use.

Indicates instructions or procedures that must not be performed.

@€

B General Information Symbols and Terms

This manual uses the following symbols and terms for general information.
Symbol Description

5

D

Note' Provides hints on correct product use, or supplementary
Y information.
\a

Indicates an item's related information (manual name, chapter,
section, sub-section).
ys on the computer keypo.a.rd. .

W Keyboard Compatibility List
IBM Compatible|Indicates a PC that can run the Windows® operating system.
A device connected to the GP, such as a programmable logic
controller, sequencer, thermoregulator or inverter.
Generic name for the "GP Series" of programmable operator
interface made by the Digital Electronics Corporation. For a
list of compatible GP products please see "Compatible
Products and Environmental Specifications”.
LIST OF SUPPORTED MODELS M List of GP
Series Product
Generic name for the GLC Series of Graphic Logic Controllers
made by Digital Electronics Corporation.
LIST OF SUPPORTED MODELS & List of
GLC Series Product

W Reference .4

Device

GP

GLC
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B Keyboard Compatibility List
This manual uses the following symbols to indicate computer keyboard keys.

The key names used by your computer keyboard may differ. Please use the chart
below for reference.

Type PS/2 Compatible

Symbol 101 Keyboard
Esc Esc
Tab re
Ctrl
-Shift
Al
Delete
SBpZ%Z Backspace

B Typical User Configuration

This manual’s description of this software's operating procedures and features is
based on the PC system configuration shown below.

If you use a different configuration, the PC and GP screens, as well as the names
used for pre-made Parts may differ. In this case, please substitute the equivalent
screen and part names of your system for those given in this manual.

Hardware/Software Specification Remarks
Personal Computer Windows compatible
Memory 32MB
Mouse Windows compatible mouse
0S Windows 98
Device Mitsubishi MELSEC AnAseries (Link)
GP GP-2600T
Recommended Cable:
Connection between GPW-CB02
RS-232C . ,
the GP and PC Made by Digital Electronics
Corporation
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PRECAUTIONS

B CD-ROM Usage Precautions

To prevent CD-ROM damage or malfunctions, please observe the following
instructions:

:

Do not remove the CD-ROM from the CD-ROM drive while the drive’s opera-
tion lamp is lit.

Do not touch the CD-ROM recording surface.

Do not place CD-ROMs in a place where they may be exposed to extremely
high or low temperatures, high humidity, or dust.

Product Usage Precautions

To prevent program malfunction or accidents, be sure to observe the following
instructions:

A .

Warning

18

Touch panel switches should NOT be used for
a device’'s Emergency Stop Switch. Minister of
Health, Labour and Welfare speaking, all indus-
trial machinery/systems must be equipped with
a mechanical, manually operated emergency
stop switch. Also, for other kinds of systems,
similar mechanical switches must be provided
to ensure safe operation of those systems.

Do not turn off your personal computer’s power switch during the execution
of a program.

After you create a screen with this product and transfer it to the GP unit, do
not send the same screen from the GP to a DOS version of this screen
editor software (e.g. GP-PRO/PB Ill, GP-PRO IiI).

Do not change the contents of this product’s project files using the Text
Editor software.

Do not send a screen to a GP unit if that GP does not support the functions
provided by your screen editor software.
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GENERAL GP RESTRICTIONS

» The GP-PRO/PB Il for Windows software displays screen data using your
personal computer’s fonts and graphic functions. Therefore, there may be a
slight difference between the data displayed on your personal computer and
the data displayed on the GP unit after that screen data is sent to the GP.

» When characters are positioned on a tiling pattern, they may not be displayed
properly on the GP unit if the dot pattern of the characters matches that of the
tiling pattern and the characters are positioned on the same color. To solve the
problem, shift the characters by one dot.

*  WhenaGP unitis vertically installed, the panel’s coordinates will differ from
those used on the screen editor software. Therefore, when you enter screen
coordinates using tags or D-Script, please consider the GP’s orientation.

(0. 0) on the screen editor software

(0. 0) on the GP series’ panel

» Double-byte characters used in a project may not display correctly when
displayed in a single-byte drawing environment. If you intend to use your
screen data in a single-byte environment, be sure to use only single-byte
characters for screen text.

 Data should be edited using the same environment (OS) it was created with. If
a different OS is used, characters may change or be unreadable.

€ Software and GP Setting Controls

« Certain functions and setting supported by the GP unit are not supported by
the GP-PRO/PB I11 for Windows program, and vice versa.
[Setting and functions items set via the GP unit (Not by GP-PRO/PB 111
for Windows) |
- Language Fontselection
- GPDate/Time
- GP Self-Diagnosis Function
- Functions for adjusting the Video Display
[Functions and setting items supported by GP-PRO/PB 111 for Windows
only (Not by the GP unit)]
The following settings are included in the “GP System Settings” area:
“Checksum \erification”
“BuzzerOutput”
- Screen Change Order in hierarchical display mode
- Turning the "Common Password" On/Off
- Screen Change according to standby mode time
- Shiftto OFFLINE mode
- “K-tag” processing
- GPunit’s internal memory (LS area) backup function
- “Error Display Reset”
- “Watchdog” (Monitoring the communication status between the GP and
the device)
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- Address setting for "CF Card Control Setting™ (Data Storage/Space

Storage Address/SRAM Auto Backup)

- “Q-tag” settings (Display format, Print Settings, and Alarm Trigger
Count Write’s Start Address/Processing Performed at GP power-ON/
Perform External Operations/Q-tag: Time Character addition (format)

- Communication Monitoring Periodsettings (Designate transmissionwaittime)

- Data Backup
- Display Colors

- FEP Setting

- Serial code reader (LS storage start address/Read complete bit ad-
dress/Data storage setting)
- The Control Word Address setting for the ""Screen Capture™ function

- "Print Type" (Setting the print function with the tool connector)

This feature is only available with GLC2300 Series units.
- Thefollowing GP/PRO/PB Il1 for Windows features, even though they can
be set using the GP-PRO/PBIII software, are currently not supported for
the following PLCs. SETermX Tag Reference Manual
Be sure to check that your type of PLC supports the features you wish
to use on the GP prior to creating your GP-PRO/PBIII for Windows

project data.

* When adevice/PLC shown in the table below is connected, some GP settings
and software features may be limited.

Before creatingnew screens, see the table below.

Device/PLC Connection Manual

<Functions of GP-PRO/PB I11 for Windows Ver. 6.3>
O : Supported @: Depends on the type X: Not supported:

Specified
in:

Item

Rockwell (Allen-Bradley)

Modicon

SLC500/PLC-5
DataHighway+

PLC-5
Remote I/0

SLC500
DH485

Modbus
Slave

Modbus
Plus

GP

Communication setting

X1

X1

X1

X1

Operating environment

X1t

X1t

*
.2

X1t

Software

Use System Area

Use Read Area

E-tag, K-tag: Indirect setting

H-tag: Read after startup

S-tag: Read after startup

Trend graph "block display”

IN

IN

D-script: Memory Copy

D-script: Address Offset
Designation

Filing data function

CSV data transfer function

Logging function

GP resetting due to write error

Data backup

2-Way driver

W

O x| |x|x]| x |x|X|x|x|x|o|O

O ||| || > [>x|>x|>x|>|x|x|x

[

® olo|o|olol o |o|o|olo|x|olo

O|0|X|0O|0|0| O |[O|O|0|0o|0|0|0|o|0o

W

O | |x|x|x| x |x|X|x|x|x|o|O

*1 These items can be set using [GP Setup] of GP-PRO/PB IlI for Windows.

*2 "maximum id" can be set using [GP Setup] of GP-PRO/PB Il for Windows.
*30nly the LS area can be used.
*4 Displays support available when Device/PLC Device Addresses are used.

Use of the GP LS Area’s Read Area is supported (““O”).
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<Functions of GP-PRO/PB Il for Windows Ver. 6.0>
O : Supported ®: Dependiing on the type X: Not supported

GP 70 Series
GP-H70
GP- | GP- | GP- | GP- | GP- | GP- | GP- | GP- | GP- | GP
Items GP-370
270 470 570 571 675 |570VM | 870VM | 377L | 377S |37W2B
GP-57JS
Full color (64-color) display X X X X (0] 0] X X X (0] X
3-speed blinking X X X X (0] 0] X X X (0] X
Data sampling (0] X (0] o (0] 0] o o O (0] o
LS area backup X X [ ) (0] O X X O (0] o
Trend graph (tag) backup X X ° ) (0] 0] X X o (0] o
Trend h (t
gr.ap (ag) o X O O o O O O o) O o)
“block display”
Trend h (t
grap(ég) o | x|o]lJ]o|l]o|lo] o] o|]of|lo]o
lower-section fill
Changing color using
. o X O O o O O O o) O o)
K-tag bit
E-tag, g-tag, K-tag: Indirect
9. g7lag, Biag: Indired o X o 0 o 0 0 0 0 o 0
color setting
E-tag, g-tags: Indirect
designation of relative (0] X (0] o (0] o o o o (0] o
value range
C-tag, E-tag, S-tag: Tiling
O X O 0] (0] 0] 0] @] 0] O 0]
background colors (Bg)
g-tag: Color differentiation
; . o] X o O o O O o) o) e} @)
in graph display
D-script Additions
. . (0] X (0] @] O 0] @] @] @) (e} @)
(Drawing, Math Functions)
Drawing function (H-tag) (0] X (0] O (0] o o o o (0] O
T-tag: Radio switch X
function
In.chmg outpqt switch o o o o X X X
(Tih-tag and Tiw-tag)
Q-tag: Backup X X o ) (0] 0] X X
Q-tag: Setting display o o o o o
format
Q-tag: Display by o | x|o|lo|lo|lo|lo|lo|lo|o]lo
second
Q-tag: Setting print X X X o o o o o X X X
color
Tank graph o | x|o|lo|o|lo|]o|o|o|]o]|oO
(pre-made parts)
Meter graph o | x|o|lo|lo|]o|lo|o|o|o]o
(pre-made parts)
Video window display X X X X X X o o X X X
(V-tag)
Setting Dllrectlon of X X X X X o X X X X X
Screen Printout
Interrupt/cancel hard- X X o o o o o o X X X
copy printout
SeF OFFLINE” mode o o o o o o o X o o o
switch feature off
Q-tag: Sub-display ©] X O ©] O ©] O o @) (0] @)
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<Functions of GP-PRO/PB |11 for Windows Ver. 6.0>

O : Supported @®: Dependiing on the type X: Not supported

GP 70 Series

ltems

GP-H70
GP-370
GP-573S

GP-

270

GP-

470

GP-

570

GP-

571

GP-

675

GP-
570VM

GP-
870VM

GP-
377L

GP-
377S

GP
37W2B

Q-tag: Grouping of
alarms into a block

X

X

A-tag: Indirect
designation of text
screen or sub-display
screen

@]

O

@]

Filing data function

Data logging function

Sound output function

CF Card compatibility

Global D-script

Compatible with
Pro-Server

X XXX X] X

X XXX X] X

XXX XXX

XXX XXX

X XXX X] X

XXX XXX

X XXX X] X

X XXX X)X

X [O]X[Xx]|O|O

X |0 X[X|O]|O

X [O]X[Xx]|O|O

Compatible with LS area
for simulation

>

>

>

>

x

>

x

x

@]

O

@]

GP resetting due to write
error

Compatible with transfer
speed of 115.2Kbps

Creation of composite
parts for Filing Data

@]

o

@]

D-script: Bit dual state
trigger

D-script: Memory Copy

D-script: Memory block
initialization

D-script: Loop function

D-script: Address offset
designation

X | X| X [>x] >

X | X|] X | <] X

X [ X] X | x| x

X [ X] X | x| x

X | X X | x| X

X [ X] X | x| x

X [ X] X | x| x

X | X|] X |x<] X

O |0 © |[0O] O

O |0l © [Oof O

O |O0] O |[0O] O

D-script:Temporary
address (can be used up
to 90 addresses)

@]

O

@]

Filing function:Can be
designated up to 10,000
pieces of data

Filing function: Multiple
folders

Filing function: Stores
the cursor position.

Filing function: PLC data
transfer completion Bit
Address

Logging function: Loop
function

Logging function: Total
LS data write

CF Card free capacity
storage
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<Functions of GP-PRO/PB Il for Windows Ver. 6.0>
O : Supported ®: Dependiing on the type X: Not supported

GP 70 Series
GP-H70
GP- | GP- | GP- | GP- | GP- | GP- | GP- | GP- | GP- | GP
ltems GP-370
270 | 470 | 570 | 571 | 675 |570vM|870vM| 377L | 377S [37W2B
GP-57JS
4-state lamp

X X X X X X X X o] o] o]
(pre-made parts)

T-tag: Grouping with auto

X X X X X X X X o 0] @)

OFF
T-tag: Interlock Touch
Available Conditions X X X X X X X X @) (0] 0]
(bit OFF)
Offline shift X X X X X X X X o o o
(pre-made parts)
Q-tag block printing X X X X X X X X X X X
Q-tag external operation X X X X X X X X @) (0] 0]
A-tag blank line display X X X X X X X X @) (0] @)
Alarm message: Can be X X X X X X X X o o o
used up to 512 messages
Backlight burnout X X X X X X X X o o X
detector
Internal 2-Port function X X X X X X X X O (0] O
GB-WEB compatibility X X X X X X X X X X X
PLC Simulation via Ethernet X X X X X X X X X X X
F -Set IP
ac.tory Set IP address X X X X X X X X X X X
settings for data transfer
General SIO Protocol X X X X X X X X X X X
Serial 2-D reader
- X X X X X X X X X X X
compatibility
o
Serial bar .code reader X X X X X X X X X X X
compatibility
256-color display X X X X X X X X X X X
Q-tag: up to 2048 messages X X X X X X X X X X X
-tag: Expansion of ti
Q-tag: Expansion of time X | x| x| x| x| x| x| x]o|]olo

format digits

T-tag: momentary (one-shot
buzzer)

Number of logging words:
255

Image Fonts X X X X X X X X X X X
Multi Language Display
Function

Screen Snapshot
Function for Simulation
[/0 Setting (Monitor
function for touch panel
input time)

Image Parts

Screen Capture Function
Compatible with v-tag
Pop-up Keyboard
Function

Global Vibration Function| X X X X
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<Functions of GP-PRO/PB |11 for Windows Ver. 6.0>

O : Supported @®: Dependiing on the type X: Not supported

GP77R/GP2000 Series

ltems

GP-
377R

GP-
4TTR

GP -
577R

GP-
2301H

GP-
2401H

GP-
2400

GP-
2401

GP-
2600

GP-
2601

Full support (64-color)
display

@)

X

@)

@)

@)

o

@)

@)

3-speed blinking

Data sampling

LS area backup

Trend graph (tag) backup

Trend graph (tag) “block
display”

Trend graph (tag) lower-
section fill

Changing color using K-tag
bit

E-tag, g-tag, K-tag: Indirect
color setting

O| O O] O |O|lO|O|O

O| O O] O |O|O|O|x

O| O O] O |OflO|0|O

O] O| O] O |O|O|O|e

O| O O] O |OflO|0|O

O] O0| O] O |0O|O|O

O|O| O] O |O|O|O

O| O O] O |O|lO|O|O

O| O O] O |O|lO|O|O

O|O| O] O |O|O|O

O] O0| O] O |0O|O|O

O| O O] O |O|lO|0|O

O| O O ]| O |OflOf0|O

E-tag, g-tags: Indirect
designation of relative value
range

@)

@)

o

@)

@)

@)

o

@)

o

@)

@)

@)

@)

C-tag, E-tag, S-tag: Tiling
background colors (Bg)

g-tag: Color differentiation in
graph display

D-script Additions (Drawing,
Math Functions)

Drawing function (H-tag)

T-tag: Radio switch function

ool o] O | O

ool o | O | O

ool o | O | O

ool o | O| O

ool o | O | O

ool o | O| O

ool o | O| O

ool o | O | O

ool o | O| O

ool o | O| O

ool o | O| O

Inching output switch (Tih-
tag and Tiw-tag)

x

Q-tag: Backup

O

O

O

O

O

O

O

O

O

O

Q-tag: Setting display format

O

O|0l O |[Oo|of O | O | O

O|0l ©O |[Oo|of O | O | O

O

O

O

O

O

O

O

O

O

O|O

*1 GP-2300L, GP-2301L, GP-2500L and GP-2501L units do not support this feature.
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<Functions of GP-PRO/PB Il for Windows Ver. 6.0>
O : Supported ®: Dependiing on the type X: Not supported

GP77R/GP2000 Series

GP- [ GP-[ GP-[ GP- [ GP- [ GP- [ GP- [ GP- | GP- | GP- | GP- | GP- | GP-

ltems 377R | 477R | 577R [2301H | 2401H | 2300 | 2301 | 2400 | 2401 | 2500 | 2501 | 2600 | 2601

Q-tag: Display by second Oj|0|J]O]J]O]J]O|J]O]J]O]J]O|JO]J]O]|O]O]O
Q-ag: Settingprintcolor [ O [ X [O [ X [ X | e[ X |O]O|O|O|O]|O
Tank graph (premadeparts) | O | O | O | O[O [ O[O [ O[O | OO0 |0
Meter graph (premadeparts) | O | O | O | O[O ] O[O | O[O ]|]O[O ]| O[O
Video window display X X X X X X X X X 0*4 X 0*4 X
(V-tag)
Setting Direction of Screen
Printout X[ X[ XX X[X]X]|X]O[X]|X]0]O0O
Interrupt/cancel hard-copy *9

. 0 Ol]O0O| X|X]O|X|O]|]O|J]O|O|O]|O
printout
Set “OFFLINE” mode switch
feature off oj]ojofoj]ojo|jJofojojJo|J]Of0O]|O
Q-tag: Sub-display OjJ]OoO]J]OfO]O]J]O]J]O[O]|]O]J]O]J]O[O]|O
Q-tag: Grouping of alarms o o o o o o o o o o o o o

into a block

A-tag: Indirect designation of
text screen or sub-display
screen

Filing data function

O
O
O
O
O
O
O
O
O
O
O
O
@]

Data logging function

Sound output function

N

o|lo| ol olClolCC]lolo

CF Card compatibility
Global D-script

N

3 3

Compatible with Pro-Server

Compatible with LS area for
simulation

GP resetting due to write
error

Compatible with transfer
speed of 115.2Kbps
Creation of composite parts
for Filing Data

ol o| o |ClolC|x|olo
ol ol ol|x|ololx|olo
ol ol ol|x|ololx|olo

o|o|o|o]|%ol%%olo
olo| ol o|x|ololx|olo
o|lo|o| ol|o|lolo|lx|olo
o|lo|o| ol|ololo|lo|lolo
olo| ol o |x|ololx|olo
o|lo|o| olololo|lololo
olo| ol ol|ClololClolo
o|lo|o| olololo|lololo
olo| ol o|ClololClolo

O O O

*1 A large-size multi-unit is necessary to enable this function.
*2 A middle-size multi-unit E is necessary to enable this function.

*3 A large-size multi-unit E or GP Ethernet I/F unit is necessary to enable this func-
tion.

*4 To utilize this feature, the optional VM unit is required.

*5 A bus conversion unit and a sound output unit (a large-size multi-unit S or a large-
size multi-unit E) are required to use this function.
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<Functions of GP-PRO/PB I11 for Windows Ver. 6.0>
O : Supported @: Dependiing on the type X: Not supported

GP77R/GP2000 Series

" GP- | GP- | GP- 2032'1 2?13-1 GP- | GP- | GP- | GP- | GP- | GP- | GP- | GP-
ems 377R |477R(ST7R| 7| “ 1 | 2300 | 2301 | 2400 | 2401 | 2500 | 2501 | 2600 | 2601

D?SCI’IptZ Bit dual state 0 0 0 0 0 0 0 0 0 0 0 0 0
trigger
D-Script: Memory Copy 0 0
P-.S.crllpt:. Memory block 0 0
initialization
D-Script: Loop function 0 0 0 0 0 0 0 0 0 0 0 0 0
D-S.crlpt:. Address offset 0 0 0 0 0 0 0 0 0 0 0 0 0
designation
D-Script:Temporary
address (can beusedup | O 0 0 0 0 0 0 0 o o o o 0
to 90 addresses)
Filing function:Can be
designated up to 10,000 0 0 0 0 0 0 0 0 o 0 o o 0
pieces of data
Filing function: Multiple 0 0 0 0 0 0 0 0 0 0 0 0 0
folders
Filing funct|on.: Stores 0 0 0 0 0 0 0 0 0 0 0 0 0
the cursor position.
Filing function: Device
data transfer completion | O 0 0 0 0 0 0 0 0 o o o 0
Bit Address
Logg!ng function: Loop 0 0 0 0 0 0 0 0 0 0 0 0 0
function
Logging fu_nct|on: Total 0 0 0 0 0 0 0 0 0 0 0 0 0
LS data write
CF Card free capacity o2 lot|ot| o 0 0 0 0 0 0 0 0 0
storage
4-state lamp (pre-made 0 0 0 0 0 0 0 0 0 0 0 0 0
parts)
I)—;ia:g: Grouping with auto 0 0 0 0 0 0 0 0 0 0 0 0 0
T-tag: Interlock Touch
Available Conditions (bit | O 0 0 0 0 0 0 0 o o 0 o 0
OFF)
Offline shift (pre-made 0 0 0 0 0 0 0 0 0 0 0 0 0
parts)
Q-tag block printing o%| o 0 X X 0 X 0 0 0 0 0 0
Q-tag external operation 0 0 0 0 0 0 0 0 0 0 0 0
A-tag blank line display 0 0 0 0 0 0 0 0 0 0 0 0
Alarm message: Can be 0 0 0 0 0 0 0 0 0 0 0 0
used up to 512 messages
Backlight burnout 0 X X 0 0 0 0 0 0 0 0 0 0
detector
Internal 2-Port function 0 0 0 0 0 0 0 0 0 0 0 0 0

*1 A large-size multi-unit is necessary to enable this function.

*2 A middle-size multi-unit E is necessary to enable this function.
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<Functions of GP-PRO/PB I11 for Windows Ver. 6.0>
O : Supported @: Dependiing on the type X: Not supported

GP77R/GP2000 Series

tems GP-| GP- | GP- 2(22'1 2(312-1 GP- | GP- | GP- | GP-| GP- | GP- | GP- | GP-
377R|477R|577R 2300 | 2301 | 2400 | 2401 | 2500 | 2501 | 2600 | 2601

GB-WEB compatibility
PLC Simulation via
Ethernet

Factory-Set IP address
settings for data transfer
General SI10 Protocol
Serial 2-D reader
compatibility

Serial bar-code reader
compatibility

256-color display

Q-tag: up to 2048
messages

Q-tag: Expansion of time
format digits

T-tag: momentary (one-
shot buzzer)

Number of logging
words: 255

Image Fonts

Multi Language Display
Function

Screen Snapshot
Function for Simulation
|/O Setting (Monitor
function for touch panel
input time)

Image Parts

Screen Capture Function
Compatible with v-tag
Pop-up Keyboard
Function

Global Vibration Function

O.i
O,\’S
O,\’S
o
X
o
X
o
Ox—

2
o
Ox—

2

*
~

oO|lOoO|0OlO|O
X | X [X]| X | X
O|lOo|0OlO|O
X | X [X]| X

ol
ol
ol
ol

X |1 O [XI X|O | O | X |IX| X| X |IX] X | X
X |1 O [XI X|O | O | X |IX| X| X |IX] X| X
X |1 O [XI X|O | O | X |IX| X| X |IX] X | X
olololo|lo|o]|o|x| x| x|x| x| x]|x|z
olololo|lo|o]|ol|o|l x| x |x| x| x|x|x
o|lololo|lo|o|o|lolo|lololo]|o
olololo|lo|o]|o|o|l x| x x| x| x
olololo|lo|lo|ol|lolo|lololo]|o
olololo|lo|lo|lo|lo| x| x|x|x]|©

oO|lo|oflo|o|oO| O
oO|lo|oflo|o|oO|Ofe.
o|lo|olo|o|o|oOfe.
o|lo|olo|o|o|oOfe,

O
O
O

w

O |x|Oo|o| O
O | X|[O|Oo| ©O
O |Xx|[Oo|o| ©O

X| O | X[X]|X

X| O | X[X]|X

X| O | X[X]|X

x| o |x|olo| o
x| o |x|olo| o
x| o |x|olo| o
x| o |C.lolo| ©
x| o |x|olo| o
x| o |C.|olo| ©
x| o |x|olo| o

O
O
>

*1 A middle-size multi-unit E is necessary to enable this function.

*2 A large-size multi-unit E or GP Ethernet I/F unit is necessary to enable this func-
tion.

*3 To utilize this feature, the optional VM unit is required.

*4 A bus conversion unit and a large-size multi-unit E or a GP Ethernet Interface unit
are required to enable this function.

*5 GP-2300L/S, GP-2301L/S, GP-2500L/S and GP-2501L/S do not support this fea-
ture.
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<Functions of GP-PRO/PB I11 for Windows Ver. 6.0>
O : Supported @: Depends on Unit X: Not supported

ST Series
Items ST ltems ST ltems ST
. A-tag: Indirect designation of text -
Full support (64-color) display X g ) g O ||Q-tag block printing X
screen or sub-display screen
3-speed blinking X ||Filing data function O ||Q-tag external operation (0]
Data sampling O [|Data logging function O [|A-tag blank line display o
. Alarm message: Can be used up to
LS area backup O ||Sound output function X (0]
512 messages
Trend graph (tag) backup O ||CF Card compatibility X ||Backlight burnout detector X
Trend graph (tag) “block display” O [|Global D-script O ||Internal 2-Port function O
Trend graph (tag) lower-section fill | O |[fCompatible with Pro-Server X [|GB-WEB compatibility X
. . . Compatible with LS area for . . i
Changing color using K-tag bit of. P ) O [[PLC Simulation via Ethernet X
simulation
E-tag, g-tag, K-tag: Indirect color . . Factory-Set IP address settings for
_g gtag g O ||GP resetting due to write error (e} y g X
setting data transfer
E-tag, g-tags: Indirect designation of Compatible with transfer speed of
A (e} O [|General SIO Protocol X
relative value range 115.2Kbps
C-tag, E-tag, S-tag: Tilin Creation of composite parts for . .
g g g- 1ing of._.. I postiep O || Serial 2-D reader compatibility X
background colors (Bg) Filing Data
-tag: Color differentiation in graph . . . . I
3_ gl grap O ||D-Script: Bit dual state trigger O || Serial bar-code reader compatibility | X
isplay
D-script Additions (Drawing, Math . .
.p ( g O ||D-Script: Memory Copy O ||256-color display X
Functions)
Drawing function (H-tag) O ||D-Script: Memory block initialization| O ||Q-tag: up to 2048 messages O
. . . . . Q-tag: Expansion of time format
T-tag: Radio switch function O ||D-Script: Loop function (0] diait (0]
igits
Inching output switch (Tih-tag and . . .
Tiwet g; P ( g X ||D-Script: Address offset designation | O |[T-tag: momentary (one-shot buzzer) | O
iw-tag
D-Script:Temporary address (can be .
Q-tag: Backup (0] P porary ( O [[Number of logging words: 255 (0]
used up to 90 addresses)
. . Filing function:Can be designated
Q-tag: Setting display format (0] . O [|Image Fonts (0]
up to 10,000 pieces of data
Q-tag: Display by second O ||Filing function: Multiple folders O [[Multi Language Display Function (0]
. . Filing function: Stores the cursor Screen Snapshot Function for
Q-tag: Setting print color X o o | .. . X
position. Simulation
Filing function: Device data transfer 1/0 Setting (Monitor function for
Tank graph (pre-made parts) (0] . . (0] . . (0]
completion Bit Address touch panel input time)
Meter graph (pre-made parts) O ||Logging function: Loop function O |[Image Parts (0]
) ) . Logging function: Total LS data .
Video window display (V-tag) X it O [|Screen Capture Function X
write
Setting Direction of Screen Printout | X [|CF Card free capacity storage X [|Compatible with v-tag X
Interrupt/cancel hard-copy printout [ X [|4-state lamp (pre-made parts) O ||Pop-up Keyboard Function O
Set “OFFLINE” mode switch feature . . I .
ﬁ O ||T-tag: Grouping with auto OFF Global Vibration Function X
0
. T-tag: Interlock Touch Available
Q-tag: Sub-display (e} g . . (e}
Conditions (bit OFF)
-tag: Grouping of alarms into a
Qtag uping ! O ||Offline shift (pre-made parts) O

block
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<New Functions of GP-PRO/PB 111 for Windows Ver. 6.1>
O : Supported @: Depending on the type X: Not supported

GP70 Series
tems 222'778 GP- | GP- | GP- [ GP- | GP- | GP- | GP- | GP- | GP-
) 270 | 47 7 71 | 67 70VM[870VM| 377L | 377
GP-57JS 0 0570 |5 675 |570VM|870VM| 3 377S
CSV Data Transfer
] X X X X X X X X X X
Function
CSV File Display
: X X X X X X X X X X
Function
CF Card File Manager
. X X X X X X X X X X
Function
Extended SI0 Script X X X X X X X X X X
Trend Graph: Data
) X X X X X X X X X X
Record Display
Trend Graph/Data
Sampling: Up to 40 trend X X X X X X X X X X
lines
Backup Function for
X X X X X X X X X X
Trend Graph parts
Q.-tag Log Alarm: Date x " « X « X x « « «
display for all alarms
SRAM Auto Backup
) X X X X X X X X X X
Function
Filing Function: Block
X X X X X X X X X X

No./Block Name Transfer
Text Size: Added Control
for size adjustments X X X X X X X X X X
(integers from 1 to 8)
Loop Function with

X X X X X X X X X X
Screen Capture
Screen Capture
) . X X X X X X X X X X

Completed Bit Setting
On/Off of Common
Password for Offline X X X X X X X X X X
mode
GLC Ladder Monitor

n X X X X X X X X X X
Function
Support fo_rlndex Text in X x x X x X x X o o
Message Display

*1 Supported only by the GLC-2400/2600 Series.
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<New Functions of GP-PRO/PB Il for Windows Ver. 6.1>

O : Supported @: Depending on the type X: Not supported

GP77R/GP2000 Series

" GP- | GP- | GP- 2221 2(221 GP- | GP- | GP- | GP- | GP- | GP- | GP- | GP-

ems 377R |477R(ST7R| 7| “ L 2300 | 2301 | 2400 | 2401 | 2500 | 2501 | 2600 | 2601
CSVpataTransfer X X X o o o o 0 0 o o o o
Function
CSVFile Display x| x| x|olo|lo|lo|lo|lo|lo|o|o]|o
Function
CFCa_rdFlleManager . x x o o o) o) o) o o 0 o
Function
Extended SIO Script x | x | x [0%] 0% o2l o® | o2 ]0° 022 0% | 0?
TrendGraph:Data X X X ol o olololololo]| o
Record Display
Trend Graph/Data
Sampling: Upto40trend [ x | x | x [ Ol O] O]J]O|O|[O]J]O]J]O|O]|O
lines
Backup Function for . x x olololololololololo
Trend Graph parts
Q.-tagLogAIarm: Date X X X olololololololo]lol o
display for all alarms
SRAM Auto Backup x| x| x|o|lo]o]o|lo|lo|o|o]|o]o
Function
Filing Function: Block . . . olololololololololo
No./Block Name Transfer
Text Size: Extended
options for text size X X X oJ]o|JOoO]J]O]J]O]J]O|lO|lO|lO]|O
(integers from 1 to 8)
Loop Function with X X x olololololololo]lol o
Screen Capture
Screen Capture x| x| x|olo|lo|lo|lo|lo|lo|o|o]|o
Completed Bit Setting
On/Off of Common
Password for Offline X X X @) 0] O] 0] 0] 0] O O O O
mode
GLC Ladder Monitor

. n X X X X X X X X X X X X X

Function
Supportfo_rlndexTextln olololololololololololo]| o
Message Display

*1 Supported only by the GLC-2400/2600 Series.

*2 To enable this function, first install GP-PRO/PBIII version 6.2 or later to enable
the serial interface selection feature.

*3 Depending on the GP revision, it may sometimes not be possible to change the
“Serial I/F Switch’ setting to ““Yes”. For details regarding GP revisions,

4.2.8 Changing Extended SIO Type
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<New Functions of GP-PRO/PB |11 for Windows Ver. 6.1>
O : Supported @: Depending on the type X: Not supported

Display

ST Series

[tems ST
CSV Data Transfer Function X
CSV File Display Function X
CF Card File Manager Function X
Extended S10 Script o™
Trend Graph: Data Record Display | O
Trend Graph/Data Sampling: Up to o
40 trend lines
Backup Function for Trend Graph o
parts
Q-tag Log Alarm: Date display for o
all alarms
SRAM Auto Backup Function X
Filing Function: Block No./Block o
Name Transfer
Text Size: Extended options for o
text size (integers from 1 to 8)
Loop Function with Screen X
Capture
Screen Capture Completed Bit X
Setting
On/Off of Common Password for o
Offline mode
GLC Ladder Monitor Function X
Support for Index Text in Message o

*1 To enable this function using ST400/ST401 units, first install GP-PRO/PBIII Ver.
6.3 or later to enable the serial interface selection feature.
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<New Functions of GP-PRO/PB |1l for Windows Ver. 6.2>

O : Supported @: Depending on the type X: Not supported

GP70 Series
wms | paro | O | OP | G| e o | G| D0 e g | o
GP-571S 270 | 470 | 570 | 571 | 675 w | v 377L | 377S 2B
8-level monochrome
. X X X X X X X X X X X
display
Trend graph (Block
Display) X X X X X X X X X X X
Dot display
Trend graph (Block
Display) X X X X X X X X X X X
Assistant line display
Trend graph (Block
Display)Display range X X X X X X X X X X X
designation
CSV data transfer:
Condition name X X X X X X X X X X X
search/auto-transfer
D-Script
CF file operation X X X X X X X X X X X
function
D-Script
Printer port operation X X X X X X X X X X X
function
Serial interface selection X X X X X X X X X X X
Multilanguage function
Support for other X X X X X X X X X 0 0
language input
Background color for G-
tags and bar/pie/half pie X X X X X X X X X 0 0
graph parts
CF Memory Loader Tool:
Conversion from MEM X X X X X X X X X X X
file to PRW file
CF Memory Loader Tool:
: . X X X X X X X X X X X
Multiple projects
7-segment display of
X X X X X X X X X X X

parts
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<New Functions of GP-PRO/PB 111 for Windows Ver. 6.2>
O : Supported @: Depending on the type X: Not supported

GP77R/GP2000 Series

Items

GP-
377R

GP-
477R

GP-
577R

GP-
2301
H

GP-
2401

GP-
2300

GP-
2301

GP-
2400

GP-
2401

GP-
2500

GP-
2501

GP-
2600

GP-
2601

8-level monochrome
display

e

Trend graph (Block
Display)Dot display

O

Trend graph (Block
Display)Assistant line
display

Trend graph (Block
Display)Display range
designation

CSV data transfer:
Condition name
search/auto-transfer

D-Script
CF file operation
function

0"

0"

0"

0™

0™

0"

D-Script
Printer port operation
function

Serial interface
selection

o'

o

ot

o'

Background color for
G-tags and bar/pie/half
pie graph parts

CF Memory Loader
Tool:

Conversion from MEM
file to PRW file

CF Memory Loader
Tool:
Multiple projects

7-segment display of
parts

X

X

X

O

O

O

O

O

O

O

O

O

O

*1 Depending on the GP revision, it may sometimes not be possible to change the
“Serial I/F Switch™ setting to ““Yes”. For details regarding GP revisions,

4.2.8 Changing Extended SI1O Type

*2 This function can be used for the D-Script or Global D-Script. For the extended
SIO Script, the serial interface selection must be designated in advance for the
extended SIO Script protocol.

*3 The GP-2501T and GP-2501S do not support this function.
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<New Functions of GP-PRO/PB 111 for Windows Ver. 6.2>
O : Supported @: Depending on the type X: Not supported

34

ST Series

ltems ST
8-level monochrome display (0]
Trend graph (Block Display) Dot o
display
Trend graph (Block Display)Assistant o
line display
Trend graph (Block Display)Display o
range designation
CSV data transfer: X
Condition name search/auto-transfer
D-Script X
CF file operation function
D-Script X
Printer port operation function
Serial interface selection ot
Multilanguage function support for o
other language input
Background color for G-tags and o
bar/pie/half pie graph parts
CF Memory Loader Tool: X
Conversion from MEM file to PRW file
CF Memory Loader Tool: X
Multiple projects
7-segment display of parts (0]

*1 Supported only by the ST400/ST401.
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<New Functions of GP-PRO/PB 111 for Windows Ver. 6.3>
O : Supported @: Depending on the type X: Not supported

GP70 Series

GP-H70
Items GP-370
GP-57JS

GP- | GP-
270 | 470

GP- | GP-
570 | 571

GP-
377L

377S

GP-
37W

Multiple Copies -Copy
Direction Selection

0] O] 0]

@]

@]

o

Index Text Center
Positioning

x
x
x

x
x

x

x

x

Extended Font Char. Size

Security Levels

x|x|O
B3 le)
x<|x|O

Time Schedule

B3 le)
Bl le)

x<|x|O

x|x|O

x|x|O

X|xX|O|l O

X|IxX|O| O

X|IX|O| O

OFFLINE Language
Switching

x
x
x

x
x

x

x

x

x

x

x

Half-2 Byte Character (0] X (0]

GP77R/GP2000 Series

cp-| cp- | Gp-
Items 377R |477R | 577R | B0

GP-
2300

GP-
2301

GP-
2400

GP-
2401

GP-
2500

GP-
2501

GP-
2600

GP-
2601

Multiple Copies -Copy
Direction Selection

Index Text Center
Positioning

Extended Font Char. Size| O 0 0 0

Security Levels X X X X

Time Schedule X X X X

OFFLINE Language
Switching

Half-2 Byte Character 0 0 0 0

ST Series

Items ST
Multiple Copies -Copy
Direction Selection
Index Text Center
Positioning
Extended Font Char. Size
Security Levels
Time Schedule
OFFLINE Language
Switching
Half-2 Byte Character

O

Ol O |0O|0o|0] ©
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GP SERIES COMPATIBILITY

Files created with prior versions of the software can be converted to GP-PRO/
PB I11 for Windows Ver. 6.3 project files.

! * Ver. 6.3 data cannot be converted to the following data types.
Important
Original Data Type Converted Data Type
GP-PRO
GP-PROII

GP-PRO/PBIII for  |GP-PROIIl

Windows Ver.6.3  |GP-PRO/PBIII (DOS Version)
(This product)  [Gp-prRO/PBIII (Prior 10 Ver. 6.3)

Parts Box

LT Editor

* Pro-face strongly recommends that you do NOT try to open a
project file made using GP-PRO/PBIII for Windows Ver. 6.3 with a
prior version of the GP-PRO/PBIII for Windows software.

Doing so may delete important setting data.

B Converting GP-PRO/PB 111 for Windows File Data
A project file from earlier GP-PRO/PB 111 for Windows versions can be easily
opened with this software.
SAEETITIX 1.1.2 W Selecting an Existing Project

@\ * When the following Project files are opened with GPPRO/PB 111 for
‘Note: Windows Ver. 6.3, the time stamps of the selected Project files are

X2 updated as a result of file data conversion.
* Project files created with GPPRO/PB 111 for Windows (Version 6.0 or
earlier)

Once the time stamp has updated, opening the same Project file using
version 6.3 will not update the time stamp.

»  When the following Project files are opened with GPPRO/PB |11 for Win-
dows Ver.6.3 and the [Transfer Settings] dialog box is activated, the time
stamps of the selected Project files are updated due to the file data conver-
sion.

» Project files created with GPPRO/PB 111 for Windows Ver. 6.2 or
earlier

Once the time stamp is updated, opening the same Project file using

version 6.2 will not update the time stamp.

B Converting Data from GP-PRO/PB 111 (DOS version)
Screen data from GP-PRO/PB 111 (DOS version) can be opened with the GP-PRO/
PB I11 for Windows Ver. 6.3 software. To do so, specify the "File Type" asa DOS
project file (*.PRO) in the [Files of type:] area, when selecting a project.
1.1.2 M Selecting an Existing Project

36 GP-PRO/PB Il for Windows Ver. 6.3 Operation Manual



GP SERIES COMPATIBILITY

B Converting Data from GP-PRO, GP-PRO I1, or GP-PRO/PB Il
GP-PRO Il or GP-PRO I11 Screen data can be converted to 6.3 data for use on
GP70/GP77R/GP2000 series units using the GP-PRO/PB |11 for Windows er.
6.3 file converter utility. However, after the GP-PRO Il or GP-PRO 111 SO
(System) screen data is converted and sent to a GP70/GP77R/GP2000 series
unit, you must then review all GP settings in OFFLINE mode.
12.1 File Converter

€ Cautions when converting GP-PRO Il Data

Ifa GP-PRO Il screen contains "filled" data, filled tiling patterns may be shifted
when displayed on Power GP series (GP70/GP77R/GP2000 series) units. On
GP-*30 and GP-*50 series units, color is filled on the screen based on the
drawing's starting point. However, Power GP series (GP70/GP77R/GP2000
series) units fill color from the upper-Ileft corner (0,0) of the screen, and only
show the drawing area. Please be aware of this difference when you call up a
filled drawing using L-tags, or when placing filled objects on top of one another.

(Example) Created with GP-PRO Il
Filled tiling pattern

When the above screen is
converted with the file con-

Transferred from GP- verter of GP-PRO/PBIII for
PRO Il to GP-*30 or r A Windows (Ver.4.0 or later), and
GP-*50 series units a Q] sent to the POWER GP (GP70/

GP77R/GP2000) series unit:

XN

Displayed on a GP-*30 .
. . Power GP series
_*
or GP-*50 series unit (GP70IGPT7R/
GP2000 series)
unit display
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B Fill-in areas

When painted objects drawn with the GP-PRO, GP-PRO II, GP-PRO Ill, or
GP-PRO/PB |11 (DOS Version) are converted into data for GP-PRO/PB Il11 for
Windows, the object may appear to be incompletely painted. Modify the con-
verted objects as necessary with GP-PRO/PB 111 for Windows.

B Converting''Parts Box" Data

The GP-PRO/PB |11 for Windows file converter can convert Parts Box screen
data for use as GP70/GP77R/GP2000 series unit data.

12.1 File Converter

B Data Conversion from LT Editor

‘Note: This function is available only when GP-PRO/PB |1l C-Package is in-
2 stalled.

GP-PRO/PB Il for Windows Ver. 6.3 can open screen data from LT Editor.

Select the LT Project File (*.LTE) in the "Files of type™ field in the "Select™ dialog
box.

1.1.2 M Selecting an Existing Project
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WHEN USING GLC SERIES UNITS

GLC2000 Series units are equipped with the same features as GP2000 units,
with the addition of control-related features. As a result, please change the word
“GP” to “GLC” when reading this manual. However, please remember that GLC
Series units cannot use AUX output or Sound output.

Be sure to understand this manual thoroughly before using your GLC unit.

WHEN USING ST SERIES UNITS

In this manual, read the word “GP” (“GP2301L") as “ST”. However, ST units
have certain restrictions owing to hardware specification differences with GP-
2301L units. Be sure to understand this manual thoroughly before using your ST
unit. Functions incompatible with your ST unit, [GENERAL
GP RESTRICTIONS] section, 2.11.2 Restrictions
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FUNDAMENTALS OF GP-PRO/PB Il for WINDOWS

I his chapter describes GP-PRO/PB 111 for Windows’ basic operations

such as how to start and quit the software. It also explains the Project
Manager and Screen Editor areas, which are used for the majority of screen
creation work. Also, a number of tools are introduced here, such as online
help, which provide explanations of GP-PRO/PB Il1 for Windows’ functions
and operations.

L. From Start to Finish
12 Project Manager
1.3 Screen Editor

14 s GP-PRO/PB 111 Manuals and Help



1.1 From Start to Finish Chapter 1 - Fundamentals

m From Start to Finish

This section describes the GP-PRO/PB 111 for Windows program’s operation
flow from start to finish.

Usage Pattern |

Create/Select a Create/Edit a Save the screen, Save the project,
Start — project file with the - screen with the - and quit the — and quit the
Project Manager. Screen Editor. Screen Editor. Project Manager.

@ Getting Started |

W Starting GP-PRO/PB |11 for Windows

The following explanation assumes your PC is turned on and the Windows
desktop has appeared.

PROCEDURE REMARKS
(1) Click on the [Start] button, and point to the [Pro- If you double-click directly on a
grams] - [Pro-face] - [ProPB3 C-Package] menu. previously made project file

Then, click on the [1. Project Manager] command. | (*.PRW file) via the Explorer soft-
ware, GP-PRO/PB 111 for Windows

will automatically start.

B FioPB2CPackage *|45 1Project Manager N

Far [ Accessories » =5 2Fie Converter
B (& StartUp 3 & 3 FRebu
Favorites [ B8 MS-DOS Prampt a3 4Pack Tedl
- WicrosoftWard 0 & Project Comp. toal
&% Documents HBg wincows Explorer 5] Readde
P
=%, Uninstal
% Settings 4 Eﬂl
Eind 4
& Hep
= Bun..
iw Shut Down.
o stert

(2) The Project Manager screen appears.

5 Plant 1.prw : Production Monitoring - Project Manager
Pioject  Screen/Setup  Contiol Uty Help

GFZE00

m MITSUBISHI MELSEC-An&{LINK)

nane

Ready Y
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Chapter 1 - Fundamentals 1.1 From Start to Finish

@ Creating/Selecting/Saving a Project ]

A project file (PRW file) normally contains multiple screens intended for the
operation of a certain system. GP-PRO/PB |11 for Windows creates one
project file for the operation of one system, enabling system management by
project file units.

You can send the screen data of one project file or individual screens of the
same project file to the GP unit. Screens of different project files cannot be
used simultaneously on the GP unit.

B Creating a New Project

Before creating a new project, designate the GP type, serial interface selection,
Device and Extend SIO information according to your current application.

&GP Type

Select your Device/PLC Type accordinig to the series of the Device/PL Type
LIST OF SUPPORTED MODELS

@& Serial interface selection

Specify whether to change the destination of the serial interface and the
Extend Serial Interface before selecting/changing the device or the extended
SIO. This feature is available only with the GP-2000 Series.

4.2.7 Changing Your Project's Device/PLC Type and
Addresses, 4.2.8 Changing Extended SI10O Type

Page 27 General GP Restrictions @ Extended SI1O Script
@ Device/PLC Type
Select the type of Device/PLC to be connected to your GP unit.

Device/PLC Connection Manual

@ Extend SI0 Settings

Select the type of Extend SIO.
This feature can be selected only when the GP-2000 series is selected as the
GP Type.

* Serial Code Reader (LS)

Select this option when connecting a Two-Dimensional Code Reader to the
extended serial interface.

Tag Reference Manual, 4.8.2 Compatible Serial-code
readers

* General SI10O Protocol
Select this option when using extended SIO functions with D-script.

Tag Reference Manual, 3.1.11 Example Communication
Using Extended S10

GP-PRO/PB Il for Windows Ver. 6.3 Operation Manual 1-3
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« Serial Code Reader (K-tag)
Select this option when connecting a One-Dimensional Code Reader to the
extended serial interface.

Tag Reference Manual, 4.9 Bar-Code Reader Compatibility
» Extended SIO Script Protocol

Select this option when using the Extended SIO Functions with the Ex-
tended SIO Script.

2.7 Extended SI10 Script, Tag Reference Manual 3.2
Extended SI10 Script
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1.1 From Start to Finish

PROCEDURE

REmMARKS

(1) Select the Project Manger's [Project] menu - [New]

command, or click on m

(2) Enter a description and select a GP Type, serial in-
terface and Device/PLC Type from the pull-down
menu. Make the settings for Extended S1O Settings
as necessary.

Extend SI0 Type(EXT Serail /F)

[l=———|

Help

Click the [OK] button in step (2) to skip step (3) and
jump to step (4).

Easy Com

(3) Click the| "3 [button toenable [Mode Settings],

[System Area Settings] and [Communication Set-
tings] for the PLC Type selected in step (2). When all

settings are completed, press the button.

(4) The GP-PRO/PBIII for Windows system will then
ask you if you wish to create a screen. If you click

on the button, the Screen Editor will start

and you can begin laying out your screen.

L 3
@ Do pau want to launch the Editar 7

=

When entering a description, you
can use up to 60 single-byte char-
acters.

Device/PLC
Connection Manual

The settings on the left can also be
made by clicking m in
the Project Manager.
When setting the “Serial I/F
Switch” feature to “Yes” in a
GP2000 Series unit that does not
have Extend Serial I/F,you cannot
use the button.

Easy Com
Settings

1.1.3 Opening/
Closing/Saving a Screen

GP-PRO/PB Il for Windows Ver. 6.3 Operation Manual
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ﬁ@te: If you attempt to create another project file without saving a newly created
project file, the system asks if you wish to save the current file. If you click on

the button, the [Save As] dialog box appears. If you click on the

button, the system opens a new screen without saving the current
project file.

1.1.2 @ Saving a Project File under a Different Name

Project Manager

@ Do pou want to gave changes 7

e[ me ][ canca ]

BWSelecting an Existing Project
Select the Project Manger's [Project] menu - [Select] command, or click on

. When you select a project, the following setting screen
appears:

Used to create
anew folder

Used to display
the folder of the
preceding level

Used to display
afile list

Used to select the
folder containing the
target project file

Used to display
a detailed file

Lists the current —&

folder and existing
project files

File name:

Files af type

Description :

Display Type:

Flant 1 pror
] P

T o= |

[indaws Project Files ¢ praj

E” Cancel

J Production Monitoring

] GP2B0D

Device/FLE Type ] WMITSUBISHI MELSEC-AnA(LINK)

Extend 510 Type: ] nane

A

n Process. prw ||St

Displays the
project file
name selected
from the list
You can
specify the
project file by
typing the file
name

I
Displays the project file's
comment and the selected
GP unit, Device/PLC Type
and Extend SIO Setting

Used to select the
project file type desired

@File Types

You can select either a project file created with the DOS version of GP-
PRO/PB 11l (DOS project file: *.PRO), or a project file created with GP-
PRO/PB 111 for Windows (project file: *.PRW).

ﬁ; If you specify the GP type as “GP570VM” in a DOS project file,
|mpo'rtam and the GP type is not recognized as “GP570VM” in GP-PRO/PB
[ll for Windows, then re-register the GP type as “GP570VM” in
the Windows version.
Kote;
X2l

Double-clicking on the file (project file: *.PRW) itself in Explorer automati-
cally starts GP-PRO/PB 111 for Windows and opens the file.
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1.1 From Start to Finish

PROCEDURE

REmMARKS

(1) Select the Project Manger [Project] menu’s [Select]

command, or click on .

(2) Select a project file from the list that appears, or

type the project file name.
Select “ Factory A”

FelE & EE

File name:

| N
|

Files oftype:  [Windows Project Files (*pro) =]

Description: Procuction Marnitoring

Device/PLC Type: | MTSUBISHIMELSEC-AnA(LINK

| \
Display Type: J GP2600 ‘
| |
| \

Extend 510 Type: none

[7]x]

To type a
L — file name
viathe

type the
file name
here.

S

(3) Click on the button to open the selected

file.

B Saving a Project

keyboard,

To select a project file located in
another folder, find a desired file
from the “Look in: (File location)”.

To select a file created with the
DOS version of GP-PRO/PB I, se-
lect “DOS Project File (*.pro)” in
“File Type:”.

When you double-click on the file
name selected in step (2), you can

skip the command.

To create a screen,
refer to 1.1.3 Opening/Closing/
Saving a Screen.

When the data of an existing project file is changed, the changes will be automati-

cally saved.

However, if you attempt to create a another new project file without first saving your
current project file, the GP-PRO/PBIII will ask if you wish to save the current file. If

you click on the button, the [Save As] dialog box will appear.
P Reference SR Saving a Project File under a Different Name

GP-PRO/PB Il for Windows Ver. 6.3 Operation Manual
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M Saving a Project File under a Different Name
You can save an existing project file under a different name or with different GP

type, Device/PLC type and Exend SIO settings.

PROCEDURE

REMARKS

(1) Select the [Project ] menu - [Save As ] command in
the Project Manager.

(2) The comment, GP type, Device/PLC type and Ex-
tend SI0O of the currently opened project file are dis-
played.

Enter the desired file name, and enter the items to be

changed.
Select m

Lookin: | &3 database E"

File name: JProducﬂDn Process.prw ‘ Save
Files of type JWmdDws FrojectFiles (“prw) E” Cancel

Description Froduction Processing

Display Type: GPZB0D

) |
) |
Device/PLE Type J MITSUBISHI MELSE C-AnALINK) |
J |

Extend 510 Type: none

(3) Click on the button to save the file.

If a project file with the same name exists, GP-PRO/
PBIII will ask if you want to replace (overwrite) the ex-
isting project file with the project file you are attempt-
ing to save.

If so, click on the button. If you do not wish to

overwrite the existing project file, click on the

button.

C:\Program Files'Pro-faceProPE'win\databasenewglc. prw alieady exists.
['o you want to replace it?

Tes

The file name can contain up to 255
characters (including the path-name
and extension.)

7 \

]
Important
Before changing the GP
type, check the preset data,
since the drawing area and
functions vary depending on
the type of the GP unit.

4.2.6 Changing a
Project’s GP Type

A

!
Important
Once the Device/PLC type is
changed, you must change
the addresses of the Parts,
Tags, D-Scripts and alarms,
and perform the GP system
setup again.

4.2.7 Changing
Your Project’s Device/PLC type

and Addresses

To open another
project file, see 1.1.2 MCreating a

New Project or BSelecting an Ex-
isting Project.

To close GP-
PRO/PBIII for Windows, see 1.1.4
Quitting GP-PRO/PBI 11 for Win-
dows.
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A

/A
] « When a Vertical GP unit is replaced with the horizontal type, or

important  ViC€-Versa, the displayed screen will rotate 90° relative to the
original data. In this case, you must edit the displayed data
using the [Rotate] command. After editing, be sure to check
the displayed data.

ABC I

Horizontal type Vertical type

Example)

ABC I

* When a high-resolution type GP unit is replaced with a low-reso-
lution type, high-resolution data can no longer be displayed. If the
low-resolution type GP unit is again replaced with a high-resolu-
tion type and the same project file is used, the data will once
again be displayed.

* The maximum number of characters used for an alarm summary
in the low-resolution type is different from that of the high-reso-
lution type. When an alarm message created with the high-resolu-
tion type is used in a low-resolution type, data extending beyond
the message area will not be displayed.
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1.1 From Start to Finish Chapter 1 - Fundamentals

@ Opening/Closing/Saving a Screen ]

After selecting a project file, you can create a screen. First, you must move
from the Project Manager to the Screen Editor, and open a screen. This
section describes the procedures for opening, closing, and saving a screen.

BOpening a New Screen

PROCEDURE

REMARKS

(1) Select the Project Manger's [Screen/Setup] menu -

[Editor] command, or click on .

The Screen Editor’s opening screen will appear.

- Qton Dy gy B Sovsid Livey irdon Hb

‘Secen £ Vew Doion D Sag S Loy wadow 1
DEAs M| r|[F] ot bB|LRBBS ¢ & |
Nl - v»Dovanxmr @amwe | bEEmOE 5

AWCDIERFGIHIKEKL !MMW%@W%F!%TM/@V“/M%“
IO I B DRI T EIRE

— == W A i
Bl & @ 9 & % B ew i roea v |0 5

(2) Select the Screen Editor [Screen] menu’s - [New]

command, or click on[[3].

(3) Select the screen type.

Base Screen Cancel
[Base Screen

Mark Screen
Trend Screen

Keypad Screen k

Video Screen

“inclown Screen

(4) Click on the button to create the desired

type of screen.
The designated GP type’s drawing screen will appear.

Scieen £ Vew Opion Diw Lsgs Pots Special Liway Wi
D& H T @I v |8 ] oe|si

Bl - ~O0COoamnumeEamlow]|
7 Uninieat

[A2cPdEFGOHIKEL IMNOPARS
IEEERFERC I EEEERECICEEIE
e o

When the Screen Editor has already
been started, skip step (1).

Selecting the [Screen] menu’s -
[Open] command or clicking on
and entering an unregistered

screen number can also be used to
open a new screen.

Enter the screen number and title
when saving the screen.

1.1.3 M Saving a
Screen under a Different Name

Up to twenty screens can be simul-
taneously opened.

Multiple types of windows can be
opened on any one screen at the
same time.

1-10
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B Opening a Previously Saved Screen

1.1 From Start to Finish

PROCEDURE

REMARKS

(1) Select the [Screen/Setup] menu’s - [Editor] com-
mand, or click on in the Project Man-

ager.
The Screen Editor’s opening screen will appear.

(2) Select the [Screen] menu’s - [Open] command or
click on ]

(3) Use this screen to select a screen name from the list,
or select the screen type and enter the screen number.

When checking the [Preview] check box, the selected
screen image can be viewed in the dialog box.

[Openscreen |
Praject File: Praject 1.pna
Screer: B
T e

| T

|Base Screen E”
Place a check mark in
@ the [Preview] box.

QOpen Screen

Project File: Froject 1.prw

3 -

Screen:

:

Open

Copy

Y

| Change I

Wiy

Delete

[ F'review
TG |
AN

Preview Check Box

When the Screen Editor has already
been started, skip step (1).

When you double-click on the de-
sired screen number in step (3), you
can skip the operation of the

button.

If you enter a screen number that
has not been registered in the list, a
new screen will be opened and that
number will be assigned to it.

When selecting multiple screens, a
screen with the smallest screen
number of them will be displayed.

GP-PRO/PB Il for Windows Ver. 6.3 Operation Manual
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1.1 From Start to Finish

Chapter 1 - Fundamentals

PROCEDURE

REMARKS

(4) Click on the button to open the screen.

The selected screen will be opened.

v Tags Pats Specidl Lbiay Window Help

D& AQafr o B|2|LEEsO XY

M- +O00Cvanu"EaE|we| amallnEd

Lk lct

& i svich [ Woaswien [ 75 Fone ]

] Ohrge 0

[#2 P dEFSOHIKKLIMNNRPARS T
[esaviownonvar|@Eola|les|ab |8

oo [ 65a Jneas

[ T
(e

p Up to twenty screens can be open at the same time.
No\eﬁ To select several screens simultaneously, while pressing the key, click on a
screen and drag the mouse over desired adjacent screens; or, you can select
screens individually by clicking on them while pressing the key.

Opensereen |
Project File: Project 1.pres
Sereen B
Open
Copy
Change:
iew
Delete
Freview
IBase Screen E” " Help |

s Pats Specal Libvay window Heb

BRI ER IR XS+
O EEET R s

ABECDIEFGIHIRKLIMNNPARS T §TiwUVY vWX
SeHG|OBHOAPER|EC |GG |GD CBEEEE|NE

Blras FTas ) Obiests

gy

I ik Seect

25 Charge O

TEE =0T Jres [y T

g 2@ 8@ Y [[Brew
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MSaving a Screen

1.1 From Start to Finish

PROCEDURE

REMARKS

(1) Select the [Screen] menu- [Save] command, or click

on in the Screen Editor.

(2) The current screen will be saved overwriting the pre-
vious one.

After the screen is saved, it will re-
main open.

To open another
screen, see 1.1.3 M Opening a New
Screen.

To quit GP-PRO/
PBIII for Windows, see 1.1.4 Quit-
ting GP-PRO/PBI |1 for Windows.

When you attempt to save a new
screen, the [Save As] dialog box
will appear.

1.1.3 W Saving a
Screen under a Different Name

BSaving a Screen under a Different Name

PROCEDURE

REMARKS

(1) Select the [Screen] menu - [Save As] command in
the Screen Editor.

(2) The type, number, and title of the current screen is
displayed.

You can change the setting of a desired item; however,
the screen’s type cannot be changed.

Save Ag

Praject File: Manufacturing System
Screen Type: Base Screen ’%
Cancel

Sresh: 1
Securty Level 11_:':::] |M
D escription: ]Drder Accepted ||

Mo, Security Title

M aintenance
Production M anagement

Acceptance Inspection
‘wiarehouse &

Azzembly Help ]

2 i
3 i]
4 1] Relzase Scheduls
5 i
1 i
7 1]

A “” (comma) cannot be used in a
description.

When using the Security feature:

Click on |Password Setup |, For informa-

tion about setting security levels,

2.11.3 Security
Feature

After the screen is saved, it will
remain open.

If the screen is saved as a different
screen number, the screen of the
updated number will be displayed.

To open another
screen, see 1.1.3 MOpening a
New Screen or BOpening a Pre-
viously Saved Screen.

To quit GP-PRO/
PBIII for Windows, see 1.1.4
Quitting GP-PRO/PBIII for
Windows.

GP-PRO/PB Il for Windows Ver. 6.3 Operation Manual
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PROCEDURE REMARKS

(3) Click on the button to register the above

settings.

If a screen with the same number exists, the system asks
if you want to replace the existing screen with the screen
you are attempting to save.

If so, click on the button. If you do not wish to
overwrite the existing screen, click on the but-

ton.

Scieen Alieady Exists!

@ Do wou wish to Dvenite?

BClosing a Screen

PROCEDURE REMARKS
(1) Select the [Screen] menu - [Close] command in the | You can also close the screen by
Screen Editor. clicking on the [X] button at the up-
i per right corner of the window
(2) The screen will close. (drawing area).

If you attempt to close an updated screen without saving
it, the system asks if you wish to save the current screen. | When you attempt to save a new

If you click on the button, the system saves | Screen, the [Save As] dialog box ap-

the updated data. If you click on the button, pears.
the system closes the screen without saving the updated 1.1.3 ®MSaving a

data. Screen under a Different Name

Drawing Board

To open another
screen, see 1.1.3 M Opening a New

Screen or M Opening a Previ-
ously saved Screen.

To quit GP-PRO/
PBIII for Windows, see 1.1.4 Quit-
ting GP-PRO/PBIII for Windows.
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Chapter 1 - Fundamentals 1.1 From Start to Finish

EE®) uitting GP-PRO/PBIII for Windows ]

BQuitting the Screen Editor

PROCEDURE REMARKS

(1) Select the [Screen] menu - [Exit] command, or click
on [gk | in the Screen Editor.

(2) The Screen Editor will close.

If you attempt to close the Screen Editor without first | When you save a new screen, the
saving the currently edited screen, GP-PRO/PBIII asks | [Save As] dialog box appears.

if you wish to save the updated screen. If you click on 1.1.3 W Saving a
the button, GP-PRO/PBIII saves the updated | screen under a Different Name

data. If you click on the button, GP-PRO/PBIII

quits the Screen Editor without saving the updated data.

Drawing Board

@ Save changes to Screen: Untitled?

HNo H Cancel |

BQuitting GP-PRO/PBIII for Windows

PROCEDURE REMARKS

(1) Select the [Project] menu - [Exit] command, or click | Once you have opened the Screen
[— ) . Editor, you must either quit it, or

on m in the Project Manager. go to the Project Manager.
1.1.4 M Quiting

(2) The Project Manger will quit. the Screen Editor

If you attempt to close the Project Manager without sav-
ing the currently opened screen’s updated data, GP-PRO/
PBIII asks if you wish to save your project’s data. If you

click on the button, GP-PRO/PBIII saves the
updated data. If you click on the button, GP-

PRO/PBIII quits (closes) without saving the updated

data.
Dravning Board
@ Save changes to Screen: Untitled1?
e[ me || conca |
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1.2 Project Manager Chapter 1 - Fundamentals

E Project Manager ]

All GP-PRO/PB 11 for Windows system level settings and functions are
controlled via the Project Manager.

@ Project Manager Areas and Functions ]

Here, each of the Project Manager’s features is explained. To begin working
with GP-PRO/PBIII for Windows, simply click on the desired button.

a. Title bar 3 Plant 1.prw : Production Monitoring - Project Manager  |IlE] IEY
Froject  ScreenfSetup  Contral | Utility || Help
b. Menu bar | Screen Capy..

ConvertImage. .
| Compress Image...

Corevert DXF..
c. Pull-Down menu

Convert Addresses
Convert Load Screen Number.

Global Cross Beterence

e. Function buttons CF Card Tool...
, Pack Toal...

AELSEC-AnALLINK]

d. Status bar ——— "Gp Setup information

a. Title Bar:
Displays the current project’s file name and title.
b. Menu Bar:

Displays the menus used for the operation of GP-PRO/PBIII for Windows.
When you select a desired menu using the mouse or keyboard, one of the
pull-down menus described below will appear.

¢. Pull-Down Menu:

When you select a desired item on the menu bar, its pull-down menu ap-
pears. These menus includes a variety of commands.

d. Status Bar:

Displays GP and Device/PLC Types as well as GP-PRO/PBIII operation
related messages.
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Chapter 1 - Fundamentals 1.2 Project Manager

e. Function Buttons

These buttons indicate the GP-PRO/PB |11 for Windows program’s main
functions (e.g. Creating Screens/alarm, Printing). You can start each func-
tion by simply clicking on that function’s button. You can also start these
functions by selecting the corresponding command from the Project
Manager’s pull-down menu.

Creates or modifies screen
Performs GP Initial data via the Screen Editor
Settings Transmits screen
and GP system
setting data to the

GP unit

Creates a new project

H Performs Simula-
tion with the GP
unit

Selects an existing
project

Creates Alarm
Editor alarms

Switches to Prints out Screen
Pro-Control Editor Editor screens
EditratioPrZOMC;%T;(l)l Switches the Project Manager Quits the GP-PRO/
P to Hierarchical (Explorer-like) PBIIl for Windows
Display mode program

SATETEIK Chapter 11
PROJECT MANAGER HIERAR-

CHICAL DISPLAY
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B Screen Editor ]

GP operation and display screens are created in the Screen Editor.

@ Screen Editor Item Names and Functions ]

The names and functions of the GP-PRO/PBIII for Windows editor’s screen
items are as follows:

j. Selection Tool Box

a. Title Bar

b. Menu Bar\
h. Tool Bar —

c. Pull-down
Menu

i. Zoom Box

Text
Load Screen
Load Maik.
ConyertImage.

[3

d. Drawing :
Area \ | oo /\
: ‘h. Tool Bar

MPats ¥ Tags ] Objects gy

Dtk seeor ] Change O ||

e w K. Screen
1 Data List

+

~

e. Screen
Center Mark

SW_3D005

Sw_3D008

Sw_3D007

. . I. Parts
h. Tool Bar ame R ::::: ) B Switch | @ Word Suitch | 75 Furclion Sw[T [[7] Palette

[#2 2D dEFBIHIKRELINNRPGRST v vy wy |
ssselennoavoi|@Eo|ales|Gb | EEREWE |

g. Status Bar — == T =T memree \\
.G

0@ [FrAlNG Iz

f. Grid Points

a. Title Bar
Displays the project file name, screen number and title.

b. Menu Bar

Displays the menus used to operate GP-PRO/PBIII for Windows. When you
select a desired menu using the mouse or keypad, the pull-down menu (c)
appears.

c. Pull-down Menu

When you select a desired menu from the menu bar, the pull-down menu
appears. This menu includes various commands.

d. Drawing Area

Here, you can create a screen for your GP unit. The size of the screen you
see here is designated via the “GP Type” setting you entered when you first
created the project file.

Depending on the size of your PC’s display, the screen’s entire display area
may not be displayed. In this case, simply scroll up or down to view the
entire screen.
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Chapter 1 - Fundamentals

e.

Screen Center Mark

Indicates the center of the screen. This mark is not displayed when the data
is sent to the GP unit.

Grid Points

Used as reference points when you draw or paste an object in the drawing
mode. Grid points will not be displayed on the GP unit’s screen. The Option
area’s “Snap” function allows you to position your screen objects using a
pre-made grid. You can also set the interval and display ON/OFF status of
the grid points.

2.9.1 Grid/Snap

g.

Status Bar

Displays information related to the current screen and provides messages
explaining the screen operation you are currently performing.

515'8,2? Send the selected objectz] to the front [:} - i@
Coordinates 'Amount of Screen Description of the ) ,
Display area’s

of current memory currently currently selected  Project’
roject’s A
mouse used (Ratio of used  command Deince/ ngn[[flcatlotlfl/
position screen area to entire PLC Type reauction ratio
screen)
h. Tool Bar

The Tool Bar provides easy to use icons for drawing and editing. Clicking
on one of these icons performs that command. The Tool Bar can either be
hidden or displayed, and individual Tool Bar areas can be moved freely
around the Screen Editor screen, i.e. top, bottom, left, or right.
The following Tool Bar areas are available:

Main Tool Bar

Edit Tool Bar

Draw Tool Bar

Option Tool Bar

Grid/Snap Tool Bar

Tag Tool Bar

Parts Tool Bar

Parts State Change Tool Bar

. Zoom Box

Shows the cursor’s current position at three times magnification.

. Selection Tool Box

Used to select objects to be edited (Parts, Tags and figures). Using the
commands included in this tool box, you can select objects using a variety of
methods.
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k. Screen Data List

Lists the settings and layout conditions of the objects (Parts, Tags and
figures) that have been arranged on the screen. You can select a desired
object from the list.

ST 2.9.4 Screen Data List

|. Parts Palette

Parts such as switches, lamps and graphs are placed on a tabbed palette
(except for the keyboard, alarms, File Name Display, Logging Display, Data
Transfer Display, CSV Display, File Manager Display, Picture Display, and
Window parts).

To place parts on the drawing screen, simply select the desired part from the
palette and place it on the screen with drag & drop operation. Only one part
can be selected per operation.
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@ Display Area (50%, 100%, 200%)

Ko,
2]

1.3 Screen Editor

You can enlarge or reduce the drawing area by selecting a magnification/
reduction ratio.

To change the display area, select the [& | or [&]icon on the tool bar, or
select the [50%], [100%], or [200%] command from the [View] menu.

B Cetion Draw Tags |
Tag List 3
Bartis Ligt ...

Lagd Seream List ...

Load Seieen esting

Cross-Reference List .. »
Preview
50 %
v 100 %
200 %
V\Sﬁn Data Box
Tool Bar »

v Status Bar

v Zoom Box

R

Zoom out Zoom in

Zoom out: Used to reduce the current display area to 50%.
Zoom in: Used to enlarge the current display area to 200%.

In the [50%] display mode, the created screen data is reduced. In this case,
the displayed screen data may be different from the actual data. We recom-
mend you to use a [100%0] or larger display area.

@ Tool/Icon Display ]

The Tag tool box, Parts tool box, tool bar, status bar and parts palette can be
designated as either shown (displayed) or not shown (not displayed). Each
time you select the [View] menu's [Screen Data Box], [Status Bar], [Zoom
Box], or [Parts Palette] as well as the [Tool Bar] command's [Main], [Edit],
[Draw], [Option], [Grid/Snap], [Tag], [Parts], [Parts State Change] or
[String Table] sub-commands, these View/Hide settings will toggle ON or
OFF.

TagList ... 3
Btz Ligk....
Load SereemLish....
Load Sereen et
Crass-Reference List ... »
Preyview
B0z
v 100 %
200 %
//Screen DiataBox
v Status Bar v Edit
v Zoom Box v Draw
v Parts Palette v Option
v Grid/Snap
v Tag
v Parts

v Partz State Chan
v ShingLa
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m GP-PRO/PB Iil Manuals and Help

While you are learning how to use the GP-PRO/PBIII for Windows soft-
ware, please refer to the following learning aids:

- Related User Manuals

- On-line Help Topics

- Digital’s Home Page

For the help concerning the operation of the Windows operating system, see
the Windows software’s manuals and help screens.

BUsing GP-PRO/PBIII for Windows Manuals

The following manuals have been created for the GP-PRO/PB I11 for Win-
dows software.

Describes the system requirements, installation procedures
Setup Guide for GP-PRO/PB Ill C-Package02 and the method for
reading the manuals in PDF format

Operation Manual

. Provides detailed program operation information.
(This manual) Prog P

Provides detailed descriptions of this sofware's special and
advanced functions.

Lists all the pre-made Parts included in the GP-PRO/PB I
for Windows sofware.

Describes connection methods used between the GP and
the device, as well as the necessary operating environment
settings.

Tag Reference Manual

Parts List

Device/PLC Connection
Manual

BUsing the Help Feature

If you have any problems or questions during GP-PRO/PB Il for Windows
operation, you can view the explanations for each feature and setting via
each window’s Help button, or from the main menu’s Help feature.

MUsing the Home Page

Users can obtain the latest GP-PRO/PBIII for Windows information by
accessing the Digital Electronics Corporation Home Page at “GP-PRO/PBIII
for Windows Members Club”.

1-22 GP-PRO/PB Il for Windows Ver. 6.3 Operation Manual



Chapter 1 - Fundamentals 1.4 GP-PRO/PBIII Manuals and Help

@ Browsing Help Topics ]

To display the help screen, select the [Help] menu or click on the

button in the dialog box.

- When multiple screens are loaded or many Tags and Parts have
! been registered on the screens, the PC’s system memory may
Important ot pe sufficient to display the help screen.

- If you jump from one topic to another on the help screen, an
error message may be displayed. When this happens, simply
quit and then re-start help.

B Searching for a Topic and then Display Help

Select the [Help Topics] command from the [Help] menu, or press the [F1]
key. A list of help topics will be displayed.

You can search for a topic by either trying to find it from the table of con-
tents, or entering a keyword for that topic.

@ Scearching for a Topic from the Contents Menu

To select a topic from the contents menu, double-click on the [Contents] tab.
Follow the screen instructions to search for a desired topic.

Help Topics: GP-PROSPB3 for Windows

Contents | Index | Find |

Click a topic, and then click Display. Or click another tab, such az Indes.

L)

Froject banager

% Screen Editor

@ Alarm

@ GP Setup

@ Tranzfer

% Simulation

@ Frint

@ Change Project kanager
e GP2000 S eries

Cloze ” Brint.. H Cancel

GP-PRO/PB Il for Windows Ver. 6.3 Operation Manual 1-23



1.4 GP-PRO/PBIII Manuals and Help Chapter 1 - Fundamentals

@ Searching for a Topic by a Keyword

To enter a keyword, click on the [Index] tab.

Search for a desired topic according to the instruction indicated on the
screen.

(When you enter initial characters of the keyword, the topics specified with
these initial characters are also automatically listed)

Help Topics: GP-PRO/PB3 for Windows [2] %]

Contents| Index  [Find |

1 Type the first few lstiers of the word you're looking for.

Jprmgm

2 Click the inclex entry you want, and then click Display.

Address batch conversion
Change GP Type

Change FLC Type

Copy screen from other project
Device Manitor

GPZ000 Series

Layered screen project manager
Print

Print presdiew

Praject information
Project manager
Sereen/Setup

SRAM informatian
Switch project manager
Utilty

vipley |[ m. ][ canca

BCalling up Help from a Dialog Box

When you click on the button in the dialog box or press the [F1]

key during execution of a command, a description of the currently-executed
command will be displayed.

Bit Switch Settings [BS_001] n
General Setiings | Shape/Calor | Label | Extend |
Description Operation Bit Address
)
) Manitar
WinniorBliddess
[<oo0o0 ~E
Function
1% Bit Set
e
£ Mamentary
£ Bitnvert

Place | | Cancel 1 |i " Help
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m Browsing Home Page ]

The procedure to connect to Digital Electronic Corporation's home page
"GP-PRO/PBIII for Windows Members Club" is described here.

i1/ ‘- To browse the home page, you must have hardware environ-
]

important MeNt to access the Internet. You also must have a browser to
view the home page, and subscribe to an Internet provider.

- To view the home page, register yourself as a user in “GP-PRO/
PB Ill for Windows Members Club.”

- Please understand that Digital Electronics Corporation cannot
respond to any questions about your Internet connection.

Operating procedures

C Click on the
[Help] — LConnectto - aqg/edivDelete
Home Page] Connect home page
button.

Outline of the Home Page Connection screen:

Used to add a home

page address

Displays the regis- Al List Used to edit a regis-
tered home page ™ tered home page
address (title) address and title

™~ Used to delete a
registered home
page address

|| Connecthome page s O Hel
Used to connect | ose || nelp |

to the specified
home page

B Registering a Home Page Address

The address of Digital Electronics Corporation’s Home Page “GP-PRO/
PBIII for Windows Members Club” has been preregistered in your GP-PRO/
PBIII for Windows software. When you click on the button, the
address setting dialog box appears.

When you first visit the Member’s Club page, you will be prompted for a
registration number (from your software’s User Registration Card), and will
be given a password.

B How To Register a Home Page Address

B Deleting a Home Page Address

Any registered home page address can be deleted. When you select the
home page address to be deleted and click on the button, the
confirmation dialog box appears. If you click on the button, the
selected home page address will be deleted. If you click on the
button, the deleting operation will be canceled.
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BEditing a Home Page Address
The registered home page address or title can be changed. When you select the home
page address to be edited and click on the button, the address setting dialog

box appears (same as for the home page addition procedure), enabling you to change
the title and address of the home page. If Digital Electronics Corporation’s home
page address is changed in the future, please edit the currently registered address.

BConnecting to the Home Page

PROCEDURE REMARKS

(1) Select the [Help] menu - [Connect to Home Page]
command in the Project Manager.

(2) Select the target home page address.

Home page m
Home pa

" Add List

© Edit

. Delete

Connect home page ‘ Close ” Help

(3) Click on the | connesthome page | button to start connection.

The browser is started, and you will be connected to the
home page.
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BMHow To Register a Home Page Address

1.4 GP-PRO/PBIII Manuals and Help

PROCEDURE

REMARKS

(1) Select the [Help] menu - [Connect to Home Page]
command in the Project Manager.

(2) Click on the button.

Home page m
Home page

Connecthome page Clace || Help

(3) Enter a home page title and address to be registered

and click on .

The specified home page address will be registered.

Home page address

Title JPeriacE Home Page

Address Jh"F' {peeony pro-tace.com ‘
-_ﬂelp
Home page m
Horme page
termbers Club j Add List ]
Pro-face Home Page
Connecthome page ‘ Close H Help ‘
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p CREATING BASE SCREENS

commands can all be used. Also, Edit commands can be used to modify
any Parts, objects or Tags that you have created. In addition to
editing these screen objects, the procedures for registering Library Items and
Windows are also explained.

T o create Base screens, the Editor area’s Part, Draw, Tag, and Menu Bar

2. L Parts
2.2 Drawing
2.3 s Tags
2.4 Object Editing
2. D Libraries
2.8 D-Script/Global D-Script
2.7 e Extended S10 Script
2.8 Data Sampling
2.9 Efficient Drawing Techniques
2.10 Creating Handy-type GP Screen
211 Creating ST Series Screen

2.0 DXF Conversion



2.1 Parts

Chapter 2 - Base Screens

m Parts

Each Part’s attributes such as setting Addresses and colors will be designated via
the dialog box. After designating all the necessary Part attributes, decide their
position and size on the object drawing area.

Parts can be placed on the drawing screen simply by selecting the desired part
from the palette and placing it on the screen with drag & drop operation.

The [Parts] command is enabled only on the Base screens.

Usage Pattern |
Decide on Select the specific - Place it
o[Parts] - atypeof — Partfromthe - Spegfy Its - onthe
Attributes
Part Browser Screen
or - Select a desired icon from the Parts Tool Bar.
Place the part on the .
Select the . Specify the
eParts Palette — . -
desired part Screen W'th drag & Attributes
drop operation
BGP-PRO/PBIII for Windows Part Type List
Icon Name Function Reference
_ _ Used to change a device’s Bit Address o
Bit Switch 2.1.1 Bit Switches
data.
Word - .
Switch Changes a device’s Word Address data. 2.1.2 Word Switches

Function [|Used to go back to the previous screen, to

: ) 2.1.3 Function Switches
Switch  |switch screens, and to reset the GP.

Turns the device's Bit Address ON or
Toggle 2.14Toggle Switches

& 1€l |lel| [ ] (@l

Switch  |OFF.
Turns ON or OFF according to the device’
Lamp N 2.1.5 Lamps
s Monitor Bit.
Switches the 4 states of the lamp,
43?;3 according to whether the device’s two 2.1.6 4-State Lamp
Monitor Bits are ON or OFF.
: Displays the device’s Word Address data
Ei Bar Graph | 2.1.7 Bar Graphs
in a bar graph.
e _ Displays the device’s Word Address data ,
ﬁ Pie Graph | _ 2.1.8 Pie Graphs
in a pie graph.
ie [Displaysthe device’s Word Address data
E Half Pie | VISpIaySth 2.1.9 Half Pie Graphs
Graph  |in a Half-Pie graph.
Displays the device’s Word Address data
W Tank Plays 2.1.10 Tank Graphs

Graph  [as absolute values in a Tank graph.
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Chapter 2 - Base Screens 2.1 Parts
Icon Name Function Reference
Vet Displays the device's Word Address data 2111 Meter Graphs
eter L.
a Meter. P
Displays the device’s Word Address data
0 Trend Pays | 21.12 Trend Graphs
Graph  |as absolute values in a trend graph.
Used to enter a device’s Word Address
Keypad 2.1.13 Keypads
=1 data.
Keypad
@ Input  |Displays data input via the keypad. 2.1.14 Keypad Display
Display
When monitored Bits are turned ON, a list
e of “Basic” Alarm summary messages ,
fﬁ Alarm Y , g 2.1.15 Alarm Display
Display  |appear that have been previously
registered in the Alarm Editor.
N Displays data registered in the Filing Data 2 1.16 File Name
@ Filing Data |,y by specifying the corresponding file T
Display Display
number.
_ Displays device data loaded in the data 2117 Data Loagin
e Logging logging settings by specifying the address |~~~ _ Jging
Display , Display
for the corresponding block number.
Enables manual transfer of the data-
% Data Transfer |transferring CSV data (ZR*****, CSV) from | 2.1.18 Data Transfer
Display |the CF Card to the device, or from the PLC Display
to the CF Card.
Enables the display, editing and printing of
- CSV Disol the CSVfile on the CF Card. Place and 2119 CSV Displa
P e this Display together with the Data - Py
Transfer Display or File Manager Display.
a File Manager | Displays the foldersffiles of the CSVfiles 2.1.20 File Manager
=] Display |on the CF Card. Display
ic [Displays the device’s Word Address
ﬁl NL_Jme”C P ys 2.1.21 Numeric Displays
Display  [numeric data as an absolute value.
Displays a previously registered message,
according to device Word Address data
'\g?:;ge changes. Amaximum of 16 messages 2.1.22 Message Display
can be displayed in a single Message
Display.
. . Displays the current date, using the GP’s ,
Date Display |. 2.1.23 Date Displays
== internal calendar.
Time Disol Displays the current time, using the GP’s 2124 Time Displa
"M PSP linteral clock. - plays
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2.1 Parts Chapter 2 - Base Screens

Icon Name Function Reference
_ Displays a single registered Libraryimage
:. ;:Zg;i (only graphic data), according to device | 2.1.25 Picture Displays

Word Address data changes.
Windows created on the Window Screen

@ W;)g‘:tzw (U) can be called up on the Base Screen 2.1.26 Window Parts
(B).

BEntering a Comment

If desired, a comment can be entered for a Part.

Up to 20 [ Goners) Setings [ShapsiColr [ Label | Exand| | Applies the
alphanumeric___ || Srerelon 51 fdees device
(single-byte) I comment

" Manitar

characters or Moo BitAddiss

10 Chinese
(double-byte) Funcion
characters can oo
be entered £ Momentary

L3 Bitlnvert

‘. Place l | Cancel 1 ‘ Help

@ Reflection of a Device Comment

If you click on the @ [Apply Device Comment] button after entering an address,
the device comment entered using the Symbol Editor is automatically searched
for, and the comment corresponding to the entered device appears in the De-
scriptionfield.

SOOI 4.7 Symbol Editor
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Chapter 2 - Base Screens 2.1 Parts

B Entering Addresses

Here, Addresses that are operated for Parts’ functions and that are monitored are

designated.
General Seflings |Shape;‘CDIan Lahel [ Extend I
Description [ Operation Bit Address Enter the address data
I— ) —
here
T Monitar
iy B Addess
[¥] [<00000
Function
= 1 Bit Set
£ Bit Reset
2 Momentary
£ Bit Invert

| Flace ] | Cancel I ‘ Help

@ Entering from a keyboard

Click on the address entering field, and the cursor will appear there, which
indicates data entry is now effective. Then, enter device and address data via the

keyboard.
€ Entering from an address keypad

Click on the address keypad icon, and the address keypad will appear, allowing
you to enter numeric data and addresses on the screen via the mouse.

Bit Switch Settings [BS_001]

' General Setings | shape/Calar | Label | Extend |

Description Operstion Bit Address

] | (] 00000

Activates the ad-
dress keypad.

=]

I Monitor
anitarEldddess
[<00000 [+

To move the address
keypad to the desired
position, drag its title bar. | To close the address
Bit Address keypad, click here.

To display the device —__ ||
names in a list, click here. Jx\Ji] (I —]—— Display

Backspace key /-—E'Bac:k © Chr

— — I~ CI k
Hexadecimal [ﬂ| B|C I Gl e
number entry key M|E F [1”5 B

L'1_"'2 g Enter key

[E]'ENT{
D,

Note:  To prevent mistakes, be sure to double-check the address you are enter-
N3] ing in the address keypad.

~
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Chapter 2 - Base Screens

€ Entering from a pull-down list

Click on the [=] box next to the Address entering field, and a pull-down list
appears including symbols selected via the Symbol Editor and device comments
together with corresponding Addresses. Selecting a symbol or device comment
from the list designates an Address.

4.7 Symbol Editor

Bit Switch Settings [BS_001]

Gieneral Setings | Shape/Color | Label | Extend |

Diescription Operation Bit Address

[ S—
Unit B Run - 00101

o

fdanior Bl Addiess

2N
Note: A Part’s specified address can be entered so that it is displayed during
=1 Base screen creation.
2.9.2 Screen Property Settings
Regardless of whether addresses are designated as either displayed or not
displayed during Base screen creation, they will not be displayed on the
GP panel after screen transfer.
B Selecting a Part Shape

Click on the General Settings Area’s button in the dialog box, and the
Shape Browser (hereafter called “Browser”) will be displayed.
The Browser’s Part Shapes are stored in a Part File (PDB file or BPD file), separate
from the main Project File (PRW file). Searching through different pre-made Part files

~ allows you to easily find useful Part Shapes for almost any application.

No% Parts (image parts) stored in BPD file is corresponding to GP2000 series only.
Click on a Part number and then the button, or double-click directly on
the Part number to select a Part Shape. (Browser disappears)

ﬁ(k)fei Part File and Part Shape lists for each file are included in the GP-PRO/
X2l PBIII for Windows Parts List Manual.
Clicking here
% scrolls
through the
Part Shapes
in this file
The ID number Click here to
of the Part W _3D002 register cus-
Shapeis dis- tom imaae
played here. parts. g
Rgver_se v_ideo M | o J—Deletes custom
(highlighting) image parts
indicates it is sw 30004 ||| Sw 30005 || SW 3D006 [|[-]]|  PartsFile . created by the
Selected Current PDE File J:'\pmgramfiles\prn-far:e\pmpb3m{\in\;§db\l‘ user y
\FL e | '

Shows the ID number of the
currently selected Part Shape

Shows the Part name
of the currently open
Part File

Calls up alist
of the other
Part files

2-6
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Chapter 2 - Base Screens

2.1 Parts

& Parts Files

Two types of part files can be used: PDB files and BPD files.

Select the parts best suited to your application from the applicable files.

On. *Use the parts included in BPD files (image parts) for switches and lamps.
ote: However, these parts cannot be used for Toggle Switches or 4-State
1 Lamp settings.
* The Image Parts feature is supported only by the GP2000 Series.
Click onthe button and a list of the Part files will appear. After
clicking onaPart File, the information displayed will change to reflect that file.
Next, click on the button and the selected Part file’s Part Shape will
appear in the Browser.
Moves to the next higher Displays file
file directory level Creates a names and details
Shows the new folder
currently
open folder Open N\
Loak i Jﬁ pdb E‘ 09| [
Lists the TR oot
names of all plootazod P
the Part Eftipg Displays file
files in this i, names in
folder it summary
Shis form
Shows the Fie name:  [Opd 3a01 pdb | [ geen ]
Currently s of bype: [Pats files [“pobybpdl] | | canea
selected e R ] [ o |
Part file’s Y
comment Shows the name of the currently
selected Part file. A name can also
be entered here to select afile.
%e. * The BPD file is located in the [imageparts] folder in the [PDB] folder.
S

* Part files (PDB File/BPD File) are automatically installed in a folder
named ""PDB" when GP-PRO/PB |11 is first installed. If desired, these
files can be installed in other folders instead. To display part shapes
located in other folders, use the [Look in:] area to switch to the appli-
cable folder.

<Differences between the PDB File and BPD File>

Preprogrammed Registration/ Color Setting

File Deletion by Users [ Adjustment
PDB m X m
BPD m m*1 X

*1: A preprogrammed BPD File cannot be registered or deleted.

GP-PRO/PB 11l for Windows Ver. 6.3 Operation Manual
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2.1

Parts Chapter 2 - Base Screens

@ Registering Image Parts

Image files in bitmap file format and JPEG file format can be registered in the BPD
File as Image Parts for switches and lamps (except for Toggle Switches and 4-
State Lamps). Image files can be specified separately as either ON and OFF.

Click the|:
for registering Image Parts will appear.

| button in the Shape Browser dialog box. The dialog hox

Select the BPD File in which to
register the Image Part.

Create parts

. . = Register the part
File Name] || Brow |||New F|Ie] || Sl -1_ to the specified
=OFF FN— . BPD File as a
Select an new Image Part.
image for the
OFF state.
Create a new
BPD File in
[ Load Image [ Loadmage which to register
Enter the title the Image Part.
(name of the ~Tite | ||
Image Part). = Color .
Select an image
Fleaze zet the color bype: for the ON state.
{3 Mono 120 GrayscaleMomal] 120 Grayscale[Reverse)
{2 8 Colors 15 64 Colors {30 25E Colors

| Compress

Ii | Specify the number of colors
ﬁl for the Image Part.

The following table shows the types of image files that can be registered.

1 bit 4 bits 8 bits
Number of colors 2 colors 16-level 256-level| 16-bit | 24-bit | 32-bit
(black & |16 colors| gray |256 color| gray color color color
white) scale scale
Windows BMP/DIB 0] (0] (0] (0] (0] @] 0] (0]
Windows
- o) o) - - - - -
BMP/DIB(RLE4) [*.BMP
Windows BMP/DIB ) ) i o o i i i
(RLES)
JPEG *JPG - - - - (0] - 0] -

2-8
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Chapter 2 - Base Screens

2.1 Parts

2N
NOt\eg:J * Image Parts can be registered to a maximum size of 160 x 160 (dots).

* Image Parts will increase the size of the Project file. WWe recommend

enabling the "Compress" setting in "Color" settings.

 Up to 200 Image Parts can be registered in a single BPD File.

* Before registering the Image Part, select image files for both ON and OFF

states.

* When the sizes of the images for the ON and OFF states differ, the smaller
image is magnified to equal the size of the larger image.

* Image Parts that are zoomed in or zoomed out may appear slightly different on

the GP screen than from the PC screen.

This section describes the procedure for registering

Image Parts in the BPD File.

PROCEDURE

REMARKS

.........................................

(1)Click the|i " "Create ‘| button in the Shape Browser

dialog box.

(2)Specify the location for registering the Image Part.

[Register the Image Part in an existing BPD File.]

a) Click the [Browz] button and select the BPD File
in which to register the Image Part.

Create parts

File Narne J ) Brovwz ‘ | Mew File | | Fiic ] |

[ em— | | —

b) Press the button to confirm the
destination file for registering the Image Part.

[Register the Image Part to a new BPD File.]
a) Click the button.

Save As m
Save in ]@pdb E
[ imageparts
[ Mi
[2 5ample
File name ﬂ ‘ ,?I
Save as type Jlmage parts file (* BFO) E” /ml
Descriplion J |
i
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Chapter 2 - Base Screens

PROCEDURE

REMARKS

b) Specify the file name of the new file.
In the "File Name" area, enter the file name of the
destination BPD File.

Inthe "Description" area, enter the category name of the
BPD File as well as any remarks that may be useful as
notes.

¢) Press the button to confirm the desti-
nation file for registering the Image Part.

(3) Select an Image Part for the OFF state. Click the

button and specify the desired bitmap

image.

File Mame ] [ Brow ‘ ‘ New File ‘ ‘ o ‘

‘ Load Image ‘

OFF.

‘ Load Image ‘

Tt | |

(4) Select an Image Part for the ON state using the pro-
cedure described in step (2).

(5) In the "Title' area, enter the name of the Image
Part.

Create parts [x]

File Name | | mrowe 1 ‘ New File ‘ | el ‘

OFF-

| Load mage ‘

o | \

e 1

(6) Inthe ""Color' area, specify the display color for the
Image Part.

(7) Click the button.

(8) Click | Ok, | to complete the registration.

Project Manager

Farts data created.

Image Parts can be registered to a
maximum size of 160 x 160 (dots).

Before registering the Image Part, se-
lect image files for both ON and OFF
states.

Image Parts will increase the size of the
Project file. We recommend
enabling the "Compress™ in"Color".
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Chapter 2 - Base Screens 2.1 Parts

B Selecting Colors

Specify Part colors using the Shape/Color setting screen. The setting items will
differ depending on the Part, i.e. the border type, ON/OFF states, graphs, and
label colors.

Tiling patterns can be selected for some of the Parts, Lamps, and Graphs.

%e. Specific colors are pre-assigned to each Image Part (BPD File) when it is
) selected from the browser. Color settings cannot be modified.

Word Switch Settings [W5_001] '
General Settings| Shape/Color | Label ]

Biorder Calor

ENEORNEDONEE F

Color

Fo MEE DN CWE) ek -
Eo M IN®OCIWE ek ]

Fattern

I

" Place H Cancel H Help

& Colors

Color setting methods will differ for each model, i.e. monochrome, monochrome
LCD (eight levels of gray), 8-color, 64-color and 256-color settings.

64-color model : GP-571T, GP-675S, GP-675T, GP-377S, GP-377RT,
GP-577RS, GP-577RT, GP2000 series (except GP-2301HL,
GP-2300L, GP-2301L, GP-2500L and GP-2501L)

256-color model : GP2000 series (except GP-2301HL, GP-2301HS, GP-
2300L, GP-2300S, GP-2301L, GP-2301S, GP-2500S and
GP-2501S)

8-level gray-scale model: monochrome LCD GP2000 Series (GP-2301HL, GP-
2300L, GP-2301L, GP-2500L and GP-2501L)

m - Do not transfer a Project File created using 64-color (256-color)

Important — qata to a 64-color (256-color) incompatible GP panel. The 64-
color (256-color) data may be automatically changed to mono-
chrome data and some object elements, such as fills or pat-
terns, may not be displayed as they were originally drawn.

Pro-face recommends of using the basic 8 colors (on the color
bar). Objects and image data created using colors (on the color
palette) other than the basic 8 colors may flicker.

GP-PRO/PB 11l for Windows Ver. 6.3 Operation Manual 2-11



2.1 Parts Chapter 2 - Base Screens

( mmooEECONE Color palette
(other than basic 8

colors)

Color palette
(basic 8 colors)

(5657
<When using an 8-color or monochrome GP unit (incompatible with 64-color
screens)>
There are 8 colors available in the color bar. Use this bar to select the foreground
(Fg), background (Bg) and other colors. When the [Reverse Display] option in
the [GP Setup | 1/0 Settings] has not been checked, on a monochrome GP
screen, black, blue, green, and cyan will be displayed as white (same as back-
ground); red, magenta, yellow, and white will be displayed as black.

Fo NI/ ex]
Bo I IO ) I ] B

Color GP unit BK[BL|GR|CY|RD[MG]YL|WH

White (not | Black (dis-
displayed) |played)
<When using Monochrome LCD (eight levels of gray) GP unit >

When the [Reverse Display] option in the [GP Setup | 1/O Settings] has not been checked,
OFF Calor

Fo [ ) ) 535 5 Bk L

Monochrome GP unit

Color GP unit BK\BL

Monochrome LCD |
GP unit

Light <
'd Colors are displayed in

eight levels of gray.
D Depending on the color used, selecting MONOCHROME 8 HUES may
NOfe; cause the GP unit’s screen to flicker. Confirm the color before using this
mode.

<When using a 64-color GP unit>
There are 64 colors available via the color palette. Use the palette bar to select
the foreground (Fg), background (Bg) and other colors.

1]

Geneidl Settings|| Shape/Color | Label |

Eiorder Color

I 0 5 ) O OV
Caolor

- FErrec
Ba

m Pattern

—
Color bar

—

(48] 49][S0][5 1 | o [ 3
Il =01 e o1 | ez e

“ Flace | ” Cancel | ” Help |
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Chapter 2 - Base Screens 2.1 Parts

After converting 64 color data to After converting 64 color data to
8 color data, each color will be monochrome data, each color
displayed like this: will be displayed like this:
[BK[BL[GR [CY[RDMG]YL[WH BK|BK |BK | BK [WHWH|WH|WH]
\
ﬂ!QQ%DD! QQQQFDDQE

Color bar

Color bar

Color palette Color palette

_||_||_||_||_|

BK |BL |BK|BK |BL|BL |GR |GR BK|BK BK |BK |BK |BK |BK | BK
CY|CY|GR|CY|BK|BK|BL | BL BK |BK BK |BK |BK|BK |BK |BK
BK|BK |BL |BL|GR|GR |CY |CY BK |BK BK |BK |BK|BK |BK |BK
GR|GR |CY |CY |RD|RD MG|MG| BK |BK BK |BK [WHWIHIWH|WI
RD|EDMGMG|YL|YLWH/WH WHWHWH WHWHWHWH|WH
YL|YL WHWH|RDMGRD RD WH{WHWH WH[WHWH|[WH| WH|
MGMG| YL | YL (WHWH| YL |WH WH{WHWH WHWHWHWH WH

<When using a 256-color GP2000 series unit>

7

79~
B7

Color bar = =
Color 55 [0t 0103

101051 04(107A[10E109)110 11%'

palette 1R O K R

The following tables describe the changes in the display when the GP type is
changed from a 64-color model to a 256-color model.

64-color No blink T oo e uts]  64-color BlinK 1w rwio s
16 | 17 | 18 | 19 | 20 | 21 | 22 | 23 16 | 17 | 18 | 19 | 20 | 21 | 22 | 23
24 | 25 | 26 | 27 | 28 | 29 | 30 | 3L 24 | 25 | 26 | 27 | 28 | 29 | 30 | 31
32 | 33 | 34 | 35 | 36 | 37 | 38 | 39 32 | 33 | 34 | 35 | 36 | 37 | 38 | 39
40 41 42 43 44 45 46 47 40 41 42 43 44 45 46 47
48 | 49 | 50 | 51 | 52 | 53 | 54 | 55 48 | 49 | 50 | 51 | 52 | 53 | 54 | 55
56 | 57 | 58 | 50 | 60 | 61 | 62 | 63 56 | 57 | 58 | 50 | 60 | 61 | 62 | 63

0 1 2 3 4 5 6 7 255 [ 250 | 72 [ 75 | 140 | 143 [ 100 | 103
8 9 |10 |1t |12 ] 18] 14| 15 243 | 249 | 160 | 161 | 162 | 163 | 192 | 193
16 | 17 | 18 | 19 | 20 | 2t | 22 | 23 194 | 195 | 73 | 74 | 120 | 121 | 122 | 123
24 | 25 | 26 | 27 | 28 | 29 | 30 | 3L 168 | 169 | 170 | 171 | 200 | 201 | 202 | 203
32 | 33 | 34 |35 | 36 | 37 | 38 | 39 80 | 8L | 82 | 83 | 132 | 133 | 134 | 135
40 41 42 43 44 45 46 47 180 181 182 183 212 213 214 | 215
48 | 49 | 50 | 51 | 52 | 53 | 54 | 55 92 | 93 | 94 | 95 | 141 | 142 | 188 | 189
56 | 57 | 58 | 59 | 60 | 61 | 62 | 63 190 | 191 | 220 | 221 | 222 | 223 | 101 | 102
64-color Fast orrrersrerstert ) 64-color Slow ittt
16 | 17 181920 [ 21 ] 22723 16 | 17 | 18 | 19 | 20 | 21 | 22 | 23
24 [ 5[ 26 [ 27 ] 28] 2930 [ 31 24 | 25 | 26 | 27 | 28 | 29 | 30 | 31
32 | 33 | 34 [ 35|36 [ 37 [ 38| 3 32 | 33 | 34| 3 | 3 | 37 |38 | 39
40 41 42 43 44 45 46 47 40 41 42 43 44 45 46 47
48 | 49 |50 [ 51 | 52 [ 53 | 54 | 55 48 | 49 | 50 [ 51 | 52 | 53 | 54 | 55
56 57 58 59 60 61 62 63 56 57 58 59 60 61 62 63

232 | 235 | 104 | 107 | 244 | 247 | 116 | 119 251 | 254 | 76 79 | 136 | 139 | 96 99

233 | 234 | 144 | 145 | 146 | 147 | 224 | 225 252 | 253 | 164 | 165 | 166 | 167 | 196 [ 197
226 | 227 | 105 | 106 | 236 | 237 | 238 | 239 198 | 199 | 77 | 78 | 124 | 125 | 126 | 127
148 | 149 | 150 | 151 | 228 | 229 | 230 | 231 172 | 173 | 174 | 175 | 204 | 205 | 206 | 207

108 | 109 [ 110 | 111 | 240 | 241 | 242 | 243 84 85 86 87 | 128 | 129 | 130 | 131
152 | 153 | 154 | 155 | 64 65 66 67 176 | 177 | 178 | 179 | 208 | 209 | 210 | 211
112 | 113 | 114 | 115 | 245 | 246 | 156 | 157 88 89 90 91 | 137 | 138 | 184 | 185
158 | 159 | 68 69 70 71 | 117 | 118 186 | 187 | 216 | 217 | 218 | 219 | 97 98
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2.1 Parts Chapter 2 - Base Screens

@ Blink

Blink settings will also differ slightly depending on whether a single speed Blink
GP model or a three speed Blink GP model is used. Digital’s three speed blink
models are the GP-571T, GP-675S, GP-675T, GP-377S, GP-377RT, GP-
577RS, GP-577RT and GP2000 series units (except GP-2301HL, GP-2300L,
GP-2301L, GP-2500L and GP-2501L). Other GP models have only one
blinking speed. When 256-colors are selected in a project, the “Blink” feature cannot
be used for any of that project’s screens.

<Using a three speed Blink type GP>

Next to the Check Box, there is a Button that will display a range of 3 speeds and
“No BIk” (indicates no blinking). When one of the blink speeds is selected, the
color bar is displayed in a darker color and the specified Part will blink on the GP

screen. Blink speed settings

Lamp Settings [LA_001]

The normal blink speed is “Mid.”

“Fast” is twice as fast as “Mid”

Border Color and “Slow” is half as fast as
INEUEEDOE e “Mid”. When “No BIk” is se-

OFF Colar lected, the Part will not blink.

| General Settings || Shape/Color | Label |

State OFF

B I ) ) ) IS

<Using a single speed Blink type GP>

When the Blink (BIk) Check Box is checked [, the color bar is displayed in a
darker color and the specified Part will blink on the GP’s screen. With mono-
chrome (eight layers of gray), the color bar on the GP-PRO/PBIII screen will be
displayed in dark blue color. (black color blink is excluded)

Fa 1)) /) )] @D Blink Check Box
Ba I I ][] k[

When the GP model is changed from a three speed Blink type to a single speed
type, the “Mid” and “Slow” speeds will be changed to the single speed GP’s
“Blink” speed, and “No BIk” and “Fast” will be changed to “No BIk”. The
blinking rate for a single speed GP model is equal to the “Mid” setting of the three
speed type.

Lamp Settings [LA_001]

No Blk |No blink

Mid Blink

Border Calor h< Fast No b||nk
ENED® Wk Slow Blink

OFF Calar g

Fo ) ) ) e

B I ) ) T 1 S

General Settings:
State

Shape/Color | Label |

Transparent mode can be selected as the background color (Bg) text and
Note: Mark objects. This function is useful when overlaying text on Switches,
) Lamps, and other objects.

For example: Change the background color of the label from *'Black' to
"Transparent™.
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Chapter 2 - Base Screens 2.1 Parts

Label
Sitch—
The background color of The background color of the
the label is black. label becomes transparent.
<All models> <Non-256-color models>
Bo 1 I O O 1) B [ N N O O O 1 )
Specify the background Specify the background color of
color of the label as the labels as "Black and Blk
"Black" only. (Blink)".

*On 64-color models, this feature
is enabled only when the "Mid"
blink speed is selected.

<256-color models>
Specify the background color of the
labels as "Clr".

& States

Only Parts which can have two states are displayed with this feature. Display
colors for Parts can be specified separately for each state; for example, a Bit
Switch can be displayed as red in the OFF state and green in the ON state.
Click on either state button to select it, and specify that state’s color using the
color bar.

B Alarm Settings

In both graph and numeric value displays, Alarms can be set up.
First, click on the [Alarm Settings] tab at the top of the Dialog box. When

checking the Alarm Display box (Check mark [ appears), the Alarm setting
itemswill appear.

Bar Graph Settings [BA_001]

]

[Tieneral Gettings || Graph Setfings | ShapedCalar] fam Settings | — Sets the Alarm
g value's Format
lar Displng i —— ;
& ovec: to fixed or
2 ndeec variable

Alarm Colar

Vi Vo Fo DDDEI!IEI'
Mo Vahue b IEEDNEDDNE [ T | Sets the Alarm
colors used

Sets the minimum —T]
and maximum
Alarm values

[ Pace J[ conest |[ meb |

@ Alarm Type

The Alarm value can be specified as either direct (fixed value) or indirect (variable
value) by simply clicking on the appropriate circle.
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€ Alarm Range

Here, you can specify the maximum and minimum Alarm values.

When the Alarm value has been specified as indirect, the maximum and minimum
values can also be specified as indirect. In this case, the Word Address number
used to store these values will be automatically assigned continuously from the
Word Address currently specified.

The following example uses “n” to denote where the Word Address’ display data

is stored:
Alarm Fange
Mir, 0 .7| Word Addresses are automatically
n. e = allocated in sequence, starting
= from the Address designated
Max Walue |30 | 9

<Relationship between display data’s storage address and Alarm register ad-

dress>
With 16 Bit data With 32 Bit data

n Display Data n .

n+1 [Data value - Max. n+1 — Display Data -

n+2 |[Data value - Min. +
n+2 — Data value - Max. —
n+3
n+4 — Data value - Min. -
n+5

& Alarm Color

Here, you can select the colors used for an Alarm display.
2.1 Parts B Selecting Colors

W Creating Labels

Here, a Label means the text characters shown on the faces of the Switch and
Lamp button Parts. Labels can be registered via the Part’s Setting dialog box.

ot

As with Parts, Label display colors can be created for each of a 2-state Part’s
states; up to 4 lines of text can be used for each state.

<OFF state> <ON state>

When a lamp’s Text Display changes
(This Switch’s ON/OFF colors are also selected)

igot\% The Part must be large enough to display the entire Label.
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Enter characters to be

Select the text type. displayed as direct text.

If using the Bit Switch Settings I55_001]
direct text as\ [(General Sgyiffos | Shape/Colof] Lavel |Exend | Copies the characters
Image Font, | o & from the Description
place a check @wm—] ' field to the label of
mark in the o )erackmg the current state.
check box. Operating Cooling System 7
Copies the charac-

SeIeCt th? \ i Copy from Description Copy to Off State I ters to the Iabel for
character’s N~ Character Siza the Off state.
size.

:EISSIDEWP"ESS Text Color

v |2 TV IO [Moe L
Select the 5 Bol 0 EEEEER N vd ]\ [ ———Select the label’s
character’s o color here.
type.

‘ Flace | | Cancel } | Help }

@ Direct Text
The text entered in the text entry field is placed directly as a fixed text string.
@ Index Text

Select and add the index text.
4.6.3 MSelecting the index character string € Entering
the index character string
€ Image fonts
Windows fonts are displayed in bitmap format.
This feature is enabled only when the "direct text” mode is selected.
2.2.9 Text 4 Image Font

The Image Font is supported only by the GP2000 series.
1€, @ Label

Here, you can type in the text displayed on a button. When typing in text, press
the . key to move to a new line. When the [Tracking] check box is checked
(enabled), after the Part has been placed on the screen, if the Label’s size or
position is changed, for either state, the alternate state’s Label size and position
will be also automatically changed. If, however, the Label’s size and position
need to be specified independently for each state, DO NOT check [ this box.

2.4.3 Scaling Up/Down

@ Copy from Description

The characters entered in the Description filed are copied to the label in the
selected state.
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@ Copy to Off (On) state

When the state is On, the characters entered in the label are copied to the label in
the Off state. When Off, the characters are copied to the label in the On state.

& State

States are displayed only for Lamps, and for those switches with two states (ON
and OFF). The text displayed for each state can be specified independently.
Simply click on either state button to specify its text and colors.

@ Character Size
Specifies the size of character.
2.2.9 Text
@ Style (Font)
Specifies the type of character (Normal, Bold, Raised) used in each Label.

SLBITTK 2.2.9 Text
& Text Color

Specifies Label colors.
The default settings are Fg: White, and Bg: Transparent mode (Black + BIk).

@ Alignment (Justification)

When the text input for a Label exceeds one line, the Alignment icons will appear.
Select Left, or Right justification, or Centering.

State OFF Tet Tracking
[on] on

Character Size Spacing Alignment

Left-justified Centered Right-justified

2-18
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B ID Numbers

When creating a Part, an ID number is automatically assigned to the Part before it
is placed on the screen. This number shows how many of that kind of Part were
previously placed on the current screen. When a Part is deleted from a screen, all
following Part numbers will be adjusted downwards.

Example of an ID number

BS _ 010
J
l
Indicates that this Part is a Bit Indicates the placement/
Switch creation order of the Part; in
(Varies according to the Part) this case, it is the 10th.

The ID number is displayed in the title bar at the top of the Setting dialog box.

Bit Switch Settings [BS_001]

| General Setfings |Shape,¥CU\UrT Label r Extend ]

Description Operation Bit Address

T hanitor
Bifdaldiess

% The ID number can be entered so that it is displayed during Base screen
Olg;, drawing. 2.9.2 Screen Property Settings

Even if the ID number is entered to be displayed during Base screen
drawing, it will not be displayed on the GP panel after screen data trans-
fer.

<ID Number List>

Part Name ID Number Part Name ID Number
Bit Switch BS-** Alarm Display AL-*+*
Word Switch WS-#** |File Name Display FD-**
Function Switch FS-r* Data Logging Display LG-r*
Toggle Switch T S-*x* Data Transfer Display DT -***
Lamp LA-*** CSVDisplay CS-***
4-state Lamp LF-*x* File Manager Display FM-*+*
Bar Graph BA-*** Numeric Display ND-***
Message Displa
Pie Graph P-x¥x g. ey , MB-***
(Operation Mode: Bit)
Message Displa
Half-Pie Graph HP-*+* g. Play MW-*x*
(Operation Mode: Word)
Tank Graph SG-***  |Date Display DD-***
Meter MT-***  [Time Display TD-***
Picture Displa
Trend Graph TR-*** , blay , LB-***
(Motion mode: Bit)
Picture Display
Keypad KE-*+* _ L=k
(Motion mode: Word)
Keypad Input Display KD-***  |Window Parts W|-*x*
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B Maximum Number of Automatically Created Part Libraries

When a Part is used in a project, a Part Library will be automatically created in
preparation for data transfer. The number of Part Library items are limited to
6000 per project. If this number exceeds 6000, all Parts in excess of 6000
cannot be transferred to the GP. To avoid this, please remember the following:

1. Automatic Library creation will be performed follows: (per screen)

Switches: 2 (only switches with the Monitor function selected)
Lamps: 2

Messages: 2 to 16 (depending on the number of states used)
Picture Displays: 2 to 16 (depending on the number of states used)
Trends: 1 to 20 (depending on the number of channels)

However, Part Libraries using the same Parts (i.e. Part’s that are the same
size, same attributes, and without labels or other items) will be used commonly.

Forexample:
When 30 Switches (Monitor function is selected) and 20 Lamps are placed
on asingle Base screen, (30 x 2) + (20 x 2) = 100 Part Library items will
be automatically created. Therefore, 60 of these size screens can be used
in one project(’s data).

2. When using the same Parts for multiple Base screens, register the Part on one
Base screen and then place it other Base screens using the Load Screen
function. Thus, when multiple Base screens use those Parts, only one Part
Library will be used, thereby reducing the Project File’s size.

B Placing a Part in Position

After all of a Part’s attributes have been entered or selected, click on the desired
position on the screen to place the Part.

PROCEDURE REMARKS

(1)After all of a Part’s attributes have been entered or

selected, click on the button.

The Part’s outline will appear on the Base screen, next to
your Cursor.

”l [ re [ |
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PROCEDURE REMARKS

(2)Click on the point where the Part’s top left corner is to
be placed.
The selected Part will then appear on the screen.

(3)Adjust the Part’s size, if desired. 2.4.3 Scaling Up/
Click onthe Part to select it, and drag any one of the handles | pown

to change the size of the Part.
To change the size of a Part, move the cursor to a Part
“handle” and click, then drag the “handle” to re-size the Part,

and click again. After placing the Part, double-click-

ing on it automatically brings up its
Attribute Setting dialog box.
2.4.14 Changing
Attributes

D Depending on the Part, when scaling up or down, a one dot error may

Not\eé occur in the frame width.

E.g.)
9

B Touch Panel Grid

When placing Switch Parts and Keypad Input Display Parts (when the pop-up
keypad is used), be sure to place them so they align with the Touch Panel’s 20 x
20 dot grids. (See figure below.)

These 20 x 20 dot grids are the smallest units available for placing items on the
Touch Panel. Be sure not to place 2 switches on a single grid, as pressing the
point could activate both switches.

N Correct Incorrect

a0
. . . . . . . . . j—
20 dots
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@ Bit Switches ]

Here, the creation of a touch panel switch, used for turning a specified Bit
ON or OFF, is explained.

A If the GP unit has not been connected to the device, Bit
! Switches with the Monitor function selected will not be dis-
Important  played on the GP unit after the Project File transferred.

B Bit Switch [General Settings] Attributes

Enter comment Bit Switch Settings [BS_001] .
data here Gamerel 5ot | gt ol | St | Enter the Bit
Deseription Opsration Bit Address @/ Switch Address
N ‘ 5] om0 5s
image of the B e | When creating
currently se- N a Bit Switch
lected Part Shape Funcion with two states,
o check this box
Calls up the Part £ Morrertary and enter the
Shape Browser ©8timen alternate Bit
where a different Switch Address
Part Shape can below
be selected
Place [ concel || hels Select the

switch’s function

€ Operation Bit Address
Here, the Bit Address data controlled by the Switch is input.
€ Monitor Bit Address

Only after the Monitor check box is checked can the Monitor Bit Address
used to change the Switch’s display setting be entered. The Switch’s state
(ON/OFF) display can be specified so that it will change according to
changes in this Bit Address. Addresses input in the Bit Address area can
also be done here.

Appears only

when creating a
Bit Switch with

| General Setiings |ShapefCDIor T Label TExtend ]

Description Operation Bit Address

two states. — . —
Toggles the State whieTia

switch’s state
either ON or OFF,
allowing you to
set the attributes
of each state

Monitar Bit Address
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After entering the Bit Address, if you attempt to perform another area’s
operation before entering the Monitor Bit’s address data, the dialog box

shown below will appear. Clicking on the button automatically
inputs the Bit Address’s data into the Monitor Bit Address. To enter a

different address, click on the button and input the desired ad-
dress.

Bit Switch

Do you want to use the zame Bit Address
far the Monitor Bit Address?

& Function

The Bit Switch functions are as follows.

Bit Set: When the Bit Switch is pressed, the device’s designated
Bit Address is turned ON. This state continues (i.e.
remains ON) even after the switch is released.

Bit Reset:  When the Bit Switch is pressed, the device’s designated
Bit Address is turned OFF. This state continues (i.e.
remains OFF) even after the switch is released.

Momentary: Only while the Bit Switch is pressed and held is the
specified device Bit Address turned ON. Thus, when the
switch is released, the specified Bit Address is turned OFF.

Bit Invert:  Every time the Bit Switch is pressed, the device’s desig-
nated Bit Address state is changed (from ON to OFF, or
from OFF to ON).

M Bit Switch [Shape/Color] Attributes

Here, the Switch’s border color (Frame), ON/OFF state colors (On Color,
Off Color), and pattern can be selected.

2.1 Parts B Selecting Colors

The color and pattern settings available will differ depending on the switch’s
settings.

B Bit Switch [Label] Attributes
Here, the text of the Label to be displayed on the Switch button is entered.
2.1 Parts M Creating Labels
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B Bit Switch [Extend] Attributes

Set up the Interlock and Buzzer functions.

[ General Setings | Shape/Color | Latel ‘ Extend I
Icerieck] Dt 41— Can be set at the
Interlock Address ¥l Buzzer momentary
Touch available condition
@ERON  DERCH - Selects the Inter-

lock function

Flace | ‘ Cancel I ‘ Help

& Interlock

Only when a bit designated via Interlock Address is in a state that has been
selected via [Touch available condition], the switch becomes effective.
Whether the switch is effective in ON state or in OFF state is selectable

here.
@V\Otﬁ The “Bit Off” feature is available only with the GP-377, GP77R and GP2000
2] series.
Touch Available Interlock Address Touch Available/
Condition Status Not Available
. ON Touch Available
BItON OFF Touch Not Available
. ON Touch Not Available
BItOFF OFF Touch Available
& Buzzer

Select ON or OFF for the buzzer sound.

When buzzer setting is enabled, the buzzer sounds while the touch switch is
being pressed.

€ One-Shot
Enable/disable the "One-Shot" feature.

This setting can be enabled only when "Momentary"” mode is selected in the
"Function” area in the "General Settings" tab. When the "One-Shot" feature
is enabled, the buzzer will sound briefly only at the moment the touch
switch is pressed.

Tag Reference Manual, 2.23.4 One-Shot Buzzer for T-tag
@\ momentary
Note:

2] The "One-Shot" feature is available only with the GP-377, GP77R and
GP2000 series.
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B Placing a Bit Switch

An example of how to place a Reverse Switch is shown below.

ot T e ] (6T

First press of the Switch The next press resets M0016
sets M0016
PROCEDURE REMARKS

(1)Select the [Parts] menu - [Bit Switch] command, or
click on the [&)] icon.

(2)In the [General Settings] screen, input the Bit Ad- | When the Change State function se-

dress and select the Bit’s Function. lected, after entering the Bit Ad-
T = dress, if you attempt to perform

General Setings |Shape/Calor | Label | Extend | ] H
 Enter MOO16 another area’s operation before en-

| HE— || tering the Monitor Bit Address, the

) Monitor

When the switch dialog box shown below will ap-
\ en the switch’s . .

state can change, pear. Click on the button
click here to input the same address as used
for the Bit Address. To enter a dif-
ferent address, click on the

— Select the Bit button and input the de-
Invert function sired address.

Bit Switch

Do pou want to uze the same Bit Address
fior the Monitor Bit Address?

(3)Select a Part Shape from the Browser. i
Specify settings for Shape/Color, Label and Extension
Settings if necessary.

2.1 Parts W Select-
ing a Part Shape

Image Parts can be used with the
GP2000 series.

Gurrent PDB File :[Siprogram fles\propb3winlpdbiop4-3d01 |

T :|5/_30001 E]” Help ]

(4)After all of a Part’s attributes have been entered or

selected, click on the button.

The Switch’s outline will appear on the Base screen, next
to your cursor.

GP-PRO/PB Il for Windows Ver. 6.3 Operation Manual 225



2.1 Parts

Chapter 2 - Base Screens

PROCEDURE

REMARKS

(5)Click on the point where the Switch’s top left corner | To cancel the placement, click on

is to be placed.

the [«] icon.

If desired, use the Switch’s handles to alter its size. To change the

Part’s size, refer to 2.4.3 Scaling
Up/Down.

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s Attribute Setting dialog
box.

2.4.14 Changing
Attributes

2-26
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@ Word Switches ]

Here, a touch panel switch for setting data to a specified Word Address can
be created.

B Word Switch [General Settings] Attributes

Enter comment

data here Word Switch Settings [WS_001] x]_— Enter the Word
| Genaral Seftings ‘Shape/Culurr Lahel IExtend | Add ress yOU
Description YWord Address W|Sh tO use
Image of thes, || N g EiE
currently se- Conctont
lected Word 5 = H—— Enter the data
= .
Switch —— for the Switch
) Word Set to send to the
£ Addl/Sub Word Address
Calls up the Part £ DigiA0D)
Shape Browser © Digi(UB)

where a different
Part Shape can

be selected Select the
Flace ] | Cancel I | Help SW|tCh 'S fu nc-
tion
€ Word Address
Here, the desired Word Address is entered.
& Constant

Here, number registered to the Word Address is input. The data format is
Decimal (Base 10), and the input range is from -32768 to 32767.

& Function
The Word Switch’s functions are as follows:

Word Set:  When the Word Switch is pressed, constant data is written
to the device’s designated Word Address. Fixed or default
values will be written to the timer, counter, etc.

Add/Sub:  Every time the Word Switch is pressed, the Data value is
added to the data currently in the device’s designated Word
Address, and the result is then written to the Device’s
address. If a Data value is positive, the function will
increment, and if it is negative, it will decrement.

Digit (ADD): Every time the Word Switch is pressed, the designated
decimal place’s data will be added by the Constant’s value.
The result will not be carried up to the next digit, so “9”
simply rolls around to “0”. Select the data format from Bin
and BCD.

Digit (SUB): Every time the Word Switch is pressed, the designated
decimal place’s data will be subtracted by the Constant’s
value. The result will not be carried down to the lower
digit, so “9” simply rolls around “0”. Select the data
format from Bin and BCD.
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B \Word Switch [Shape/Color] Attributes

Here, a Word Switch’s color, and pattern can be selected.

2.1 Parts B Selecting Colors

The color and pattern settings available will differ depending on the
Switch’s settings, such as its shape and Change State condition.

B Word Switch [Label] Attributes

Here, the text characters shown (engraved) on the Switch button face are

input.
2.1 Parts M Creating Labels

Wm\Word Switch [Extend] Attributes

Here, the interlock and the buzzer can be set as shown below.

Word Switch Settings [WS_001] E
"General Settings | Shape/Color | Label | Extend l
Option

Intelnek Addiess ’F‘Z] Buzzer

[E¥] Mooao ~E

Touch axaiizlle candifomn

#) i O 0 B O
Flace | | Cancel \] | Help

Select the Interlock
function state

& Interlock

Only when a bit designated via Interlock Address is in a state that has been
selected via [Touch available condition], the switch becomes effective.
Whether the switch is effective in ON state or in OFF sate is selectable here.

@Ikv\ote: The “Bit Off” feature is available only with the GP-377, GP77R and GP2000

21 series.

Touch Available Interlock Address |Touch Available/

Condition Status Not Available

. ON Touch Available
BItON OFF Touch Not Available
. ON Touch Not Available

Bit OFF OFF Touch Available

& Buzzer

Sets the buzzer to ON/OFF
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B Placing a Word Switch
An example of how to place a Data Set Switch is shown below.

2.1 Parts

i e e

When the button is pressed, 34 is sent to DO0001.

PROCEDURE

REMARKS

(1)Select the [Parts] menu - [Word Switch] command,

or click on the [&] icon.

(2)In the [General Settings] area, input the Word Ad-
dress and Constant data, and select a function.

[Word Switch Settings [WS_001]

General Setings | Shape/Calor [ Label | Extend |

= Wvord Address
I \

[E¥][puoooo

Constant

£ AddiSub
£ Digit(ADD)

£ Digit(SUE)

—=a— | Enter DO0O01

™ Enter 34

Select Word Set

(3)Select a Part Shape from the Browser.
Specify settings for Shape/Color, Label and Extension

Settings if necessary.

Shape Browser

SW_30004_|

Current PDB File Jc\pmgram filegh\proph3wintpdbtiop4-3d0l |

[x]
R
|

Create

)
| e ]

=l

Tille :[8/_30001

Help

]

(4)After all of the Part’s attributes have been entered

or selected, click on the button.

The Switch’s outline will appear on the Base screen, next

to your cursor.

2.1 Parts W Select-
ing a Part Shape

Image Parts can be used with the
GP2000 series.
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PROCEDURE

REMARKS

(5)Click on the point where the Switch’s top left corner| To cancel the placement, click on

is to be placed.

If desired, use the Switch’s handles to alter its size.

the [<] icon.
To change the

Part’s size, refer to 2.4.3 Scaling
Up/Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes
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2.1 Parts

@ Function Switches

Here, a touch panel with special functions can be created.

B Function Switch [General Settings] Attributes

Enter comment

Function Switch Settings [FS_001]

[x]

NGeneral Setlings | 5hape/Color | Label | Extend |
i  Furctior

data here ndoton —| — Select the
£ Frevious Scieen Switch’s

Image of the oo (o__H operation

— £ Reset GP
currently se- £ FleName Koy ||
H 1D Mo.

lected Function o T~ When “Go To

Switch £ CSV Display Kew Screen” is
12 File Manager Key

Calls up the Part D e Koy selected, the
£ Difline (GO TO)

Shape Browser
where a different
Part Shape can
be selected

3 Trend Key

screen’s num-
ber and data
format must be
entered

‘ Place ” Cancel H Help

€ Function (Switch Operation)
The Function Switch’s attributes are as follows:

Previous Screen: When the Switch is pressed, the currently
displayed screen on the GP will change to
the previously displayed one.

When the Switch is pressed, the currently
displayed screen on the GP will change to
the specified screen. Input the screen
number to be changed (jumped) to. The

Data Format can be either Bin or BCD.

Go To Screen:

If a screen number is specified in the BCD data format to place the corre-
sponding screen, it is still displayed in the BIN data format when the screen is
closed and then opened.

Ko,
X2l

Reset GP: When the Switch is pressed, the GP will be
reset to the save status as when the GP’s
power was turned ON.

File Name Key: This is a function switch corresponding to

the File Name Display and is the same as
the one that is automatically placed together
with the File Name Display.

Designate the same ID number as the one of
the File Name Display and select a opera-
tion mode.

2.1.16 File Name Display
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Data Logging Key:

CSV Display Key:

File Manager Display Key:

Data Transfer Key:

OFFLINE:

Chapter 2 - Base Screens

This is a function switch corresponding to
the Data Logging Display and is the same
as the one that is automatically placed
together with the Data Logging Display.
Designate the scroll direction and the
number of lines being rolled up or down.

SO 2.1.17 Data Logging Display

This function switch corresponds to the
CSV Display and is the same as the one
automatically placed together with the CSV
Display. This switch can be used only with
GP2000 Series units. Designate the scroll
direction, number of lines to be scrolled up
or down, and the print area.

SEOTEIK 2.1.19 CSV Display

This function switch corresponds to the File
Manager Display and is the same as the one
automatically placed together with the File
Manager Display. This switch can be used
only with GP2000 Series units. Designate
the switch on which the File manager
Display is to be displayed.

ST 2.1.20 File Manager Dis-
play

This function switch corresponds to the
Data Transfer Display and is the same as
the one automatically placed together with
the Data Transfer Display. This switch can
be used only with GP2000 Series units.
Designate the direction of the transmission,
scroll direction, number of lines to be
scrolled up or down, and the touch key on
which the Data Transfer Display is to be
displayed.

2.1.18 Data Transfer
Display

When this switch is pressed, the GP enters
the OFFLINE mode.
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Trend Key: This function switch corresponds to the
Data Record Display of the Trend Graph
and is the same as the one that is automati-
cally placed together with the Trend Graph.
This switch can be used only with GP2000
Series units. Designate the touch key used
to execute the ON/OFF status of the Data
Record Display mode, scroll direction of
the displayed data, and number of lines
being rolled up or down.

SO 2.1.12 Trend Graphs

B Function Switch [Shape/Color] Attributes

The Switch’s color, and pattern are selected here.

2.1 Parts B Selecting Colors

The color and pattern settings available will differ depending on the switch
shape.

B Function Switch [Label] Attributes
Here, the characters shown (drawn) on the Switch button face are entered.
2.1 Parts B Creating Labels

B Function Switch [Extend] Attributes

Here, the interlock and the buzzer are set.

Function Switch Settings [FS_001]

[General Settings T Shape/CD\orT Lahel | Extend 1

\nterlackj Optio
ntestag Adess k] Buzzer

[ [<o0o0n ~|E

Ty exaiahlz condiion
“ Em@m;l 2 Bib O

/ | Flace | ‘ Cancel } ‘ Help

Select the Inter-
lock function
state
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@ Interlock

Only when a bit designated via Interlock Address is in a state that has been
selected via [Touch available condition], the switch becomes effective.
Whether the switch is effective in ON state or in OFF sate is selectable here.

@Ikv\ote: The “Bit Off” is available only with the GP-377, GP77R and GP2000 series.

= Touch Available Interlock Address [Touch Available/
Condition Status Not Available
_ ON Touch Available
BItON OFF Touch Not Available
_ ON Touch Not Available
Bt OFF OFF Touch Available
& Buzzer

Sets the buzzer to ON/OFF.
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B Placing a Function Switch

2.1 Parts

The Screen Switching (Function) Switch’s placement procedure is shown

below.
e ™

E1 B10

. |:>
O H
Pressing this button, shifts to screen B10.
- /
PROCEDURE REMARKS

(1)Select the [Parts] menu - [Function Switch] command,

or click on the [] icon.

(2)Designate the [Function] on the [General Settings]

tab.

Function Switch Settings [F5_001]

General Setings | Shape/Color |[Label |[Extend |

Description

) Previous Scresn
@ooTosoeen  — B0 \ & DEn  DED
) Reset GP
123 File: Name Key
1D N, o0 E‘
1 Data Logging Keyp
) Data Tranfer Koy
173 Dif line
£ Trend Kep

e [ comel |[ Bk |

(3)Select a Part Shape from the B

1 ___Select Go To

Screen

Enter 10

rowser.

Specify settings for Shape/Color, Label and Extension

Settings if necessary.

Current PDE File JE.\nmgram filesproph Iwinypdiiop4-3a01 ‘

Title sz_aDnm E]H Help

2.1 Part B Select-

ing a Part Shape

Image Parts can be used with the

GP2000 series.
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PROCEDURE

REMARKS

(4)After all of Part’s attributes have been entered or

selected, click on the button.

The Switch’s outline will appear in the Base screen, next

to the cursor.

(5)Click on the point where the Switch’s top left corner | To cancel the placement, click on

is to be placed.

the [«]icon.

If necessary, use the Switch’s handles to alter its size. To change the

Part’s size, refer to 2.4.3 Scaling
Up/Down

Double-clicking on any Part placed
on the screen calls up that Part’s At-
tribute Setting dialog box.

2.4.14 Changing
Attributes
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2.1 Parts

@ Toggle Switches

Here a toggle type touch panel switch, used to turn a specified Bit ON or

OFF is created.

ﬁé\(e: A Toggle Switch will not be displayed on the GP when transferred, if the GP
has not yet been connected to the device.

B Toggle Switch [General Settings] Attributes

Enter comment
data here

Changes the
state of the
dialog box’s
switch display to
either ON or OFF

Displays the/

currently se-
lected Part

Calls up the Part
Shape Browser
where a different
Part Shape can be
selected

Toggle Switch Settings [TS_001]

General Setings | Shape/Calor [ Label | Extend |

Enter the Bit
Address to be

Description

Operation Bit Address

operated via

[E3] f<noo00

(-

Browser...

Maonitor Bit Address

the Switch

— Enter the
desired Monitor
Bit Address
here

Place I |

Cancel | |

Help

@ Operation Bit Address
The number of the Bit Address to be operated via the Switch is entered here.
€ Monitor Bit Address

Here, the Monitor Bit Address used to change the Switch’s display is en-
tered. The Switch’s ON/OFF state can made to change according to changes
in the Monitor Bit Address data. The same address as the Bit Address’s can

be used here.

After entering the Bit Address, if you attempt to perform another area’s
operation before entering the Monitor Bit Address’s data, the dialog box

shown below will appear. Clicking on the button automatically
enters the Bit Address data. To input an address different from the Bit
Address, click on the button and input the desired Monitor Bit

Address.

Toggle Switch

Do you want bo uze the zame Bit Address

for the Monitor Bit Address?
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B Toggle Switch [Shape/Color] Attributes

The Switch’s frame colors (Frame) for the ON and OFF states can be selected.

2.1 Parts B Setting Colors
The color and pattern settings available will differ depending on each
switch’s settings, such as its shape and state change conditions.

B Toggle Switch [Label] Attributes

Here, the text characters shown (Raised) on the Switch button face are
entered.

2.1 Parts W Setting Labels

B Toggle Switch [Extend] Attributes

Here, the interlock and the buzzer are set.

{ General Setings I Shape/Color [ Lahel | Extend I

Interock: Opiic
etk rduiess F] Buzzer

Troweh ssalizhlz condiion

| 1 Bt Om 3 B OH

/ ‘ Place ] | Cancel | ‘ Help }

l

Select the Interlock function state

@ Interlock Address

Only when a bit designated via Interlock Address is in a state that has been
selected via [Touch available condition], the switch becomes effective.
Whether the switch is effective in ON state or in OFF sate is selectable here.

@Ik\l\o\tg This “Bit Off” feature is available only with the GP-377, GP77R and GP2000

series.
Touch Available Interlock Address [Touch Available/
Condition Status Not Available
_ ON Touch Available
BILON OFF Touch Not Available
_ ON Touch Available
Bit OFF OFF Touch Not Available
& Buzzer

Sets the buzzer to ON/OFF.
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2.1 Parts
B Placing a Toggle Switch
The Toggle Switch placement procedure is shown below.
'\
Pressing ON sets M0016, and pressing OFF resets it. )

PROCEDURE

REMARKS

(1)Select the [Parts] menu - [Toggle Switch] command,
or click on the [€] icon.

(2)In the [General Settings] area, input the Operation
Bit Address.

[Toggle Switch Setiings [TS_001] [x]

General Setings | Shape/Color | Label | Extend |

Description

Operation Bit Address

[xonaon [ @

Manitor Bit Address i

Enter MO016

(3)Select a Part Shape from the Browser.
Specify settings for Shape/Color, Label and Extension
Settings if necessary.

Sw 3D104 ||| Sw 3D105 | SW 3D106
Current PUEB File :[epragrarn filesipropb3virtpdelopd-3di |
Tile [SW_aD101 E”‘ Help ‘

(4)After all of a Part’s attributes have been entered or

selected, click on the button.

The Switch’s outline will appear in the Base screen, next
to your cursor.

After entering the Operation Bit
Address, if you attempt to perform
another area’s operation before en-
tering the Monitor Bit Address
data, the dialog box shown below
will appear.

Toggle Switch

Do pou veant to use the zame Bit Address
far the Maonitaor Bit Addreszs?

Clicking on the button

automatically inputs the Operation
Bit Address into the Monitor Bit
Address area. To input an address
different from the Bit Address,

click on the button.

2.1 Parts W Select-
ing a Part Shape
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PROCEDURE REMARKS

(5) Click on the point where the Switch’s top left corner | 10 cancel the placement, click on

is to be placed. the [« icon.
If desired, use the Switch’s handles to alter its size. AT To change a Part’s
size, refer to 2.4.3 Scaling Up/

Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes
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BB o )

Here a lamp is created, which turns ON or OFF according to the device’s
Monitor Bit Address state.

Lamps will not display on the GP unless the GP has been
1 connected to the device.

]
Important

When placing a Lamp, DO NOT overlap it with other objects. If
you do so, it may not be displayed correctly.

B Lamp [General Setting] Attributes

Enter comment Lamp Settings [LA_001]
data here " Gieneral Settings | Shape/Color | Label | — Enter the
Desciiption Bit Address desired Bit
2| M|
i I ] oo ] Address here

Displays the cur-
rently selected Part |
|~ Changes the

Calls up the Part —| state of the

Shape Browser. [ moneer ] diqlog ng’s
Part Shapes can switch display
be selected to either ON or
directly from here OFF

" Place ” Cancel H Help

& Bit Address
The Bit Address to be monitored is entered here.

B Lamp [Shape/Color] Attributes

Here, border colors for both ON and OFF states, and Lamp’s colors and
tiling pattern in each state can be selected.

2.1 Parts B Selecting Colors
The color and pattern settings available will differ depending on each lamp
shape.

B Lamp [Label] Attributes
Here, the text characters shown on a Lamp button’s face are entered.
2.1 Parts B Creating Labels
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B Placing a Lamp

The procedures for creating and placing a Lamp are shown below.

When X0017 the Lamp When X0017 the Lamp
is ON... lights up. is OFF... turns off.
PROCEDURE REMARKS

(1)Select the [Parts] menu - [Lamp] command, or click

on the [@] icon.

(2)In the [General Settings] area, enter a Bit Address.

Lamp Settings [LA_001] [x]

General Settings | Shape/Color [ Label |
Bit Address

i mET — || Enter X0017 here

” Place ”l Cancel |” Help I

(3)Select a Part Shape from the Browser.

) . . ¥ Reference .4 [ ] -
Select Colors and input a Label, if desired. . 2.1 Parts W Select

ing a Part Shape

Image Parts can be used with the
GP2000 series.

With the Blink check box checked
_— ). and if the Bit is turned ON, the
: Lamp will blink. Lamp blinking
can also be seen via the pull down
menu [View]’s [Preview] com-
mand.

2.9.3 Preview
(4)Switch the state of the lamp with the On/Off but- | Screen

tons, and then select Colors and input a Label.

Current PDE File Jc'\prngram filasiproph3winipdbiopd-3d01 |
Tie JLM_30001 =l Help |

(5)After all of the Lamp’s attributes have been entered

or selected, click on the button.

The Lamp’s outline will appear in the Base screen, next
to your cursor.
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PROCEDURE REMARKS
(6)Click on the point where the Lamp’s top left corner| To cancel the placement, click on
is to be placed. the [« icon.
If necessary, use the Lamp’s handles to alter its size. MEIEITK To change the Part’s
size, refer to 2.4.3 Scaling Up/

Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes
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@ 4-State Lamp

Here, a 4-State Lamp, which changes its state according to whether the
device’s two Monitor Bits are ON or OFF, are created.

/A

)
Important

)

Even when a 4-State Lamp data is transferred to the GP, if the

GP and device have not communicated, the 4-State Lamp will
not be displayed on the GP.

When placing a 4-State Lamp, DO NOT overlap it with other
objects. If you do so, it may not be displayed correctly.

B Features of 4-State Lamp

Enter comment 4 State Lamp Settings [LF_001] ]
data here, if General Seftings | Shape/Colar || Labal |
necess al‘y Description Lamp Address1
1 G S

Chan es the Lampddress] Lamp Address2 H— Enter a

9 1 [ Ton] (B fronto EiEE] desired Bit
State Of the Lamp Lamp Address2
currently dis- [on J or] Address to
played on the be moni-

tored.

dialog box to

either ON or OFF.

. [oowe |
Displays the

currently selected
Part’s image.

|| Flace I ” Cancel | " Help

Calls up the Part
Shape Browser. A
Part Shape can be
selected directly
from here.

€ Lamp Address
Enter the two Bit Addresses (Lamp Addresses 1 and 2) to be monitored.

@ Lamp Address [ on [ oi]

Changes the Lamp state by changing the combination of the two Bit’s ON/
OFF state.

ﬁé}e; When the two Bits that have been assigned to the Lamp Addresses are
A3 changed simultaneously, the Lamp state change is recognized as follows

according to the Bit read timing, which makes the Lamp display flicker.

e.0.) When Lamp Addresses 1 and 2 are changed from OFF to ON
simultaneously:

Lamp Address 1
Lamp Address 2
Or

Lamp Address 1
Lamp Address 2

0-1-1

0151
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2.1 Parts

B Features of 4-State Lamp [Shape/Color]
Here, a 4-State Lamp’s border colors for both ON and OFF states and
Lamp’s colors and tiling pattern in each state can be selected.
2.1 Parts B Selecting Colors
The color and pattern settings available (effective) will differ depending on

each Lamp shape.

B Features of 4-State Lamp [Label]

Here, the text characters shown on a Lamp button’s face are entered.
2.1 Parts B Creating Labels

W Positioning a Lamp

The procedure for creating and placing a 4-State Lamp are shown below.

and X0018’s ON/OFF states.

When X0017 is
OFF and
L X0018 is OFF

When X0017 is
ON and X0018
is OFF

[ The Lamp state will be switched according to the Lamp Addresses X0017’s )

When X0017 is
ON and X0018
is ON

When X0017 is
OFF and
X0018 is ON

PROCEDURE

REmMARKS

(1)Select the [Parts] menu - [4-State Lamp] command,

or click on the | icon.

(2)Enter Lamp Addresses 1 and 2 in the [General Set-
tings] tab.

4 State Lamp Settings [LF_001] [<] B Y
General Settings | Shape/Color | Label | - Enter “X0017".
Deescription Lamp Address]
| ] B LB
Lamp Address1 Lamp Address2
Oole] @ @

Lamp Addiess?

Y

T Enter “X0018".

[ Place || rancsl || e

GP-PRO/PB I11 for Windows Ver.6.3 Operation Manual

2-45



2.1 Parts

Chapter 2 - Base Screens

PROCEDURE

REMARKS

(3) Select a Part Shape from the Browser.
Select Colors and set up a Label, if desired.

g
T
5

Title :|[LM_30001 [~

(4) User either or button to change the Lamp

Address states and select Colors and Pattern for each
state.

Set up a Label for each state, if desired.

4 State Lamp Settings [LF_001] _

[General Setings || Shape/Color [ Label |

Lamp Address1 Border Color

To]  wwEowECONERw o

Lamp Address2
[on o] ro I E] )W
go I O ) O O ] o [

[ Piece || cance | Hep |

(5) After all of a Part’s attributes have been entered or
selected, click on the button.

The 4-State Lamp’s outline will appear on the Base
screen, next to your cursor.

(6) Click on the point where the 4-State Lamp’s top cor-
ner is to be placed.

Use the 4-State Lamp’s handles to alter its size, if nec-
essary.

2.1 Parts W Select-
ing a Part Shape

To cancel the placement, click on

the [«=] icon.
SAEITEEIK To change the

Part’s size, refer to 2.4.3 Scaling
Up/Down.

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

ST 2.4.14 Changing
Attributes
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2.1 Parts

@ Bar Graphs

Here the setup (creation and placement) of a bar graph is explained. Bar
Graphs are used to display device Word Address numeric data in absolute or
relative values. This graph’s display will change according to Word Address

data changes.

B Bar Graph [General Settings] Attributes
<When displaying Word Address numeric data in absolute values>

Enter comment
data here

Displays the
currently se-
lected Part

Calls up the
Part Shape
Browser. Part
Shapes can be
selected di-
rectly from here

@ Absolute

~

Browser...

Select absolute or relative

value display

Bar Graph Settings [BA_D01]

General Settings | Graph Settings | 5hape/Colar | Alam Settings |
Desciiption ( 12 Absolute 1 Felative )
word Address
@ Doooo | 7] Display Mode +-

Data Format—
8 Bin
£3ECD

‘ Flace || Cancel H Help 1

\‘

. Enter the
desired Word
Address to
store graph
data here

= Select the
display data’s

data format

Data stored in the Word Address is displayed in absolute values from 0 to
100 (with Display Mode +/- selected, -100 to 100).

€ Word Address
Here, enter the Word Address used for storing the Bar Graph’s data.

& Data Format

The display data’s format can be either Bin or BCD.
When Bin is selected, negative numeric data can also be displayed. In that

case, check [[«]| the Display Mode +/- check box.
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<When displaying Word Address numeric data in relative values>

Enter comment
data here

Displays the
currently se-
lected Part

Calls up the Part

Shape Browser. ——

Part Shapes can be
selected directly
from here

Select the Relative value display

Bar Graph Settings [BA_D01]

General Settings ‘ Graph Settings [ Shape/Colar Vﬁlarm S etings |

Description £ Absalute o He\allv&

Wiord Address

0000 ~EE
Bit Length Z

put Rang Input Cod;

|

1 +/- s Complemer

D Display Mode +/-

Brawser

Max Value  |B5535 %] L +/- M3SB N

/A

‘ Place ” Cancel H Help ]

Used to store the
L — graph’s data.

Enter the desired

Word Address

~_ Select the
display data’s
format

™ Select the data’s

Input Code

Specifies data’s Bit Specifies data
Length Input Range

& Relative

The data stored in the Word Address are converted to a value between 0 and
100 according to the designated Input Range and displayed as relative
values.

€ Word Address
Here, enter the Word Address used for storing the Bar Graph’s data.
& Display Mode+/-
When this check box is checked, negative numeric data can also be
displayed.
& Bit Length
Specifies the Bit Length of data stored in the Word Address.
€ Input Range
Specifies the data’s Input Range.
@ Input Code

When No Code is selected, only positive data can be entered. To enter
negative number data, select +/-2’s Complement or +/-MSB.
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B Bar Graph

Bar Graph Settings [BA_001]

Select the U
graph’s display
direction

[Graph Settings] Attributes

Gereral Settings || Granh Setting | Shape/Color || Alam Setting |

P—

Az Divisions

Digplay Direction
©ig
2 Left

120 Down
2 Right

” Place | ” Cancel | || Help

2.1 Parts

.l — Only when a

graph with
graduations
has been
selected will
this box
appear.
Enter the
number of
divisions

& Direction

desired here

The graph’s display direction can be specified as either Up, Left, Down, or

Right.

ﬁé\te; If [Display Direction] is changed for a 3D part, its shade is rotated along with
that part. To let the shade displayed properly, click on the button,
and select the part again from [Shape Browser].

@ Axis Divisions

For a graph which has graduations, the number of divisions are entered here.
If the number of the divisions is specified to 10, then 11 division lines are
used. When graduations are not necessary, specify the number of the divi-

sions as 0.

ﬁé\[e; Whether the graduations are necessary or not will differ depending on the

Part’s shape.

B Bar Graph

[Shape/Color] Attributes

The graph's border color, division color (Axis Color), display data color
(Graph Color), display data patterns, and background color are selected here.

WY Reference .4

B Bar Graph

2.1 Parts B Selecting Colors

[Alarm Settings] Attribute

It desired, an Alarm can be setup here by toggling the Alarm check box.

WY Reference .4

2.1 Parts B Setting Alarms
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B Placing a Bar Graph

An example of the Bar Graph’s creation and placement procedures are
shown below.

-,
Data stored in D00102 displays on the Bar

Graph

When the value 34 is storléd inzb\00102,
the graph will look like this: )

h

PROCEDURE REMARKS

(1)Select the [Parts] menu - [Bar Graph] command, or

click on the [ icon.

(2)In the [General Settings] tab, input a Word Address
and select a Data Format.

Bar Graph Settings [BA_001]

General Settings | Graph Settings | Shape/Color | Alsm Seltings |
Dasarpton Sabde O R | Enter D00102
here

| I

‘whord Address

T Display Mode +/-
Dt Format——
gl 1+ SelectBCD

vvvvvvv

[ Pace || Cancel H Help 1

(3)Select a Part Shape that has graduations from the
Browser. _ _ 2.1 Parts ® Se-
Here, you can enter Alarm settings and select Colors, if lecting a Part Shape

desired.
If the Bar Graph’s Alarm value is

specified as Variable, a pointer
showing levels will be displayed.
This pointer’s position will move
according to the specified Alarm
value.

Level pointer
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2.1 Parts

PROCEDURE

REmMARKS

(4)In the [Graph Settings] tab, select the graph’s dis-
play direction and input the number of Axis Divi-
sions.

Bar Graph Settings [BA_001]

Gieneral Settings | Graph Settings | 5hape/Colar | Alarm Settings |

Ais Divisions

S
=

Display Direction
4 Left
2 Down
£2 Right

Enter 10 here

7

Select Up

Place ” Cancel H Help

(5)After all of the graph’s attributes have been entered

or selected, click on the button.

The Bar Graph’s outline will appear on the Base screen,
next to your cursor.

(6)Click on the point where the Bar Graph’s top left
corner is to be placed.

If necessary, use the Bar Graph’s handles to adjust its
size.

The area to enter the number of the
divisions will appear only for a graph
type which has axis divisions.

To cancel the placement, click on

the [ icon.
SAEEEEK To change the

Part’s size, refer to 2.4.3 Scaling
Up/Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes

The Bar Graph’s sizing handles are
located inside the graph.
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@ Pie Graphs ]

Pie Graphs create an area where a device’s Word Address data is displayed
as absolute values. The graph’s display will change to reflect changes in the
designated Word Address data.

B Pie Graph [General Settings] Attributes
<When displaying the data using absolute values>

Select Absolute or Relative

display
Enter comment . _ _ Enter the
data here |e Graph Settings [PI_001] . Word
General Settings | Graph Settifhs | Shape/Calor | Alam Setiings
Desciiption 3 Absolute #3 Relative Ad d ress
The currently IS by used to
selected Pie @M 7] Display Mode +/- store g rap h
Graph's image 1 [T data
appears here ow T I
Calls up the Part Szlst?rcédthe
iz;atzecir:ol;Nes er ‘ Place I | Cancel | | Help Data FO r m at

selected directly
from the Browser

& Absolute

Data stored in the designated Word Address is displayed in absolute values,
from 0 to 100 (with Display Mode +/- selected, -100 to 100).

€ Word Address

Here, the Word Address’ location data is entered to show where the desired
data is stored.

& Data Format
Select either the Bin and BCD display formats.
@ Display Mode +/-

With this check box || checked and the Bin data format is selected, a
negative numeric data can also be displayed.
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<When displaying the data using relative values>

Select Absolute or Relative

ispl
Enter comment display
data here Pie Graph Settings [PI_DD1] / Enter the
Genersl Settings | Graph Settings | Shape.f&%] Alam Seftings | Word Ad-
Description £ Absalute o i’H’é\SiuJ\% d reSS '[0
The curren_tly ard Aderess store graph
select?d_Ple I ) s | Uo‘smamm.\ data
craph's image e T~ Select the
appears here Lingut Fiangs il Co i
Im\,:ue J:E {I:;;NUEE;E geswe? Data
Calls up the Part —{ Mo e -55535 % g:i izgomn\emenl orma
Shape Browser. 1 N
Parts can be [race J[ concel || \\ualp ] Specifies the
selected directly \ data Input
from the . , - Code
Browser Specifies the data’s Specifies the data
effective Bit Length Input Range
& Relative

The data stored in the Word Address are converted to a value between 0 and
100 according to the designated Input Range and displayed as relative
values.

€ Word Address
Here, enter the Word Address used to store Pie Graph data.
@ Display Mode +/-
When this check box [[«]| checked, negative numeric data can also be dis-
played.
@ Bit Length
Specifies the Bit Length of all data stored in the Word Address.
€ Input Range
Specifies the data’s Input Range.
@ Input Code

With No Code selected, only positive numeric data can be entered. To enter
negative numeric data, select either +/-2’s Complement or +/-MSB.
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B Pie Graph [Graph Settings] Attributes

Pie Graph Settings [P1_D01]

General Settings | Graph Settings | Shape/Color [| Alam Settings | | Enter the

Select the Pie graph’s
y Dizplay Direction Az Divisions
Qraph s (data o . e ngr_nl_)er of
display) £ Chws. From Batiom IS divisions
Direction
“ Place I “ Cancel | || Help
@ Display

Here, the graph’s data display start point, either Clkws. From Top or Clkws.
From Bottom, can be selected.

ﬁé\[e: If [Display Direction] is changed for a 3D part, its shade is rotated along with

that part. To let the shade displayed properly, click on the button,
and select the part again from [Shape Browser].

& Axis Divisions

The number of segments the Pie Graph will be divided into is entered here.
If the number of Axis Divisions is specified as 10, 10 division lines will be
displayed. When no divisions are necessary, simply enter 0.

B Pie Graph [Shape/Color] Attributes

A Pie Graph’s border color, division line color (Axis Color), data display

color (Graph Color - Fg and Bg), data display pattern and background color
are selected here.

2.1 Parts B Selecting Colors

B Pie Graph [Alarm Settings] Attributes

Clicking on the Alarm Display check box will call up the Alarm Settings.
2.1 Parts B Alarm Settings
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B Placing a Pie Graph

2.1 Parts

The procedure for placing a Pie Graph is shown below.

Data stored in D0102 displays on the Pie

Graph
When the value 34 is stofrléd irﬁDOlOZ,
the graph appears like this:

PROCEDURE

REMARKS

(1)Select the [Parts] menu - [Pie Graph] command, or

click on the @] icon.

(2)In the [General Settings] area, input a Word Address
and select a Data Format.

Pie Graph Settings [PI_002]

Gieneral Setings | Graph Setlings | Shape/Colar | Alam Settings | — Enter D00102
Desuiiption 1§ Absolute % Relative he re

:l Word Address
ey Doz F ] Display Mode +-

Dista Foimat—
72 Bin
#BCD

[ Place H Cancel H Help

Select BCD

(3)Select a Part Shape from the Browser.
You can also use the Alarm Settings area to choose an
Alarm and select Colors, if desired.

Shape Browser

OK

Cancel

CG 3D003U CG 3D004U

Current PDB File - [c\program filsspropb3intpdbiopd |

Title JCGjDum U E” | Help ‘

2.1 Parts m Se-
lecting a Part Shape
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PROCEDURE REMARKS
(4)In the [Graph Settings] tab, select the display direc- | The area to enter the number of the
tion and input the number of Axis Divisions. divisions will appear only for a graph

type which has axis divisions.

Pie Graph Setlings [PI_001]

— Enter 10

Display Direction

42 Clkws, From Togt
29 Cllwss. From Bottom

" Select Clkws.
From Top

[ Flace |H Cancel H\ Help

(5)After all of the Graph’s attributes have been entered

or selected, click on the button.

A Pie Graph’s outline will appear on the Base screen,
next to the cursor.

(6)Click on the point where the Pie Graph’s top left cor- | To cancel the placement, click on
ner is to be placed. the icon.
If desired, use the Pie Graph’s handles to alter its size. To change the
Part’s size, refer to 2.4.3 Scaling
Up/Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.
2.4.14 Changing
Attributes
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@ Half Pie Graphs ]

This graph displays a Word Address’ numeric data (received from a device)
as absolute or relative values in a Half-Pie graph. The graph’s display will
also change to reflect Word Address data changes.

B Half Pie Graph [General Settings] Attributes
<When displaying the data in absolute values>

Select Absolute or
Relative display

Enter comment

Half Pie Graph Settings [HP_001]

data here =|_— Enter the

Word Ad-
The currently dress to
selected Half Pie store graph
Graph’s image data
appears here N

=~ Select the

Calls up the Part —{ - desired Data
Shape Browser. Format
Parts can be [Face [ el ][ Hew

selected directly
from the Browser

@ Absolute

Data stored in the designated Word Address is displayed as absolute values,
from 0 to 100 (with Display Mode +/- selected, -100 to 100).

€ Word Address

Enter the Word Address where the data will be stored.
@ Data Format

Select the display data format from Bin and BCD.
@ Display Mode +/-

When this check box [[]| is checked and Bin data format is selected, nega-
tive numeric data can be displayed.
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<When displaying the data in relative values>

Select Absolute or
Relative display

Enter comment Enter the
data here Hall Pie Graph Settings [HP_001] WOfd Ad-
General Settings | Graph Settings | Shape/Color | Alaih Settings | dress used to
Description solute
The currently N f’::dd“ store graph
selected Half Pie ] oeam FlE Do ot data
Graph’s image o g EilLength =
e 15 i
appears here oput Fang Input Cod Selgcts the
we R S desired Data
+/- 2¢ Lomplement
Calls up the Part —{ - TR | Format
Shape Browser. N
Parts can be / [ ][ e [ % ] Specifies the
selected directly / data’s Input
from the Browser o - Code
Specifies the data’s Specifies the data’s

effective Bit Length Input Range

& Relative

The data stored in the Word Address are converted to a value between 0 and
100 according to the designated Input Range and displayed as relative
values.

€ Word Address
Here, enter the Word Address used to store Half Pie Graph data.
@ Display Mode +/-

When this check box [I#]f checked, negative number data can be displayed.
& Bit Length

Specifies the Bit Length of all data stored in the Word Address.
€ Input Range

Specifies the data’s Input Range.
@ Input Code

With No Code selected, only positive numeric data can be entered. To enter
negative numeric data, select either +/-2°’s Complement or +/-MSB.
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B Half Pie Graph [Graph Settings] Attributes

Half Pie Graph Settings [HP_D01]

General Settings|| Graph Settings | Shape/Color || Alarm Settings | . — Enter the
Select the Half —{| oy piectin graph’s
Pie Graph’s (data || @ g number of
display) Direc- divisions

tion

|| Place |” Cancel |” Help

@ Display Direction
Here, the Half Pie graph’s display direction is fixed to clockwise.
@ Axis Divisions

The data entered here determines how many pieces a Half Pie Graph is
divided into. If the number of Axis Divisions is specified as 10, 11 division
lines are displayed. When no divisions are necessary, specify the number of
divisions as 0.

B Half Pie Graph [Shape/Color] Attributes

Here, a Half Pie graph’s border color, division color (Axis Color), display
data color (Graph Color - Fg & Bg), display data pattern and background
color are selected here.

2.1 Parts B Selecting Colors

B Half Pie Graph [Alarm Settings] Attributes
If desired, Alarm settings can be set here.
2.1 Parts B Alarm Settings
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B Placing a Half Pie Graph

The procedure for placing a Half Pie Graph is as shown below.

Data stored in D0102 displays on the Semicircle Graph

When data 34 is stored in D0102, the
Half Pie graph will appear as follows:

PROCEDURE REMARKS

(1)Select the [Parts] menu - [Half Pie Graph] command,
or click on the [™] icon.

(2)In the [General Settings] area, input the Word Ad-
dress and Data Format.

Half Pie Graph Settings [HP_001]

General Setlings [ Graph Setlings | Shape/Color | Alarm Settings | | Enter DO0102

Desoription %5 Abschute £ Relative

| IRy

@/—* Select BCD
@D

nnnnnn

(3)Select a Part Shape from the Browser.
You can also use the Alarm Settings area to enter Alarm
settings and select Colors, if desired.

2.1 Parts ® Se-
lecting a Part Shape

Shape Browser

oY

Curtent PDB File - [SAprogram flesypropbawiripdbiopd |
Tite -[HG_3D001 = ‘ Help }
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2.1 Parts

PROCEDURE

REmMARKS

(4)In the [Graph Settings] tab, input the number of axis
divisions.

| Bereral Settings]| Granh Setings | Shape/Color || Alarm Settings |

Display Ditection fis Divisions
& Elcmis i

= Enter 10

[ Flace H| Cancel H| Help

(5)After all of a Part’s attributes have been entered or

selected, click on the button.

The Half Pie graph’s outline will appear on the Base
screen, next to your cursor.

(6)Click on the point where the Half Pie Graph’s top
left corner is to be placed.

If desired, use the Half Pie graph’s handles to alter its
size.

The area to enter the number of the
divisions will appear only for a
graph type which has axis divi-
sions.

To cancel the placement, click on

the [« icon.
MEEEIX To change the

Part’s size, refer to 2.4.3 Scaling
Up/Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes
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m Tank Graphs ]

This Part creates an area where a Word Address’ numeric data received from
the Host (device) is displayed as absolute or relative values in a special
“Tank” shaped graph. The graph’s display will change to reflect changes in
Word Address data.

Regarding the following parts, if the value of 100 on the scale is displayed, the
graph area may not be filled completely depending on display magnification.
In this case, the graph can be displayed properly by enlarging or reducing the
part by one dot.

- Part file name: op4-3d01.pdb
GR_3D007, GR_3D008, GR_3D010, GR_3D015, GR_3D017

- Part file name: op4-p101.pdb
GR_PL007, GR_PL008, GR_PL010, GR_PL015, GR_PL017

B Tank Graph [General Settings] Attributes
<When displaying data in absolute values>

Select Absolute or

Enter comment

Relative display

data here Tank Graph Sellings [SG_001] | Enter the Word
General Settings | Graph Setting€| Shape/Calor | Alam Settings | A d d ress to
Description % Abshie £ Relative store araph
The currently ( ) grap
Word Address data

selected Tank
Graph’s image
appears here

Calls up the Part —]
Shape Browser.

Browser...

[ [pooon &

Data Format=—=
% Bin
£ 800 I

7] Display Mode

| Place ” Cancel H

Help

=~ Select the
desired Data
Format

Parts Shapes can
be selected
directly from the
Browser

@ Absolute

Data stored in the designated Word Address is displayed as absolute values,
from 0 to 100 (with Display Mode +/- selected, -100 to 100).

€ Word Address

Enter the Word Address where the data will be stored.
@ Display Mode

Select the display data format from Bin and BCD.
@ Display Mode +/-

When this check box [l is checked and Bin data format is selected, nega-
tive numeric data can be displayed.
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<When displaying data in relative values>

Select Absolute or

Relative display Enter the Word

Enter comment Tank Graph Settings [SG_001] ; Address used
data here General Sellings | Graph Setings | Shape/Ghlor | Alam Seflings | to store graph
The currently e (T data

selected Tank T,

Graph’s image — Selgct the
appears here _ vl s L s ggfr';jtj Data

fr Vialie =] ([ % Mo Code

Calls up the Part Coome | g ’%:Zazgommmm 1l B

Shape Browser; Specifies the
Part Shapes can R EINTE data’s Input
be selected di- Code

rectly from here. Specifies the data’s Specifies the data’s

effective Bit Length Input Range

@ Relative

The data stored in the Word Address are converted to a value between 0 and
100 according to the designated Input Range and displayed as relative
values.

€ Word Address
Here, enter the Word Address used to store Tank Graph data.
@ Display Mode +/-
When this check box |l+l| checked, negative number data can be displayed.
@ Bit Length
Specifies the Bit Length of all data stored in the Word Address.
@ Input Data Length
Specifies the data’s Input Range.

@ Input Code

With No Code selected, only positive numeric data can be entered. To enter
negative numeric data, select either +/-2’s Complement or +/-MSB.
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B Tank Graph [Graph Settings] Attributes

Tank Graph Settings [SG_001]

5 [SG_|
General Settings || Graph Settings | Shape/Color || Alam Seftings |

Select the
Tank Graph’s
display
Direction

|| Place |” Cancel Hl Help

@ Display Direction

| — Only when a

graph type
which has axis
divisions is
selected, will
this appear.
Enter the
graph’s num-
ber of divi-
sions

Here, Up, Left, Down, or Right can be selected for the Tank graph’s display

direction.
The display direction varies depending on the part types.
N
No:[g:j If [Display Direction] is changed for a 3D part, its shade is rotated along with

and select the part again from [Shape Browser].

& Axis Divisions

that part. To let the shade displayed properly, click on the button,

Here, the Tank Graph’s divisions are entered if the graph is a division type.
When no divisions are necessary, specify the number of divisions as 0.
Whether a Tank graph has divisions or not will vary depending on the Part

Shape selected.

B Tank Graph [Shape/Color] Attributes

Here, a Tank graph’s border color, division color (Axis Color), data display
color (Graph Color - Fg & Bg), as well as the data display pattern can all be

selected.
2.1 Parts B Selecting Colors

B Tank Graph [Alarm Settings] Attribute
If desired, Alarm Settings can be set here.
2.1 Parts B Alarm Settings
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B Placing a Tank Graph

The procedure for placing a Tank Graph is as shown below.

Data stored in D0102 displays on the Tank Graph R
When data 34 is stored in D0102, the Tank
Graph will appear as follows:
/
PROCEDURE REMARKS
(1)Select the [Parts] menu - [Tank Graph] command,
or click on the [@]icon.
(2)In the [General Settings] area, input the Word Ad-
dress and Data Format.
Tank Graph Settings [SG_001]
ings | Graph Settings | Shape¢Color | Alam Settings | | — Enter D00102
9 dhsolute £ Relative
— Select BCD
[ Pace [ cawe [ Hek |
(3)Select a Part Shape from the Browser. 2.1 Parts B Se-

You can also use the Alarm Settings area to enter Alarm | lecting a Part Shape
settings and select Colors, if desired.
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PROCEDURE REMARKS
(4)In the [Graph Settings] tab, input the number of axis | The Axis Divisions area will appear
divisions and graph data display derection. only for a graph type which has axis
divisions.
gfﬁt T 5 Enter 10
320 Dowy
3 Right
T Select Up

|| Place ||| Cancel |H Help

(5)After all of a Part’s attributes have been entered or

selected, click on the button.

The Tank graph’s outline will appear on the Base screen,
next to your cursor.

(6)Click on the point where the Tank Graph’s top left | To cancel the placement, click on

corner is to be placed. the [« ] icon.
If desired, use the handles to alter its size. To change the
Part’s size, refer to 2.4.3 Scaling

Up/Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s Attribute Settings dialog
box.

2.4.14 Changing
Attributes
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2.1 Parts

@ Meter Graphs

This Part creates an area where a device’s Word Address’ numeric data is
displayed as absolute or relative values on a Meter Graph (i.e. a needle

moves to show the value). The graph’s display will change to reflect PLC
Word Address data changes.

B Meter Graph [General Settings] Attributes
<When displaying data in absolute values>

Enter comment
data here

The currently
selected Meter
Graph’s image
appears here

Calls up the Part

Shape Browser; ™

Parts Shapes can
be selected
directly from the
Browser.

@ Absolute

Select Absolute or
Relative display

Meter Graph Settings [MT_001]

| General Settings | Graph Settings | Shape/Color | &fam Settings |

Description (B pbsoite £ Relative )

N i woeyroe

| Enter the
desired Word
Address data

lllllll

Select the
desired Data
Format

Data stored in the designated Word Address is displayed as absolute values,
from 0 to 100 (with Display Mode +/- selected, -100 to 100).

€ Word Address

Enter the Word Address where the data will be stored.

& Data Format

Select the display data format from Bin and BCD.
@ Display Mode +/-

When this check box [l| is checked and Bin data format is selected, nega-
tive numeric data can be displayed.
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<When displaying data in relative values>

Enter comment
data here

The currently
selected Meter’s
image appears
here

Calls up the Part -
Shape Browser.
Parts Shapes

can be selected

Meter Graph Settings [MT_001]

Select Absolute or
Relative display

| General Seltings | Graph Settings [ Shape/Color | pfem Setings |

Description (Q Ahsolute

i Ha\atlvel)

S [ e

Bit Length [1g t:]lﬁ

Input B

D000 & ) Display Mode +/-
=

HMin. Valug

|
=
May e [E558 =

£ +/- 2's Complement

Input Cod
£ No Code
£ +/-MSE

[Pece |[ Concel

[T

directly from the
Browser

& Relative

Specifies the data’s
effective Bit Length

Specifies the
data’s Input
Range

Enter the
Word Address
used to store
display data

T— Select the

desired Data
Format

Specifies the
data’s Input
Code

The data stored in the Word Address are converted to a value between 0 and
100 according to the designated Input Range and displayed as relative

values.
€ Word Address

Here, enter the Word Address used to store Meter Graph data.

@ Display Mode +/-

When this check box [[«]| checked, negative numeric data can also be dis-

played.
& Bit Length

Specifies the Bit Length of all data stored in the Word Address.

€ Input Range

Specifies the data’s Input Range.

@ Input Code

With No Code selected, only positive numeric data can be entered. To enter
negative numeric data, select either +/-2’s Complement or +/-MSB.
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B Meter Graph [Graph Settings] Attributes

|— Only when a

graph type
Select the which has
Meter’s (data divisions is
di_spla_y) selected, will
Direction this selection

appear

|| Place ||| Cancel |H Help

@ Display Direction

Here, the Meter’s display direction, either Clockwise or Counterclockwise
can be selected.

@ Axis Divisions

Here, the Meter increments are entered. If the number of Divisions is
specified as 10, 11 division lines are displayed. When no divisions are
necessary, simply enter “0”.

B Meter Graph [Shape/Color] Attributes

Here, a Meter’s border color, division color (Axis Color), and needle color
(Meter Color) can be selected.

2.1 Parts B Selecting Colors

B Meter Graph [Alarm Settings] Attributes
If desired, an Alarm’s settings can be set here.
2.1 Parts B Alarm Settings
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M Placing a Meter Graph

The procedure for placing a Meter Graph is as shown below.

4 N

Data stored in D0102 displays on the Meter Graph

When data 34 is stored in D0102, the
Meter will appear as follows:

- /

PROCEDURE REMARKS

(1)Select the [Parts] menu - [Meter Graph] command,
or click on the [E] icon.

(2)In the [General Settings] area, input the Word Ad-
dress and Data Format.

Meter Graph Settings [MT_001]
G ereral SeHiNGs | Graph S eitings || Shape/Color || Mlam Sattings | — Enter
Description ) Absolute £ Relative DOO 102

| E— ey
B = Ll Display Mode +-

e - ’,Da|a meatﬁ‘

; | e Select Bin
| MmO, 3 i) BCD

[ Pace | Cancel |[[ Heb |

(3)Select a Part Shape from the Browser. 2.1 Parts B Select-
You can also use the Alarm Settings area to enter Alarm | ing a Part Shape
settings and select Colors, if desired.

Shape Browser

QK

Cancel

MT_3D001

MT_3D003 MT_3D004 Parts File
Current POB File 'Jc\pmgram filegiproph3winypdbiop4 ‘
Title :[MT_30001 rl | Hslp }
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2.1 Parts

PROCEDURE

REmMARKS

(4)In the [Graph Settings] area, input the number of
divisions and data display direction.

Meter Graph Settings [MT_001]

™ Select Clockwise

Ploce Hep

Enter 10

(5)After all of a Part’s attributes have been entered or

selected, click on the button.

The Meter Graph’s outline will appear on the Base

screen, next to your cursor.

(6)Click on the point where the Meter Graph’s top left

corner is to be placed.

If desired, use the Meter Graph’s handle to alter its size.

The Axis Divisions will appear for
a Meter Graph type which has axis
divisions.

To cancel the placement, click on

the [=| icon.
SATOEEK To change the

Part’s size, refer to 2.4.3 Scaling
Up/Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes
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@ Trend Graphs ]

This Part displays Word Address numeric data as absolute values on a Trend
(line) graph. The graph’s display will then change to reflect Word Address

data changes.

B Trend Graph [General Settings] Attributes

Trend Graph Settings [TR_001]

Enter comment
data here |

Il Display Mode +-
.

The currently selected
Trend Graph Shape

) Bin
Lo | Select the
desired Data

appears here Format

’—D ata Format——s

Calls up the Part
Shape Browser,
displaying a list of
pre-made Trend
Graph Shapes. Part
Shapes can be
selected directly from
the Browser. =1 o [ =

& Data Format
Here, the display data format is specified as either Bin or BCD. With the

Display Mode +/- check box |l+l| checked, and Bin data format selected,
negative numeric data can also be displayed.

B Trend Graph [Graph Settings] Attributes

Trend Graph Settings [TR_001]

Select a graph type 5

) Nomal 1) Pen Recoider 123 Block Display

Pt ) [ 8 | [Sww™ || Enter the number
Oten st [T o] o ) o Il of X and Y divi-
Select the data o —— cions

%) Right

display direction

s

U
| Hlrapn Baclap -dvis Diviions [10__ =] DBz O et

Saves the previ- [ R cawoman T 2 ||| [T B |l When "Scale" is
ous data of the — checked, you can
graph to the Sy [0 ]| i 3secim specify the range
backup SRAM. Hioredvioly of data displayed

- = with the trend

[ sown| graph (display
Barder Color EJJDJJDDJE@ rang e) .
\
[Pree ][ Coneel ][ He | \

\
Enter the No. of Samples, Scroll  Displays the
value, and Sampling Time previous data.
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@ Graph Settings

Using “Normal”: The specified Word Address’s data changes are dis-
played over time in a Trend Graph. Display data
always starts at the “0” point. As each (time) sampling
period elapses, the latest data is added in the specified
display Direction. When the graph’s poly (gonal) line
reaches the limit of the Trend Graph, the graph is
shifted in the display Direction for the number units
specified in “Scroll”.

E.g.) Display Direction: Right, Scroll Count: 4

Enter screen scrolls
at this point

|

=> =;-. => =;> =]
] ] ] ] 1

BeginDisplay | zo| | 28] [ en| | 4] | o]

Using “Pen-Recorder”:
A specified Word Address’s data changes are displayed
over time in a Trend Graph. The data’s display always
begins with “0”. As each sampling period elapses, the
graph’s poly(gonal) line is shifted one division opposite
the specified display Direction. The latest data is
always displayed at the very limit (in this example, the
right side) of the Trend Graph’s display area.

E.g.) Display Direction: Right

Begin Display | & | 251 | el | 40| [ o]
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B Block (Display Mode)

All the data in consecutive word addresses are sampled at the designated
time, then graphed as a single trend line. Data changes in multiple word
addresses can be monitored as a single block by the graph. Enter address
numbers to control the ON/OFF display of the graph.

T ' ' 1 ! '
N . ] ] | ] I
1= :\/\:Z}%: =] =] !=}5:/—/\
| 4 | 4 | i | 4 1 4 1
| ] ] | ] | ] | — ] |

et —r — " e e g e
Sy Son
0 |*1 1 2 Z 1 3
& |*2 £ £ & £ &
30 30 30 40 40) 20
25 25 25 60 60) &)
60) &) &) 25 25 &)
41) 40) 40) a0 20 70
20 20 20 75 75 40
Status 1 Status 2 Data Status 1 Status 3
displays deletes Change displays clears old
the graph. the graph. the graph. graph and
displays
new one.

*1 Control Status (address for controlling display)
*2 Number of address data to display

For details of each graph type, refer to Tag Reference
Manual, 2.31 Trend Graph Display.

& Data Samples

Data Samples: The number of data “units” to be displayed in a single
Trend Graph. Up to 638 can be used.

Scroll: The number of data units to be scrolled when the
polygonal line reaches the limit of the Trend Graph’s
display area.

Sampling Time: The data read interval (from the device) is input in
seconds. The field is enabled when the graph type is
designated as "Normal" of "Pen-Recorder". This option
cannot be specified when the graph type is designated
as "Block".

@ Display Direction
Select the Trend Graph’s display direction, either Up, Left, Down, or Right.

ﬁé}e: If [Display Direction] is changed for a 3D part, its shade is rotated along
21 with that part. To let the shade displayed properly, click on the
button, and select the part again from [Shape Browser].
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@ Axis Scale

Enter the number of units that the X and Y axes are to be divided into.
When no divisions are necessary, input “0”.

€ Backup

Graph Backup: Trend graph data displayed for each trend graph screen
is backed up in the GP. The graph types that can be
backed up are “Normal” and “Pen Recorder”. When
backing up only trend graphs in 32K bytes of backup
SRAM, approximately 12 trend graphs of 639 pieces of
display data each can be saved.

%\[e; This function is valid only for the GP models with back up SRAM. GP
models with back up SRAM can be recognized by the label attached to the
GP’s rear face. When the GP70 series unit’s label color is copper brown,
the unit has back up SRAM. GP-377, GP-77R and GP2000 series units all
have backup SRAM.

SRAM Seal

Pro-face GRAFHIC PAMEL
GPET1-TGC11

SN 8800150000

DIGITAL ELECTROMICS CORP.
rADE | 1 JAPAR

@ Synchronous Mode

When the power is turned back ON by selecting the Synchronous Mode, you
can start drawing trend graph at the point where you stopped. If this mode is
not selected, the trend graph data starts from the beginning.

@ Previous Data Display

The previous data record of the trend graph can be displayed. This function
is supported only by GP2000 Series units and is available when the graph
type is designated as "Normal™ of "Pen-Recorder”. Enabling "Data Record
Display" automatically enables the "Backup” option. The previous data
record is saved in the GP's backup SRAM.

Tag Reference Manual, 2.31 Trend Graph Display

Sampling Count

Designate the quantity of sampling data to be stored in each channel. Enter
the total value of the quantity of sampling data being displayed on the trend
graph (current) and the cumulative quantity of sampling data (previous).
Confirm that the Sampling Count is greater than the value of the Display
Data Amount. The display can be made to return further than the trend graph
data that are being displayed on the GP. Select "Bin" as the Display Format
and enter a value between 1 and 65,238.
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Automatically Placed Switches

These are function switches automatically placed on the right of the Trend
graph parts for display of Previous Data. When using these switches, be sure
to enable all switches. All switches are enabled with the initial settings.

Trend Graph

Display (Disp)

Previous (Prev)

Forward (Fwd)

When placing the switches

Display switch

5 Previous switch

Forward switch

Switches to the trend graph to the Data Record Display
mode.

Touching the ey switches to the Data Record

Display mode and displays the switch in inverse video.
When the switch is touched again, the inverse video is
reset, and the Data Record Display mode is canceled.

This switch is enabled only while the Data Record

even if it is touched while th
in inverse video.)

scrolling (backward) the data by a predetermined
number of data items.

The number of data items to be scrolled can be desig-
nated between 1 and 65,238.

If the switch is touched while the last (oldest) data are
displayed, the buzzer sounds three times. The display
cannot be scrolled further.

This switch is enabled only while the Data Record

even if it is touched while the |
in reverse video.)

the previous data up to the end point, which is the most
recent data at the moment the display mode is switched
to the Data Record Display. The number of data items
to be scrolled can be designated between 1 and 65238.
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When the switch is touched while the most recent data
(at the moment the display mode is switched to Data
Record Display) are displayed, the buzzer sounds three
times. The display cannot be scrolled further.

Browser Displays the browser. The Part shape can be selected on
the browser. 2.1 Parts MSelecting a
Part Shape

Border Color/Color/Pattern
Select the border color of the switch (Border color),
color of the switch (Color), and the pattern of the

switch (Pattern). 2.1 Parts ESelecting
Colors

@ Display range

When "Scale" is checked, you can specify the range of data displayed with
the trend graph (display range).

Enter the upper and lower limit values of the data using direct/indirect
addressing.

This function is effective only with the GP2000 Series when the graph type
is designated as "Block Display".

When "Scale" is checked, specify the type and line type of the assistant line
in the [Assist Line] tab.

Tag Reference Manual 2.31 Trend Graph Display

Scale : Enables the settings for designating the display range of
the data in a "Block Display" type trend graph or for speci-
fying the details of the assistant line.

Upper/Lower : Designate the upper and lower limit values directly or

indirectly.

Direct - Designate the range directly. Values can range between 0
and 65535 or, when a negative value is used, between
-32768 and 32767.

Indirect : Designate the range with word addresses.

ﬁé}%  Data exceeding the designated display range is not displayed.

* When the display range setting is changed, the updated trend graph is

displayed only after the graph display has been cleared or the screen has
been switched.
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B Trend Graph [Channel Setting] Attributes

DeSig nateS or Tend Graph Selings [TFL[I[H — l ” ” l X Enters the
General Settings || Graph Settings annel Settings | Shape/Color || Alam Settings || Assit Line
e . . Word Address

enters the No. of Channets “whord Address T d
number of data |N“g " Ee  F@—ow— || used to store
lines (channels) || cuentare  (EHone the current
to be displayed Comer Tl = channel S
on the Trend - WEECEECONE [ ] display data
Graph 80 NN EECCIWE voex -

oo Can be
Designates the enabled .when
channel being g LT T nal R Block" is
currently se- selected.
lected / Selects the

color and

Designates the | type of line
type and color used for the
of dots when current
"Block Display" channel
is selected. (e |

€ Number of Channels

Enter the number of channels used in the Trend Graph. Use the “Current Chan-
nel” area to select which channel is being specified. The maximum number of
channels that can be set up for the entire Project file (PRW file) is 40 with
GP2000 series units and 20 with other models. (When Data Sampling is desig-

nated, the quantity of data sampling is included.)

€ Word Address

Enter the Word Address used to indicate where the Trend graph’s data is

stored.

For details of the Word Address for block display when the

graph type is designated as "Block™ in the [Graph Settings] area, refer to Tag
Reference Manual, 2.31.5 Block Display Mode (for Device Direct Access).

& Offset

This function can be selected when "Block™ is selected as the graph type on
the Graph Settings tab. The address in which graph data are stored can be
designated as Offset. The Offset setting becomes valid when the device
Word Address is used as the Word Address. Tag Reference
Manual, 2.31.5 Block Display Mode (for Device Direct Access).

®Line

Specify the type and color of the line in the trend graph.

& Dot

Specify the type and color of the dots when the data is displayed in dots. This
function is available only with the GP2000 Series units. This option is active only
when the graph type is set to "Block Display". This option cannot be used to-
gether with the "Fill Below Line" option of the trend graph.
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B Trend Graph [Shape/Color] Attributes

The Trend Graph’s border color, division color (Axis Color), and Trend Graph’s
display area color (Graph Area Color) can be selected.

2.1 Parts B Selecting Colors

B Trend Graph [Alarm Settings] Attributes

If desired, an alarm’s settings can be set here.

2.1 Parts B Alarm Settings

B Trend Graph [Assist Line] Attributes

ﬁé\te; e Options for the assistant line can be set only when ""Block Display’* and
""Scale™ are selected in the [Graph Settings] tab.

Trend Graph Settings [TR_001]

Desi gnate [General Settings || Graph Setings || Charnel Settings || Shape/Calor || flarm Settings]| Asst Line
the assistant |ue=]
line for the =

Y-axis. Tiewe]
o] (e ) ] Designate

Enable the M the assistant

. %9 Direct = .
settings go L H line for the
for each X-axis.
assistant %%‘%%‘%
line Y1 ][ | )

. rEENCEECCNE]f
Designate

the type and
color of each
assistant
line.

[ Prace |\| Cancel H\ Help

& Draw Line

Click the desired assistant line button - | Upper |, [ Base | OF [ Lower | - and check

"Line". You can now specify the position (direct/indirect addressing), type
and color of the selected assistant line.

Tag Reference Manual 2.31 Trend Graph Display
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’fData stored in D0102 is displayed on the Trend Graph

~,

When 34 is stored in D0102
.\Ehe graph will look like this:

Auis Sefings
Sample 20
Scroll 13

Sampling Time 10 sec
Potis Diw. Qfery 10
" (Hoe) 1o Y,

PROCEDURE

REMARKS

(1)Select the [Parts] menu - [Trend Graph] command,
or click on the [&] icon.

(2)After clicking on the [General Settings] tab, select
the data format.

Tiend Graph Settings [TR_001]

I Display Mode +-

F;Ja;?mtE/__ Select Bin

Zyeco

[ Pree |H Cancel ||| Help

(3)Select a Part Shape from the Browser.
You can also use the Alarm Settings area to enter Alarm

settings and select Colors, if desired.

Shape Browser

TR 3D003R ___ |

Cunrent PDE File::[ fles\proph 3winpdblop-3d01 pdb

Title:| TR_3D00TR 4 ‘ Help

Data in the range of 0 to 100 can
be displayed on the Trend Graph.
When the data range is from -100
to 100, check the Display Mode
+/- check box.

2.1 Parts W Select-
ing a Part Shape
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PROCEDURE

REmMARKS

(4)In the [Graph Settings] area, select the Graph Type
and Direction, and enter the number of Data Samples

and Axis Divisions.

Select Normal

Trend Graph Settings [TR_001]
General Sslings]| Graph S2#1Gs | Charnel Selings || Shape/Colr || Alam Sefings |[Asst Line 1 — E nter 2 0
180 Nomal T PenRecorder £ Block Display
5
Display Di
‘z;ip ecten Diats Samples |20 =] % Geales E t l 9
EHA = Ry nter
2 Dawn
Right
Baghup- s
I Graph Backup M —
i

~l[Historical |

sy [0 B suishdssin I Enter 10
i iriealielby ::--- \\
B [T [ ™ Enter 10
o agd) |1 =

Buaussz..
Pl Cancel Help
Select Right

[When Data Record Display Setting is Disabled]

(5)In the Channel Setting area, enter the Number of
Channels, then enter each channel’s Word Address

and select the desired colors.
In this example, since the Number of the Channels is

“1”, you only need to enter one Word Address.

“Word Address [ En r D 1 2
WroE i T | ter DOO10
] Line

Fo IO I CY M o Bk [
&0 I/ WU e ]

Currert Channel

|Charrel T

When "Block™ is selected as the
graph type, the "Data Record Dis-
play" setting is disabled.

The "Display range" settings can be
designated when the graph type is set
to "Block Display".

If the more than one channel is used,
be sure to enter the Word Address
and select the Color for each chan-
nel before placement.

For parts using two or more word
addresses and trend graph channels,
confirm that the word addresses will
not overlap; otherwise, an error may
occur in the GP.

GP-PRO/PB 11l for Windows Ver.6.3 Operation Manual

2-81



2.1 Parts

Chapter 2 - Base Screens

PROCEDURE

REMARKS

(6)After all of Part’s attributes have been entered or

selected, click on the button.

The Trend Graph’s outline will appear in the Base screen,
next to your cursor.

(7)Click on the point where the Trend Graph’s top left
corner is to be placed.

If desired, use the Trend Graph’s handles to alter its size,
after placement.

[When Data Record Display Setting is Enabled]

(5)Put a check mark in the Data Record Display
checkbox.
In this example, since the Number of the Channels is
“1”, you only need to enter one Word Address.

Trend Graph Settings [TR_001]

General Seliings || Grsph Settings | Channel Seflings |[Shape Calor |[&laim Seftings |[&ssit Line

) Nomal 9 PenRecoider 123 Block Display

Dot Diseh
Display Direction g
U Data Samples |20 =] 2 Gaale
— L
=
e ool 8 B S0 O balsax
£9 Down Sempling Tine [ 10 =] 0 =
53 Right =
9 =i Ul
| Graph Backup s Divisions [10 =] Goin D et
T Sunchionous Made g =
i Divisons [10__ =] 100 Sﬁ

Sampling 00 [ Switch Selection
) Histerical Display
) Previous 1

M Forward |

Browiser,

Badercolr /I W OO 5 ]

[ Frace |H Cancel |H Help

Up to 20 channels can be designated
for a Project file (including the Data
Sampling frequency number) is 40
with the GP2000 series units, and 20
with the other models.

Up to 8 Trend Graph display areas
can be placed on a single screen.
Data Record Display can be set up
to only one of those trend graphs.

To cancel the placement, click on the
icon.

To change a Part’s size, refer to

2.4.3 Scaling Up/
Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

SO 2.4.14 Changing
Attributes

Checking the Historical checkbox
automatically calls up the Backup
settings.

SAEIETK For details on His-
torical Display and Backup func-
tions, refer to Tag Reference
Manual, 2.31 Trend Graph Display.

In the initial settings for the default
switches (automatically placed
switches), Historical Display, Previ-
ous and Forward are all enabled.
When using switches, place a check
mark in every checkbox.
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2.1 Parts

PROCEDURE

REMARKS

(6)In the Channel Setting area, enter the Number of
Channels, then enter each channel’s Word Address
and select the desired colors.

In this example, since the Number of the Channels is
“1”, you only need to enter one Word Address.

Curent Charnel [ Line

-
fo BN |NECONA hoek
o2 WM W oo R

™ Enter
D00102

[ Place ||| Cancel ||| Help

(7)After all of Part’s attributes have been entered or

selected, click on the button.

The Trend Graph’s outline will appear in the Base screen,
next to your cursor.

(8)Click on the point where the Trend Graph’s top left
corner is to be placed.

If desired, use the Trend Graph’s handles to alter its size,
after placement.

If the more than one channel is used,
be sure to enter the Word Address
and select the Color for each chan-
nel before placement.

For parts using two or more word
addresses and trend graph channels,
confirm that the word addresses will
not overlap; otherwise, an error may
occur in the GP.

Up to 20 channels can be designated
for a Project file (including the Data
Sampling frequency number) is 40
with the GP2000 series units, and 20
with the other models.

Up to 8 Trend Graph display areas
can be placed on a single screen.
Data Record Display can be set up
to only one of those trend graphs.

To cancel the placement, click on the

icon.

The trend graph with the default
switches (automatically placed
switches) has been grouped. To
change its size or attributes, ungroup

it first by clicking on the [Z] icon.

2.4.12 Group/
Ungroup, 2.4.3 Scaling Up/Down,

2.4.14 Changing Attributes

Only one trend graph part with the
Data Record Display setting can be
placed on each screen. Do not place
a function switch designated with the
"Trend Key" setting in the same
screen on which a function switch
has been automatically placed on the
screen.
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@ Keypads ]

Here, pre-made keypads are used to enter data to a designated Word Ad-
dress. In order to input data via the keypad, it is necessary to first create a

Keypad Input display.
2.1.14 Keypad Display

B Keypad [Description] Attributes

Keypad Settings

DiSpIayS the ) General Settings ] Select the

currently selected Kepad Typemey _—— | Keypad’s data
% Decimal | format
i Hen
2 Teut

Keypad’s image
Pad Color || — Select the

L] Ty ] T Keypad’s
border color

Calls up the Part
Shape Browser.
Parts can be
selected directly
from the Browser

Flace || Cancel || Help ]

@ Keypad Type

First, a Keypad type needs to be selected that will be suitable for the data
format specified. To select a Keypad type, simply click on the Browser and
the selection of available Keypads will be displayed.

@ Pad Color
The Keypad’s border color (Pad Color) can be selected here.
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B Keypad Key Functions

The various Keypad Key functions are shown in the table below.

Decimal Hexadecimal

Keypad Specs

Numeric value keys (for Hex, the keys are 0 to F).
Inputs the corresponding value in the display.

Delete key
Deletes the character above the cursor.

Clear key

Clears the entire display. If the Bis pressed after clearing,
0 is stored in the PLC Word Address.

Enter key

Registers the set value and writes it to the PLC Storage
Address. Then, the cursor moves to the next display and
awaits next input.

Cursor keys
Moves the cursor right and left within the display.

Jump keys
Moves to the next Key Display without entering the set value.
You can use these keys to jump to the area where you wish to
enter data.

Negative key

Only available for
Dec(imal) and +/-
format.

Decimal Point key
Valid when Decimal
Places have been
entered for Decimal
and BCD numbers.

Common Keys

Dec. Only keys
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B Placing a Keypad

The procedure for creating and placing a keypad is shown below.

' ™

MO0ED

KD_2

II

KD_z

When the Trigger KD_1t03 Input data %

Bit MOOS8O turns (Word Address D0050 from the

ON, ... to D0052) can receive... Keypad
S A

For how to create the display area for the keypad shown
here, refer to 2.1.14 Keypad Display.

PROCEDURE REMARKS

(1)Select the [Parts] menu - [Keypad] command, or click
on the [ icon.

(2)Select a Keypad Data Format Type.

Keypad Settings

Feypad Type=——

£ Decimal Select Decimal
3 Hew

9 Test

Pad Calor

) ) o i ) e I

General Settings ]

|. Flace ] | Cancel } | Help |

(3)Select a Keypad Shape from the Browser. 2.1 Parts B Select-
If desired, select a color from the Shape/Color area. ing a Part Shape

T R R
v [ e e e e

KP_3D001D KP_3D002D

Cy
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PROCEDURE REMARKS

(4)After all of the Keypad’s attributes have been en-

tered or selected, click on the button.

The Keypad’s outline will then appear in the Base screen,
next to your cursor.

(5)Click on the point where the Keypad’s top left cor- | To cancel the placement, click on
ner is to be placed. the [« ] icon.

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes

ﬁé}e: Regular Keypad parts have all been previously grouped. Therefore, to create
a new keypad, simply un-group the Keypad and arrange the pieces as you
like.

2.4.12 Group/Ungroup
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@ Keypad Display ]

This section describes the procedure for creating an area for displaying the
data input from the keypad.

Touching the Keypad Input Display can automatically call up a pop-up
keypad. When not using the pop-up keypad, place an additional keypad
separately from the Keypad Input Display.

@e: » The pop-up keypad is automatically set up by placing the Keypad Input
S Display. Setting up an additional keypad is not required.

» K-tag functions can be set up (except for the operation function). Also see
"2.12 K Tag (Key Input)™ in the Tag Reference Manual.

» The Keypad Input Display cannot be set up simultaneously with the CSV
Display, Logging Display or N699-tag.

1 { The pop-up keypad feature is supported exclusively by the GP-
Imp;rtant 377, GP77R and GP2000 series.

B Keypad Display [General Settings] Attributes

Keypad Input Display Settings [KD_001] % / Enter th e
Enter comment General Settings | Display Format || Shape/Color [ Alarm Settings |[Extend | WO rd Add ress
data here \ Description Word Address ./ used to store

i 5% [ooooon ille ;

Rk | B ElE display data
The currently Tiaaarliiotinss

i ===
selected Part’s _ 8] o000 Enter the.
image will appear i P e Trigger Bit
se Pop-up Keyppa

here [Eower| Address to

allow you to

Calls up the Part
Shape Browser.
Parts can be
selected directly
from the Browser

|| Place ||| Cancel |H Help

€ Word Address

perform data
settings via
the Keypad

Select this
option to display
a keypad when
the GP screen’s
Keypad Input
Display is
touched.

The Word Address is used to store the keypad display’s data.
@ Trigger Bit Address (When not using the Pop-up keypad feature.)
When this bit is turned ON, the Keypad’s data entry area becomes active.

@ Use Pop-up Keypad

When this option is selected, touching the Keypad Display will automati-
cally display the pop-up keypad on the screen. When this option is selected,
the Trigger Bit Address is disabled.
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B Keypad Display [Display Format] Attributes

When selected, the
address storing the
data to be dis-
played is specified
indirectly.

The decimal point
is not included in
the display digits.
Enter the No. of
Display Digits

Enter the No. of

Digits after the —

decimal point

Keypad Input Display Settings [KD_001]

J’ General Settings| Display Fomat ‘ Shape/Color r Alarm Settings | Extend

(R

1 Relative

12 Char Sting

Indirect

&) Sddiesses
12 Dewiee Typeddddiessy

Baseddiinss

)

) Bin {2 BED

Select the data to be
L
displayed.

Tag

Reference Manual,
2.12 K-tag (Key
Input)

7] Code +- Display & 'ite Data Format=——=
) Bogund g, 16 Bit 32Bit

) Decimal 1 Decimal

120 Hex £ Hew

i BCD {2 BCD

£ Octal 12 Bin

12 Bin 24 Float

( Ma. of Display Digits ]5

El| ) Character Size |
|

Select the Data
Length and Data
Format here.

—

Decimal Places [0 %‘ )

H Place I” Cancel ‘H Help ‘

Character size can
be selected here

& Absolute

Handles 16-bit or 32-bit data. SLTITIETIK Tag Reference Manual, 2.12
K-tag (Key Input)

Also designate the Data Format, Code, and Data Length of the data to be

displayed.

When "Dec" is selected, put a check mark in the "Code +/-" checkbox to
enable display of negative data values.

@ No. of Display

Digits

Here, the number of digits displayed, to the right of the decimal point, is

input.

& Decimal Places

Here, the number of digits to the right of the decimal point is input.

When using 32 bit data, the relationship between the top and bottom of the Word
Address will differ depending on the device used.

Device (PLC Connection) Manual
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ﬁé}e: When the No. of Display Digits is set to 5 and the Decimal Places is set to 2, a
value appears on the Keypad Input Display as shown below.

& Character Size
The label’s character size is selected here.

2.2.9 Text

B Keypad Display [Color/Shape] Attributes

Keypad Input Display Settings [KD_001]

General Settings || Display Format|| ShapeCalor |Alarm Settings || Extend | [ Sp ec | fy th e co | or
directly or indirectly.

elect Indirect Address Area

Calor Type:
&) Direct ) dienffter Diplagdaiasy
E 120 Indirect ) fimafirerBasadichiesy
Border Color WO NECOONE [MeEk [

The browser is o] e meEOeEOCES e E

displayed. The Ple o
ate Color 10 R 00 1 ) ) ) T o B [
Part shape can Perr

be selected
here.

H Flace ||| Cancel ||| Help

The Keypad Display’s border color, data display color (Text), and interior
color (Plate) are selected here.

@ Color Type
Direct Directly designates the color settings.

Indirect  This option is enabled when the Data Format is set to "Absolute"
and the Alarm is set to "OFF". The Text color and Plate color
settings can be designated indirectly. Designate the color at-
tributes to the address displayed right under the "Text color" and
"Plate color". Note that this setting is not available with the
GP270. Tag Reference Manual, 2.10.4 H-tag/
Object Drawing Data/Color attributes

B Keypad Input Display [Alarm Settings] Attributes
Set up alarms if necessary.
Tag Reference Manual, 2.12 K-tag (Key Input)
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B Keypad Display [Extend] Attributes
Use this tab to designate the Input Style, Display Style, and Interlock func-

tion.
Keypad Input Display Settings [KD_D01]
[ General Settings || Display Format || Shape/Color |[Alaim Settings|| Extend ‘
=rput Syl
@Auloﬁ\ealDFF Tl Bar Cads Input
2 Auta Clear OM
2 Auta Clear & Input Check
=Dizplay Sty =
125 Shift Fight | Zero Suppress | id H
123 Shift Lelt 1 Zero Display Spec ! fy the
Supported by | 7 Segment Display D|Sp|ay Style
the GP2000 .
Series only e Specify the ON/
] T 7= OFF status of the
Tauet aaibbl sondlian .
S ERn £ BRL Inte_rlock fgnctlon.
(This function can
be set up only
[ Fiacs ||| Cancel ||| Help When the pop_up
keypad is used.)
@ Input Style

¢ Auto Clear OFF

The previous input is not cleared and displayed in the input area. The new
input is appended to existing data. To clear the existing values, enter "CLR"

from the Touch Keypad.

* Auto Clear ON

The previous input is cleared when the first character (except the cursor
keys, ENT, DEL and BS keys) is entered.

* Auto Clear & Input Digit Monitor

When barcode input is performed in this mode, the Auto Clear function is
enabled and the input data are monitored so that it matches the No. Display
Digit. If the data length is inappropriate, it is not written into the word
address. When data is input from the Touch Keypad, only the Auto Clear

function is enabled.
* Barcode Input
Selecting this feature enables input from the Touch Keypad and barcode
readers.
@ Display Style
* Shift Left
« Shift Right

Select the display style from the Shift Left and Shift Right. The data will
appear, starting from the side designated here. The Shift Right is selected by

default.
» Zero Suppress

Select this option to omit the leading zeros of display data. E.g. When the
Display Length is 4 and the Zero Suppress is NOT selected, 25 appears as

0025.
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« Zero Display

When this option is clicked, and the Device data is 0, the value 0 will not
display.

7 Segment Display

When this option is selected, numerical values are shown on a 7-segment
display. Only the GP2000 Series supports the 7 Segment Display.

%

iVote: When a GP type other than the GP2000 Series is selected and the "'7 Segment
X2 Display" option is enabled, the following alarm appears.

Project Manager

& "The GF tppe vou selected iz not supporting the function. [t could not be available even if you selected the function.”

To clear the alarm, disable the "7 Segment Display" option.

@ Interlock (Only when the pop-up keypad is used)

Only when a bit designated via Interlock Address is in a state that has been
selected via [Touch available condition], the pop-up keypad becomes effec-
tive. Whether the pop-up keypad is effective in ON state or in OFF state is

selectable here.

XNote: This function is available only with the GP-377, GP77R and GP2000 series.
2]

Touch Available Interlock Address Touch Available/
Condition Status Not Available
: ON Touch Available
BILON OFF Touch Not Avalable
: ON Touch Not Available
BItOFF OFF Touch Avalable
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B Placing a Keypad Display

The Keypad Display’s placement procedures are shown below.

PROCEDURE REMARKS

(1)Select the [Parts] menu - [Keypad Input Display]
command, or click on the [ icon.

When [Use Pop-up keypad] is se-

lected, the Trigger Bit Address is

disabled.

(2)Make the following settings on the [General Settings]
tab.
[When using the Pop-up Keypad]
Place a check mark in the [Use Pop-up keypad] box.

Keypad Input Display Settings [KD_001]

Description word Address

I | e FEE

TiingerEitdeblesy

@ - -
ﬂ Use Pop-up Keypad
I

|| Place ||| Cancel ||| Help

[When not using the Pop-up keypad]

Remove the check mark from the [Use Pop-up Key-
pad] box, and enter the word address and trigger bit
address.

Keyppad Input Display Settings [KD_001]

General Settings | Display Format || Shape/Color |[Alam Settings |[Extend |

Description “word Address

! | 18] o0 & Enter DO0050
Trigger Bit Addiess
e iEE] Enter MO0O80
ﬂ Use Pop-up Keypad

|| Place ||| Cancel ||| Help
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PROCEDURE

REMARKS

(3)Select a Part Shape from the Browser.
If desired, select colors from the [Shape/Color] area and
input the extension settings.

i Parts Fils

Current it POB File JE\pngramﬂ\es\nmnb3wm\pdb\up4'3dm ‘

Tite:[KD_3D001 EH Help }

(4)In the [Display Format] area, specify the Data Dis-
play Format, No. of Display Digits, and Decimal
Places (i.e. number of the digits after the decimal
point) to be used. If desired, select the Character Size.

Keypad Input Display Settings [KD_001]

General Settings|| Display Foimat | Shape/Color [[ Alam S ettings |[Extend
) Absolute L Relative ) Char. String

Ll indrect Bpsafiohiasy
O Uz Tipstiteiasy & Bia DBED
T Code +/- Display & Wiite Data Formate—s
] Bromd U 16Bit 32Bit
) Decimal {3 Decimal
£ Hex 9 Hex
8CD {3 BCD
2 Octal £J Bin
£ Bin £J Float

No. o Display Digts [ —E——Chasach Enter 4

Do not enter anything
[ here (i.e. “0")

(5)After all of the Keypad Display’s attributes have been

entered and selected, click on the button.

The Keypad Display’s outline will appear on the Base
screen, next to your cursor.

2.1 Parts W Select-
ing a Part Shape

When placing the Keypad Input
Display, do not rotate it. Doing so
will cause the Pop-up keypad to dis-
play in the incorrect orientation.
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2.1 Parts

PROCEDURE

REmMARKS

(6)Click on the point where the Keypad Display’s top
left corner is to be placed.
If desired, use the Keypad Display’s handles to alter its
size.
Even though the set value display area is scaled up or
down, the character size will not change. To change
the character size or position, directly select the charac-
ters inside the border.

(7)Repeat from step (1) to create Keypad Displays with
Word Addresses “D00051 and “D00052”.
Except for the addresses, all settings should be the same.

To cancel the placement, click on

the [ icon.
SAEIEEK To change the

Part’s size, refer to 2.4.3 Scaling
Up/Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes

If the [Ctrl |key is pressed when the
display area’s border is scaled up
or down, its interior characters are
also scaled.
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B Using a Keypad to Input Values

€ \When not using the Pop-up keypad

The procedures for
are shown below.

entering setting values via a Keypad on the GP screen

- ™
MO0E)
w2 ]
oz |
. KD 1to 3
Bimooso s WodAddress
oN D0050 to D0052) from the
L can receive... Keypad p.
PROCEDURE REMARKS

(1)Here, three Direct Call-Ups have been set to share a For how to create

common start bit.
ID No.

(2)Then, when the PLC’s internal Trigger Bit M0080

turns ON,

PLC
N

1.

(3)First, the Keypad Display KD_1’
(highlights) and waits for input.

The square box shown below represents the cursor’s po-

sition.

[T
[ 1
[ 1

a Keypad, refer to 2.1.13 Keypads

For how to create
a Keypad Display, refer to 2.1.14
Keypad Display ® Placing a Key-
pad Display

s display reverses
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PROCEDURE REMARKS

(4)Press the Keypad’s keys to input the desired value.

o5l |[A] [W] <[]
9 ]18] [7 ] [ee]
[6]15] [4][-]
[0]L ]l

(5)Press the [ENT] key to register the value.
i

(6) The registered value will then be stored in Word Ad- | Set value display areas having a
dress D0050, which was designated in KD_1. Next, | common Trigger Bit will enter a

KD_2 will be highlighted and be ready to receive in- | Wwait state in order, from the lowest
put. ID number upwards. After the first

value has been registered, the next
£5 % PLC value’s display area will automati-

I .
-j j]]]]j]] cally be ready to receive input.
s I ~
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€@ \When using the Pop-up keypad

Chapter 2 - Base Screens

The procedure for positioning the Keypad Input Display featuring the Pop-

up Keypad is shown below.

Note:  The Pop-up Keypad feature is available only with the GP-377, GP77R, and
X GP2000 series.
4 I
KD_1 ko_1 [ 7284
Word
address
D0050
When the KD_1 The Pop-up Keypad Input data
Keypad Input appears, and the using the
Display is touched display waits Pop-up
touched. .. for input. Keypad.
\_ p yp Y,
PROCEDURE REMARKS

(1) The Keypad Input Display ""KD_1" is displayed on
the GP screen.
ID Number

(2) When the KD_1 Keypad Input Display is touched. . .

KD_1 %

(3) The Pop-up Keypad appears, and the touched
display waits for input.
The square box shown below represents the cursor’s
position.

(4) Touch the appropriate key on the Pop-up Keypad to
enter the value.

5 5[2]

N

For how to create a
Keypad Display, refer to 2.1.14
Keypad Display ® Placing a Key-
pad Display

Select this option to display a key-
pad when the GP screen’s Keypad
Input Display is touched.

In the following two cases, the pop-

up keypad will disappear with no

confirmation of the input during

data input:

- When the active Keypad Input Dis-
play is touched

* When another Keypad Input
Display is touched during data
input (only when the [Use Pop-
up keypad] feature is enabled for
Keypad Input Display)

The Keypad Input Display that has

been touched becomes active and is

displayed in reverse video, calling

up the pop-up keypad for display on

the screen.
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PROCEDURE REMARKS
(5) Press the ENT key to register the value. When [Cancel] is touched, the Pop-
The Pop-up Keypad will then close. up Keypad closes without register-

M

(6) The registered value will then be stored in Word Ad-
dress D0050, which was designated in KD_1.

ing the input value.

852

-, I -
Dooso T[T W TT]
s | ~

€ Notes for using Pop-up Keypad

Do not specify [High Speed] from [Designated Window] of a U-tag when using
Pop-up Keypad with the Keypad Input Display.

Do not rotate the Keypad Input Display when you position it. Otherwise, the Pop-up
Keypad will not appear in the proper orientation.

@ Restrictions for using Pop-up Keypad

If the Keypad Input Display selected does not use the Pop-up Keypad feature or
if the trigger bit in the K-tag is set to ON, the Pop-up Keypad will not appear.

The Pop-up Keypad will appear to the right of the Keypad Input Display.

If there is insufficient space to the right of the Keypad Input Display to display
the Pop-up Keypad, the Keypad automatically appears in a position either
above, below, or to the left of the Keypad Input Display.

If there is insufficient space in each of these positions, the Keypad will appear
in the lower right corner of the screen. In this case, the Pop-up Keypad and the
Keypad Input Display may overlap so that you cannot see the input value.

The Pop-up Keypad is displayed as a local window. When two local windows
are already displayed on the screen, the Pop-up Keypad does not appear even if
the Keypad Input Display is touched. In this case, the Keypad Input Display
will not wait for input.

When the pop-up keypad and other windows overlap, touch the desired window
to bring it to the front.
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» The tag size of the Keypad Input Display that uses the Pop-up Keypad is
greater than those without the Pop-up Keypad by 60 bytes. (When the Pop-up
Keypad is used with the initial setting, the Keypad Input Display capacity is
276 bytes, and 216 bytes when the Pop-up Keypad is not used.)

* When the Touch Available Condition of the Interlock function is disabled, the
Pop-up Keypad is not displayed.

* When the Touch Available Condition is switched to OFF while input is being
made on the Keypad Input Display, the Pop-up Keypad continues to function.
Continue the input, and confirm the entry with the Enter key as usual, or press
the Cancel key to cancel the input. However, note that touching the Keypad
Input Display will not cancel the input.

B Editing the Pop-up Keypad

When a check mark is added to [Use Pop-up Keypad] in the [General Settings] tab
of the [Keypad Input Display], a keypad is displayed that is preset with the [Dis-
play Data Format] settings in [Display Format]. However, the keypad settings can
be edited to your preference.

PROCEDURE REMARKS

(1) Select the [Screen] menu - [Popup Keypad Edit] com- | When "GP***** \frtical Type" is
mand. selected as the GP Type, a pop-up
keypad for the vertical type is dis-
(2) Select the type of Pop-up Keypad to use ( [Dec | played. When editing the pop-up
Landscape],[Dec Portrait], [Hex Landscape], [Hex | keypad, select a keypad designed
Portrait], [Text Landscape]or [Text Portrait].) for the vertical type.
The editing screen for the Pop-up Keypad appeatrs.

% Drawing Board - Plant 1
Screen | Edit ¥iew Option Drew Tags Parts Special

e

Open Screen
Close

Save

Sawe As

gfl*g ) D/ﬂi]'-“] EEAEY
T

Chrl+&

Erevions Soesn
Iz Sepmem

Screen Information

Window Registration

Papup Keypad Edit

Sawe oz defaliifeypad

Dec FPortrait

Transfer..
Alarm...
Text Table

HexLandscape
Hex Fortrait

TextLandscape
Text Porrait

Exit

The library browser automatically
opens. You can select a keypad
from the library.

The CPK file displayed here can-
not be edited.
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PROCEDURE REMARKS

e S You can also create a keypad as de-
E R R NN BRI LR RS SR LY sired.

3.3 Creating a
Keypad: the Keypad Screen &
Creating a Keypad (3)

Do not use the keys. They
are non-functioning on the pop-up
@ keypad.
B
fi. Viewing All Objects /A

(3)Edit the Pop-up keypad. When the range of the clear area is

When changing the size and place of the Pop-up | specified, the X-axis can be speci-
Keypad, a clear area must be changed. Specify a | fied in units of eight dots.Fractions

. will be automatically translated into
clear area to surround the entire pop-up keypad. eight-dot units. The Y-axis can be

specified arbitrarily.

(4)Select [Save] from the [Screen] menu or click the | When saving the edited Pop-up key-
icon to save the pop-up keypad you have | pad, select [Save as default Keypad]
edited from the [Screen] menu. The pop-

o o up keypad will be used as the de-

This will be used as the Pop-up keypad within the | fault keypad for all future projects.

project.
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@ Alarm Display ]

When the device Monitor Bit has been turned ON, messages registered in the
Alarm Summary by the Alarm Editor, can be displayed in a list.

Chapter 5 CREATING AND EDITING ALARMS

Message display order is decided according to which Monitor Bit is in the lowest
position in the Alarm Summary display area. Itis recommended that Monitor Bit
assignment begins from the message with the highest priority.

Be sure to input only one message per line. The characters of a message
that exceed one line will be truncated.

The number of the characters that can be displayed in one line will vary
depending on the character size and GP type. When the size is 1 x 1, the
maximum number of characters that can be displayed per line for each GP

model is:
Maximum Number of
Characters GP Type
0 GP-H70, GP-270, GP-370, GP-377, GP-377R, GP-2301H, GP-
2300, GP-2301
80 GP-470, GP-570, GP-571, GP-870, GP-477R, GP-577R, GP-
2401H, GP-2400, GP-2401, GP-2500, GP-2501
100 GP-675, GP-2600, GP-2601

B Alarm Summary [Description] Attributes
Enter the start

Alarm Summary Settings [AL_001]
Enter Comment o 5ot [ Dintey ot /| address for
eneral aellings t I
data here izplay Farma yle/Color each
Diezcription Whord Address message’s
%] [poooo ~EE Monitor Bit
: Barder Typ
ireelzct::;:];e?|splay £ Mo Border Mo, of Monitor words |1 \,%\
® [ T~ Enter the
(frame) B number of
Words allo-
cated for a
|I Place || Cancel || Help | Monitor Bit

@ Border Type
The display area frame types are No Border, Outside, and Outside + Inside.
€ Word Address

The Monitor Bit’s first address for the messages specified by the Alarm
Editor is input. Input this address in word units.

E.g.) How to designate a Word Address (MELSEC-A Series - Mitsubishi):
When designating the Word Address for the input/output or internal
relay, the Word Address is designated from the Least Significant Bit.

MOTES MOTEE MOT4E MOT44 YOUF YO1E Y011 00
~ High Low - LSB ~ High Low - LSB
In this case, M0144 is In this case, Y010 is
designated designated
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& No. of Monitor Words

Here, the number of words a Monitor Bit is assigned and entered. Up to 100
words can be monitored.

B Alarm Summary [Display Format] Attributes

Alarm Summary Settings [AL_001] Desig nates the No.
DeSignates from General Settings * Display Format Stylex’l:olor] — of Lines of a
which existing —7f i = message that can
error message Display Start Line = be displayed on
will the display M. of Display Lines [12 ~ = one screen

begin

I

Mo, of Display Char, |40 \:EI\
. Designates the

maximum No. of
Characters per line

|I Flace I| Cancel || Help

B Display Start Line

Among the messages whose Monitor Bit is turned ON, the Start Line desig-
nates from which message the display starts.

%{g When the Alarm Summary display cannot fit in a single screen:

Only one Alarm Summary display can be placed on a screen. When the number of
messages to be displayed does not fit on one screen, create Alarm Summary
displays on multiple screens, so that the screens will switch to display all the
messages. To display all error messages continuously, specify each screen’s Start
Line as follows:

The first screen:........... The starting line
The second screen: ...... The number of display lines on the first screen + 1
The nth screen: ............ The number of display lines on any screen x (n-1) + 1

@ No. of Display Lines

Designates the maximum number of alarm message lines that can be dis-
played on one screen. Up to 50 lines can be displayed.

@ No. of Display Char.

Designates the maximum number of characters that can be displayed on a
line. The screen’s limit is 100 characters per line. However, the maximum
number of characters for each GP unit will vary depending the model.

B Alarm Summary [Style/Color] Attributes

The display area color when a message is cleared (Clear Color) is selected.
2.1 Parts B Selecting Colors
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B Placing an Alarm Summary Display Area

The Alarm Summary Display Area’s setting procedure is shown below.

4 N
[Gididess e Juesse | ErrorCode030 Unit 0D5
50053 Sy ErrorCode040 Unit 0D5
3 Iwaoost Summary ErrorCode041 Unit 0D6
Appear on the screenin a
100 Alarm Messages, have . .

. : Summary Display, at 10 lines
been assigned to bits M0O800 ~ by 30 characters ver displa
MO0899 in the Alarm Editor y P play.

\ J

PROCEDURE

REMARKS

(1)Select the [Parts] menu - [Alarm Display] command,
or click on the [&] icon.

(2)In the [General Settings] tab, input the Word Address,
No. of Monitor Words, and select one of the Show
Border options.
Here, since the Word Address range is from M0800 to
MO0899, enter “7” for the number of Monitor Words.

Alarm Summary Settings [AL_001]

 General Settings | Display Format | Style/Color |

|~ Enter MO800

Deszcription whord Address
[ @

Border Type=—— -

124 No Border Mo, of Monitar wWords |7 :

o |:| — \{\\

Enter 7
1= \
| T Select Border type

Place I |

Cancel ] |

Help ]

(3)In the [Display Format] tab, input the Display Start
Line, No. of Display Lines, and No. of Characters.
In the [Style/Color] tab, select the Clear(ing of Data)
Color, if desired.

Alarm Summary Settings [AL_D01]

“General Settings . Drizplay Format Stylea’CoIor]

Digplay Start Line |1

— Enter 1

=1

— Enter 10
Mo, of Display Lines [10 ~
Mo, of Digplay Char. El| \__EJ\

T Enter 30

Place ” Cancel ||

Help

SEOETTIEIK 2.1.15 Alarm Dis-

play ® Alarm Summary [Descrip-
tion] Attributes 4 Word Address
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2.1 Parts

PROCEDURE

REmMARKS

(4)After all of the Part’s attributes have been entered

and selected, click on the button.

The Alarm Summary display area’s border will appear
in the Base screen, next to your cursor.

(5)Click on the point where the Alarm Summary dis-
play area’s top left corner is to be placed.
If desired, use the Alarm Summary display handles to
alter its size. When the Alarm Summary display is scaled
up or down, the displayed character size will also change,
according to the border’s size.

To cancel placement, click on the

icon.

SEETTTEIK To change the Part
size, refer to refer to 2.4.3 Scaling

Up/Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s Attribute Settings dialog
box.

SEOTTTIK 2.4.14 Changing
Attributes

|

]
Important
Be sure to use the Alarm
Summary’s display area only
for displaying Alarm Mes-
sages, i.e. never place, over-
lap, or overlay another Part or
object in this area.
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m File Name Display ]

Data registered in the Filing Data settings is displayed.

§ / Set up the Filing Data Settings before placing the File Name
,mp;,,a,,,Display. For information on registering the Filing Data:

Tag Reference Manual, 4.2 Filing Data (Recipe) Function

B File Name Display [General Settings] Attributes

Enter adescrip- —eo _ Specify
tion if desired File Display [FD_001] H|

whether or not
General Settings | Display || Style/Calor || Switch Settings [| 5 witchT ype/Cokar | to use the LS

Diescription =lze L5

Enter the ID ] 5 Use LS Area area

numbef for the Top “Write Word Address

File Name [ el == Enter the start

Display and its —— word address

function switch ) Use Transfer Complated Bit Address of the LS area

1D Mo, PLE Transfer Completed Bit Address
Enter the File No.||  rene | | EIR__E]E
of filing data to Set up the
i PLC Transfer

bed ISplayed : || Flace I " Cancel | " Help | .
Completed Bit
Address.

@ Description
Enter a description using a maximum of 20 single-byte characters.
¢ 1D No.

The File Name Display is linked to its function switch (File Name Key).
Specify the number to identify this link is here. This number is available up
to 255.

& File No.

Enter the file number registered in the Filing Data list (1 to 2047). The
names under this number are displayed when the file is opened.

Tag Reference Manual, 4.2 Filing Data (Recipe) Function
€ By Way of LS

When Filing Data is transferred between backup SRAM and the PLC, it can
be modified on the GP screen by routing it via the LS area (the data is stored
temporarily in the LS area). If data transfer via the LS area is used, specify
the LS area’s start-word address where Filing Data will be stored from. The
address where the data can be stored is from LS0020 to LS2031, and
LS2096 to LS4095 (LS2096 to LS8191 for GP2000 series).

& PLC Transfer

This Bit is turned ON when filing data transfer to the PLC is completed.
Since this Bit does not turned OFF automatically, to use the PLC Transfer
Completed Bit again, turn it OFF beforehand.

%te; When the PLC Transfer Completed Bit Address has been entered, in the case
A where filing data cannot be transferred to the PLC, the GP’s special relay
LS2032 Bit 10 will be turned ON.
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B File Name Display [Display] Attributes

File Display [FD_001] _

| General Settings || Display I Style/Color || Switch Settings || SwilchType.fCUIDrl

1

— Enter the
number of

Mo. of Display Characters mgl names being

Specify the name —| — i

P y [T~ Direct Selection d ISplayed
selection method /D] Curgor Position Control N— Enter the
number of
Specify the characters
cursor position used for the
retention names being

[ Face |[ Cancel [ Heb displayed

Mo, of Display Lines

@ No. of Display

Specify the number of Filing Data rows displayed on the GP. A maximum of
50 rows may be specified.

@ No. of Display Characters

Specify the number of Filing Data characters used on each row. A maximum
of 100 characters may be specified.

@ Direct Selection

Select a File Name Display being placed on the GP by directly touching its
border. If [Direct Selection] is not used, select the file name using the data
scroll switches [Roll Up/Roll Down].

M File Name Display [Switch Settings] Attributes

& Cursor Position Control

Even when the screens are changed on the GP , the current screen’s cursor
position can be retained. When turning the GP’s main power switch ON or
resetting the GP, however, the cursor will appear in the first line.

%{e; The cursor position will be stored for each ID No. To retain the cursor posi-
2 tion, be sure that the File Name Display 1D Nos. will not be overlapped
through all the screens.

B File Name Display [Style/Color] Attributes

Specify a color [display color (Fg)] for characters in the Filing Data display
area, and a color [display color (Bg)] of the Filing Data display area.

2.1 Parts B Selecting Colors
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B File Name Display [Switch Settings] Attributes
Set the function switches that are placed automatically.
SEOETTREIK 2.1.3 Function Switches

File Display [FD_001] |
. i i Switch Settings i .
Switches to General Settings || Display || Stwle/Color] bt IM'_ Switches to
tranSfer Flllng Automatic Switch Placement kethod transfer data
Data between the \ iathe LS
backup SRAM ) (O send o Ls Fiom SR vi
area. These

O Sondi T SRS Fam LS

O Send T LS Fram RLE:

and the PLC switches are

valid when By
O 3end T LT Rrami LS ) Way Of LS is

Switches to scroll

names and select selected in
one [General
Settings]

|| Flace I " Cancel | " Help

€ Automatic Switch Placement Method
Automatically places the function switches for the selected names.
@ Send To PLC From SRAM

Places the switch used to transfer Filing Data from the backup SRAM to the
PLC.

& Send To SRAM From PLC

Places the switch used to transfer Filing Data from the PLC to the backup
SRAM.

€ Roll Up

Places the Roll Up key used to scroll names and select one. Touching the
Roll Up key once will roll up names by the number specified here.

& Roll Down

Places the Roll Down key used to scroll names and select one. Touching the
Roll Down key once will roll down names by the number specified here.

& Send To LS From SRAM

Places the switch used to transfer Filing Data from the backup SRAM to the
LS area.

& Send To SRAM From LS

Places the switch used to transfer Filing Data from the LS area to the backup
SRAM.

@ Send To LS From PLC

Places the switch used to transfer Filing Data from the PLC to the LS area.
@ Send To PLC From LS

Places the switch used to transfer Filing Data from the LS area to the PLC.
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B File Name Display [Switch Type/Color] Attributes
Specify colors (border colors) for the function switches which are placed

automatically.

SEOFTEEIK 2.1.3 Function Switches

B Place File Name Display

Shows how to call up the File Name Display.

e N
) Registered File No. 1's filing data is dis-
79 ~—35 0, played on the File Name Display with 3
- display lines and 10 display characters.
3 By pressing a function key (File Name Key),
filing data can be transferred from the
_:..
S_Hﬁlrj‘ﬂ EEEM SRAM to the PLC, or from the PLC to the
SRAM.
For filing data list and reg-
istering filing data, refer to Tag Reference
Manual, 4.2 Filing Data (Recipe) Function.
\ J
PROCEDURE REMARKS

(1)Select the [Parts] menu - [File Name Display] com-

mand, or click on the [&] icon.

(2)In the [General Settings] tab, enter the File No. of | SIITINTIK W File Name Dis-
filing data to be transferred and the File Name | play [General Settings] Attributes
Display’s ID No.

Here, since File No. 1’s data is transferred, enter “1” for

the file number. The File Name Display’s ID No. is “0”. | T0 transfer Filing Data via the LS

File Display [FD_001]

[x]

General Settings I Digplay || Style/Color || Swatch Settings ” SW|lcthDEfEuIUr|

=lse LS

Use LS Area
Top Wiite Word Address

=PLC Tear

Q] Use Transfer Completed Bit Address
PLC Transfer Completed Bit ddress

B =

I” Cancel I” Help |

Enter 1

area, mark the check box for [Use
LS Area] in the [Use LS Area].
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PROCEDURE REMARKS

(3)In the [Display] tab, specify the No. of Display Lines,
Display Characters, Direct Selection, and Cursor
Position Control.

If necessary, specify the display color in the [Style/Color]
tab.

File Display [FD_001] [x]

| General Settings|| Display | Style/Colar [| Switch Settings || SwitchType/Calor |

Mo of Display Lines E I Enter 3

MNo. of Display Characters l

Cursor Position Control

1— Enter 10

|| Place I” Cancel |” Help |

(4)In the [Switch Settings] tab, select the function
switches which are being placed automatically, and
specify the number of lines being rolled up or down.

File Display [FD_001] |
| General Settings || Display || Style/Color]| Switch Settings [ SwitchType/Color |
Automatic Switch Placement Method
L — Select

Send To PLC From SRaM ) [ $end Tols Ramfu these two
Send Ta SFAM From PLC Szl Toy SRER Fiam L3 Sw i tc h es
Oraus [T B O semlotsfenpls

Fdbon [ & Sand ToPLE FamlLs

|| Place I” Cancel |” Help |

(5)Specify the border colors for the function switches in
the [Switch Type/Color] tab.

(6)After setting all the attributes, click on [ pace |

The frame of the File Name Display size will be dis-
played in the drawing area.
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(7)Click the mouse button where you want to place each

attribute.

1234567300 lspa

o —pPLG

3 |PLO—>
5

RAM

(8) Select the placed File Name Display. Then, select the
[Edit] menu - [Ungroup] command, or click on the

%2 icon to ungroup the File Name Display and alter

each item’s position and size.

1234567800
2
3

To cancel the placement, click on

the [=|icon.

The File Name Displays are
grouped. To change any attribute,
first ungroup the File Name Dis-
plays, and then change the attribute.
SOOI 2.4.12 Group/
uUngroup

SEOOTHTIK 2.4.14 Changing
Attributes

If the By Way Of LS area is se-
lected, the address for the LS area
can be changed after ungrouping
the File Name Displays.
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@ Data Logging Display ]

Data created in the data logging settings can be displayed and edited on the
GP unit.

§ / - After the data logging settings, place the Data Logging Dis-
Imp;rtant p l ay.
For registering logged data, refer to Tag Reference Manual;
4.3 Logging Function

The Data Logging Display does not operate in a window.

%@ Only one Data Logging Display can be placed on each screen.

- The Logging Display cannot be set up simultaneously with the K-tag, N699
tag, Keypad Input Display or CSV Display.

- Data that could not be logged due to a read error is identified with “***” in
acell.

- Data that is not logged is not displayed.

W Data Logging Display [General Settings] Attributes

Enter acomment, [ErrrrE G Using a word
|f necessary ) General Settings |Data type T Color ]"Switch zetting ]"Switch Shape.-"[lglm’}/ addreSS,
Descrtien Block Mumber Address SpECify the
Specify whether —_|| G FlE block number
the data edit of data being
function is I7] Data Edi displayed
enabled or
disabled — Using a bit
address,
SpeCIfy Whether . Flace ” Cancel H Help ] speCIfy the
the interlock interlock
function is address
enabled or
disabled

& Block Number Address

On a block basis, specify the data being displayed. The logged data for the
block number stored at the word address specified here will be displayed.

The block numbers that can be entered are between 0 and 2047, but the
maximum of the effective range is [Number of Blocks] specified in [Trigger
Settings] in the data logging settings. If [Number of Blocks] specified in
[Trigger Settings] is 4, the block numbers are 0 to 3 (BIN values only).

%t , Ifany block number that does not exist is specified, no data will be dis-
X2 played.
- When the loop function has been designated via [Trigger Settings] of the
data logging settings, the Block Number Address will become ineffective.
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& Data Edit

The logged data can be modified by directly touching the frame of each item
in the Data Logging Display placed on the GP. If Data Edit is enabled,
touching the cell of data that can be modified in the table will cause the
buzzer to sound and allow you to enter data. If Data Edit is disabled, this
touching will be invalid and the buzzer will not sound.

. - The data that can be modified is only [Date] and [Value] that have been

logged.

- If a block or logged data is selected by changing the block humber during
on-screen modification of data, the data edit mode is canceled.

- If the cell is moved beyond the display area, using the scroll keys during the
data edit mode, the data edit mode is canceled.

@ Interlock

The interlock can only be activated when the data edit capability is enabled.
If the interlock is enabled, data can be modified only when the bit address
for the interlock is ON. If the interlock is disabled, data can always be
modified by touching it.

%te: If the bit address for the interlock is turned OFF during on-screen modifica-

tion of data, the data edit mode is canceled.

B Data Logging Display [Data Type] Attributes

Logging display[LG_001]
SeIeCt a Border ['GeneraISettingsl_ Diata type |EOI0r ]"Switch zetting ]"Switch Shape.-"[lolor]
Type of the LL— Enter the
H Border Type=— numbel’ Of
display area 5 Mo Berder
e rows for the
o H items dis-

played (0 to 40)

Specify Whether/_/D

the scrolling of
the totaling
section is en-
abled or disabled

|I Flace ” Cancel H\ Help ]

|

Enter the
number of
columns for
the items

@ Border Type

|

Enter a display interval
(the number of dots) (0 to 10)

displayed (0 to
25)

Select a border type of the display area from among three types, No Border,
outer border ff (1-dot lines), and outer border plus inner border f (the
outer border and item use 2-dot lines, while the inner border uses 1-dot

lines).
€ Row

Specify the number of rows used to display logged data on the GP. A maxi-

mum of 40 rows may be specified.
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& Column

Specify the number of columns used to display logged data on the GP. A
maximum of 25 columns may be specified.

€ Spacing

Specify spacing at which to display logged data on the GP. A maximum of
10 dots may be specified. This entry is only valid when the display area
border type is specified as No. Border. Draw the border line using the
drawing tool.

%te.' The gap equivalent to the specified display spacing is provided between the
el cell and the border line. The entire cell is filled with the clear color specified
in the Data Logging Display [Color] Attributes. However, the gap is not
displayed in the clear color, but its background is displayed. If No Border is
selected to draw an arbitrary border, ensure that the border is drawn using
the same width as the specified display interval without overlapping the cell.

<Display Spacing>

& Scroll data area

Border (the gap between the Draw the border so
border and the cell is not filled that it does not
with the clear color) overlap any cell.

Cell [:>

If the scroll data area is enabled, the totaling section is scrolled together with
the data section. If the totaling section scroll is disabled, the totaling section
always appears on the screen.

B Data Logging Display [Color] Attributes

Select a color (clear color) displayed when the border of each item is
cleared. 2.1 Parts B Selecting Colors
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B Data Logging Display [Switch Settings] Attributes

The number of rows and that of columns specified in [Data type] are dis-
played on the Data Logging Display. If any data exceeding these numbers
exists in the GP, use the function switches to scroll the data.

ST 2.1.3 Function Switches

Loagging display[LG_001]

['GeneraISettings ]"Data type T Color | Switch setting ]Wapex’[ﬁolor]_

. Select Place Switch . H— Enter the

Wl|ue = number of
Select the ——|¥pown rows/columns
function [right scrolled
switch type to #)|ett
be placed
|I Flace I | Cancel ] | Help ]

B Data Logging Display [Switch Type/Color] Attributes
Specify a color (border color) of each function switch.
2.1 Parts B Selecting Colors

GP-PRO/PB Ill for Windows \er. 6.3 Operation Manual 2-115



2.1 Parts Chapter 2 - Base Screens

B Placing the Data Logging Display
The procedure for setting the Data Logging Display is described below:

The logged data for the block number stored at the block number desig-
nated address is displayed.

WA/ Date | Time | Datal e
1st | 98/10/16 | 09:14:00 144
2nd | 98/10/16 | 09:14:00 145 EM
15 0 3rd | 98/10/16 | 09:14:01 146

4th | 98/10/16 | 09:14:01 147 R

) 5th | 98/10/16 | 09:14:01 148 |
If 3is stored at D0100. TOTAL ol |

The logged data in block No. 3
will be displayed.

PROCEDURE REMARKS

(1)Select the [Parts] menu - [Data Logging Display] com-
mand, or click on the [gg] icon.

(2)In the [General Settings] tab, specify the block num- 2.1.17 M Data
ber designated address, data edit, and whether the | Logging Display [General Set-

interlock is enabled or disabled. tings] Attributes 4 Block Number
Specify D0100 for the block number designated address. | Address

General Settings | Data Tups | Color | Switch Sefting | Switch Shape/Col
‘ ata | ype olor I IC] elng]’ WILC] 1ApE. 00!] | Enter DOlOO

Diezcription

:l Elock Mumber Address

I Data Edit
) tstenc,

Interlock Address

|. Flace ” Cancel H Help ]

(3)In the [Data Type] tab, specify the display settings.
If necessary, select a clear color in the [Color] tab.

Logging Display[L G_001] [x]
General Setlings || Data Tupe | Color || Switch Setting || Switch Shape/Color |
Border Type=——=; Row | T Enter 7
20 No Border Column =|
gt s |
gﬁ Spacing I [ Enter 4

(w0

|| Place I ” Cancel I ” Help
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2.1 Parts

PROCEDURE

REmMARKS

(4)In the [Switch Settings] tab, select the function switch
type that is to be placed automatically, and specify
the number of rows, columns scrolled.

If necessary, select a color for the special switch in the

[Switch Type/Color] tab.

Logging display[LG_001]

( General Sett\ngsr Data type | Color | Switch sstting ] Switch Shape/Colar ]_

Select Place Switch

e
] Down
Hra [T &
] Leit

| Place H Cancel H Help }

(5)After entering and selecting all the attributes, click

on the button.

The border of the Data Logging Display size will be dis-

played in the drawing area.

(6)Click on the point where the function switch is to be

placed.

To cancel the placement, click on
the [=] icon.

The Data Logging Displays are
grouped. To change any attribute,
ungroup the Data Logging Displays
by clicking on the [Zg] icon before-
hand.

SEOTTIK 2.4.12 Group/
Ungroup

If you double-click on the function
switch placed on the screen, the
address confirmation screen for
parts will appear, enabling you to
change the address.

2.4.14 Changing
Attributes
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@ Data Transfer Display ]

The Data Transfer Display allows you to manually transfer the data-transfer-
ring CSV data from the CF Card to the PLC or from the PLC to the CF
Card. This area is used to display the names of the data-transferring CSV
files on the CF Card and execute the transmission. When placed together
with the CSV Display, the CSV file selected with the Data Transfer Display
area can be viewed, edited, and printed via the data display area of the CSV
Display.

For the CSV Display, refer to 2.1.19 CSV Display.

A_ . The CSV Data Transfer function is available only on the

m GP2000 series.

Imp;ltant )
* Be sure to configure the parameters of the CSV Data Transfer
function and edit the CSV data before placing the Data Trans-
fer Display on the screen.

For the procedures for configuring the parameters of
the Data Transfer Display function and CSV data editing, refer to Tag
Reference Manual, 4.4 CSV Data Transfer Function.

ﬁi\t .* Do not place more than one Data Transfer Display on a single Base screen.
Q Otherwise, a malfunction of the switch may result.

e Up to 32 Data Transfer Displays can be set up in one Project. When 33 or
more are set up, the Data Transfer Displays will not function.

B Data Transfer Display [General Settings] Attributes

Data Trans Display [DT_001]

General Settings | Display |[ Style/Color |[Switch Settings |[SwitchType/Color |

Desciy iption E Transfer status address
Enter the | Designate a word
description as address for the
necessary. Transfer Status

Address.

” Place ||| Cancel ||| Help
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@ Transfer Status Address

To transfer data, store the following status in the Transfer Status Address.

15 12 11 02 01 00 Bit
| Reserved (0) | | |

| |_> Transferring
Error status

Ly Transfer completed

Error Error Descriotion
Code| Message P
Completed .
0 The processing is completed successfully.
successfully
1 |Reserved
The Group No. (transfer condition No.)
No transfer , . .
2 . corresponding the file No. specified for CF-to-
condition No. _ _
PLC or PLC-to-CF transfer setting does not exist.
In a CF-to-PLC data transfer in which the start
LS area address of the transfer is specified as being in
3 the LS area, a data transfer is attempted to the
range error . .
address outside the specified range of the LS
area.

No CF Card is inserted or cover of CF Card slot
4 |NoCF Card |.
is open.

CF Card Read-out from CF Card failed in a CF-to-PLC

° read error  |data transfer.

6 CF Card Data writing onto the CF Card failed in a PLC-to
write error  |CF data transfer.

- CF Card CF card isinvalid (unformatted) or media
error inserted is nota CF Card.

8 |Reserved

The timing chart below shows the relationship between the data transfer and
transfer status.
! !
ON :
i
!

Triggered bytouch

OFF

Transferring Bit ON
(Status) OFF

Transfer-completed ON

Bit (Status) OFF
Holds

Data Transfer S — Data transfer
Fails

i i
* The Transfer-completed bit address cannot be turned OFF via the GP
side. Turn Off the bit address via the PLC.
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B Data Transfer Display [Display] Attributes

Data Trans Display [DT_001]

[ General Settings|| Display | Style/Color |[ Switch Settings || SwitchT ype/Color |

No.of Display Lines B =) Specify the number of lines for

No. of Display Characters @\ dlSplaylng the data |tem (l tO 50)

'™ Specify the maximum number of
characters to be displayed in a
line.

H Place I” Cancel ||| Help

@ No. of Display Lines

Specify the maximum number of lines for displaying messages on each
screen. Up to 50 lines can be displayed on a single screen.

@ No. of Display Characters

Specify the maximum number of single-byte characters to be displayed in a
line. Up to 100 single-byte characters can be displayed per line. However,
the display varies with the model.

W Data Transfer Display [Style/Color] Attributes

Data Trans Display [DT_001]

[General Settings || Display]| Stle/Color [ Switch Settings || SwitchT ype/Color |

Border Type— Display colar

Qtosuder | Fa MW EWOICIME ook ]

gl ts MNEDNEOCNE Nk 7

=] o Select the desired border
LT ] el type for the display area.

|| Place |H Cancel ‘H Help

@ Border Type

Select from three types of borders: "No border", "Outer border"”, and "Outer
and inner borders."

& Color

Select the desired text color when data are displayed (Display Color: Fg),
the color inside the display area (Display Color: Bg), and the color for the
display area that will be used when the data are cleared (Erase Color).

2.1 Parts BmSelecting Colors
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W Data Transfer Display [Switch Settings] Attributes

Configure the settings of the function switches automatically placed on the
screen. 2.1.3 Function Switches

Switches for transferring —— ||
data between the CF Card

and PLC
9 U ' F
Switches for scrolling and Gown | E

selecting data items (Data
items can be scrolled be-
tween 1 and 100.)

ﬂ Display

H Place I” Cancel ||| Help

Displays the selected CSV
data on the CSV Display.

& CF = Device/PLC

Put a check mark in the checkbox to place a switch for transferring CSV
files from the GP's CF Card to the PLC. When transferring two or more
CSV files in one operation, select the desired files and touch the switch you
have placed on the screen. Tag Reference Manual, 4.5
CSV Data Transfer Function

& Device/PLC = CF

Put a check mark in the checkbox to place a switch for transferring CSV
files from the PLC to the GP's CF Card. When transferring two or more
CSV files in one operation, select the desired files and touch the switch you

have placed on the screen. Tag Reference Manual, 4.5
CSV Data Transfer Function

M Data Transfer Display [Switch Type/Color] Attributes

Designate the border colors and shapes of the parts here.
2.1 Parts mSelecting Colors
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B Configuring a Data Transfer Display

The procedure for configuring a Data Transfer Display is as shown below.

e A
<Data Transfer Display> [Transferred data]

Data of File No. 1
(ZR00000.CSV)

: Data 2002/1/19 9:30:00
:Group No. (1
: Group Name |Agitator No. 1
Item Name Value

150

230

300

540

18

Select the data-transferring CSV file The data are transferred to

data on the CF Card (Group Name: the PLC according to the
: data transfer conditions of
Agitator No. 1), and touch

the specified Group Name.

i Unit 1

NARAEL  Unit2

NARAZ  Unit3

AABAS  Production Start Data
nana

n@Ra

4 Production Stop Data
O TestDala

For the procedures for transferring two or more data items
and creating the data-transferring CSV data, refer to Tag Reference Manual,
4.4 CSV Data Transfer Function.

& J

PROCEDURE REMARKS

(1)Select the [Parts] menu-[Data Transfer Display] com-
mands, or click on the Ffg| icon.

(2) In the [General Settings] area, set the Transfer Sta- 2.1.18 W Data

tus Address. Transfer Display [General Set-
Enter "D0030" here. tings] Attributes @ Transfer Sta-
Data Trans Display [DT_001] tus Address
General Settings | Display || Style/Color || Switch Setlings |[ SwitchT ype/Color |
Description E Transfer status address
) EpE —EE Enter "D0030".

Place ||| Cancel ‘H Help
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2.1 Parts

PROCEDURE

REmMARKS

(3) In the [Display] area, specify the number of Display
Lines and number of Display Characters.
Specify the borders and colors in the [Style/Color] area
as necessary.

Data Trans Display [DT_001]

[General Gettings|[ Display | Style/Color [ Switch Settings |[SwitchT ype/Color |

No. of Display Characters 20 i

Enter "8".
Enter "20".

Ma. of Display Lines

H Place ||| Cancel ||| Help

(4) In the [Switch Settings] area, select the switches
(Transfer directions, Scroll, Display) you want to
place on the screen.

If necessary, specify the border color and the shape of
the part in the [Switch Tupe/Color] area.

Data Trans Display [DT_001]

General Setings |[ Display |[Style/Color]| Switch Settings | SwitchType/Color |

Automatic Switch Placement Method

Select the
types of the
function
switches to be
placed on the
screen.

|| Place |H Cancel ||| Help

(5) After all of a Part's attributes have been entered or

selected, click on the button.

A frame the size of the Transferring data display area
appears in the screen creation area.

(6) Click on the point where the Data Transfer Display
is to be placed.
Change the part size as necessary.
When the Transferring data display area is scaled up/
down, the size of the displayed text changes accordingly.

In the example, the "Border Dis-
play" is designated to ] (Outer
and Inner borders).

To cancel the placement, click on

the [=] icon.

To change a Part's
size, refer to 2.4.3 Scaling Up/

Down.

Parts are grouped. To change a
Part's attributes, ungroup the Parts
and double-click on the desired Part
on the screen.

2.4.14 Changing
Attributes

Do not overlap other Parts and
drawings with the Transferring data
display area. Be sure to use the area
as a dedicated area for displaying
the data.

When CSV Display is placed close
to the Data Transfer Display, you
can view the selected CSV file by
switch on the GP
screen. For details of the CSV Dis-
play setting,

2.1.19 CSV Dis-
play
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@ CSV Display ]

The CSV file stored on the CF Card can be displayed, edited and printed
with the CSV Display. Place the CSV Display together with the Data Trans-
fer Display or File Manager Display.

» The CSV Display feature is available only with the GP2000
| series.

fmportant . The CSV Display will not function on Windows.

%\t@ * Only one CSV Display can be set up on each Base screen.
» The CSV Display cannot be set up simultaneously with the Logging Display,
Keypad Input Display, K-tag or N699-tag.

« Do not rotate the CSV Display when placing it on the screen. Otherwise, the
pop-up keypad used for editing the CSV data may not be displayed in
proper orientation for the CSV Display.

« All CSV file data created with the GP can be displayed on the CSV Display
as listed below.

Folder Name File Name Data Type
\log ZL¥*** CSV  [Logging Data
ZT*x*x CSV | Trend Graph Data
\trend :
ZS**+** CSV  [Sampling Data
Alarm Data
ZA*x CSV | o Alarm Active/Block 1 Data
\alarm

ZH***** CSV | « Alarm History/Block 2 Data
ZG****x CSV | « Alarm Log/Block 3 Data

For details of the CF Card, refer to Tag Reference Manual,
4.7 Using the CF Card.

* When the data currently being displayed on the CSV Display is modified
(for example, when data are transferred from the PLC to the CF Card with
the CSV data transfer function), the CSV Display displays the data of the
CSV file from the beginning. The data currently being displayed on the
CSV Display also cannot be deleted with the File Manager.

For precautions about the display, refer to Tag Reference
Manual, 4.5.4 CSV Data Display Function (Combination).
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B CSV Display [General Settings] Attributes

Enter the

C5V Display [C5_001] =1
Gereral Settings | Swich Settings || SwitchTvpe/Color || Extend |
Description Color H

descriptions as
necessary.

" W CIWE W) (oo F
" M W] W

Character Size

2.1 Parts

— Select the color
and text size of the
CSV Display.

O Edit
Ol Display Colum

Enter the word
address for

designating the
Status Address.

& Color

| Status Address

" Place

I” Cancel l” Help l

When selected, the
CSV data can be
edited with touch
operations.

When selected,
Line/Row numbers
are appended for
displaying the CSV
data.

Select the colors for characters (Fg) and the background color of the display

area (Bg).

2.1 Parts mSelecting Colors

& Character Size

Specify the character size. 2.2.9 Text

& Edit

When this function is enabled, touching the desired cell of the CSV data

displayed on the CSV Display allows you to edit the data. (This function is
disabled with the initial setting.)

@ Display Column

When this function is enabled, the Line No. and Row No. will be displayed
on the lines and rows of the CSV data display area. (This function is dis-
abled with the initial setting.) The Line/Row numbers of the Column display
are shown in bold typeface. The outer border of the Line/Row for the Col-
umn display and items are divided with 2-dot lines. The borderlines and
numbers of the Column display cannot be printed.

GP-PRO/PB Il for Windows Ver. 6.3 Operation Manual

2-125



2.1 Parts Chapter 2 - Base Screens

& Status Address

When enabled, "Outputting the Edited Data™ status, "Printing™ status or the
error status of the CF card processing is set to the specified address.

15 12 11 02 01 00 Bit
Reserved (0) | | |

v

Outputting the
Edited Data

ON: While the data are
being read out to the
CF Card, triggered
by touching the
[Enter] key after the
CSV data are edited
OFF: States other than
above
* Printing and
editing of the data
are disabled while
the bit is ON. In
addition, the GP
cannot be
4 switched to
OFFLINE mode.

Printing

ON: While the printing opera-
tion is being performed
OFF: States other than above
* Printing of other data
and data editing are

v disabled while the bit is
ON.
Error status
Error Error Descriotion
Code| Message P
Completed o
0 Processing is completed successfully.
successfully
Reserved
Reserved
Reserved
No CF Card is inserted or cover of CF Card slot
4 [No CF Card |.
is open.
Read-out from CF Card failed in a CF-to-PLC
CF Card
5 data transfer or the CF Card doesn't have
read error

sufficient free space.
CF Card Data writing onto the CF Card failed in a PLC-to

¢ write error  |CF data transfer.

7 CF Card CF card is invalid (unformatted) or media
error inserted is nota CF Card

8 |Reserved
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B CSV Display [Switch Settings] Attributes

)

Switches Toneral Setings|| S#itch Gettngs | SwitchT ype/Color || Extend |

used to ScrO” Automatic Switch Placement Method

the items. o —

1 R =

E}iﬁgg?’;?e - ;E Switches used to

data items to i [ T execute print
operations.

be scrolled Haaw | e Select whether to

between 1 and print all of the

65’535) | Print - Display dlSplayEd CSv
data or only the

e [ oomd |[ ok area displayed.
@ Print

The switches are used to execute a print operation of all data of the current
CSV data or only the area displayed.

%te: » Up to 160 characters can be printed per line. Characters exceeding the limit
are not printed.

e The Column display is not printed.

B CSV Display [Switch Type/Color] Attributes

The border colors and part types can be designated here.
2.1 Parts BmSelecting Colors

B CSV Display [Extend] Attributes

When a check mark is put in the [Data Editing] checkbox on the [General
Setting] area, the Interlock setting can be enabled.

[ General Settings |[Switch Settings || SwitchType/Color || Extend |
1 fnterlock ———
(%] [=o0000 = esign ate
T T—— whether to enable
Boum Osug or disable the

interlock function.

H Place I” Cancel ‘H Help
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@ Interlock
The switch becomes effective only when the bit designated via the [Interlock
Address] is in a state that has been selected via the [Touch available condi-
tion]. Select whether the switch becomes effective in the state or OFF state

of the [Touch available condition].

Touch Available |Interlock Address| Touch Available/Not
Condition Status Available
Bit ON ON Touch avalle}ble
OFF Touch not available
Bit OFF ON Touch not a\./allable
OFF Touch available
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B Placing a CSV Display
The procedure for configuring a CSV Display is as shown below.

2.1 Parts

ZRPBERZ. CSV
ZRPRRRS. CSY
ZRAPER4. C5Y
ZRAPAR, C5Y DEL

Time o B7/09/11 B9 24

Size : 112 bvtes

<File Manager Display>

(Place the CSV Display along with the File Manger Display to display the\
specified CSV file. Similarly, the CSV Display displays the CSV file when

placed in combination with the Data Transfer Display.
For details of the File Manager Display, refer to 2.1.20 File
Manager Display.
N OTHITIK For details of the Data Transfer Display, refer to 2.1.18 Data
Transfer Display.

1 2
1{:DATE 20B2/84/18
2|:GROUP Mo, |1
3| GROUP NAME|Unit 1
4| 1TEM NAME |WALUE
5 il
b 230
1 208
8 h4p

<CSV Display>

PROCEDURE

REMARKS

(1)Select the [Parts] menu-[CSV Display] commands,
or click on the || icon.

(2) Specify the ON/OFF settings of Data Editing, Col-
umn Display, and Status Address on the [General
Settings] area.
Specify the Display Colors and Character Size if neces-

sary.
CSY Display [C5_001]
General Settings | Switch Settings || SwitchType/Color |[Extend |
Description Color
| -
= | | s | wul [juaac

* Wl DN e ]

Character Size

Tl Edit

ﬂ Display Colum
Il Status Address

&%) Jpooooo ]

|| Flace ||| Cancel ||| Help |

For the proce-

dures for sett

ing up the File Man-

ager Display, refer to 2.1.20 File
Manager Display.
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PROCEDURE

REMARKS

(3)On the [Switch Settings] area, specify the switches
(Scroll and Print switches) to be placed on the screen.
If necessary, specify the border color and part type on
the [Switch Type/Color] area.

CSV Display [C5_001]
General Settings|| Switch Settings | GwitchT ype/Color |[Extend |
Automatic Switch Placement Method
'Y
Select the b —E
types of 4——j9
function e =
switches to e F
be placed on B 1
the screen. = i
it
~—
H Place |H Cancel ‘H Help

(4) When [Edit] is enabled in the [General Settings] area,
specify the ON/OFF status of the [Interlock] func-
tion in the [Extend] area.

(5) After all of a Part's attributes have been entered or

selected, click on the button.

A frame the size of the CSV data display area and a
switch frame appears in the screen creation area.

(6) Click on the point where the CSV Display is to be
placed.
Change the part size as necessary.
When the CSV data display area is scaled up/down, the
size of the displayed text changes accordingly.

To cancel the placement, click on

the [«] icon.

ST To change a Part's
size, refer to 2.4.3 Scaling Up/

Down.

Parts are grouped. To change a
Part's attributes, ungroup the Parts
and double-click on the desired Part
on the screen.

2.4.14 Changing

Attributes

Do not overlap other Parts and
drawings with the CSV data display
area. Be sure to use the area as a
dedicated area for displaying the
data.
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@ File Manager Display

Important ¢

%te:
N\

The File Manager Display displays a list of the folder/file structure on the
CF Card. Touching the Display switch displays or hides the File Manger
Display in the pop-up window.

Tag Reference Manual, 4.6 File Manager Display Func-
tion

When placed together with the CSV Display, the CSV file selected via the
File Manager display area can be viewed, edited and printed via the data
display area of the CSV Display.

For details of the CSV Display, refer to 2.1.19 CSV Dis-
play.

The File Manager Display feature is available only with the
GP2000 series.

« Only one File Manager Display can be placed on each Base screen. Even
when two or more Display keys of the File Manager Display are set up/
touched, the operation is interlocked with the single File Manager Display.

e The settings of the File Manager Display (shape of the display area except
for the switch, borderlines and colors, etc.) cannot be edited with the Screen
Creation Editor.

» The File Manager Display is displayed as a local window. If two local
windows are already displayed on the screen, the File Manger Display will
not appear even if the Display key of the File Manager Display is touched.
In this case, the File Manager Display will not wait for input.

* When the File Manager Display and other windows overlap, touch the
desired window to bring it to the front.

* When placing a U-tag on the same screen with the File Manager Display, do
not specify [High Speed] in the U-tag's [Designated Window].

* When the Index Text Tables are switched, the File Manager Display is
closed. To display (activate) the File Manager Display, touch the switch
again.

B File Manager Display [General Settings] Attributes

File Manager Display [FM_001]

General Settings ] Switch Setting ]

Description

Enter a description | DlinckudeDokete Button Put a check mark
if necessary. I Use Status Address to automatically

/ B EE place a switch
that deletes the

Designate a word — selected CSV file.

address for the
Status Address. [ Place [ Camcel ][ Heb
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@ Delete button
Deletes unwanted CSV files selected via the File Manager display area.

%@ » The Delete button does not delete read-only CSV files.

 After deleting the unwanted file(s), the File Manager display area displays
the CSV files in a list starting with the file with the oldest file No.

* When used together with the CSV Display, the CSV file currently being
displayed on the CSV Display cannot be deleted.

& Status Address
Stores the status of the CF Card error code.

15 12 0 Bit
| Reserved (0)
L» Error status

Error Error Description

Code| Message P
Completed o

0 Processing is completed successfully.

successfully
Reserved
Reserved
Reserved

No CF Card is inserted or cover of CF Card slot
4 |NoCF Card |.
is open.

CF Card Read-out from CF Card failed in a CF-to-PLC

5
read error  |data transfer.

6 |Reserved

. CF Card CF card is invalid (unformatted) or media
error inserted is nota CF Card
CF Card

8 Deletion of files on CF Card failed.

delete error

B File Manager Display [Switch Setting] Attributes

Put a check mark Pl laces Display Soilch
to automatically
place the Display

Border Color

ENE D EEOON R 5] W Specify the color
and the switch type

key. only when the
[ erowser_| [Place Display
Switch] option is
enabled.

|| Place |H Cancel ‘H Help
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B Placing a File Manager Display

The procedure for configuring a File Manager Display is as shown below.

s N
< The File Manager Display displays the
file information on the CF Card in list
. SOIRS ﬁ form. Touching the function switch (File
/R — Manager DISP) displays the File Man-
CRAAART. G5V ~Z ger Display in a pop-up window.
%E% ggE DISP Use the| = |and | <Z | keys to scroll the
LRABAR, CSY — list up and down.
DEL

ZRuias. G5V Use the |DisF| (Display) key to select the
Time = B7/@9711 B9:24 desired file name.*
Size © 112 bvtes

Use the |CEL| (Delete) key to delete the
specified file.

*When CSV Display is placed together with the File Manager Display,

touching the [oisP| key on the File Manager Display after selecting the

desired CSV file allows you to view, edit, and print the CSV data via the
CSV Display.

PROCEDURE REMARKS

(1)Select the [Parts] menu-[CSV Display] commands,
or click on the [Z] icon.

(2) Specify the ON/OFF settings of the Delete button
and the Status Address on the [General Settings] area.
In this example, the Delete button is not placed and Sta-
tus Address is set to OFF.

General Settings 1 Switch Samng}

Description

-
[ ﬂ Include Delete Button

ﬂ Use Status Address

[f%] jpooooo Bl

|| Place ||| Cancel ||| Help
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PROCEDURE

REMARKS

(3)Specify the presence/absence of the Display switch
in the [Switch Settings] area.
If necessary, specify the part color/type as well. Here,
set the Display Switch to “Present”.

File Maneger Display [FM_D01]

General Settings| Switch Setting l

E] Place Display Switch
Border Colar

] |

|. Flace || Carcel H Help ]

(4) After all of a part's attributes have been entered or

selected, click on the button.

A frame the size of the File Manager display area and a
switch frame appears on the screen creation area.

(5) Click on the point where the File Manager Display
is to be placed.

Designate the point at which the
File Manager Display is to be
placed in 40-dot increments for the
X coordinate, and 20-dot incre-
ments for the Y coordinate. If the
designation of the placement posi-
tion differs from the above units,
the position of the File Manager
Display on the GP may become
misaligned.

The File Manager Display cannot
be scaled up or down.

Parts are grouped. To change a
Part's attributes, ungroup the Parts
and double-click on the desired part
on the screen.

2.4.14 Changing
Attributes

For the operation
of the File Manager Display on the

GP, refer to Tag Reference
Manual, 4.6 File Manager Dis-
play Function.
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@ Numeric Displays ]

This Part displays the device Word Address numeric data as an absolute
value.

B Numeric Display [General Settings] Attributes

Enter CO mm ent Humeric Display Settings [ND_001]

 Gieneral Settings | Display Famat | Shape/Color | Alam Settings |
data here \ Description Word Address T Enter the Word
Sicol ) ~F | (%] oo ﬂ@/ Address where
isplay’s the ~_ the display

currently se- datais stored
lected Part’s

image

Browser...

—

Calls up the Part
Shape Browser

|. Place I | Cancel } | Help

€ Word Address
Here, input the Word Address where the display data is to be stored.

B Numeric Display [Display Format] Attributes

Mumesic Display Settings [ND_001] Enter th e total num ber
General Seftings || Display Format | Shape/Color |[Alarm Settings | // Of d | g itS used (n ot
Select the —{ rossom rore - Wﬁl/ including the decimal
Data Format Di{ede 2 S point) in the display
and Data 16 Bit a2 Bit Decimal Places IU—\:E'T”\\

%) Decimal £ Decimal | Character Size
Length ChHes O Hes
{JBCD £PBCD
2 Octal

| Enter the number of

digits to be displayed
after the decimal point

Specify the—H{ o0

P y £33 Shift Flight ] Zero Suppress Preview

DISp'ay L sittet [ Zero Display Select the size used for
Sty le Il 7 Seament Display ,

. the label’s characters

|| Flace I” Cancel ||| Help ‘

Supported by the GP2000 Series only

@ Data Display Format

Here, the Data Display Format, Code, and data length are selected. Choose
a data format of either Decimal (base 10), BCD, Hexadecimal (base 16), or
Octal (base 8). With the Code +/- check box || checked, when you select
“Decimal”, negative numeric data can also be displayed.

@ No. of Display Digits

Here, enter the total number of digits used (not including the decimal point)
in the display.

%\te:When the No. of Display Digits is set to 5 and the Decimal Places is set to 2, a
value appears on the Numeric Display as shown below.
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@ Decimal Places
Here, enter the number of digits to be displayed after the decimal point

The types of numeric data that can be used with each data format are listed
below.

Data Form Code Data Length No. of-D-|spIay Decimal Alarm Range
Digits Places
16 bit 15 04 o | 06553
+/- -32768-32767
Dec +- + only 0-4294967295
32 it 1-10 0-9 4 -2147483648-
) 2147483647
BCD + 16 b!t 1-4 0-3 0-9999
32 hit 1-8 0-7 0-99999999
16 bit 1-4 0-FFFF
Hex + :
32 bit 1-8 0-FFFFFFFF
Oct + 16 hitonly 1-6 0-177777

The relationship between upper and lower position Word Addresses when
32 bit data is used will differ depending on each Device/PLC Type.

Device/PLC Connection Manual
@ Character Size

The label’s Character Size is selected here.

2.2.9 Text

%te; Only when the GP type is the GP-77R , GP-377, or GP2000 series, is the 8 x
16 setting valid. For any GP other than the GP-77R , GP-377 or GP2000
series, selecting 8 x 16 in the editor will display 16 x 16 on the GP.

@ Display Style
« Shift Left

* Shift Right

Select the display style from the Shift Left and Shift Right. The data will
appear, starting from the side designated here. The Shift Right is selected by
default.

* Zero Suppress

Select this option to omit the leading zeros of display data. E.g. When the
Display Length is 4 and the Zero Suppress is NOT selected, 25 appears as
0025.

 Zero Display
When this option is clicked, and the device data is 0, the value 0 will not
display.

7 Segment Display

When this option is selected, numerical values are shown on a 7-segment
display. Only GP2000 Series units support the 7-segment Display. 7-seg-
ment display is possible only when the Character Size is “16X16”.
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B Numeric Display [Shape/Color] Attributes

Here, the Numeric Display area’s border color, value display color (Number
color), and interior color (Plate color) are selected.

2.1 Parts M Selecting Colors

B Numeric Display [Alarm Settings] Attributes

If desired, specify a variety of Alarm settings.
2.1 Parts B Alarm Settings

B Placing a Numeric Display

The procedure for placing a Numeric Display is shown below.

designated Numeric Display.

w el e

00100
0101 HE >
When 32 bit data 65539 is

stored in addresses D0100
and D0101,...

p
Data stored in the specified Word Address is displayed in the

The maximum number of
digits is 10, with 2 decimal
places.

J

PROCEDURE

REMARKS

(1)Select the [Parts] menu - [Numeric Display] com-
mand, or click on the [& icon.

(2)In the [General Settings] tab, input the Word Ad-
dress used to store the display data.

Mumeric Display Settings [MD_001]

General Settings ‘ Display Format T Shape/Colar r Alarm Seltlngs]
Description Word Address

| | [E]oooion FEE

'™ Enter D00100
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PROCEDURE

REMARKS

(3)Select a Part Shape from the Browser.
If desired, set an Alarm and Colors from the [Alarm Set-
tings] and [Shape/Color] area.

(4)In the [Display Format] area, specify the Data Dis-
play Format, and input the No. of Display Digits and
the Decimal Places.

Specify the Character Size, if desired.

Mumeric Display Settings [ND_001]
General Settings || Display Format | Shape/Color |[Alam Settings |
__—Enter5

=Data Display Fi i . =
I Codo +r Mo, of Display Digits 5 i
16 Bit 32 Bit Decimal Places 2 [= I Enter 2
2 Decimal {53 Declmi Character Size
DoHer  QHew BB o]
{3 BCD i BCD —_— .
900 Select 32 bit

Decimal

=Dizplay Skyl
Presvies

%) Shift Right M Zem Supprass
£ Shitt Left %] Zera Display oaase

| 7 Segment Display

“ Place ||| Cancel ||| Help ‘

(5)After all of the Part’s attributes have been entered

and selected, click on the button.

The Numeric Display’s outline will appear on the Base
screen, next to your cursor.

(6)Click on the point where the Numeric Display’s top
left corner is to be placed.
If necessary, use the Numeric Display’s handles to alter
its size after placement.
Regardless of whether the numeric data display area is
scaled up or down, the character size will not change.
To change the character size and position, select the char-
acters inside the border directly.

2.1 Parts ® Se-
lecting a Part Shape

Only the GP2000 Series supports
the 7 Segment Display.

When a GP type other than the
GP2000 Series is selected and the
"7 Segment Display" option is en-
abled, the following alarm appears.

& “The GP e you selected  nat sugpating the function. It cauld notbe avalatle v f ou selected the urcton”

To clear the alarm, disable the "7
Segment Display™ option.

To cancel the placement, click on

the [=] icon.

ST To change a Part’s
size, refer to 2.4.3 Scaling Up/

Down

Pressing the key while re-siz-
ing an area’s border will also re-size
that area’s characters.

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

SEOTEIEK 2.4.14 Changing
Attributes
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@ Message Display

This display is used to show single-line alarm messages in response to
changes in the device Word Address data. Select the message from Direct
Text or Index Text.

' The Index Text feature is available with the GP377/GP77R/
" GP2000 series.

Important

B Message Display [General Settings] Attributes

Enter Comment
data here

The currently
selected Part
Shape is dis-
played here

Calls up the Part —

Shape Browser;
Part Shapes can
be selected

directly from the

Meszzage Display Settings [Mw_001]

General Settings wmages]

Drescription Address

] | oo T
Border Color

T e
\\\

Character Size

x| — Select the

Word or Bit
Address to be
monitored

IT——Select a Border

color

—— Select the type
of alignment
desired for the
text of the
Display

elect the

Browser

Centers the Index Text
within a box/border

€ Address

/ H Place IH Canc&l ||| Help |
/

Select a
Character Size

Operation
Mode

Enter an Address to be monitored. Select either Bit Address or Word Ad-

dress according
@ Border Color

to (operation) Mode.

The Message Display’s Border color can be selected.

SOOI 2.1 Parts W Selecting Colors
€ Center Arrangement

When this feature is enabled, the Index text's text block is centered within a
box/border. This feature is only available for Index text.

SOOI 4.6.3 B Selecting the index character string

€ Alignment

Here, the text’s alignment can be selected.

Center

€ Mode

There are two methods to change messages displayed on the Message
Display, i.e. via Bit’s turning ON/OFF and Word state changes. Here, select

either mode.

Mode: When selecting Bit
Messages will change according to the specified Bit Address’s ON/
OFF changes.
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Mode: When selecting Word

Chapter 2 - Base Screens

Messages will change according to the state changes of the desig-
nated bits, consecutively from the specified Address’s 00 bit.
According to the number of the messages (either 2, 4, 8, or 16), a
bit is automatically assigned from the specified Address’s 00 bit.

Numbers of Number of
Messages Bits Used
2 1
4 2
8 3
16 4

When the value set in
the No. of Messages is
16, bits 00 ~ 03 are

used.

N\~

03 02 01 00

The remaining bits can be
used for other purposes

N

When the value set in the No. of
Messages is 8, bits 00 ~ 02 are

used

When the value set in the
No. of Messages area is 4,
bits 00 and 01 are used

When the value set in the
No. of Messages area is 2,
only bit 00 is used
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B Message Display [Messages] Attributes
(Operation Mode example: When using Word Address)

Select the text type for Enter the message’s
the message entry. text here

Deletes the
currently selected
message, and

Enter the number Messzage Display Settings [MWw_001] 2 SpeCIfleS the '
of messages Gérers Settings | M2 agesl message (and its
(states) here ‘:j{i[’oi;e“ - color) as unde-
Me.ssages Ch;agtem | Delete ] fl n ed .
Enter the maxi- CE pE | [ _
mum number of — Message =Shyle [ Copy fiom Description ||| Copyto &1 k—/COpIeS all the
characters only EnaE ?ﬂ:?‘f characters in
when "Direct 3 Raied . :\;16 Selectf(_edId
" il essage fie
Text" is selected. rorcon EEEOEEOEE L © pesoage
Plate Colar !.DQD!E_NDB‘k (G
The state indica- ' only when
tion buttons appear "Direct Text" is
according to IEE / [P ] Coed JI e | selected.
7 E _
No. of Messages Select the Select the message’s Copies the char-
Character Type (display) Color acters in the

Description field
to the Selected
Message field
only when "Direct
Text" is selected.

@ Direct

The text entered in the Selected Message field is placed directly as fixed
character strings.

The message is displayed in a single line. Up to 16 types of messages can be
displayed in each Message Display.

@ Index
Select or add the Index Text. Two or more lines of messages can be dis-
played.
4.6.3 MSelecting the index character string 4 Entering
the index character string

@ No. of Messages

The number of the messages (number of states) can be selected from 2, 4, 8,
and 16.

@ Display Characters

Here, the maximum number of characters displayed in a message is selected.
Up to 40 characters can be input. If the number of a message characters
exceeds the specified value, characters that do not fit in the area will be
truncated.
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€ Message
According to the No. of Messages, designate a message for each state.

Operation Mode: Bit

Designate a message for each state (ON and OFF).

Operation Mode: Word [a][1]2]#]

As many buttons as the number of the specified messages will be displayed.
Designate a message for each state.

@ Selected Message

Enter the message in this field with the "Direct” option selected. After
entering a message, the message will be displayed in the selected color(s).
The default value setting is “Undefined”.

To select the "Index" option, refer to 4.6.3 MSelecting the
index character string 9 Entering the index character string.

& Color

Here, each message’s display colors can be selected.
Default settings are = Char. color - White; Plate (background) color - Blue.
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MPlacing a Message Display

The Message Display setting procedure is shown below. (When using a Word
Address in "Direct Text" mode)

2.1 Parts

Vs

Message No. 0 (When the Word Address is "00"):

None

Message No. 1 (When the Word Address is "01"):

Signal A Operation

Message No. 2 (When the Word Address is "10"):

Signal B Operation

Message No. 3 (When the Word Address is "11"):

Signal A & B Operation

A message from those listed above, allocated
to the specified Word Address...
N

...displays in response to
changes in the Word
Address data.

PROCEDURE

REMARKS

(1)Select the [Parts] menu - [Message Display] command,

or click on the [& icon.

(2) In the [General Settings] tab, input a Word Address.
Select the message’s Border Color, Text Alignment and

Character Size, if desired.

[General Setfings | Messages |

= Enter M0064

Description Addhess

] ] ] Jrroces FEd

Eorder Color

) ek
E L Bt fumnapmenk Mode——
Aligrment: ’Vg Bt

ChescterSize
<t F]

[ Place ||[ Cancel ||| Heb

(3)Select a Part Shape from the Browser.

Shape Browser

Current PDE File Jc.\prugram files\prophdwin\pdihopd-3d01 ‘

[x]
T

Parts File.

Title - [MD_30001 EH

Heln }

If the message is displayed on more
than one line with the Index character
strings, the characters are always
aligned to the center.

2.1 Parts W Select-
ing a Part Shape
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PROCEDURE REMARKS

(4)Enter the number of Messages and number of Dis- If selecting the "In-
play Characters with the "'Direct Text" option selected | jex Text" option, refer to 4.6.3

in the [Message] area. W Selecting the index character
 —— “"f“““ ' string ¥ Entering the index char-
[General Settings || Messages i
e o -— Enter 16 acter string.

Display
Characters

efine
T,&w fram Description ] Copy to &ll 1

Eﬁu;ﬁ 3 Normal
= 4 Bold -
£ Raised Color Enter 4
Test Color IO || ek
Plate Color NI O O 0] B L

“ Place Hl Cancel H‘ Help

(5)Enter your Alarm Messages. Any characters entered that are over
Select the message number to be registered and enter the | the limit specified in step (4) will be
message. When displaying a border with no message, be | cut from the GP’s display.
sure to delete the words “Undefined”. Select Colors and
Character Size, if necessary.

(Example) When registering the message “A Unit Operat-
ing” as message Number 1:

If the text “Undefined” is not deleted,
itwill be registered and then displayed
as a message.

! Message Display Settings [MW_001]
(GoneralSotinge]| Meveaces | Enter A Unit Oper-
8 Direct 120 Index atl n g

Ho. of Display
Messages Characters

| Copy from Description ||| Copyte &l |

Message

Calar

Test Color 1IN || DO I3 Bk I T Select 1
Plate Color [ 1 O I )] e I

| Place || Tancel ||| Heb

(6) After all of the Part’s attributes have been entered and

selected, click on the button.

The Message Display’soutlinewill appear onthe Base screen,
next to your cursor.
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PROCEDURE REMARKS
(7)Click on the point where the Message Display’s top | To cancel the placement, click on the
left corner is to be placed on the Base Screen. icon.
If necessary, use the Message Display’s handles to alter its i
size after placement. AR To change the Part’s

The message, corresponding to the message number desig- | Size, refer to 2.4.3 Scaling Up/
nated in the Dialog box, is displayed on the Message Dis- | Down
play.
Regardless of whether the Message Display is scaledupor | \nhen the Message Display is scaled
down, the character size will not change. To change the | yp(larger), the message characters
character size and position, directly selecta character inside | may not be displayed in the correct
the text box. position. In that case, use the pull
: : down menu [Edit] menu’s [Align...]
command to adjust the position.

2.4.9 Align

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s Attribute Settings dialog
box. Also, clicking on the message
numbers allows you to view the
message’s display status.

2.4.14 Changing
Attributes

% - Changing the state via the Parts State Change Tool Bar after placing a
ole; Part allows you to check each state’s Library display condition.

- Every time a part’s screen is opened, the Part’s state will be reset to 0.

- If a state which has not been defined is designated, the Message Display
may show nothing. For example, when the number of messages is 16 and
only states 0 to 3 actually have a message registered, designating states
4 to 15 displays only message frames.
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@ Date Displays ]

Date display data is created using the GP’s internal calendar and formatted as;
February 11th, 2001, or 01/02/11; however, the date format can be changed.

B Date Display [General Settings] Attributes

Enter Comment Date Dispaly Settings [DD_001]
data here GeneralSelt\ngs] — SeleCt the Data
. : Format
1l Description Character Size
The currently se- ] |18 Fl[wnmad —T+] The time is
!ecped Part’s image I e Dy T (o o a7
is displayed here .
| NEEEEETTIN ] Wl G segment dis-
Calls up the Part oo | | ™S NEBONBOONE R F play.
Shape Browser. / Plae Coor W] IME ogi o Supported by
Parts can be se- the GP2000
lected directly from =l T = Series only.
the Browser -
Select the

Border (frame),
Text and Plate
(background)
colors

# Data Format
The following display formats are available:

yy/mm/dd
dd/mm/yy
mm/ddlyy
20yy/mm/dd™
dd/mm/20yy™
mm/dd/20yy™

(yy: year, mm: month, dd: day)

& Color

The Date Display’s border color, character display color (Text), and interior color
(Plate) can be selected here.
2.1 Parts n Selecting Colors

& Character Size

The label’s Character Size is selected here.
2.2.9 Text

€ 7 Segment Display

When this option is selected, numerical values are shown on a 7-segment display.
Only the GP2000 Series supports the 7 Segment Display.

*1 The characters used for the display of 2000’s first two characters (*“20”) are single-
byte characters.
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B Placing a Date Display

The Date Display placement procedure is shown below.

Used to display the date.

PROCEDURE REMARKS

(1)Select the [Parts] menu - [Date Display] command, or
click on the [tz icon.

(2) In the [General Settings] area, select a display format. Only the GP2000 Series supports the
7 Segment Display.

e — — Selecttheyy/mm/ | When a GP type other than the
SE—— dd format GP2000 Series is selected and the "7
) e Segment Display" option is enabled,
[Fom | =0 EEECEBOCNE s ] the following alarm appears.
Pite Coior ]I B WF Jricer 7]
|

[ Place ||| Cancel H\ Help |

To clear the alarm, disable the "7 Seg-
ment Display" option.

(3)Select a Part Shape from the Browser. 2.1 Parts M Select-
If desired, select Colors and Character Size. ing a Part Shape

Cument PDE File: [Eiprogram lestpropbdwinlpabiop4-3d01

Tite:[DD_30001 E”| Help ‘

(4)After all of the Part’s attributes have been entered and
selected, click on the [Place] button.
The Date Display’s outline will appear in the Base screen,
next to your cursor.
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PROCEDURE REMARKS

(5)Click on the point where the Date Display’s top left | To cancel the placement, click on the
corner is to be placed. icon.
If desired, use the Date Display’s handles to alter its size. - To ch Part’
Regardless of whether the Date Display is scaled up or down, 0c ang<|a_a aL; i
the character size will not change. To change the character size, refer to 2.4.3 Scaling Up
size and position, directly select the characters inside the Down
border.

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes

w7/ o, cld

When scaling up or down the display
area, if the Ctrl pressed at the
same time, the characterswill scale in
unison with the border.
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@ Time Displays ]

Time Display areas can be created, based on the GP’s internal calendar function.
Time will be expressed in 24 hour format.

(E.g.) 2:25pm > 14:25

Only one Time Display Part can be used per screen.

ETime Display [General Settings] Attributes

Time Settings [TD_001] /Select the
Enter Comment [General Sotings | Character Size
data hel’e Drescription [Charactersize ]/Esecmds Display

N | (<16l . — Supported by
The currently L oot the GP2000
selected item’s g oo EERCEECCEE:c -
image appears : Tet Cobr | EECAEOC B Ne: F Series only

Plate Color I 03 hd . -

here LNl N /YT The time is also

/M shown in sec-
Calls up the Part —| onds.
Shape Browser. : .

| Flace Cancel Hel

Part Shapes can be | 1 [ Heb | The time is

shown on a 7-
Select Border, Character, segment display.
and Plate colors

selected directly
from the Browser

@ Color
Here, the Time Display’s Border color, character display color (Text), and
background color (Plate) can each be selected.

2.1 Parts  Selecting Colors

& Character Size
The label’s Character Size is selected here.

2.2.9 Text

@ Seconds Display
The time is also shown in seconds. This feature is only available with the GP2000
Series.

Example: Todisplay "nine twenty-fiveand tenseconds™: ~ 09:25:10

€ 7 Segment Display
When this option is selected, numerical values are shown on a 7-segment display.
Only the GP2000 Series supports the 7 Segment Display.

%fe.' When a GP type other than the GP2000 Series is selected and the “Sec-
onds Display” and "7 Segment Display’* options are enabled, the follow-
ing alarm appears.

To clear the alarm, disable the “Seconds Display” and "7 Segment
Display** options.
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B Placing a Time Display

Chapter 2 - Base Screens

The Time Display is placed using the following procedure.

Display thetime.

PROCEDURE

REMARKS

(1)Select the [Parts] menu - [Time Display] command, or
click on the [E] icon.

(2)Select a Part Shape from the Browser.
If desired, select Colors and Character Size.

Current POB File :[e\progran flesipropbwinipabiopd-3d01
Title:[T0_30001 E]H Help |

(3)After all of the Part’s attributes have been entered and

selected, click on the button.

The Time Display Part’s outline will appear on the Base
screen, next to your cursor.

(4)Click on the point where the Time Display’s top left
corner is to be placed.
Change the size if necessary.
Regardless of whether the Time Display is scaled up or down,
the character size will not change. To change the character
size and position, select the characters directly.

HH: HH

2.1 Parts W Select-
ing a Part Shape

To cancel the placement, click on the

icon.

To change a Part’s
size, refer to 2.4.3 Scaling Up/
Down

When scaling up or down the display
area, if the Ctrl pressed simul-
taneously, the characters are also
scaled up or down together with the
border.

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes
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@ Picture Displays ]

Registered Library items are displayed according to device Word Address

changes. Parts and Tags, however, cannot be displayed in these displays. Up to

16 different kinds of Library items can be displayed on a single Picture Display.
2.5 Libraries

The Picture Displays will not be displayed on the GP when trans-

ferred, if the GP has not been connected to the PLC yet.

£ L AN
Important

W Picture Display [Description] Attributes.

Picture Display Settings [LB_001] : Enter the
Enter Comment ) General Settings Librarylmage] AddreSS to be
data here monitored
\\ Description Address h ere
\J | [E]unnun =

The currently

selected Part | Mode——
State’s image ) Bt Selects the
appears here £ word Operation

Mode
[Pace ][ cocel [[ beb ]
€ Address
Here, either a Bit or Word Address is entered, after first selecting a Type (either
Bit or Word).
€ Mode

There are two methods used to switch the Library images displayed on the
Picture Display; one is Bit access and the other is Word access. Select either of
these.

Mode: When selecting Bit
Messages will change according to the specified Bit Address’s ON/
OFF changes.
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Mode: When selecting Word
Messages will change according to the state changes of the designated
bits, consecutively from the specified Address’s 00 bit. According to
the number of the messages (either 2, 4, 8, or 16), a bit is automatically
assigned from the specified Address’s 00 bit.

Numbers of Number of
Messages Bits Used
2 1
4 2
8 3
16 4

When the value set in
the No. of Messages is

16, bits 00 ~ 03 are M

used.
03 02 01 00

The remaining bits can be
used for other purposes

N

Messages
used

When the value set in the
No. of Messages area s 4,
bits 00 and 01 are used

When the value set in the
No. of Messages areais 2,
only bit 00 is used

When the value set in the No. of

is 8, bits 00 ~ 02 are

B Picture Display [Library Image] Attributes

Displays the —__

currently
selected
Library image

Reflects the
currently
selected item’s
designated
state

¥ Browser

Picture Digplay Settings [LE_001]

Calls up the
Library Browser.
Library items can

| Settings  Library Image ]

Library

Ergze Color

Delits:

be selected
directly from here

Deletes the
currently selected

oo I/ W] &
Pattern D

Fo I I &k )

kI

Library item

|

—Selects the item’s

background and

|I Flace || Cancel || Help |

foreground colors

(used for clearing)

When clicking on the button, the Library Browser (Library list) will
appear. Selectadesired Library from this list and drag it to the inside of the

Library image display border on the Dialog box.

W Reference .4

2.5 Libraries
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@ Delete
The selected Library item is deleted and the display will disappear.
@ No. of Lib.

Displays only when Type’s Word is selected. The number of Library images
(number of states) to be displayed on the Picture Display can then be input.
Select any of 2, 4, 8, or 16.

@ Library

Here, the Library item used for each state is specified. Settings will differ de-
pending on the Type selection.

Mode: When selecting Bit
Specify a Library item’s ON and OFF states, respectively.

Mode: When selecting Word
The n.umber of buttons will match the designated number of Library
items. Specify a Library item for each state.

%te: Changing the state via the Parts State Change Tool Bar after placing a Part
allows you to check each state’s Library display condition.

& Color

The background square colors (Clear Fg, Clear Bg)) and pattern (Pattern) are
selected. The default settings are black. The square colors can be selected so as
to match the Picture Display placement area background’s color.

<Back Ground Square>

The Library item to be displayed while the GP is running needs the filled square
for the background to be the rearmost, so that the items(images) do not overlay
each other when they are switched. When designating a Library item, the GP-
PRO/PBIII for Windows program will draw this colored square automatically.
Right after the Library item(s) is/are placed, the background square will match the
size of the largest Library item designated. After the items are placed, it can be
scaled larger or smaller, independently from the Library items.

For a state with no designated Library item, only a background square will be
displayed and it will become the Library’s deletion screen, i.e. it will be overlaid
on top of an existing item to “delete” that item.
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B Placing a Picture Display

The Picture Display’s creation procedure is shown below.

State O State 1 State 2 State 3
(When the Word (When the Word (When the Word (When the Word
Address is "00") Address is "01") Address is "10") Address is "11")

The 3 pictures registered as libraries, as illustrated above, will change
L in response to changes in the state of Word Address D00250.

PROCEDURE REMARKS

(1)Select the [Parts] menu - [Picture Display] command,
or click on the [ icon.

(2)In the [General Settings] area, enter an Address and
select a Mode.

Picture Display Settings [LB_001]

| General Settings m} Enter D00250
L

Dezcription Addiess
D00250 7

I~ Select Word

| Place ” Cancel H Help ]

(3)In the [Library Image] area, input the No. of library
items (No. of Lib.) used.

Picture Display Settings [L\W_002]

r General Setings | Library Image ]

Mo of Lib

Library

Erase Color:

o [N 0 ) ) ) Bk I

oo [l
Pattern I:I 4

" Place H Cancel || Help ]

)] ek ]
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2.1 Parts

REmMARKS

PROCEDURE
(4)Select a state (to register an item as), and then click
on the button.
Here, perform settings for state 0.
Picture Display Settings [L'_002]
[M. Library Image ]
Mo, of Lib :
Libram

Erase Color

5 Il III

Fo 1N I I ) ] ) B'kg

\ | Flace I| Cancel H Help ]

Select 0

(5)Select a Library to be displayed for state 0 from the

Browser.

Flle Edit “iew Window Help

L= [*[=[E

(6)Drag the selected item to the Dialog box’s black item
display area.
Select foreground or background Colors, if desired.

Picture Display Settings [L'w_002]

Genersl Settings| Library Image |

No. of Lib. N

Library

Erase Color

2.5 Libraries

To select a Library from a file dif-
ferent from the currently displayed
one, click onthe Library Browser’s

icon.

2.5 Libraries
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PROCEDURE

REMARKS

Picture Display Settings [L\W_002]
General Settings

Mo of Lib

Library

Library Image I

Erase Color

Fo I ) L) 1] &k [
& NN & D
Pattem D N

[Fece [ cacel ][ Hap ]

(7)For States [7]and [[z], repeat steps (4) ~ (7). Since
State[z|is used to delete Library item from the screen,

nothing is specified for it.

(8)After all of the item’s attributes have been entered

and selected, click on the button.

The Picture Display’s outline will appear on the Base
screen, next to your cursor.

(9)Click on the point where the Picture Display’s top
left corner is to be placed.
Here, the Picture Display’s border (dotted line or filled
square) and the Library item will appear. At this time,
the Library item corresponding to the state currently se-
lected in the Dialog box is displayed on the Picture Dis-
play.
Regardless of whether the Picture Display’s border is
scaled up or down, the Library item’s size will not
change. The border size is common through all the Li-
braries. The Library item’s size and position can be al-
tered by clicking directly on its inside border.

To delete a Library item, click on

the button.

To cancel the placement, click on

the [«] icon.

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings. Also,
switching the states allows you to
view the Library display status.

2.4.14 Changing
Attributes

Changing the state via the Parts
State Change Tool Bar after plac-
ing a Part allows you to check each
state’s Library display condition.

%te.' - Every time the screen is opened, the state will be reset to 0.

- If a state with no Library registered is designated, nothing will be displayed
on the Picture Display. For example, when the number of messages is 16
and only states 0 to 3 actually have a message registered, designating states
4 to 15 displays only background square frames.
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m Window Parts ]

Calls up the window onto the Base Screen (B). Register the windows to the
Window Registration via the Window Screen (U). This operation is easier
than using the U-tag.

B \Window Parts Attributes

Enter comment Window Part Setting [w1_002]

data here. —_———
General Settings ]

This displays Specify the

Degcription L .
the Window \: Window Control Address Window Control
Address.

Number of the

\r,\gg'i?;/\rled on BitD OM/OFF

I window Mumber Bit! Display Order .

the Window // \Ij’v:ﬁ\éf\\l/vv ;rSuSaOCi_
Screen (U). 1 2600200

ated with the
selected Win-
dow Number in
this area.

Select the Win-
dow Number you
want to call up
onto the Base
Screen (B). [ Pace || cancel |[  Hep |

€ Window Control Address

Enter the address to control the Hide/Show status of the windows.

15 02 01 00 Bits

v Show[0]: Hide the window
Changing the order of window layer [1]: Show the window

[0]: Touching the window will
change the order of the layer.

[1]: Touching the window will NOT
change the order of the layer.

3.7.1 Overview of Window Display, 3.7.2 Window Registration
on the U Screen
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B Placing Window Parts
Procedure for placing Window Parts will be shown below.

4 N

_—
\

—— Show window
Window | © o) Window |0 o
Display |F N Display | ¢ N

Place a window (such as a bar graph for Window Registration on the Window
Screen (U)) on the Base Screen (such as B2). (Call up the window.)

PROCEDURE

REMARKS

(1)Select [Window Parts] from the [Parts] menu or

click the @ icon.

(2)Select the window to be displayed on the Base
Screen (B) from the "Window Number™ field.
Specify the Window Control Address as well.

'Window Part Setting [WI_002]

“Window Contral Address

Eitd OMAOFF
Eit1 Display Order

ﬁ

tarcel [ Heb |

Flace

(3) Click the button after setting all at-

tributes.
The border of the window area is displayed on the
drawing area.

(4) Click on the point where the Window Part is to
be placed.

For Window Regis-
tration of parts on the Window

Screen (U), refer to 3.7.2 Window
Registration on the U Screen.

When the specified area is over-
lapped by objects on the Base Screen,
the object will be hidden while the
window is displayed.
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E Drawing

Straight lines, rectangles, and oval objects can be drawn, using drawing
tools.

2.2 Drawing

An object’s attributes such as line types and colors are designated in its
dialog box. After designating the object’s attributes, move the cursor and
start to draw the object directly in the drawing area.

%}\eﬂ These objects can also be drawn via the Keypad and Trend Graph screens.

Usage Pattern

Select a drawing
or command

[Draw] — Setany attributes -~ Draw the object

Select a desired drawing icon from the
Draw Tool Bar.

B Drawing Tools

Icons contained in the Draw Tool Bar and their corresponding drawing
objects are as follows:

Icon Object Types Icon Object Types
Dot Filled Polygon
HE Line/Poly-line i Scale

_ Square/Rectangle Text
Circle/Oval Load Screen
H@l Arc/Pie Load Mark
| Fill

B Selecting Line Types

10 selections are available for straight and poly-lines, and for graph divi-
sions. 6 selections are available for rectangles, circles, arcs and pie sections.

Polyline |

y —

£y —p | Polyline -

£ e
= = |- === Select one of these
=l = o= — patterns

fo HEE NN e

Bs NN ek
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B Selecting Colors
For color and blink attribute settings, use the procedure same as for Parts.
2.1 Parts B Part Attributes - Selecting Colors

W Tiling Patterns

Nine different tiling patterns are available. These patterns can be selected
for squares, circles, filled squares and polygonal objects. When combining
foreground (Fg) and background (Bg) colors, a variety of filled patterns can
be drawn.

Line/Polygon |

— Select a pattern

fo HEECE®OO &<
5o /) B

When a square or circle is drawn, only the line type will be displayed ini-
tially. To display the pattern selections, check the Fill check box. (check
mark will appear)

CirclefOval [x]

||_ —— =

Circle/Owal [=]

E>

fo HEECIEE O &<
B I JEE 1] ek

Fo HEECIN® OO e

Bo [N/ 1) ex)
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ED o |

Dots can be drawn in 1, 2, 3, and 5 dot units. To draw a dot, simply click on
the desired point.

B Dot Attributes

Dot |
) =[1ot type=—=
Select the dot unit used 5 1Dat - +— Displays the currently
for drawing {3 2Dots selected dot’s image
i 3Dots
1% BDots
ro BN W]C] e Select colors and blink-
ing, if desired
B Creating a Dot
PROCEDURE REMARKS
(1)Select the [Draw] menu - [Dot] command, or click on
the[[~ |icon.
(2)Set the attributes of a dot to be drawn.
Select a dot type and colors, if desired.
Dot [<] If an arrow (—) is selected, the
= Dot type—s line’s end point will become an ar-
i 2Dots
i 3Dots
7 BDots

fo HEE_ BN &k

(3)Move the cursor to the drawing area. A dot will be | When using the keyboard to draw
drawn at the point clicked on. a dot, move the cursor to the de-

sired point and press the [ || key.

To cancel/delete the dot, click on

the k._'-'_'=:_|_|. icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s Attribute Set-
tings dialog box.

2.4.14 Changing
Attributes
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@ Line/Poly-line ]

In order to draw a line, simply click to designate the line’s start and end
points. A continuous straight line can also be drawn; holding down the
key allows you to draw lines at precisely 0°, 45°, or 90° angles.

B Line/Polyline Attributes

When drawing a polyline, check this box

Selects aline type
(with or without o — -
) /gi.] — - ;I_'he,cgrrently selected
_ ine’s image appears
Selects aline go

here

e
fo HEEOENCOO e« Select a color, and
Ba MW _JMm ) )| blinking, if desired

type

B Drawing a (Straight) Line

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Line/Poly-line] command,

or click on the icon.

(2)Set the attributes of a straight line to be drawn.
If necessary, select the color and line type.

Polyline |
5 —
£y — | Polyline -
0

e ——a—

fo HEECIEE O &<
Bo W) Bk

(3)Move the cursor to the drawing area, click on the| In step (4), while holding the
line’s starting point and drag the mouse to the end | key down, a straight line at an
point. angle of either 0, 45, or 90 degrees

can also be drawn.

When using the keyboard to draw
a straight line, use the arrow keys
to move the cursor to the start and

end points and press the || key,
to start and finish the line.
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PROCEDURE REMARKS

(4)Click again; a straight line is drawn (registered). To cancel the placement, click on

the icon.
/‘ Double-clicking on any object

drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.4.14 Changing
Attributes

B Drawing Polylines
When the Polyline check box is checked, Polylines can be drawn. Click on the
starting point then drag the mouse, clicking the left mouse button at each point of
the desired directional change of the line; and, click on the right mouse button at
the end point of the line.

@\t - When drawing, if the Keyboard’s key is pressed instead of clicking
Note; on the mouse right button, the start and end points of a polyline object will
be automatically connected.

- You can draw a line that looks hand-drawn by holding down the mouse’s
left button when drawing a polyline.
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@ Square/Rectangle ]

To draw a square, click on and designate the diagonal two points.

To draw a regular square, perform this operation while holding down the
[Ctrikey. By selecting a pattern before drawing, a filled square also can be
drawn. Both normal (non-filled) and filled squares can be beveled.

B Square Attributes

Check this check box when draw-
ing a filled Square/Rectangle

SquarefRectangle

Displays the

Selects the type of 7%@ "] Fill | — currently se-
Square/Rectangle : ]ﬂ lected Square/
L) o Rectangle type
|
[

Selects aline
(border) type

— ===l [===] [T~ When selecting
Corner, this

SelectaColorand _ |[Fs I EN ] -0 number desig-
blinking, if desired Bo NN ] exD) nates the num-

ber of dots used

<Filled Square/Rectangle Setting Screen>

Q |:| ] Fil
D D:urner-

fo HEECIEE O &<
Bo W) Bk

Select one of the
tiling patterns

@ Square Shapes and Beveling types
Square shapes and beveling types are as shown below.
|:] Not beveled.
(D All corners are beveled with straight lines.

() Allcorners are beveled with arcs.

When selecting Beveling, input a bevel dot number.

Founded + Lire
The dot value sets up

+
1 1 this spacing
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B Drawing a Square/Rectangle

2.2 Drawing

PROCEDURE

REMARKS

(1)Select the [Draw] menu - [Square/Rectangle] com-
mand, or click on the icon.

(2)Set the attributes of the square/rectangle to be drawn.
If desired, select the colors, line types, beveling type and
dot. When drawing a filled square, check the Fill check
box, instead of selecting line types.

QI:I L Fil E
{:‘;D Eorner-
==

Fo NI/ D] ek
il | ] Im] | [

Square/Rectangle
QI:I ] Fil c
D Eorner-
]

Fo NI/ D] ek
il | ] Im] | [

Select a pattern

(3)Move the cursor to the drawing area and click on the
first of the diagonal’s points, “a”.

(4)Click on the diagonal’s other point “b”.
The rectangle is automatically drawn (registered).

2.2.3 B Square
Attributes, 4 Square Shapes and

Beveling types

In step (4), hold down the key
to draw a square.

When using the keyboard to draw a
square, use the arrow keys to move
the cursor to the rectangle’s two di-
agonal points and press the | key
to start and finish the rectangle.

To cancel the placement, click on

the icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.4.14 Changing
Attributes
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@ Circle/Oval ]

To draw a circle or an oval, click on its center point and drag the mouse to
the circumference point, and click again. Holding down the key draws
a perfect circle. To draw a filled circle or oval, select the desired pattern.

B Circle/Oval Attributes

Check this check
box, if a filled Circle/

Oval is desired
L] Fil —+— Displays the
currently selected
—

Select a Line/
Border type

Circle/Oval image

=

Select a Fg and
Bg color,and — )7 HEN_ N0 B[]

blinking, if de- Bo W] &x))

sired
<Filled Circle/Oval Setting Screen>

CirclefOwval

Select one of the
Tiling patterns

fo HEECIEE O &<
B I JEE 1] ek

B Drawing a Circle/Oval

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Circle/Oval] command, or
click on the [ icon.

(2)Set attributes of an oval to be drawn.
Select colors and a line type, if desired. To draw a filled
oval, check the Fill check box and select a pattern, in-
stead of selecting a line type.

Circle/0val [x]

- IEECOEE o0
o B ] e

@ Select a Pattern
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2.2 Drawing

PROCEDURE

REmMARKS

Circle/0val [<]]

fo HEECOE®EOO e
el | ] e] T ey

(3)Move the cursor over the drawing area, and click on
the center point, shown here by “a”.

(4)As the cursor is moved, the oval will expand or con-
tract.
Click on the point shown by b. The drawn oval will be
registered.

)

In step (3), if the key is held
down, you can draw an oval which
contacts a specified area (i.e. the
side(s) of a square). This function
is useful when drawing an inscribed
circle and can also be used in step

(4), together with the key.

To draw a regular circle, hold the
key down in step (4).

When using the keyboard to draw
an oval, use the arrow keys to move
the cursor to the center point and
then, to the point which defines its
circumference (radius point), press-

ing the [J] key each time.

To cancel a drawing action, click
on the [[i=] icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.4.14 Changing
Attributes
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@ Arc/Pie ]

To draw an arc or pie, a portion of a circle must be selected. You will need
to first draw a circle, and then, click on the arc’s beginning and end points.

B Arc/Pie Attributes

Check this check box when
drawing a Pie

| Displays the
currently selected

Sele_ct one of Arc/Pie image
the line/border i

types [l = ol —

Fo HEEJEN O e+ Select the Color
Bo ) ek and Blink set-

tings, if desired

B Drawing an Arc

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Arc/Pie] command, or click

on the [|[{+] icon.

(2)Set the Arc’s attributes.
Select Colors and line type, if desired.

Arc / Pie [%]

N

||_ e | Y |

fo HEEC N &<
5 I Bk

(3)Move the cursor to the drawing area and click on the | In step (3), if the key is held
oval’s center point “a”. down, you can draw an oval which

contacts a specified area (i.e. the
side(s) of a square). This function
is useful when drawing an inscribed
circle and can also be used in step
(4), together with the key.
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2.2 Drawing

PROCEDURE

REmMARKS

(4)Click on the oval’s radius point “b”. In step (4), holding down the[Cirl]
An oval will appear and the arc’s base line will be dis- | key draws a circular arc.

played.

(5)Click on the arc’s start point “c” or on its elongation. [ When using the keyboard to draw

D

]

(6)Click on the arc’s end point “d”.
The arc will be drawn (registered).

é;‘jfﬂ
J
-

an arc, use the arrow keys to move
the cursor first, to its center point,
then, to another point on its circum-
ference (radius point), and then, to
its start and end points. Press the

key after specifying each of
these points.

To cancel the drawing action, click

on the ||« icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.4.14 Changing
Attributes

B Drawing a Pie (Sector)
Follow the same steps used for the drawing of Arcs.

When using the same procedure to draw an Arc:

S

D
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@ Fill |

To use the Fill command, simply left-click your cursor on top of an object’s
enclosed area. The selected Fill pattern will then spread outward until it
reaches a boundary. A boundary can be any line or Fill that is the same
color as that chosen for the Fill’s foreground, background, or border.

A' <Cautions when Filling an Object>

lmpo'”am e Be sure that the area to be filled is completely enclosed with
solid lines. Dotted lines can not be used as an enclosure.

e A space of only one dot on the border of an enclosed areais
enough to allow Fill to leak into other areas of the screen. Be
especially careful when drawing polygon vertexes and filling
an object while the display is set to 50%.

e DO NOT attempt to fill objects that have been designated as
blinking.

e When filling an image that uses an arc, Fill may leak when
that image is actually displayed on the GP panel display. To
prevent this, use a line to connect any gaps in the image.

B Fill Attributes

Fill

[%]
Displays the
currently selected

Select one of the Fill type
tiling patterns '

Fo NI ] ex])
e HERODOERE ) sx0 Select a Color
ed I ) 1]

% - To select the background color for all the screens used, use the [Option]
Noie; menu’s [Screen Settings] command.

2.9.2 W Setting Screen Property - [Color]

- To cancel the application of a Fill due to a mistake, such as having desig-
nated the wrong Fill point, press the key.
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B Filling an Object

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Fill] command, or click on

the [“] icon. Fill spreads outward from the se-

lected point until it reaches a bor-

(2)Set the attributes. der with one of the colors (Fg, Bg,
Select Colors and Tiling Patterns, if desired. Bd) selected in step (2).

Fill Select the same color for the Bd
(border) Color and boundary Fg

(foreground) Color.

Ey

Fill's Bd color: Hlue
Fg !]!]E]DD ElkD - :
Bg .E]DD BlkD
ed NI ) V)]

7 N—Line's Fy color: Blug

Left-clicking on a line will not
(3) Move the cursor to the drawing area and click on | cause it to be filled. Be sure to only
the area to be filled. click in an area enclosed by lines.

The designated area will be filled in. When drawing via the PC’s key-

board, press the | button to indi-
cate a fill point. Fills and fill points

1 can be specified to either display
or not display via the drawing
board.

2.9.2 Screen Prop-
erty Settings

To cancel Fill due to a mistake, such

as designating a wrong Fill point,
E press the key.

To cancel the filling, click on the

icon.

Double-clicking on a filling point
of any filled object drawn on the
screen automatically calls up that
filled object’s attribute settings.

2.4.14 Changing
Attributes

GP-PRO/PB Ill for Windows Ver. 6.3 Operation Manual 2-171



2.2 Drawing Chapter 2 - Base Screens

@ Line / Polygon ]

To draw a Polygon, either Left-click or press the key to indicate the
Polygon’s vertices. To complete the Polygon, either right-click or press the
[ C Jto automatically connect the beginning and end points.

Holding down the key while drawing a Polygon will snap the polygon’s
segments to 45 degree angles.

B Polygon Attributes

Line/Polygon

| Displays the
currently se-
lected Polygon

u x|

Select one of
the tiling pat ]

terns
Fo N IM® 0 8kO)|  Sets the Color
Bo MM _JM™ 1] e I|| and blinking, if

desired

B Drawing a Polygon

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Filled Polygon] command,

or click on the || #4 | icon.

(2)Set attributes of a polygon to be drawn.
Select Colors and Tiling Pattern, if desired.

Line/Polygon |

fo HEECIE®EO &
B 1) Bk

(3)Move the cursor to the drawing area and click on the
start point “a”.
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2.2 Drawing

PROCEDURE

REmMARKS

(4)Left-click to designate the positions of the Polygon’s
vertices.
Repeat this for as many vertices as needed. Here, points
b and c are also shown.

(5)After defining the final vertex, c, right-click or press
to complete and fill the Polygon.
Points a and c are joined and the object is filled.

ﬁé}e: - About Filling a Polygon
2

Up to 100 corners (faces) can be
created.

In step (4), holding the key
causes lines to be drawn at exactly

0, 45, or 90 degree angles.

To cancel the drawing, click on the

icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.4.14 Changing
Attributes

When a polygon’s segments overlap, the filling alternates, so that areas next
to each other do not display the same pattern. As a result, areas without
any fill (white) may develop inside the polygon. If fill is desired in these

areas as well, click on the icon.
Eg
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@ Scale ]

To draw or create a Scale, input the number of divisions desired and then
left-click the mouse’s cursor to designate the scale’s beginning and end
points. Scales can be either horizontal or vertical, linear (straight line) or
curved (semi-circle).

B Scale Attributes

Enter the number of divisions desired

Scale ] Displays the cur-

=Type=——=) Divisions
Selec,t the £ Curved rek)ntly §e_lected
Scale’s type 9 Linear object’s image

—— (Only with straight
. e —l——— line Scales) Changes
Select the line .
type | — | | | e || the scale’s orienta-
tion to vertical

Fo I/ )] &x)
el | e (T

(default is horizontal)

Select the Color and
blinking, if desired

B Drawing a Scale

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Scale] command, or click

wls

on the [ icon.

(2) Set the attributes of the divisions to be marked. <Number of Divisions>
Select the Scale’s colors, line type, and Scale type, and in- | \ihen the number of the divisions
put the number of scale divisions. If “Linear” is selected as | ;¢ specified as 8, a total of 9 divi-
the type, select the orientation direction by clicking on the sion lives will be displayed.

Vertical check box. (Unchecked means Horizontal) ]
(i.e. the number entered +1)

Scale |
FType=——= Divisions

gcun’e'j %
% Linear E] Yertical

||_ ey | ey /| prppe—y | p—
Fo AN JINEC e«
Bo I Bk
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2.2 Drawing

PROCEDURE

REmMARKS

The following explanation is divided into two parts; first,
when creating a linear type scale, and second, when
creating a curved type scale.

[Creating a Linear type scale- (Vertical, with 8 divi-
sions)]
Specify the area of division lines by a rectangle.

(3)Use the mouse’s cursor to create a rectangle in the
drawing area, i.e. left-click to indicate the linear scale’s
start point, a.

7

‘a

(4)Complete the rectangle by left-clicking on the Scale’s
end point, b.
The rectangle shape will disappear, and be replaced by
division lines.

d

[Creating a Curved type scale- (8 divisions)]
Specify the area of division lines, using double circles.

(3)Use the mouse’s cursor to create a circle on the draw-
ing area, i.e. left-click to indicate the curved scale’s
start point, a.

/

‘a

Holding down the key while
performing step (4) will draw a per-
fect square.

When using the keyboard to per-

form drawing, press the key to
designate the start and finish points.

To cancel the drawing, click on the

icon.
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PROCEDURE

REMARKS

(4)Click on the radius point “b”, which is of a scale’s
outer circle.

a’ /

%

(5)Draw another circle inside the circle drawn in step
(4) to decide the width of the scale. Click on this in-
ner circle’s radius point “c”.

~=

(6)Rotate the displayed segment and click on the scale
start point “d” or on its elongation.

©
PE/’

(7)Then, rotate the segment again until you reach the
desired end point e, and click to designate the end of
the scale’s divisions.

Division lines appear inside the area surrounded with
the double circles and the two segments. They will be
drawn clockwise from the start point to the end point.

v/
\.m./
s ~

When using the keyboard to draw

divisions, press the key after
moving the cursor to the division
circle’s center point, to the other
point on its circumference (radius
point), and then to the divisions’
start and end points.

To cancel the drawing, click on the

icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.4.14 Changing
Attributes
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@ Text ]

From the keyboard enter the text and then place it on the screen. This
software has two methods of placing text on the screen. The first method
defines the placement point, and the second defines the area where the text
will be centered.

B Text Attributes
Select the type of text.

Enter the text used as
direct text.

Select the desired font
when using Image Font

@orea £ incex for Direct Text.

Select the style of the

. (This f i .
text. (This feature is | Displays a sample of the

not available with , _
Image Font.) current text’s attributes.

et

L3
Direction >

. — Select the text’s display
Specify the character direction. (This feature

size. Svie  Tibwal DB DReked is not available with
Fentsee Image Font.)

Image text is com- —— |

—] Campress
i Select the Fg and B
pressed when this L e e [N e glinkin ;
option is selected. & EEEOEEC - ' 9.

@ Direct Text

The text entered in the text entry field is placed directly as a fixed text string.
A maximum of 100 characters can be entered per line, and 100 lines per
screen.

@ Index Text

Select and add the Index Text.

MBI 4.6.3 M Selecting the index character string 4 Entering
the index character string

€ Image Font

Text using Windows fonts is displayed in bitmap format. This feature is
enabled only when "Direct Text" mode is selected.

ﬁé\(\eﬂ Image Font is supported by the GP-2000 series only.
Click the [Select Font] button and specify the Font, Style and Size settings.

o [7]=]
Eont Fant style: Size
System [Bold i oK .
arlet [~ [a 0 & |
e Displays a sample of the
S 20 | current text’s attributes
mbol =
ME] a =
Seript
This is ascreenfont, The closest matching printerfontwill be used
for printing
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Ko
21

Chapter 2 - Base Screens

- When Image Font is selected, the [Style] and ""Vertical' text (*"Vertical"

under the "Direction' setting) cannot be specified.

- Image Font increases the size of the Project file. We recommend that the

"Compress' setting be enabled.

- The maximum capacity of one text string is 50KB when Image Font is used.

Capacity of text | _  (Number of dots Number of dots for
with Image Font for text width/8) text height
(Bytes)
€ Compress

This feature is enabled only when the Image Font option is selected. The
Image Font is compressed to one-half its original size. (The compressed size
may vary depending on the text.)

& Character Size

e
21

Clicking on the font size display area, displays the current character size
(used after text is placed on the drawing area). Move the cursor to where the
X and Y axis lines cross, and drag the cursor. As the axis lines move, the

character size will change. Click on the text block again, or press the
key to register (enter) the change.

Fart Size

Jxi6 |

6x10 e
Bx13 \TTITTT

13x23 |[-Hrr

T I = R0

Crrprree

il | SHSNEREN| ([N

3240

Half-2 Byte Character (Only Chinese, Taiwanese and Korean OS - not
available with GP-270 Series units.) can be used with Text strings, Bit
Switches, Word Switches, Function Switches, Toggle Switches, 4-State
Switches, Lamps and Message Displays.

Half Full

Character 1x1 8x8 16x16 | 8x16 16 x 8 16 x 16
Size 2x2 | 16x16 | 32x32 | 16x32 | 32x16 | 32x32
4x2 32x32 | 64x64 | 32x64 | 64x32 | 64x64

- Be aware that using Half-2 Byte Character feature may cause certain

characters to change to garbage-characters that cannot be used.
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ﬁé}% - The Text Size can be selected as a multiple of any whole number from 1
through 8 with the GP2000 series and as either 1, 2, 4 or 8 with other
models.

- Specify the point size when the Image Font option is selected. You can also
specify the point size by clicking the [Select Font] button and selecting the
font size in the [Size] field.

- When the text is zoomed in or zoomed out while the |Ctrl | key is pressed
under Image Font mode, the text may exceed the frame of the system part.

The special extended font sizes are available only when entering single-byte
numbers or symbols (6 x 10 dots/ 8 x 13 dots/ 13 x 23 dots).

ﬁé\te: - These extended fonts can also be used with Parts and Tags that allow you to
2 modify the size of entered text characters. (not available with CSV and
Logging data displays)
- Since extended font sizes are fixed, objects containing these characters
cannot be enlarged or reduced while pressing down on the key.

- 7-segment display of parts is not available with this feature.

@ Style

Characters can be either Normal, Bold, or Raised.
Style
29 Nomal
i) Bold

170 Raized

ﬁé}e: - When text character backgrounds (Bg) is specified to Black + Blk (Blink),
S transparent mode is used, thereby displaying that area as transparent. For

256-color mode, select the last (255th) color, which is “Clr”. However, for
the GP unit with three blink speeds, this mode can be specified only when
the “Mid” speed is selected. If an object has been drawn underneath these
characters, they (the characters) will appear transparent, showing the
object behind. This function is useful when overlaying text on objects, i.e.,
over the face of Switches and Lamps.

2.1 Parts M Part Attributes-Selecting Colors

- You cannot specify the style when Image font is selected.
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B Changing to a New Text Line and Line Settings

When entering characters, simply press the key to move to a new line.
When there are 2 or more lines of text, icons will appear to allow adjust-

ments in line spacing, and justification.

Faont Size Justification
Point EEEEN Controls the
E Compress tS:)i?(S:ted
Fro MEEDOEEDONE Mok ] justification
s INEDNEOORE oo F]

& Justification

Horizontal text’s alignment can be changed to either Left, Center, Right or

Full justified.

Left justified —— §f||||§|||

Full justified

Centered Right justified

B Entering Text

PROCEDURE

REMARKS

(1)Select the [Draw] menu - [Text] command, or click
on the ||| icon.

(2)Set the attributes of the characters to be input.

Select Colors and Character Size, if desired.
% Direct

Timage Font SelseFan
] .

£ Vertical

Style # MNormal 2 Bold £ Paiged
Font Size

fo HEEOEEDCONE oo
Eo I

When selecting [Index]:

ST 4.6.3 B Select the
index character string @
Enterinig the index character
string

The attributes can also be entered
and selected after entering text.

When “Raised” is selected for
Character Type, the border color
(Bd) will become shadowed (i.e.
3-D).
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2.2 Drawing

PROCEDURE

REmMARKS

(3)Click on the text field to input characters, via your
PC’s keyboard, when selecting [Direct].
Simply clicking on the text field allows you to input char-
acters there.

®Direct £ Inclex

el

Operation Screen
=
Girection

# Horizontal
£ Vertical
£ Bold

Stle
Font Siee

B8 [l

£ Normal £ Raised

F MM Mmoo T
= EMEOME M e ]

Hereafter, two text alignment cases will be explained, one
not using and one using the Centering function:

<When Centering function is NOT used>

(4)Move the cursor to the drawing area and click on any
desired point.

After clicking on a point in the drawing area, a text box
the size of the selected character will appear on the screen.

The top left corner of the text box is the base point used
for positioning.

/
]

(5)Move the cursor to the desired position and left-click
the mouse to place it on the screen.

e

Operation 3creen

<When the Centering function IS used>

(4)Move the cursor over the desired placement area and,
while holding down the key, click on any
desired point.

After clicking on a point in the drawing area, the text
box will appear on the screen in dotted line.

/A

]
Important

‘When the Image Font is selected, the
"Direction™ (Vertical/Horizontal) and
"Style" text settings are disabled.

When using your PC’s keyboard

to enter text, press the [ key to
designate a position.

To cancel the placement, click on

the [ | icon.

Double-clicking on any object
drawn on the screen automatically

calls up that object’s attribute set-
tings.

SEOTTEK 2.4.14 Changing
Attributes
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PROCEDURE REMARKS

(5)Select a centering area that is the same size or larger | To cancel the designated area, click
than the previously selected text area. the right mouse button.
The designated size’s text box will appear in the center
of the selected area.

Operation 3creen

ﬁé}e: - GP-PRO/PBIII for Windows uses the PC’s font. As a result, the text that
S you see on the GP display and that shown on the PC may differ.

- In both GP-PROIII and GP-PRO/PBIII (DOS Ver.), when an object is
overlaid on a text block, the text block will be displayed in the foreground.
With GP-PRO/PBIII for Windows, however, the text block will be placed
behind the object. When the GP-PROIII and GP-PRO/PBIII (DOS Ver.)’s
data is used in the GP-PRO/PBIII for Windows, the text block will be
displayed in the foreground.
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2.2 Drawing

@ Load Screens

)

Graphics created on screens in a project can be loaded and used repeatedly
on others with GP-PRO/PB I11 for Windows. Thus, a single screen’s con-
tents can be used repeatedly elsewhere. The Load Screen function is also a
good way to cut down on your screen’s actual size, since you only need to
call up items to your screen, not save them on it.

B Screens that can be loaded to other screens

Current Screen

Loadable Screens

B (Base) screen

B (Base) screen

T (Trend graph) screen *

K (Keypad) screen

[ (Image) screen

[ (Image) screen-CF card

T (Trend graph) screen

B (Base) screen

| (Image) screen

| (Image) screen-CF card

K (Keypad) screen

B (Base) screen

| (Image) screen

I (Image) screen-CF card

U (Window) screen

B (Base) screen

[ (Image) screen

I (Image) screen-CF card

*1 Up to 8 Trend Graph screens can be loaded onto each Base screen.
However, only one trend graph with the Data Record Display function

can be loaded.

*2 Only one Keypad screen can be loaded onto each Base screen.

The screen currently being edited cannot be loaded on to itself.

/A u A
Important

If any portion of a Trend Graph screen extends over a Base
screen’s border, the Trend Graph screen will not display cor-
rectly on the GP screen.

GP-PRO/PB Il for Windows Ver. 6.3 Operation Manual

2-183



2.2 Drawing Chapter 2 - Base Screens

%te: If a portion of an Image screen extends over a Base screen’s Y axis border,
that portion will not be displayed on the GP screen. When the Image screen
is placed over the Base screen laterally, however, any part that extends over
the Base screen X axis border will be squeezed onto the GP screen.(i.e. not
cut)

Example) When using GP-PRO/ When using the GP
PB Il for Windows panel display

Drawing
Areas

B Nesting

Screens can be nested up to 10 times (11 layers). However, if your PC’s
system memory is low, a loaded screen/object may not be displayed. Later,
however, when the data is transferred to the GP, the display will appear
normally.

E.g.) Nesting Objects Twice (3 layers)
B100 E10 B

[

@Q% L

Load Screen B100 Load Sereen B10

oo
oo

%te.' The load screen nesting condition can be viewed via the load screen nesting
display function.

SEBTTIEIK 2.9.9 Display of Screen Level Change Structure
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HLo

ading a Screen

2.2 Drawing

PROCEDURE

REMARKS

(1)Select the [Draw] menu - [Load Screen] command,

2

or click on the

icon.

(2)Select a desired screen from the list or enter that

screen’s number di
the keyboard, and

rectly on the [Screen No.] field via

then click on the button.

Then, the screen’s outline and center point will appear in
the drawing area, next to your cursor.

Load Screen

Screen Type | Bawe

5 T

SereenMo.: [11: Operation Manitor

[Ii]l | Cancel

fian

(3)Click on the point where the Screen’s top left corner

is to be placed.
The image’s center
and for other object
placement point.

point is left top corner of its border,
s, the screen center mark will be the

I =3

ERATICHN MCMITOR ”

WaRM—1ITF FIIET

WAaRM—ITE FLIIT

WARM—ITE EUTT

W ARII— TP RULT

TEMPEE.
CONTROL

RUN
HMONITOR

TROUELE

Only screens in the currently used
Project file can be loaded. Screens
in other project files can not be
loaded.

The current (selected) Screen can-
not be loaded on to itself.

A loaded screen cannot be edited
while it is being used on a different
(i.e. loaded) screen. You will need
to open the original screen to per-
form any editing.

To cancel the loading, click on the

icon.
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%@' When calling up a filled object:

When the current screen’s graphics overlap loaded filled (painted) graph-
ics, depending on the color used, unfilled areas may be created. To correct
this, add a fill to the current screen’s unfilled area.

2.2.6 Fill

B100 B10

2

B10

‘ \ ~tAdd afill in the
unfilled area

7 o If a background color is selected for the screen used for
important screen call-up, the object placed on the screen will not be

displayed on the GP.

To call up the screen for which a background color has been
selected, specify the center of the screen as the call-up posi-
tion and then place the screen.

Load B100
anto B10
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@ Load Mark ]

Marks (dot images) created in a Mark screen can be loaded and used repeat-
edly on Base/Trend Graph/Keypad/Window screens.

B Loading a Mark Screen

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Load Mark] command, or

click on the | & | icon.

(2)Select a desired Mark screen from the list or enter
that screen’s number directly on the [Screen No.] field

via the keyboard, and then click on the but-
ton.

The Mark’s outline will appear in the drawing area, next
to your cursor.

Designate its color and size before clicking on the [OK]
button, if desired.

= Only Mark screens in the current

e [1 g T project can be loaded. Mark
screens in other projects are not
available.

When the screen display size is
50%, the loaded Mark may not be
displayed correctly on the GP-PRO/

» EEEOEEO0 0 PB 111 for Windows software.
s MmO -

To cancel the loading, click on the
(3)Click on the point where the Mark’s top left corner is icon.

to be placed.
If desired, use the Mark’s handles to alter its size. SAEIEEK To change the
Mark’s size, refer to 2.4.3 Scaling
Up/Down
_ o Double-clicking on any Mark
loaded on the screen automatically
S calls up that Mark’s attribute set-
tings.
SAEETITIK 2.4.14 Changing
Attributes
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@ Convert (Import) Image ]

This section describes how to convert image data (bitmap: BMP file and
JPEG: JPEG file), created from other drawing software or imported from a
scanner, for use on a GP Image (1) screen.

For Image Conversion data, refer to 3.5 Creating an
Image: the Image Screen.

B Converting and Placing an Image

PROCEDURE REMARKS

(1) From the munu bar of the screen editor [Draw] | Once an image has been converted,
menu’s [Convert Image...] command. it can be placed on a screen using
the Load Screen function.

(2)Set all conversion settings and click on the 2.2.10 Load

button. Screens
Import Image MUGEGEIN For each setting
"Source | Effects | Destination | item, refer to 3.5 Creating an Im-
Image File age: the Image screen.
J258P3.bmp | | Hrowse... |
=5 ource Imag
Colors
Before conversion, the image dis-
Size [byles) 1 H
| playejd |n_the Import Image dialog
R box is still compressed and may
(= appear different from the actual dis-
play (after conversion).
’ e " Cancel " Corwvert ’ Hel
[_peee || | %JI P

To cancel the conversion, simply

click on the button.
(3)Click on the button.

The data is then saved as an Image screen.
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PROCEDURE REMARKS

(4)Click on the button.

The Image screen’s border will appear on the current
screen.

(5)Click on the point where the Image screen is to be To cancel the placement, click on

placed. _ the [a| icon.
The Image screen will appear on your screen.

%te.' If the Image screen(l) is placed outside the drawing area vertically, the
portion of the image that does not fit in the drawing area will not be dis-
played on the GP screen. However, if the Image screen is placed outside the
drawing area horizontally, the portion that does not fit will be squeezed so
that it is displayed on the GP screen.

E.g) On your PC's screen On the GP panel

Screen /

display

area \

B Pasting images with other file formats

The paste function can be used for images copied onto the Clipboard ™.
Executing the [Paste] command from screen editor while a copied image is
in the clipboard will display the "Paste Image" dialog box on the screen. The
“Source” tab will not be displayed on the screen.When images cannot be
pasted with this procedure, convert the images into bitmap files or JPEG
files with other image processing software before copying and pasting it to
the screen editor.

*1 The clipboard is a storage location where copied or cut data is temporarily stored. The
data stored on the clipboard can be copied or moved by pasting it.
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Tags are one of the GP-PRO/PBIII for Windows program’s many powerful
features. When you create a Tag, you can transform a square on the screen
into a switch, or create an animated display that changes according to data
from the Host PLC. Tags are created and placed on the screen where you
want a function to be; and, while most of the applications for Tags are on a
Base screen, they can be used with Keypad screens, as well as a variety of
other screens.

Here, topics such as Previously Created Tags, Changing of Tags, and Delet-
ing Tags, are discussed.

For further details of tags, refer to the Tag Reference Manual.

B Points to Consider when Creating Tags
When creating a Tag, please be aware of the following points:

€ When creating a number of tags on identical screens, if one Tag’s posi-
tion overlaps that of another Tag, the Tags will overlap when they are
called up and may not be displayed correctly. Please be aware of this
when loading (calling up) multiple Tags.

€ Using the Copy or Paste functions to place Tags with the same name on
similar screens can make identifying Tags difficult. It is suggested that
you either change the Tag’s attributes (i.e. name) directly, or use the Tag
Summary to change the name. When 2 or more K Tags have been used
to operate a common Trigger Bit, it is especially important that the Tag
names used are different.

Tag Reference Manual 2.12 K-tag (Key Input)

€ The maximum number of tags designated on the same screen is as fol-
lows. This total includes tags on any screens that have been called up, or
are included in a window that is used. The figure below, however, does
not include any k tags or R tags.

GP-470 GP-270 GP-377
GP Series GP-570 GP-370 GP77R
GP-675 GP-H70 GP2000

Number of tags 256 128 384

Refer to the figure below for the enabled tags.

<Example: when using GP-470>

Screen B2 Screen B1 Screen B3
10 tags :> 25 tags
10 tags|(25 tags <:I
Load (B2) (B3) Load
Screen Screen

Combined number of Tags = 10(B2) + 25 (B3) + 30(B1) = 65 < 256

Number of tags can be viewed from the Screen Information in GP-PRO/PBIII.

4.5.2 Screen Information

2-190

GP-PRO/PB Il for Windows Ver. 6.3 Operation Manual




Chapter 2 - Base Screens 2.3 Tags

@ Though all of a Tag’s identifying marks, lines, etc. can be seen on the
screen that it was created on, after that Tag’s screen is called up to a Base
screen, those Marks can no longer be seen and it can not be edited. In
example 1 above, even though screen tags B2 and B3 are added to B1’s
total tag count, their identification data is not displayed on B1 (Drawing
area, Tag List, etc.) and can not be edited from that screen. To edit these
Marks, call up the Base screen on which each Tag was specified.

@ The order in which each Tag is created is recorded, and when the total tag
count for that screen exceeds 256 (Digital’s GP-H70, GP-270 and GP-
370 count up to 128 tags. GP-377, GP37W2, GP-377R, GP77R and
GP2000 can use up to 384 tags.), those excess tags are ineffective. When
the tags used on a screen have been called up from a window, those tags
are added to the total, in the order that the window was called up. Thus,
when calling up multiple windows for use on a screen, be sure that the
total number of tags used in all the windows does not exceed the above
limit, or certain tags will become invalid.

€ Approximately 90 reserved tags are used for the Device Monitor func-
tion. When using Device Monitor together with regular screen tags, they
must be added to the screen’s total tag count. Thus, be sure that the tags
used for the Device Monitor are included in your tag count calculation. If
the total becomes greater than that screen’s limit, the message “Total No.
of Tags is over limit.” will appear. Until the number of tags is reduced,
there is a possibility that the Device Monitor function will not work
correctly. If using the Device Monitor function will cause a screen’s total
tag count to exceed its limit, you should not use Device Monitor function
on that screen.

4.8 Device Monitor

@ The actual amount of space required (in bytes) for each tag will vary.
When placing tags on a screen, please consider the number of tags that
have already been created, the size of each tag, and the panel’s tag limit.

Information such as the current screen capacity and number of tags used
can be viewed in the [Screen Information] dialog box.

4.5.2 Screen Information
For each tag size, refer to the following table.
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<Tag Size List>

Tag Name Function T?gyfge
A Alarm Summary Text Display 56
a Alarm Summary Display 34
C Clock Display 28
D Statistic Graph Display 48
d Statistic Data Display 74

E Numeric Data Display extended function 3210122
F Free Library Display 42
G Graph Display 40

g Graph Display extended function 3810158
H Drawing Object Display 42
J Moving Mark Display 38

K Key Input 46,58

k Keypad Setup 28
L Library Display 34

| Library State Display 4010 102
M Mark Display 34
N Numeric Data Display 36
n Alarm Boundary Display 30
P Numeric Displayin Predefined Format 118

Q Alarm Summary Display extended function 46,66, 98
R Rail Settings 20
S String Display 32
T(including Tih, Tiw) Touch Panel Input 36
t Selector Switch Input 56
u Window Display 34
\% Video Window Display 30
v Video Window Extended Features 42
w Write to a Device 32
X Text Data Display 40

Be aware of the following points:

» The total number of t-tags that can be used on the GP-470, 570, 571, 675
and 870 is 128; with the GP-270, 370, and H70, it is 64; with the GP-377,
GP-37W2, GP77R and GP2000 series, it is 192.

* Onlyone (1) A a, and C- tag can be used per screen.

» A total of 30 R tags are possible on one screen. The total number of
points used for R-tag data can be up to 406 per screen. However, when
calling up multiple screens, the total points allowable is 512.

» The number of windows that can be displayed on one screen at one time
is up to 3, i.e. one global window and two local windows via the U-tag.

» Tih, and Tiw tags cannot be used on the GP-H70, GP-270, GP-370, GP-
57J, GP-377, GP-37W2, GP-377R and GP2000 series units, since they
do not have AUX I/F Touch Switch output (TSWO to 7).
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@ Designating Tags ]

The tag setting items will differ depending on each tag type. Here, the basic
setting procedures are described.

After a Tag is selected, that tag’s dialog box will appear. Here all the tag’s
attribute data, such as the setting address, are entered. After all of the Tag’s

attributes have been entered, click on the button and designate the
point or area on the screen where the Tag will function.

Usage Pattern

Select a Tag Enter the Tag’s Designate the

[Tag] = fromthelist =  setting data = functioning area
or

Select a desired command icon
from the Tag Tool Bar.

B Tag Settings

An example of a Tag’s dialog box is shown below.
In the [General Info] area, the Tag’s name and description data are entered.
Also, the Tag’s general settings are displayed.

E.g.) L Tag
L Tag Setting = Enter the Tag's
— _ name (number)
eneral info. | | Designated Screen] within 5
Clicking here will _|{—" "= L W ] characters
bring up the Description: Q here
Screen Access ~— -
settings (ltems Wiord Address: \ Enter Com
-tting ( Bit Address: 000000 ment data
WI” vary depend- Trigger Type: 01 within 20
ing on the tag Designated Screen: Direct characters here
type Sereen Mo Baze: 1
Erase Made: Mo / Shows the
currently
|' 0k, I | Cancel H Help | SeIe_Cted Tag S
settlngs

The actual setting items displayed will differ, depending on the tag.
Tag Reference Manual
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B Setting up Tags

Chapter 2 - Base Screens

An example of an L tag’s setting procedure is shown below.

-

GP-PRO/PBIII Tag Settings PLC GP Display
[

Tag Name Lamp L1 L : ‘ /,
Display Mode i - © -

Bit Address M0016 I

Designated Screen Direct: 300 'When MOO16G is on. . the Lamp is on.
Erase Mode Yes WWhen MOOE is

off, the Lamp is off)
k. vy

In order to show a Lamp’s ON and OFF states on the screen, the above
mentioned settings will be used to create a lamp and its ON image.

(1) In preparation, draw a lamp on the screen where the Tag will be posi-

tioned.

(2) Draw an image of the lamp’s lighting area on screen B300 (This image
will be loaded onto the screen’s center point. Create the image based on

this center mark)

PROCEDURE

REMARKS

(1)Select the [Tag] menu - [L-tag] command, or click on
the [ L |icon.

—

(2)Enter the tag’s name.
If desired, enter a description.

L Tag Setting |

General | Screen Access] Enter Iamp 1
Tag Mame: L ]
[ ezcription: ] — Enter set u ]

now lamp
Word Address: -
Bit ddress: =00o00o
Trigger Mode: -1
Screen Access: Direct
Sireen Mo Baze: 1
Erase Mode: Mo
|| QK. | || Cancel | || Help

A Tag name should be 5 charac-
ters or less.

SAOATK Tag Reference
Manual, 2.14 L-tag (Library Dis-

play)
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2.3 Tags

PROCEDURE

REmMARKS

(3)Enter the required data in the [Designated Screen]
area and click on the button to register it.

L Tag Setting

General Info. || Designated Screen |
) Direct 2 Indirect

=Trigaer Type= Trigger Bit Address Erase Mode
o ) N £ No
10 &) Yes

=5cieen Type:

{5 Base Screen e
1) Image Screen JIF
{2 Image Screen - CF Card

oK NW IREN

n

£ State

— Click on Yes

1

Enter MO0O16

™ Enter 300

Select Screen
Type

(4)Click on the point where the tag is to be used.
How this point is designated will differ depending on

each Tag type.

U

b

" Llamp

If your GP type is the GP77R or
GP2000 series, [Image Screen - CF
Card] can be selected in the [Screen
Type] section.

Use the pull down menu [Option]’s
[Screen Property] command to
change the Tag name, setting ad-
dress, and Tag mark display state
(i.e. displayed or not displayed).
(However, these settings will not be
displayed on the GP screen.)

SOOI 2.9.2 Screen Prop-

erty Settings

To cancel the placement, click on

the [w| icon.

Double-clicking on any Tab regis-
tered on the screen automatically
calls up that Tag’s attribute settings.

O 2.4.14 Changing

Attributes
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E®» object Editing

Parts, objects, text, and Tags previously placed or drawn (hereafter called
“Objects”), can be edited using various functions, such as Copy and Delete.
To edit an object, first, use the cursor to select the object, and then select the
type of edit operation.

Usage Pattern

Select an [Edit] Select the type of Perform the
Object - or - editing to perform —  editing
Tool Bar

B Types of Editing Functions

Icons contained in the Edit Tool Bar and their corresponding edit operation
are as follows:

Icon Edit Type Icon Edit Type
L Undo HE Group
i Redo IE Ungroup
.;IE. Cut Ii Bring to Front
Copy E Send to Back
ik Paste [~ Change Attribute
Command Data Paste ™ Change Coordinates
Duplicate Vertex Editing
Transferring Screen to
= Delete Clipboard
E Align Converting Sgreen to Bitmap
File
£5 Rotate Left & Redraw Screen
£2 Rotate Right Select All
- Mirror X-axis Select
4 Mirror Y-axis

%te . Some of the editing tools listed above can be selected from the menu

displayed on the screen by right-clicking the mouse.

*1 This function is enabled only when GP Type selection is a GLC series unit.
Pro-Control Editor Operation Manual
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@ Selecting Objects ]

Two methods are available for selecting objects: 1) clicking on an object
directly, or 2) dragging the mouse to enclose and select single or multiple
objects.

Also, you can select individual objects that have other objects either on top
of, or overlapping them.

When the tool bar’s icon is clicked on (active), an object can be se-
lected. To activate this icon, click on it directly, or select the pull down
[Edit] menu’s [Select] command. Also, while drawing objects, right-
clicking anywhere on a desired object allows you to select it.

Either a Il or a (1 mark will be displayed on the sides of the selected object.
These square marks are called “handles”.

Handle Types

There are two types of handles, those that can be used to scale the object and
those that can not. Refer to 2.4.3 Scaling Up/Down

B : Can be used to scale the object
[J . Cannot be used to scale

When an object has been be selected, the Selection Tool box will automati-
cally appear. When multiple objects are selected, all the selection Tool
box’s functions are available.

Selects all of the After selecting a group

objects in agroup of objects, selects one
of that group

After selecting a group of
objects, selects one type
of object (i.e. squares,
circles, etc.)

After selecting either

or |Tuee|, clicking on either

or selects the next

object or type

— These keys are used to
select Tags when the Tag
box is checked

%fe-' Objects may be selected using the Screen Data List, instead of selecting them
on the screen.

2.9.4 Screen Data List

- When the tag check box for the selection tool box is marked with a check,
tags can be selected even if the tag names and marks are hidden.
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B How to Select a Single Object
Here, the procedure for selecting an object is explained.

PROCEDURE

REMARKS

[Selecting an Object Directly]

(1)Move the cursor over the object, and left-click.

To select a Tag, check the [Option]
menu’s [Screen Property]

Handles display on the object to show that it is selected.

k

O

P ]

[Selecting an Object by Dragging]

(1) Position the cursor near the object and hold the but-
ton down, then drag( this is called “Left-dragging”)
the mouse over the object. As you do so, a “box”
formed by a dotted line will expand to enclose the
object. When the entire object is enclosed within the
“box”, release the mouse button; handles display on
the object to show that it has been selected. You must
position the cursor relative to the object so that when
you Left-drag over it, the entire object will be en-
closed within the “box”; if it is not, then the object
will not be selected. This method is most useful when
selecting multiple objects, described below.

[Selecting an Object from Overlapped Objects]

(1)While holding down the[ctrl] key, click on an Object
to be selected.
That Object’s handles will appear to reveal it has been
selected.

command’s Tag Mark check box
beforehand.

When selecting grouped objects,
click on any one of the objects in a
group to select the group.

A Part’s Label can be selected in-
dependently from the Part.

Click on a Part to display its handles
and then on its Label to display the
Label’s handles. After selecting the
Label, it can be moved or scaled in-
dependently from the Part.

Numeric Display and text can also
be selected using the above-men-
tioned steps.

Left-dragging over only a part of the
object will not select it. The entire
object must be enclosed to select it.

When you wish to select another ob-
ject without de-selecting the previ-
ous one, hold down the key
while making the next selection.
This can also be done continually
to select multiple objects.
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B How to Select Multiple Objects
Use this operation to select multiple objects. All the objects in a designated area or
on the entire screen can be selected. Also, if necessary, some of these objects can be

de-selected.
PROCEDURE REMARKS
[Selecting Multiple Objects by Dragging] To select a Tag, check the [Option]

(1)Left-drag over objects as described in Selecting an ment s ’[Screen Property]
Object by Dragging (see above). Be sure to enclose command’s Tag Mark check box
all of the objects to be selected completely:; if part of | Peforehand.
an object is not enclosed within the “box”, it will not
be included in the multiple selection. Handles will

display on the objects that have been selected. Left-dragging over only a part of an
___________ object will not select it. The entire
:C\ : object must be specified to make
| | selection possible.
| _// | p
| |
l __________ -

f% When two or more objects are se-

lected, the [Change Attributes]
command cannot be used.

The editing commands available
depend on what objects have been
selected.

[Selecting All the Objects on a Screen]

(1)Select the pull down [Edit] menu’s [Select All Ob-
jects] command. All object handles will appear, to
show that they have been selected.

-
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PROCEDURE REMARKS

[Excluding Objects From A Multiple Selection]

(2)When multiple objects are selected, to de-select an
object while preserving the selection of the other ob-
jects, first move the cursor over the object; then, while
holding down the[shift] key, left-click on the object.
When the object’s handles disappear, that object is
no longer selected. Repeat this process as many times
as desired.

[Adding Objects To A Multiple Selection]

(2)When multiple objects are selected, to add an object,

either left-click on the object or Left-drag over it,
while holding down the key.
The imaginary “box” that encloses the multiple selec-
tion (represented by its” own handles) will expand to in-
clude the added object , which now has handles Using
this process, you can add as many objects to the multiple
selection as you want.
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PROCEDURE REMARKS

[Selecting One Object in a Multiple Selection]

(2)First, make a multiple selection; then, click on the

Selection Tool box’s icon. All the objects in the
multiple selection will become de-selected, except for
one.

If you wish to re-select all the
objects originally in the multiple
selection, click on the Selection

I [ Tool box’s |T button.

(3) Use the [« |and = |icons to “scroll” through all the
objects originally in the multiple selection; clicking
on these arrow keys will change the selected item,

one at a time. Clicking on the [ ]icon will select

the next object, and clicking on the [« |icon will
select the previons object , inthe order that they

were drawn. To select an Object from over-

lapped Objects.

W How to Select a
Single Object
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PROCEDURE

REMARKS

[Selecting Objects by Type from a Multiple
Selection]

(2)First, make a multiple selection; then, click on the
Selection Tool box’s icon.
Selection handles will appear for only one type of object
(here, only square objects are selected), while an outline

remains around them all. This will effectively de-select
any objects that are not the currently selected type.

(3) Use the[«]and [[> | icons to select a different object
type.
As you press either arrow key, the selected object type
will change.

Objects are classified as follows:
Parts: by each type,

Objects: by each type,

Tags: All as one type,

Loaded Screens and Marks: All as
one type, respectively.

To re-select all the objects originally
in the multiple selection, click on

the Selection Tool box’s [ a1 |
button.
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2.4 Object Editing

@ Moving Objects

)

In this section, the procedures for moving objects are described.

B How to Move an Object

PROCEDURE

REmMARKS

(1)Click on the desired object. The object’s handles will
appear, showing that it has been selected.

(2)Place the cursor over the object, away from the
handles, and after the cursor changes to &>, drag it
to the desired location.

&

ST 2.4.1 Selecting
Objects

The keyboard’s , , ,and
keys can also be used when the
object’s handles are displayed.

If an object is too small to select
and move (i.e. it is only scaled up
or down), click on and drag the ob-
ject while holding down the[ Alt |
key.

Also, you can move the object by
zooming out the screen or using the
keyboard.

1.3.2 Display Area
(50%, 100%, 200%)

To cancel the movement, click on

the ||« icon.

%te: - To move an object horizontally or vertically, do so while holding the [Shift]
S key down. In this case, the object will be moved in either the horizontal or
vertical direction where the moving distance is greater.

- To move and scale up/down an object, designating its coordinates can be

used.

SEEETITIK 2.4.15 Changing Coordinates
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@ Scaling Up/Down ]

Scaling means changing the size and proportion of an object. This function
allows you to easily scale an object up (larger) or down (smaller). Be sure
the object’s handles are displayed as ().

M Scaling An Object

PROCEDURE REMARKS

(1)Click on the object to select it. The object’s handles | SETITTINTIK.2.4.1 Selecting
will appear to show that it is selected. Objects

(2)Place the cursor on an object’s handle, and after the

Re-sizing will depend on which
handle is dragged:

double arrow cursor appears, drag the handle to re- | EX. To scale a square up or down:

size the object.

o4 Right/Left handles = horizontally

Corner Handles = proportionally
Top/Bottom handles = vertically

Place the cursor on one of the
handles of the object. When the

| cursor becomes «, use the

T keyboard’s either [1 |, [=],[<], or

down in the unit of dot.

Q key to scale the object up or

= E To cancel the re-sizing, click on the

w3 | icon.

- When re-sizing an object while holding down the key, lines will snap to

45 degree intervals, Rectangular and Scale (Linear) objects will become
square-shaped objects, and ovals will become circles. Also, if the key
is held down, all selected Lines, Rectangles, Ovals, Scales, Text and loaded
Marks will scale up or down proportionately.

- When scaling a Part with a Label, holding down the key causes the

Label to scale up or down together with the Part.

- When selecting an oblique line, 8 handles will be displayed. Click on the

line again and 8 handles will change to 2 handles, one at either end. Click-
ing and then dragging on one end’s handle “fixes” the opposite end in place,
and “releases” the dragged end, and allowing the line to pivot freely.

- Multiple parts may be selected and then scaled up/down. However, the

following parts are not scaled up/down, but their positions are moved:

- Half-pie Graphs, Pie Graphs, Meters, Trend Graphs, Alarms, Keypads, and

Picture Displays.

- To move and scale up/down an object, designating its coordinates can be

used. ST IK 2-4.15 Changing Coordinates

- When scaling the text with the Image Font, the text alone may exceed the

scaling range.
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B - |

Here, the procedure for “cutting” an object (deleting it) and placing it on
another screen, is explained. The object can also be placed elsewhere on the
same screen, instead of using the Move procedure described in section 2.4.2.
In addition, an object can simply be “cut” (deleted), and not placed any-
where. (When an object is “cut”, it is stored in the Clipboard™.)

W Cutting (Moving) an Object

PROCEDURE REMARKS

(1)Select an object. SAOTTTTIK 2.4.1 Selecting
O Objects

(2)Select the [Edit] menu - [Cut] command, or click on | To cancel the Cutting, click on the

the icon. [ | icon.

Then, the selected object will be cut.

(3)Open the object’s destination screen, and select the

[Edit] menu - [Paste] command, or click on the

icon.
Then, the outline of the object cut from the previous
screen will appear.

(4)Position the cursor and click on the point where the | To cancel the pasting, click on the
object is to be placed. icon.
The object that had been Cut from the previous screen
will be “pasted” at the new location.

S

*1 An area where text, graphics, or both, that have been Cut or Copied, are temporarily
stored. The contents of the Clipboard can be “pasted” (copied from the Clipboard)
using the Paste function. However, once the Copy/Cut command is executed, the data
stored in the Clipboard is replaced; therefore, only the data from the most recent Copy/
Cut command can be pasted.
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BED <

)

Here, the procedure for “copying” an object (without deleting it) and placing
it elsewhere, is explained. (When an object is “copied”, it is stored in the

Clipboard™.)
B Copying an Object

PROCEDURE

REMARKS

(1)Select the desired object(s).

(2)Select the [Edit] menu - [Copy] command, or click
on the [Ba| icon.
The selected object(s) will be Copied to the Clipboard.

(3)Select the [Edit] menu - [Paste] command, or click

on the icon.

Then, the outline of the object copied from the previous
screen to the Clipboard will appear.

(4)Position the cursor and click on the point where the
object is to be placed.
The object stored in the Clipboard will be Copied to the
specified location.

L2

—3
i
u

.

SABEOTITIK 2.4.1 Selecting
Objects

To cancel the Copying, click on the

2 icon.

When “pasting” the Copied object
on another screen, be sure to open
that screen first.

Selecting and dragging an object to
anther screen while holding down
the key can also be used to
copy the object.

To cancel the pasting, click on the

icon.

*1 An area where text, graphics, or both, that have been Cut or Copied, are temporarily
stored. The contents of the Clipboard can be “pasted” (copied from the Clipboard)
using the Paste function. However, once the Copy/Cut command is executed, the data
stored in the Clipboard is replaced; therefore, only the data from the most recent Copy/

Cut command can be pasted.
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2.0 I )

Here, the procedure for “pasting” an object, that has been Copied (or Cut) to
the Clipboard™, is explained.

B Pasting an Object

PROCEDURE REMARKS
(1)First, Copy (or Cut) an object. AR 245 Copy

(2)Select the [Edit] menu - [Paste] command, or click

on the icon.

Then, the outline of the object copied from the previous | To cancel the paste, click on the [
screen to the Clipboard will appear.

icon.

(3)Position the cursor and click on the point where the
object is to be Pasted.
The object stored in the Clipboard will be Pasted to the
new location.
When an object is copied from an-
other screen, it will be automati-
cally placed at the same coordinates
as its original ones. To place the
object at different coordinates,
move it after this automatic place-
ment.

*1 An area where text, graphics, or both, that have been Cut or Copied, are temporarily
stored. The contents of the Clipboard can be “pasted” (copied from the Clipboard)
using the Paste function. However, once the Copy/Cut command is executed, the data
stored in the Clipboard is replaced; therefore, only the data from the most recent Copy/
Cut command can be pasted.
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@ Duplicate ]

This command allows you to easily make multiple copies of any object. The
address of the copies can be set up so as to increment automatically from
copy to copy, or simply reuse the address of the original object.

B Duplicate Setting Dialog Box

When this command is used, the Duplicate dialog box for entering the copy
specifications, will appear as shown below.

Duplicate
Enter the number | ooy —x—
. . T ]| Columns E’%
of copiesinthe X (4. =g |E==1| When copying Parts or Tags
and Y directions —=——— =/ that require addresses, clicking
_— s S here will automatically assign
H Yertical = [Pixels] .
Enter the line | e new, incremented addresses for
H H T —
spacing, In i each copy
dot units 0l gm
gl oM .
Designates pB 5@ The device comment correspond-
; ; — ing to an address assigned by the
direction of copy : ' : _

) e automatic address increment is
placement, from cena [ 5 ’ - ;
original object T reflected in the Description field.

“Alizs addresses are not incremented.

€ Number of Copies

Here, how many times an object will be copied in the X and Y directions is
entered. When “1” is entered for either direction, copying will not be
performed in that direction.

N' . The number of copies that can be made will depend on the original object's
2] position (on the screen), size, spacing and copy direction selected.

@ Spacing

Enter the spacing interval of dot (screen pixel) units to be used when the
object is copied for both the Horizontal and Vertical directions.

When Duplicating an object, its positioning will be decided based on the top
ﬁ&e: left handle of the copied (master) object. However, if a Bar Graph’s handles
2] are located in a graph display area, the object will be placed based on the
graph display area, not the graph’s border. Therefore, when setting the
spacing, be sure to not overlap any of the graphs’ borders.

@ Copy Direction

This feature makes multiple copies, starting from original object's upper left
"handle”. It also designates the direction and positioning of the placement of
the copies. The copy direction is shown by the arrow in each of the selection
boxes. If the [Address Increment] feature is selected, each new object/copy
created will be given a new address, based on the address entered for the
original object.
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& Address Increment

To copy multiple tags and parts, specify the direction of the automatic
address increment. According to the automatic address increment, consecu-
tive Addresses will be assigned in the direction designated by the [Copy
Direction] feature. When the original object’s Address is a Bit Address, the
automatic address increment is performed in the unit of bit, and when it is a
Word Address, the automatic address increment is performed in the unit of
word.

If the automatic address increment is not used, tags and parts will be copied
using the same address as their original ones.

E.g.) When duplicating with the settings shown below:

D uplicate:

(]

ENumber of Copy-

3
=
|4 Columns 44%
Cancel
| ¥ Rows JE= —]
Hep
Horizortal nm 'l: [Pivels] =Eaaaa E-1-1-1-F§ =aaaaz =Eaaaa3
Vertical ]ZU—E[PWS]
Copy Director
wBE gl
pE gl
oB ol
nE i
| ¥ Address Increment
Addofset [T
1] Apply Devios Comment
“blias addresses are notincremerted.
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@ Reflection of Device Comments

When the [Apply Device Comment] check box is marked with a check, the
device comment corresponding to an address assigned by the automatic
address increment will be reflected in the Description Field. For tags desig-
nating multiple Addresses and Parts, however, the device comment corre-
sponding to an Address designated as the Reflected Description Address is
reflected. The Reflected Description Addresses for different tags and parts
are shown in the table below:

<Reflected Description Address Table>

Object name

Automatic input Automatic input Automatic input

Object name Object name

address address address
A-ta Monitor w ord R-ta Lam Bit address
g address g P
a-tag Monitor w ord S-tag Word address 4-state Lamp Lamp Address 1
address
C-tag T-tag (bit) Bit address Bar Graph Word address
D-tag Word address T-tag (word) Word address Pie Graph Word address
d-tag Word address T-tag (special) Half-pie Graph Word address
E-tag Word address t-tag Bit address Tank Graph Word address
F-tag Word address Tih-tag Meter Graph Word address
G-tag Word address Tiw -tag Trend Graph Channel 0 word
address
g-tag Word address U-tag Word address Keyboard
H-tag Start bit address U-tag (high-speed) |Bit address gzy;l:d Input Word address
I y
J-tag Word address V-tag Alarm Word address
K-tag Word address v-tag File Name Display
. . Data Logging Block number
k-t W-t bit Bit address
a0 ag (bit) l Display designated address
L-tag . -
Start bit address W-t d Word address N Displ Word address
(direct/indirect) ag (word) umeric Uisplay
!.-te}g (without . Word address W-tag (special) Start bit address DfataTransfer Word address
indirect start bit) Display
L-tag (state) Word address X-tag (bit) Bit address CSV Display Word address
1-tag Word address X-tag (word) Textscreen word F|.Ie Manager Word address
address Display
M-tag Start bit address Trend channel Word address Message Display |Word address
M-tag (wnhout Word address Data sampling Sampling address Date Display
start bit)
N-tag Word address Bit Switch Operation bit address|Time Display
n-tag Word Switch Word address Graphic Display Bit address
P-tag Word address Function Switch Window Parts Word address
Q-tag Toggle Switch Operation bit address
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B Duplicating

2.4 Object Editing

PROCEDURE

REmMARKS

<When Duplicating a Switch 5 times in both
the X and Y directions>

(1)Select the desired object.

(2)Select the pull down [Edit] menu’s [Duplicate] com-
mand.

(3)Enter the number of copies to make in the X and Y
directions, spacing between copies.
If desired, click on the Address Increment check box, to
increment addresses automatically.

Duplicate

=MNumber of Copy:

ﬂCo\urﬂns E’%—‘ = Enter 5
| Rews ]5— =

I

- Spacin

—_
Harizontal [0 E],’Z [Piveks]
Vetiosl [T % [Finels]

=Copy Directon:
wB o

| ———Enter5

ol o
o8 o
o8 o

| iz Increment t
sddOffset 1=

1] tipply Device Commen t

"Alias addiesses are not incremented

(4)Click on the button to duplicate the object.

When dup
tioning wil

ter) object.

To stop dup
key.

licating an object, posi-
| be decided based on the

top left handle of the copied (mas-

To cancel the duplication, click on

the icon.

licating, press the
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m Delete

)

Here, the procedure for deleting an object is explained.

Bl Deleting an Object

PROCEDURE

REMARKS

(1)Select an object.

o

(2)Select the pull down [Edit] menu’s [Delete] command. | Instead of selecting the [Delete]

command, the computer

keyboard’s key can also be
used.

To cancel the deletion, click on

the ||« icon.
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m Align ]

Here, the procedure for aligning and centering object(s) are explained.

B Alignment Dialog Box

Alignment
Resets the X axis
Shows the [OFH—a%—] .
current align- l:l — settings
ment settings —— — Aligns above the
A X axis
O — Aligns on the X
axis
Resets the Y - — | ™ Aligns below the
axis settings E M'g” X axis
/
Aligns to the left Aligns on the Y Aligns to the right
of the Y axis axis of the Y axis
W Aligning Object Positions
PROCEDURE REMARKS
(1)Select all the desired objects to be aligned. AT 2.4.1 Selecting

B - — = — e - — — - = N
! | Objects

(2)Select the [Edit] menu - [Align] command, or click
on the icon.

(3)Select the type of alignment from the Alignment dia- | While an individual label can be
log box. aligned, groups of labels cannot.
In this example, select the [ma | icon (X-axis: Bottom) | (Click on an object to select its

and do not select any vertical (Y-axis) position. handles and then C,I'Ck on its Label
to select the Label’s handles.) Text

b characters on both Numeric or other
[ types of Displays can be aligned in
[ the same manner.
mAO || To gllgn objects, comblne the se
lections shown below:
(3] - i Horizontal position: Up, Center,
Bottom
(4)Click on the button to align the objects. Vertical position: Left, Center,
¥rey Scrof fext Sorn ﬁj_iﬁ_'ﬁ_Eﬁ@,': To cancel the alignment, click on
== == == - = =

the ||« icon.
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m Rotate Left/ Rotate Right ]

With this command, an object can be rotated in 90° increments. However,
loaded Screens and Marks, some Tags, and grouped objects cannot be
rotated.

B Rotating an Object Counterclockwise (Left)

PROCEDURE REMARKS
(1)Select an object. ST 2.4.1 Selecting

Center Objects
The center point of the object is

) where two lines, connecting the
(2)Select the [Edit] menu - [Rotate Left] command, or opposite handles (other than the

click on the [£5icon. corner handles), cross.

The object will be rotated counterclockwise 90 degrees, . Center
relative to its center point; if necessary, repeat the com- ! point
mand. AR N

907 Rotation To cancel the rotation, click on the

,‘\ icon. (Clicking on the [] icon
one time reverses one 90 degree ro-
tation.)

If an object is moved outside the
drawing area by rotating, the object
will not be displayed on the GP
screen.
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B Rotating an Object Clockwise (Right)

2.4 Object Editing

PROCEDURE

REmMARKS

(1)Select a desired object.

EECenter

(2)Select the [Edit] menu - [Rotate Right] command, or
click on the icon.

The object will be rotated clockwise 90 degrees, relative
to its center point. If necessary, repeat the command.

SEOTTEIK 2.4.1 Selecting
Objects

The center point of the object is
where two lines, connecting the
opposite handles (other than the
corner handles), cross.

Center
__point

To cancel the rotation, click on the

[<]icon. (Clicking on the [] icon
once reverses one 90 degree rota-
tion.)

If an object is moved outside the
drawing area by rotating, the object
will not be displayed on the GP
screen.
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m Mirror X/ Mirror Y

)

An object can be moved symmetrically around its center line with respect to
the X or Y axis. The display position of Tags, Parts, Text, Load Screens, and
Load Marks can only be moved symmetrically.

B Moving Symmetrically along the X-axis

PROCEDURE

REMARKS

(1)Select an object.

/ Center

(2)Select the [Edit] menu - [Mirror X-axis] command,

or click on the [[&]icon.
The object will move symmetrically with respect to the

X-axis.

SABOTNEIK 2.4.1 Selecting
Objects

The center point of the object is
where two lines , connecting the
opposite handles (other than the
corner handles), cross.

Center Point/Line

| |
If an object is moved outside of the
drawing area by using the Mirror
X function, the part of the object

outside the drawing area will not
be displayed on the GP screen.

To cancel the change, click on the
[ icon.
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2.4 Object Editing

B Moving Symmetrically along the Y-axis

PROCEDURE

REMARKS

(1)Select an object.
I

———— Center

<

(2)Select the [Edit] menu - [Mirror Y-axis] command,
or click on the @] icon.
The object will moves symmetrically around the Y axis.

>

SAEETITK 2.4.1 Selecting
Objects

The center point of the object is
where two lines, connecting the
opposite handles (other than the
corner handles), cross.

Center Point/Line

If an object is moved outside of the
drawing area by using the Mirror
Y function, the overflowing part of
the object will not be displayed on
the GP screen.

To cancel the change, click on the

icon.
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m Group/Ungroup ]

This function can be used to “group” multiple objects, enabling you to
manipulate the “group” as a single object, even after changing screens or
using a different editing function.

B Grouping Objects

PROCEDURE REMARKS
(1)Select the objects to be Grouped. AT 2.4.1 Selecting

Objects

(2)Select the [Edit] menu - [Group] command, or click | To cancel the Grouping, click on the

on the icon. icon.

%[e; - When a Part is included in a group, its handles appear as [], so that the
2 individual Part cannot be scaled up/down independent of the group. Thus,
you must first ungroup the objects in order to scale any individual object.

- When a Part is included in a group, double click on the group to bring up
the Confirm Device Address dialog box, where address changes can be
made.

2.4.14 Changing Attributes
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B Ungrouping Objects

2.4 Object Editing

This function changes a Group of objects to a selection of multiple objects.

PROCEDURE

REMARKS

(1)Select a group of objects.

(2)Select the [Edit] menu - [Ungroup] command, or click

on the icon.

ST 2.4.1 Selecting
Objects

To select a group including tags,
place a check mark in the Tag check
box in the Select Tool Box.

To cancel the ungrouping, click on

the icon.
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m Bring to Front/ Send to Back ]

When graphics and Parts overlap each other, you can change the order of the

layers with these two commands.

B Changing the Order of Overlapping Objects

PROCEDURE

REMARKS

In this example, you will move the oval, partially hidden
by the rectangle, to the front.

[Bringing an Object Forward]
(1)Use the cursor to select the filled oval.

(2)Select the [Edit] menu - [Bring to Front] command,
or click on the icon.

[Sending an Object Behind]
(1)Use the cursor to select the black rectangle.

'

(2)Select the [Edit] menu - [Send to Back] command, or
click on the icon.

SEOTTIEIK 2.4.1 Selecting
Objects

To cancel the movement, click on

the icon.

To cancel the movement, click on

the icon.
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m Changing Attributes ]

Here, you can change any of an object’s attributes, i.e. its color, address, etc.
Also, with objects of the same type, you can change the same attribute of all
the objects of that type at the same time.

B Changing Attributes

PROCEDURE REMARKS

(1)F|rs'F, select an ob_Ject, to change its att_rlbutes_. _ AT 2.4.1 Selecting
In this case, an unfilled rectangle drawn with a solid line. Objects

E:::E While the attributes of Grouped ob-
jects generally, cannot be changed,

(2)Select the [Edit] menu - [Change Attribute] command, | the same type objects can be

. - hanged at the same time. When
or click on the |r'Ij icon. ¢
Grouped Parts have been selected,

only their addresses can be
(3)Select a new attribute from the dialog box. y

. changed.
Here, a dotted line is selected. g o
Sauare/Rectangl OGO IK BConfirming Ad-
quare. ectangle x|
B[] e ox dresses
38 Eﬁm@;l Cancel
| — | | || e | Y |
EE=ES Instead of clicking on the [gF] icon,
| | ] 0] Bk ) - '
[gi :%%E Bk simply double-click on the object

when selecting it, to display the At-
(4)Click on the button to register your change. | tribute Settings dialog box ( skip

step {2}).

Square/Rectangle |||
@] g [ o To cancel the attribute changes,
5O _ K . _ .
290y Comof ol [ Cancd | click on the button in the
=S dialog box.
[Fg EREJEEC0 O Even after clicking on the
ts MNEONNCC) 5D _

g [ o« ], you can reverse the at-

tributes changes (only for the most
recent change) by clicking on the
icon.

%te: You can select more than one object of the same type and change the at-
tributes of each, at the same time. With all the desired objects selected, click

on the Tool box’s button; then, proceed with step (2).

SOOI 2.4.1 Selecting Objects, B How to Select Multiple Objects,
[Selecting Objects by Type from a Multiple Selection]
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B Confirming Addresses

If a Part that requires an address has been grouped, the Confirm Device
Address dialog box shown below will appear whenever its attributes are
changed; the Part addresses are changed here.

Allows you to view either the Bit or Word Addresses of
all the Parts in the currently selected group of objects

Confirm Device Address

 Bit Address

Part Addresses are —_]

. ™| Address " Function "Paits Name “Part 1D "Description
displayed here b<00000 | Bit Set{Operation Bit)| Bit Switch BS_001
00042 Bit Set{0peration Bit)| Bit Switch B5_002

Check this box to
automatically
change all the
addresses of the
Parts in this group
that have the same 0K || concel ][ Heb
Device Address

& Bit and Word Addresses

Each Part’s address is displayed. To change an address, click on the inside
of each cell. As shown above, any Switches selected that have state changes
will have both their Operation Bit and their Monitor Bit addresses displayed.

€ Address Range Conversion
When an address is changed and this check box is checked, any other Part
with the same device address will be automatically changed.
In the example above, if the first bit address is changed from X00000 to
X00010, the following bit addresses will be changed as below.

Confirm Device Address

" Bit Adldress |

licki ;.@d_die_ss_ __ " Functioh "Parts Name "Part 1D " Description
Clicking on any || A00000 | Bit Set{Operation Bit)|Bit Switch BS_D01
cell other than the = | |xoonsz Bit 5 et{Operation Bit)|Bit Switch B5_002

changed one will
show the changed
address

QK I| Cancel || Help
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2.4 Object Editing

m Changing Coordinates

Obiject positions and sizes can be changed by specifying their coordinates.

Check this check
box to change
the size.

N

Left-Top

Right-Bottam

(XAxis J475 E” ¥ s J3ﬂ E]D\

(XAxis J132 E” ¥ i Jsr E”)__

Enter the object’s
left top coordi-
nates.

~~_ Enter the object’s

right bottom coordi-
nates.

B Using Coordinates to Change an Object’s Position

PROCEDURE

REMARKS

(1)Select a desired object.

\%

(2)Select the [Edit] menu - [Change Coordinates] com-

mand.

(3)Enter the object’s left top and right bottom coordi-
nates.

Right-Bottom

(4)Click on the button to execute the command.

&

NEOTTNEIK 2.4.1 Selecting
Objects

To change the size, check the
Change size check box in step (3).

To cancel the coordinates change,

click on the button.

To undo the coordinates change,
click on the icon.
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m Editing the Node of a Multi-segment Line ]

Creating, Editing, or deleting a node can be performed on a multi-segment
line and a filled polygon.

JMode Edit

The [Node Edit] dialog
displays.

Deletes the selected peak.

.
— | Adds a node. The added
| node is the same as the

selected node. If the screen
capacity is exceeded by the
added value, the [Insert in
Front] and [Insert in Back]
buttons are highlighted and
[0 [ concel [ e | ' cannot be specified.

If the node edit is selected, the selected point
in the displayed dialog is marked with a
Cross.

B Editing a Node on a Continuous Line

PROCEDURE REMARKS

(1)Select the desired continuous line.

SEOTTIK 2.4.1 Selecting
(2)Select [Node Edit(K)] from [Edit(E)]. Objects

(3)Select the coordinate value that you want to edit.

(4)Click onthe _ Edt | button.

(5)Enter the X/Y coordinate values in the coordinate
change dialogs.

Node Edit

* 183 =

™ -
v

(6)Click on the button to run the coordinate | T0 cancel the coordinate change,
change. Click on the button.
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m Transferring a Screen to the Clipboard ]

The current screen is transferred as an image to the clipboard™. The trans-
ferred screen can be utilized by pasting it to other drawing software. The
screen types that can be transferred to the clipboard are the Base (B) screen,
Mark (M) screen, Trend Graph (T) screen, Keypad (K) and Window (U)
screen.

W Transferring a Screen to the Clipboard

PROCEDURE REMARKS

(1)Select the [Screen to clipboard] command from the
[Edit] menu.
The current screen will be transferred to the clipboard.

(2) Paste the screen to other drawing software.

_

O
I O T

*1 The clipboard is a storage location where copied or cut data is temporarily stored. The
data stored on the clipboard can be copied or moved by pasting it.
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@ Converting a Screen to a Bitmap File ]

The current screen is converted into a bitmap file, and then saved. The
screen types that can be converted are the Base (B) screen, Mark (M) screen,
Trend Graph (T) screen, Keyboard (K) and Window (U) screen.

Usage Pattern
. Specify how to
[Edit] - [_Screen.to - .[Settm.g . save the bitmap
bitmap file] bitmap file] file.
: [Screen to [Setting
= B = pimapfile] ~  bitmap file]

B Designating a Bitmap’s File Name

Before converting the screen to a bitmap file, specify how to save the bitmap
file.

Specify a file Setting bitmap file name

name and output ~
destination to N\ Prompt for filename when saving

save the file. /(Eai&utomatically create file nams B Specify how a
] File Name type file name is to

1% Type + Mumber BMP be created
automatically.

Automatically
creates afile
name to save the i Type + Mumber + Comment .BMB

file. Output Folder
/JE:\PHDEH.&.M FILES4PRO-FACESFRO “ " Browz

Specify an output ] _ _
destination of the | oK. ] | Cancel \ | Help \
file when a file
name is being
created automati-
cally.

€ Prompt for filename when saving
When the [Screen to bitmap file] command is executed, the Save As dialog
box will appear, where you can specify the location and name of the file to
be saved.

€ Automatically create file name

When the [Screen to bitmap file] command is executed, a file name will be
created automatically, and the file saved in a previously specified location.

Example: If the No. 1 screen of the Base (B) screen named “Menu” is
converted into a bitmap file:

Screen type + number.BMP —> B1.BMP
Screen type + number + screen title. BMP —> B1 Menu.BMP

%fe.' When automatically creating a bit map file with a screen title, if one of the
el following symbols "\, /: ; *? " <> |" is used in the screen title, Windows"
cannot create a file. Prior to using this feature, be sure your screen titles do
not contain any of these characters.
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2.4 Object Editing

B Converting a Screen into a Bitmap File

PROCEDURE

REMARKS

(1)Select the [Setting bitmap file] option for the [Screen
to bitmap file] command from the [Edit] menu.

(2) Select a method for saving the bitmap file, and es-

tablish it by clicking on the button.

Selting bitmap file name
£ Prompt for flename when saving
%) Automatically create file name

File Mame type
% Type + Number .BMP
£ Type + Number + Carmmert BMP

Output Folder
JC:\PHDGHAM FILESWPRO-FACENPRO ] Erawz

|- ak k—l | Cancel | | Help |

(3) Select the [Screen to bitmap file] option for the [Screen
to bitmap file] command from the [Edit] menu.
When a file name is created automatically, the bitmap
file is saved now.

(4) If [Prompt for filename when saving] was selected in
step (2), specify a file name and output destination,

and then click on the button.

Save As .
Save in: I &) database Uz” ﬂ; e
zmall.brmp
rmap.bimp
File name: I|tes t.hrnp || Save
Save as ype: IB|tma|:| file(* bmp) lE” || Cancel

Save the source screen before per-
forming the conversion. If the
source image has not been saved,
the bitmap file cannot be created
automatically.
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m Redraw Screen |

This command updates the current drawing area display to reflect the latest
drawing data. When the Auto Redraw feature is not used, filling and editing
objects can cause after-images to remain on the screen. Use this function to
remove these images and show the screen as it will appear on the actual GP
display.

B Redrawing a Screen

PROCEDURE REMARKS

Sometimes, when removing an object’s filled color, only
the fill point area’s color will be removed, resulting in a
small, non-colored square.

Point \/
where fill E:>

began

Fill point is deleted

(1)Select the [Edit] menu - [Redraw] command, or click

on the icon.

The screen will automatically be refreshed and all the
fill color will be removed.
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@ Undo ]

With this function, an operation can be “undone” and the screen display
returned to the previous condition. Every time the icon is clicked on,
depending on memory, previous operations will be undone, in succession.

A
y/

! .  The Redraw Screen function cannot be undone.

Important

W Canceling an Action

PROCEDURE REMARKS

In this example, a circle has been accidentally deleted.
(1)Select the [Edit] menu - [Undo] command, or click | To cancel the Undo operation,

on the [«] icon. click on the icon.

The circle will reappear and the screen is displayed as it 2.4.21 Redo
was prior to the deletion.

O

@ Redo ]

With this function, an operation previously undone with the Undo command
can be “redone”, if performed immediately after the Undo command is used.

B Redoing the Previous Undo Command

PROCEDURE REMARKS

In this example, the undone circle deletion will be re-
done (i.e. deleted again).

(1)Select the [Edit] menu - [Undo] command, or click

on the icon.

The circle will reappear.

(2)Select the [Edit] menu - [Redo] command, or click on To cancel the Redo operation, click

the _icon. on the [&] icon.
The circle will disappear.
SEOTTTTIX 2.4.20 Undo
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a Libraries

The objects you created can be registered. These registered objects are
called “Libraries”. You can call up and use the registered Libraries, when-
ever necessary. Like a pre-made Part Shape, the objects registered in these
libraries can be viewed and selected using the Browser function.

Multiple objects can be combined and registered, and Marks created on
Mark screens can also be registered.

3.1 Creating a Mark: the Mark Screen
These items are stored in a Library file (CPW file), separate from Project
(PRW) files . When library data is a Mark, it will be saved in a Mark Li-
brary (MRK) file. Moving from one Library file to the other allows objects
to be called up that were previously used in a variety of screens and Project
files.

To call up an item from a Library, or save an item to a Library, either select

one of the tool bar’s icons or use the pull down menu’s [Library]

commands.

With both Base and Mark screens open, when the Base screen where the

., Library Browser is remained open is changed to the Mark screen, the Mark

Library Browser cannot be open on the Mark screen. When changing the
screen, first close the Library Browser and change the screen, and then open
the Library Browser on the newly opened screen.

Objects called up via the [Load Screen], [Load Mark] or [Window Parts (W)]
command, as well as D-script cannot be registered.

B Library Browser

When either or icon is clicked on, the Library Browser will appear.

Displays the currently selected item’s registration number and title;
clicking on the triangle brings up a list of the items in the current
library

;a0 [0pd-ib1.cpw : Data Input equipment]

Menu Bar Fils Edit View ‘Window H
Tool Bar ’ﬁ'@ BHEE ‘1:33tate SW word [I;'_[

Reverse video

indicates that Scrolls

this item is through

currently se- the differ-

lected ent items,
either left,

Displays the right, up,

item’s registra- or down

tion number

and title 4: Rotary SW bit3 |||5: Rotary SW word ||| 6: Rotary SW bitd

Status Bar hfviewing All Dbjects 4
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W Editing Library Items
Three Library Item editing functions are available.

g@i Cuts a Library item (which is then moved to the Clipboard); the
Library item can then be moved to another screen using the [Paste]
function.

Copies the selected Library item to the Clipboard.

E Pastes the Library item Cut or Copied, and temporarily stored in the
Clipboard, to another screen. The Library item can also be Pasted to
another Library file.

You can remove a Library item using the Delete function. To do so, select
the [Delete] command from the Library dialog box’s pull down [Edit]
menu.

SEEOETNEEK 2.5.3 Editing Library ltems

B Changing the Library’s Display

The Library’s image display size and type can be changed. Also, you can
change from one Library file to another.

@ Library Size
| or @ icon is clicked on, or the pull down

When either the ]

[View] menu’s either [Normal], [Adjust to Fit], or [Full Screen] command is
selected, and the Library display size can be changed. When Normal is
selected, each Library size will be displayed relatively, allowing you to
check the relationship between Libraries for their size. When the Adjust to
Fit function is selected, the Library item will be enlarged until it fits inside
the Library window’s borders. When Full Screen is selected, the Library
item will be displayed in its actual (GP) screen size.

@ Library Type

When the pull down [View] menu’s [All Objects], [Part & Tag Objects], or
[Graphic Objects] is selected, the Library type(s) shown on the Browser can

be selected.

[All Objects] Displays all the Library items in the selected Library
file.

[Part & Tag Objects] Displays only those items that are either Parts or
Tags.

[Graphic Objects] Displays only those items which are neither Parts nor

Tags (i.e. drawn objects).
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B Switching Library Files
@ Creating a New Library File
When the icon is clicked on, or the pull down [File] menu’s [New]
command is selected, the Dialog box shown below will appear. When a
Description is input and the button is clicked on, a new Library
file will appear.
Drezcription : ._
”
@ Selecting (Calling Up) another Library File
When the icon is clicked on, or the pull down [File] menu’s [Select
File] command is selected, the Library file list will appear. By selecting
(dragging) the desired Library file from this list, other Library files can be
called up.
Moves up one file Creates a new Lists the files in
level folder summary format
Shows the select
currently Lookin: |2 cow lEﬂ 5 - Lists file
displayed file’s r— gy information
folder Sﬁj_oﬁidjcﬁw '” in detail
Opd-obje.cpw
) O pd-obif. cpw
Lists all the Dp4-obia.cpw Dp4-obig.cpw
files in the Dp4-obib.cpw Dp4-obih.cpw
currently
selected folder ] .
File parne: |Dp4-||b'| || Dpen I
Files of twpe: |Windows Library Files [* cpw) \ E | Carcel
Description : J/Datalnput equipment || \
Displays the currently selected Currently selected
file’s Description data (if any) file’s name (If
) desired, can be
Currently selected file’s entered)
format (type)
Two types of Library files are available; the Library files created using the
GP-PRO/PBIII (DOS Version) (DOS Library file: *. CPL), and the Library
files created using GP-PRO/PBIII (Windows® Version) (Windows Library
file: *. CPW and *.MRK). Select either one.
Files created using Parts Box (*. CPL) can be converted into GP-PRO/PBIII
for Windows format (*. CPW).
AN 12.1 File Converter
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B Modifying Library File Names (Titles)

Library filenames can also be changed. Simply select a library from the file
list, then select [Property] from the [Edit] menu, and the Property screen
will appear. Type in the filename (title) that you wish to use and click on

OK.
Diescription : ok,
|3$tate W word || || Cancel |

B Displaying the Browser at the Top of the Normal Screen

If the [Always on Top] option is selected from the [Window] menu, when-
ever the Library Browser is called up, it will be placed at the top of the
current window. If this option is not selected, selecting another screen will
place that screen over the Library screen, hiding it from view.
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@ Registering Library Items

)

Here, the procedure for registering a Library is

explained.

PROCEDURE

REMARKS

(1)Select objects to be registered as Library items.

(2)Select the [Library] menu - [Register Library] com-
mand, or click on the ] icon.

<A. When registering a new Library item to
the currently open Library file:>

(3)Enter the Library’s registration number and descrip-
tion.
In the Cell Number area, the smallest of the currently
open Library file’s unused numbers will be automati-
cally displayed. To change it, simply enter the desired
number.

Save Library

Cell Murnber :
ell Nurnber ,T

100
ol =

Drescription

|switch ”

(4)Click on the button to register the number.
The registered Library will then be displayed in the
Browser.

& [100: switch [

e |[|47: Volume SW se |||48: Volume SW cir

2.4.1 Selecting
Objects

D-scripts as well as objects called
up via the [Load Screen (O)],
[Load Mark (M)] and [Window
Parts (W)] commands cannot be
registered.

If the Library Browser is already
showing, click on either [E| or

icon in the screen editor
drawing area, and the icon in

the Library Browser, which will
perform the function of step (2).

The following procedures will
differ depending on the Library
file registered.

» When registering a new Library
item to the currently open
Library file:

» When no Library file is dis-
played:

* When registering a Library item
to a new Library file:

* When registering a Library item
to a Library file other than the
currently open one:

Up to 200 Library items can be
registered in one file.
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2.5 Libraries

PROCEDURE

REmMARKS

<B. When no Library file is displayed:>
(3)The “New” dialog box will appear.

Drescription :

When registering a Library item to a new Library file.
<C. When registering a Library to a new Library file>’s
step (5)

When registering a Library item to an existing Library file:

Click on the button.

<D. When registering a Library item to a Library file
other than the currently open one>’s step (4)

<C. When registering a Library item to a new
Library file:>

(3) Click on the button.

Save Library

EEN

Cell Murnber :

Description

|Untit\ed ”

(4)Viathe Library Browser, select the [File] menu - [New]
command, or click on the icon.

(5)Enter a comment and click on the button.

D escriptian :

|production ||

(6)Via the Screen Editor, select the [Library] menu -
[Register Library] command, or click on the @ icon.

Enter the file name when the
Library file is saved.
2.5.4 Saving Li-
braries and Quitting M Saving a
Library File Under Another Name

A comment of up to 60 characters
can be entered.

Enter a description up to 60 char-
acters.

Enter the file name when the Li-
brary file is saved.

2.5.4 Saving Li-
braries and Quitting M Saving a
Library File Under Another Name
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PROCEDURE REMARKS

(7)Enter a Cell Number and Description.
Save Library |

E_:IE" Mumber :
—

Drezcription ;
|sw1 ||
(8) Click on the button. A maximu_m of ZQO Librar)_/ items
The newly registered Library item will appear in the | ¢an be registered in each Library
Browser. file.

(il [?.cpw : production]
File Edit “iew ‘window Help

Cl= [*Fe &

After creating a new Library item,
if you attempt to create or select
another Library file without first
saving the item via the [Save
As...] function, a prompt will
appear, asking whether the newly
created Library item should be

100: switeh saved or not.

For the proce-

dures for saving a Library item, re-
fer to 2.5.4 Saving Libraries and
Quitting M Saving a Library File

<D. When registering a Library item to a
Library file other than the currently open one.

(3)Click on the button.

Save Library <]
Cell Mumber :
-4
Cancel
D ezcription : A%
[Uniitied |

(4)Via the Library Browser, select the [File] menu - [Se-
lect File] command, or click on the icon.
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2.5 Libraries

PROCEDURE

REMARKS

(5)Select the desired Library file from the list, or input
the Library file name in the file name area.

|
View.cpw

DOp4-abie opw
Opd-obit.cpe
Opd-objg.cpw
Opd-obih.cpw

— Select “Op4-
libl.cpw”.

File pame:  [Dpdibl J [ geen |

lE” ‘ Cancel

Files of type:  [windows Library Files [*.cpw]

Drata Input equiprent

Description

(6)Click on the button to display the selected
Library file.

(4l [Dp4-lib1.cpw : Data Input equipment]
File Edit View ‘Window Help

[Ol=] (20 [ F

(7)Via the Screen Editor, select the [Library] menu -

[Register Library] command, or click on the @ icon
on the Draw Tool Bar.

(8)Input a Cell Number and Description.
In the Cell Number area, the smallest of the currently
open Library file’s unused numbers will be automati-
cally displayed. To change it, enter the desired number.

Save Library

Cell Murnber :

=
Description ;
|switch ||

2.5 Libraries ®
Switching Library Files

When selecting a Library file in an-
other directory, use the [Look in:]
window.

In step (5), simply move the cursor
to the desired Library file name and
double-click on it to open it. By
doing so, the (Step 6) but-

ton does not need to be used.
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PROCEDURE

REMARKS

(9)Click on the button to r

The registered Library item will ap

R [100: switch F

e [||47: Yolume SW se ||| 48: Volume SW cir

t1]||50: Numeric Input |

B Using the Cut,

egister the item. Up to 200 libraries can be regis-
pear in the Browser. | tered in one file.

Copy, and Paste Functions

Library items can be Cut, Copied and Pasted from the screen drawing area

to Browser. First,

select the desired Library item in the drawing area, and

then either Cut or Copy it; then, Paste it to the current Library Browser.
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2.5 Libraries

@ Placing Library Items

Here, items registered in a Library file are placed on a drawing area.

PROCEDURE

REMARKS

(1)Via the Screen Editor, select the [Library] menu -
[Call Up Library] command, or click on the icon

on the Draw Tool Bar.

(3)Drag the Library item to the desired position in the
drawing area.
The Library item can be placed on any open screens,
and will be displayed in the drawing area. If desired use
the sizing handles to alter the item’s size.

=& T<]
Pats Special Libayy Window Help

™ Off State |

arts Special Libray  Window Help
e A

Y
Off State [+

Library items Cut, Copied, or
Pasted between the screen and the
Browser. Simply select the desired
Library item and perform the com-
mand.

When calling up an item from a file
different than the currently dis-
played file, click on the [&] icon to
bring up a file list.

2.5 Libraries
W Switching Library Files

The Library item’s top left corner
is the placement point.

To cancel the placement, click on
the screen editor’s [« icon.

To change a Li-

brary item’s size, refer to 2.4.3
Scaling Up/Down

Items called up are automatically
grouped. They can be freely edited
after ungrouping them by clicking

onthe icon.
2.4.12 Group/
Ungroup

Grouped library items containing
Parts cannot be scaled up or down.
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When a Library that contains Parts is called up, the Confirm Device Address
screen will appear. After entering each Part’s address, click on the

button. To cancel these settings, click on the button.
2.4.14 Changing Attributes, B Confirming Addresses

When the Library placed on the screen is double-clicked on, the Confirm
Device Address dialog box shown below will appear, allowing you to
change the Part’s previously entered addresses.

Confirm Device Address |
Bit ddress |
[ Address [ Furiction [ Parts Mame [ Part 1D [ D ezeription
00010 | Bit Set[C) Bit Switch BS_012
=00042 Bit Set [C] Bit Switch B5_013
Q] Address Range Conversion
|| ak. | || Cancel | || Help |

After a Tag is registered in a Library, if multiple identical libraries
imporant @re then placed on the screen, their Tag names will be dupli-
cated. After placing them, be sure to change their Tag names via
either their attribute dialog boxes, or the Tag List; especially if a
common start up bit has been created for a K-tag.

SO For Changing Attributes, refer to 2.4.14 Changing Attributes.

For Tag List, refer to 2.9.6 Tag List.

For K-tags, refer to Tag Reference Manual, 2. 12 K-tag
(Keypad Input).

B Using the Cut, Copy, and Paste Functions

Library items can be Cut, Copied, and Pasted from the screen drawing area to
the Browser. First, select the desired Library item in the drawing area and
Cut or Copy it; then, Paste it to the Library Browser.
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2.5 Libraries

@ Editing Library Items

)

Library Items can be edited, Deleted, Copied, Cut, or Pasted.

W Editing a Library Item
Here, a registered Library item is edited.

PROCEDURE

REMARKS

(1)Select and double-click the Library item to be edited
from the Browser.
pre _______|

] [100: switch =]

(2)Edit that Library item.

(3)Viathe Screen Editor, select the [Screen] menu - [Save]
command, or click on the ||| icon on the Main Tool
Bar.

] [100: switch =]

In order to call up a Library item
from a Library file which is differ-
ent from the currently displayed

file, click on the icon.
2.5 Libraries

B Switching Library Files

When double-clicking on a
Library item’s title, the title
editing screen will appear. (Title
Change Screen)

Description :

" || Cancel |

AlL
Important

Once an item is edited, it
cannot be Undone.
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B Deleting a Library Item
Here, a registered Library item is deleted.

PROCEDURE

REMARKS

(1)Select the Library item to be deleted from the | In order to call up a Library item

Browser.
pognt _________________________|
] [100: switch I

(2)Select the [Delete] command from the Library

Browser’s [Edit] menu.

A dialog box appears to confirm your command.

Delete

@ Are

<]

o sure pou want to delete 7

|| i]:4 ||| Cancel |

from a Library file which is differ-
ent from the currently displayed

file, click on the icon.
2.5 Libraries

B Switching Library Files

(3)Click on the button, and the Library item | ALA
will be deleted.

] [100: switch

/mportant
Once an item is deleted, it
cannot be Undone.
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2.5 Libraries

M Cutting a Library Item (from a Library File) and Pasting
Here, a registered Library item is Cut and Pasted.

PROCEDURE

REMARKS

(1) Select a Library item to be cut (out) from the Browser.
T

] [100: switch T

(2)Viathe Library Browser, select the [Edit] menu - [Cut]
command, or click on the icon.

The selected Library will be cut.

] [100: switch =]

(3)Open a desired Library file and, via the Library
Browser, select the [Edit] menu - [Paste] command,

or click on the icon.

The following steps are the same as those used for a
Library Item registration.

(4)Input the Item’s Cell Number and Description.
In the Register Number area, the smallest number in the
currently open Library file’s empty numbers will be au-
tomatically displayed. To change it, input the desired

number.
Cell Mumber :
[ oc
Drescription :
|sw1 ||

In order to call up a Library item
from a Library file different than
the currently displayed Library file,

click on the icon.
2.5 Libraries

B Switching Library Files

To register the Library item to a
new Library file, click on the
icon.

To register the Library item to a Li-
brary file different from the cur-
rently displayed one, click on the

=] icon.

2.5 Libraries

B Switching Library Files
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PROCEDURE

REMARKS

(5)Click on the button to register the Library
Item.
The registered Library will be displayed on the Browser.

File Edit View Window Help

100: switch

B Copying a Library Item

Here, a previously registered Library item will be copied.

PROCEDURE

REMARKS

(1)Open the desired Library Item’s Library file and se-
lect the Library item from the Browser.

S
I]

2] [100: switch

(2)Via the Library Browser, select the [Edit] menu -

[Copy] command, or click on the icon.
The Library item will be copied to the Clipboard.

(3)Open the destination Library file and select the [Edit]
menu - [Paste] command, or click on the Library

Browser’s icon.

In order to call up a Library item
from a Library file different than the
currently displayed Library file,

click on the icon.
SO 2.5 Libraries

B Switching Library Files

To register the Library item to a new
Library file, click on the [3] icon.
To register the Library item to a Li-
brary file different than the current

one, click on the [&] icon to call up
a list of Library files.

2.5 Libraries

B Switching Library Files
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PROCEDURE REMARKS

Hereafter, steps are the same as Library Item Registra-
tion.

(4)Input the Item’s Cell Number and Description.
In the Register Number area, the smallest of the currently
open Library file’s unused numbers will be automatically
displayed. To change it, enter the desired number.

Cell Mumber :

[ ok
Description :
|sw1 "

(5) Click on the button to register the ltem.

The registered Item will appear in the Browser.

|_u_ﬁ| [?.cpw : production]
File Edit Yiew Window Help

100: switch
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@ Saving Libraries and Quitting ]

M Saving a Library File

When a Library file’s contents are changed, the changed data will automati-
cally overwrite the old data and be saved. However, if the Library file has
been newly created, when you attempt to create or select another Library
file, a prompt will appear asking if whether the new file is to be saved or
not. When is clicked on, the [Save As...] Dialog box will appear.

MSaving a Library File Under Another Name
B Saving a Library File Under Another Name

Here, the Library File will be saved under a different name.

PROCEDURE

REMARKS

(1)Select the [Save As...] command from the Library

Browser’s [File] menu.

(2)The currently selected Library file name and its com-

ment data, if any, will appear.

Input a new file name and change the desired settings.

Save As

Save | &7 Cow “zﬂ

@] CP4-ib5. cpw Opd-objb.cpu Opd-bih cpw

@ Opd-ib1. cpw Opd-objc.cpw

) Opd-ib2. cpw O pd-abid. cpw

Q Opd-ib3. cpw Opd-ohie.cpw

[ Opd-ibd. cpw Opd-objf.cpw

@ Opd-obja.cpw Opd-objg.cpw

File name: |Dp4-lib1.cpw || || Save I

Sawve as bype: |Wind0ws Library Files [*.cpw]

Description :  [Diata Input equipment I

[Eﬂ | Cancel |

(3)Click on the button to save the Library.

When a project with the same name already exists, a
prompt asking whether the new name should overwrite

the old name will appear; to do so, click on the

button. When you do not want to overwrite, click on the

button.

Save As

iy

EEE

[x]

CAProPEWInwcpe'test cpw
This file already exists.

Feplace exigting file?

Ho

The file name can be input within
255 characters, including a path and
extension.
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W Quitting the Library Browser

PROCEDURE REMARKS

(1)Select the pull down menu [File]’s [Exit] command. | Clicking on the Library Browser’s
If a newly created Library file has not been saved yet, a | top right mark can also be
prompt asking whether the new Library file should be | ysed to quit.
saved, will appear. When the button is clicked,
the “Save As..” dialog box will appear, and when the W Saving a Li-
button is clicked, the Library file will not be | brary File Under Another Name
saved and the Library Browser will quit. Then, a Li-
brary file creation or selection screen will appear.

Library Browser

@ Do wou warntk to zave changes 7

Erves f[ Mo || Cancel
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// i
4

14
Important

m D-Script/Global D-Script

The GP-PRO/PB Il provides a special feature that enables you to create a
program to execute functions, in addition to tags. This feature is given by D-
Scripts/Global D-Scripts. The display load on the device can be reduced signifi-
cantly by creating and registering a program with D-Scripts/Global D-Scripts. D-
Scripts are used on each screen and serve as programs that are only effective on
that screen. Global D-Scripts serve as programs that are effective on all screens.

Using D-Script, you can program separately for when the trigger is activated and
for when the action is performed.

. Then, when the trigger conditions are satisfied, the script is performed. The
procedures for writing a program with Global D-Scripts are the same as those for
writing a program with D-Scripts.

For more detailed information about D-script and Global D-script, refer to the
Tag Reference Manual Tag Reference Manual, 3.1 D-Script/
Global D-Script

» D-script and Global D-script cannot be registered as Libraries.

* To set up D-scripts or Global D-scripts, open any desired Base
screen and follow the procedure below.

Usage Pattern

[D-Script] Add, Modify, or | Close or
[Special] - or [Gl_obal o Delete o the [Egc
D-Script] key

Lists the D-
Script ID S
numbers and

An example of the D-Script dialog box (the initial screen) is shown below.

Adds a D-Script

D-Seript List
DS cript Deletes a
— registered D-
- - Script
|_— Allows you to
descriptions edit the con-
’:’pr tents of a D-
— Script
Copies the
contents of a D-
Script
Help Pastes the
copied contents
of a D-Script
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B Registering D-Script Settings

Here, additional D-Scripts can be registered. When the button is
clicked on, the D-Script Editor will appear.

Enter the D-Script’s ID No. (from 00000 to 99999)

Enter a _ — _
description iD- Editor : Untitled
here o | Trigg
Descriplﬁ Y Timer Duration __— Trigger
Displays the ] 97 O D% I area
D-Script’s Show Toolbox ] st Oes
command Formula: Funchions:
tool box
—_|| Displays
The programmed defined
“actions” (com- function
mands) of the D- names
Script
Only the com-
mand portions Erter an swpression, Prass HELF for svamples. ol Mew
("actions") can be Edit |[Delete
imported/ex- Copy|[Paste]
ported as text
files (*. txt). = 1T e | e 1,

Message area (window)

B D-Script Tool Box

The D-Script tool box contains icons for D-Script commands and Statements and
constantinputicons.

Tag Reference Manual, 3.1 D-Script/Global D-Script
When the “Show Toolbox” check box is checked, the following tool box will

appear.
[-Seript ToolBox
=Functiony =———
Data Set lE”
Bit Address
Constant
Temp. Address
‘Word Address
Entry
=Statements = =0peratars =
[ || *[=T%]
EENaEa
- Compate — li<<==] &
e o Tl
<)
=
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B Definition of Functions

Programs to be used for D-Script are defined as functions. The defined functions
can called up to the activated program and used. Also these functions can be

nested up to 10 layers. When the [ir=w] icon is clicked on in the D-Scrip Editor,
the D-Script function setting screen will appear.

Enter a function
name

Enter the D-
Script’s action
(program) to
perform

Message area — |
(window)

Displays the D-Script command tool box
when this check box is checked

%]

2 D-Script Function : Untitled

| ]

Show Toobox ]

Function Name:

/

DataType:  [Bin  [*]| Datalength

Enfer an expression. Press HELP for examples.
o

6B ]| Code s

™~ Displays
defined func-
tion names

o ) Caned | Hee |

KN

%I‘e; Only alphanumerics and the “_ (under bar)” can be used for function
names; up to 20 characters can be entered.

B Importing/Exporting the ""Action" information on the [D-Script
Editor]/[D-Script Function] dialog box

Information on the program currently being displayed in the [Formula] field of the
[D-Script Editor] dialog box or in the [Formula] field of the [D-Script Function]

dialog box can be i

mported/exported as a text file (*. txt).

ported or exported.

Information on items other than [Formula] (the information displayed in
[Trigger], [Function], and Message area (window), etc.) cannot be im-

To export the information, select the [File] menu-[Export] command. When the
[Save As] dialog box opens, enter a desired file name and click the [ save__|

button.

To import the information, select the [File] menu-[Import] command. When the
[Open] dialog box opens, select the desired text file containing the program

information and cli

ckthe button.
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B Deleting D-Script Settings
Here, existing D-Script settings can be deleted. After selecting the D-Script
settings to be deleted from the listing, and clicking on the button, the
Confirm Script Delete dialog box will appear. When the button is

clicked on, the D-Script settings will be deleted. When the button is
clicked on, the deletion command will be canceled.

Confirm Script Delete

Do you want to delete this script?
id: 00000

desc: warning view

(= =

B Editing D-Script Settings
Here, registered D-Script settings are changed. After selecting the D-Script
settings to be changed from the D-Script list and clicking on the button,

an additional registration screen will appear. Click onthe button to
change the D-Script settings. To cancel the Change command, click on the

button.
- Ifthe [Save As..] function has been used to change a project
N file’s Device/PLC Type, the D-Script program will not be able to
important automatically change those addresses. When changing ad-

dresses, use the [Project | Change Device/PLC Type] menu’s
“Convert Address” feature. For details about this feature,
4.2.7 Changing Your Project’'s Device/PLC
Type and Addresses

Be sure to not use D-Script to perform any life-threatening. or

possibly damaging actions!
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B D-Script Settings: Copy and Paste

PROCEDURE REMARKS

(1) Select the pull down [Special] menu’s [D-Script] com-
mand.

(2)Click on the[ tow | button.

D-Script List

D-Script

00001 Pump ON

(3)When the button is clicked on, the D-Script | This D-Script can also be copied to
copied in step (2) will be added. The D-Script’s ID num- | another screen.

ber will automatically be assigned to the smallest num-
ber currently available.

D-Script List

D-Seript

10001 PumE [u[§] .
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B Registering D-Script settings

The method for registering D-Script settings is shown below.

Ve

N
For a temperature controller, D-Script detects the device’s error bit and displays
alarm messages when the temperature rises to 70 °C or above, or has fallen lower
than 30°C. Also, the number of the errors detected are counted.
When error bit MO001 If the temperature has risen ALARM
turns ON... to higher than 70°C, screen Over 70 deg. !!
wis B100 is displayed.
D:I:&q]] If the temperature has fallen ALARM
o to lower than 30°C, screen Under 30 deg. !!
B101 is displayed.
Also, the number of occur-
rences is counted. Above 70
Below 30
» Temperature data is stored in D200.
* When the temperature is 70 °C or more, the number of Alarms is stored
inLS300.
» When the temperature is 30 °C or less, the number of Alarms is stored in
LS301.
 The alarm display screen number is stored in LS302.
J

To display the above mentioned alarm messages, L and N-tags are used as
follows:
(1) Create the alarm message screens, B100 and B101.

(2) SetupanL Tagto display the Alarm message screen. (Direct designation,
word address: LS302)

(3) Setup an N-tag to display the number of the errors counted when the
temperature rises to 70 °C or more. (Word address: LS300)

(4) Setup an N-tag to display the number of the errors counted when the
temperature falls to 30 °C or less. (Word address: LS301)

For details concerning each Tag, refer to the Tag Reference
Manual, 1.3 Tag List.

PROCEDURE REMARKS

(1)Select the pull down [Special] menu’s [D-Script] com- | The number of D-script registrations

mand.

(2)Click on the button.
-

D-Script List

D-Seript

will be limited depending on each GP
memory capacity.

Tag Reference
Manual 3.1.4 D-Script/Global D-

Script Limitations

il g3

) Delete

" Copy

Ade

&

" Hel
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PROCEDURE REMARKS

(3)Perform settings for each item such as ID, Trigger, For- | A description can be entered of up to

mula, etc. 20 characters.

Enter 00000 Enter Alarm Display Enter MOO01 Tag Reference

“’ ; Manual, 3.1 D-Script/Global D-

o R Script

[Elaim Display G O UK 2] Jwoom ~|EE

D%t Dt

Show Toolbox 2]

Formula: Functions
1f ([w:D00200]>=70)
{
[w:L$0302] =100

>[m:LSDSDD]Z[u:LSDSDD]+1 Settlng to “bit
endif rISIngn

—
[Action Exp7n is oy

Diata Length: 6Bt ||| Code+r [
[

Edit. |[Delet:
E/ﬂ_’zl ™ Cona | Hep p
Program
if ([W:D00200] >=70)
{ //When the temperature is 70°C or higher:
[W:LS0302] =100 /[Assign screen No. 100 for the "Over 70°C" alarm message.
[W:LS0300] =[W:LS0300] +1 //The number of errors counted increases.
}
endif

if ([W:D00200] <=30)

{ //When the temperature is 30°C or lower:
[W:LS0302] =101 IIAssign screen No. 101 for the "Under 30°C"' alarm message.
[W:LS0301] =[W:LS0301] +1 //The number of errors counted increases.

}
endif

(4) Click on the button.

Enter an expression. Prass HELP for swamples

“| Cancel H Options || Help |
S

(5)Click on the button to quit registration. In the area, the Syntax

D Serit List = Assistantand Syntax Check func-
D-Sovint tions can be used.
| Eeke

I | The current

_ registration

. information is

shown here.

DS
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m Extended SIO Script

The GPPRO/PB |11 provides a special programming function dedicated to
communication between the GP and the 1/0O device connected to the ex-
tended SIO (Extended serial interface) built into the GP. The programming
operation is executed independently of the processing of the tags on the
screen. The Extended SIO Scripts function as a programming function that
is effective on all screens in the Project, regardless of the screen type.

Three special functions - D-script, Global D-script, and Extended SIO script
- are available for creating programs to execute functions other than tags.

For details of each function, Tag Reference Manual, 3.1
D-Script/Global D-Script and 3.2 Extended SI1O Script.

This function is supported by GP2000 Series units .

! .. - When the Extended SIO script is used with a GP unit that does
Important —h 0t have an Extended Serial I/F, the “Serial I/F Switch” must be
setto “Yes” in advance. Version 6.2 or later support the serial
interface selection function.

4.2.8 Changing Extended SIO Type

When using the Extended SIO Script, ensure that the [Ex-
tended SIO Script Protocol] option has been selected in the
Extended SIO Settings. When a different Extended SIO is
selected, the Extended SIO Script cannot be selected via the
Screen Editor.

For the procedure for changing the Extended SIO type,
4.2.8 Changing Extended SI1O Type.

The Extended SIO Script cannot be registered as a Library
item.

To set up the Extended SIO script, open any desired Base
screen and follow the procedure below.

The LS device used with the Extended SIO scripts cannot be
simulated.

Usage Pattern

- Exit with the

Set up with
[Speciall [Extended SIO | theD-script or
Script] Editor [Cancel] key.
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B Setting the Extended SIO Script
Configure the Extended S10 Script settings on the D-Script Editor.

Flle Option

Enter the - Show Toolbos E‘ .

deSC” t|on Formula [t ain Fucntion] Functions: Dlsplays the D-

h P Script Tool Box
ere.

containing the D-
Script commands.

The programmed

"actions" (com- Displays the
mands) of the defined function
Extended SIO names.

Script

3
Data Lenglh' Code +/- 7]

Enter an expression. Press HELP for examples. Call [New
Edt ||Delets

Copy ﬁaste
.

Message area
(window)

|' akK ] ‘ Cancel } ‘ Help

B D-Script Tool Box

The D-Script toolbox contains the D-Script commands, Statements and
constant input icons.

Tag Reference Manual, 3.1 D-Script/Global D-Script
When the "Toolbox™ checkbox is checked on the D-Script Editor, the fol-
lowing toolbox will appear.

D-Script ToolBox

= Function: —m—m—oo—
Data Set I~ |

Bit Address
Constant
Temp. Address
Word Address

B

=Statements = =0perators ==

S8 1=
] | I
Compare == |I<<|>>I&
|'=|y:|m| [TTA]~]

MIE
HA
HEE
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B Definition of Functions

Enterafunction L e T  sowteo B—— |

name.

The programs to be used for Extended SIO Script are defined as functions.
The defined functions can be called up to the activated program and used.
These functions can be nested up to 10 layers.

When the icon is clicked on the D-Script Editor, the D-Script
Function setting screen will appear.

—Displays the D-
Script Tool Box
containing the D-
Script commands.

Functions:

Programmed
actlodn (com- Displays the
mand) defined function

Message area
(window)

Tl [Mew]| NAMes.
Edit |[Delete
Fasts

- Only single-byte alphanumeric characters starting with an alphabet charac-
ter and **_"* (underscore) can be used for function names. Up to 20 charac-
ters can be entered.

- The functions defined in the [D-Script Function] dialog box of the Extended
SIO Script cannot be used with the D-Script/Global D-Script.

B Importing/Exporting the ""Action™ information on the [D-Script

Editor]/[D-Script Function] dialog box

Information on the program currently being displayed in the [Formula] field
of the [D-Script Editor] dialog box or in the [Formula] field of the [D-Script
Function] dialog box can be imported/exported as a text file (*. txt).

- Information on items other than [Formula] (Information displayed on
[Function], and Message area (window), etc.) cannot be imported or ex-
ported.

To export the information, select the [File] menu-[Export] command. When
the [Save As] dialog box opens, enter a desired file name and click the

[ == ] button.

To import the information, select the [File] menu-[Import] command. When
the [Open] dialog box opens, select the desired text file containing the

program information and click the [gesn | button.
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A
al
/4 o

Important

- When the Project file's PLC type has been changed in the
[Project] menu-[Save As] dialog box, the addresses used with
the D-Script cannot be changed.

Never use D-scripts to perform controls that have the poten-
tial to cause life-threatening injuries or serious damage.

Setting the Extended SIO Script

The following is an example of the procedure for setting the Extended SIO
Script.

\.

Ve

On a temperature controller, the target value and current value displayed by\
the temperature controller are read out via the Extended SIO Script. The
trigger is turned ON when the [Start Communication] touch switch is pressed,
and the target value is displayed followed by the current value display. After
10 seconds, the target value and current value are read out and displayed
again.

10

seconds
[Start ~ Target value C clapse Targetvalue °C
— N
Communication] Current value°c Current value °C

Pressing the touch Displays the target Repeats display of the target
switch turns ON the  value and current value value and current value
trigger. displayed by the displayed by the temperature
temperature controller controller in sequence.
in sequence.

The target value of the temperature controller is stored in LS2000.
The current value of the temperature controller is stored in LS2001.
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2.7 Extended SIO Script

PROCEDURE

REmMARKS

(1)Select the pull down [Special] menu’s [Extended SIO
Script] command.

(2)Configure the settings for each item, such as Descrip-
tion and Formula.

Enter a description.

Formula Functions

if ([1:L5005000]=1) COMM_READT

f COMM_READ2

INIT

ACV_FUNC_A1

RCV_FUNC_R2

TRANS_FUNC_R1
TRANS_FUNC_R2

Call INIT //Execute SI0 initia lization (INIT
loopi)
€

Call COMM_READ1 //Read current value of te:
Call COMM_READZ //Read target value of

_wait(100)

]

DetaType:  [En ]| Datatengh  [16BRE )| mocesr I [Mew |
Achion Expressian & okay = Delete
Paste)

Do [ o ][ B |

N

Programmed "actions" (Main Function)
if ([b: LS005000] ==1)
{

Call INIT

loop ()

{
Call COMM_READ1

Call COMM_READ2
_wait (100)
(10-second wait).

¥

endloop

}
endif

(3) Click on the button to confirm and quit the
settings.

Enter an swpression. Press HELP for examples

I

n

Canced | [ mptons. [ Heb |

The number of Functions of the
Extended SIO Script setting is lim-
ited.

Tag Reference
Manual, 3.2.2 Details

Up to 20 single-byte characters can
be entered as a description.

Tag Reference
Manual, 3.2 Extended SIO Script

Select [Option] from the menu to
perform Syntax Assistant and Syn-
tax Check functions.

/' When Trigger bit is ON with the touch switch:
/I Executes initialization of the Extended SI10.
/I Reads out the current value of the temperature controller.

// Reads out the target value of the temperature controller.
I/ Waits the timer count period before starting transmission
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m Data Sampling

Address data designated in the device is sampled and stored (backed up) in
the GP unit. When using this function for a graph (Tag or Part)’s channel,
Trend graph data can also be stored (backed up).
The number of Data Sampling sets, including the number of channels of
Trend Graphs, that can be set up for the entire Project file (PRW file) is 40
with the GP2000 series and 20 with other models.

For more detailed information about data sampling, refer to the Tag Refer-

ence Manual.
SO Tag Reference Manual, 3.3 Data Sampling Settings

Usage Pattern

[Special]

-

_ Add, Edit, or
[Data Sampling] - pglete

the

key

An example of the Data Sampling Setting dialog box is shown below.

Lists the
registered Data
Sampling
Settings’ Tag
name and
description

Data 5ampling Settings

Add
© Edi

" Delete

Cloze

BT

Help

Registers additional
Data Sampling
Settings

|7 Changes the Data

Sampling Setting
attributes

Deletes the regis-
tered Data Sampling
Settings
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B Registering Data Sampling Settings

Additional Data Sampling Settings are registered.

When the button is clicked on, the Data Sampling Setting screen
will appear. For each item’s setting, refer to Tag Reference Manual.

SEBOETHEIK Tag Reference Manual, 3.3 Data Sampling Settings

Channel Setting | — Enters a Data

— : W Sampling Tag name
Enera (|\Data Furrinat || Sampling | of u pto5 charac-
Switches the — 1 TagMame o [ooon A ters
settlng screens Descrintion | %J’\ .
P ——— Enters a descrip-
(Sampling Address  DO0DO R tion of up to 20
characters
Trigger Bit Address 0000
Top Address L500z0 .
. —1T— Displays the
Samping Count 1 current setting
Graph Back Up Mo attributes
Q}lnchmnuus tode - /
Sampling Type ahc; B0 zeconds
|| QK | || Cancel | || Help |

B Deleting Data Sampling Settings
Here, the registered Data Sampling Settings can be deleted. Select a Data

Sampling to be deleted from the list. When the button is clicked

on, a dialog box will appear to confirm your command. If you click on the
button, the Data Sampling will be deleted:; if you click on the
button, the deletion will be canceled.

Data Sampling Setting

@ Selected Screens will be deleted |

B Editing Data Sampling Settings
Here, the registered Data Sampling Setting attributes can be changed. Select

a Data Sampling to be changed from the list. When the button is

clicked on, the Add (registration) dialog box will appear. If you click on the
button, the D-Script setting attributes will be changed, and if you

click on the button, editing will be canceled.
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W Setting Up Data Sampling

The Data Sampling setting method is shown below.

PROCEDURE REMARKS

(1) Select [Data Sampling] from the [Special] pull down
menu.

(2) Click on the button. The number of Data Sampling sets,

including the number of channels
of Trend Graphs, that can be set up

% for the entire system is 40 with the

GP2000 series and 20 with other
models.

(3) Perform the data sampling settings. After the settings | Enter a Tag name of up to 5 char-

are all completed, click on the button. acters.

Channel Setting

| General | D ata Format I Sampling 1
Toatlne o N MEEEENEP Tag Reference
Descipion ] Manual, 3.3 Data Sampling Set-
Sampling Address 0000 ti ngs

Trigger Bit Address 000000
TopWwiite Address oozo

Mo, of Sampl. Addr. 1

Graph Backup Mo
Synchronous Mode
Sampling Type Period. No; 60 seconds
|. [a]:4 kl | Cancel ] | Help ]

(4) Click on the button to quit the registration.

0_0000

— Displays the
registered items
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E Efficient Drawing Techniques ]

This section explains how the use of grids, changing display states, and the
help function can all help to increase your drawing efficiency.

@ Grid/Snap

Grid Points are placed at regular intervals on your screen and divide the
drawing area into a coordinate “grid” pattern; when the Snap to Grid func-
tion is enabled, objects that are drawn will automatically “snap” (be aligned)
on this “grid” pattern. Use the Grid Point Spacing command to adjust the
density of the Grid points, and to display the grid or not. Also, grid points
can be displayed as grid lines, not as dots. Grid Points are not shown on the

GP unit’s display.

Select the pull down menu [Option]’s [Grid/Snap] command.

B Grid/Snap Settings dialog box

Turns the display
of the Grid Points
ON or OFF

Designates the
Grid Point
display’s being
drawn on top of, or
under, screen
objects

Turns the Snap
function ON or OFF

Registers a Grip
pattern.

Registers the grid
pattern that has been
designated in Spacing
to the position high-
lighted in the Grid
Spacing List.

€ Display

Grid/Snap Settings
\E Display Spacing =
W Botom L3Top) || (%33 [0 |
Snap <
}j v [3-199] =
[Grid Spacing List: m

[] Touch Area

2] 403 40
38x16
411616
5] 32k 32

Grid Shift Start Point=———=

x B
Style

% Dot
i3 Line

Cook ] [ Ceneal || [ Hew

Designates the grid
display style, i.e. as dots
or grid lines.

Enters the
desired Grid Point
spacing

Sets up the grid
to the optimal 20
x 20 dot size

Enter the coordi-
nate for the start
point.

Set the start point
in a center area
that is to be the
start point for
calling up the
screen. (The start
point is set as the
default value.)

Sets the Grid Point display state (displayed or not displayed).

When the Grid Point's Display is set to "Top", the grid points will be dis-
played in front of all objects placed on the screen.

Grid pattern display can also be changed in the Grid Tool Bar’s grid pattern

selection list box.
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€ Snap

When the Snap check box is checked, the cursor will “snap” to the grid;
objects can only be drawn on points (start & end) along the grid.

%{% Turning the Snap function ON or OFF can also be performed via the Grid/

Snap Tool Bar’s icons [ueg]| and [B]

GliddSnap [=]

1]120% 20 F|

€ Spacing
The Grid Point intervals are entered here. The unit is a dot. Input the

interval value for the X and Y axes, respectively. The default value is 20
dots.

When clicking on [Touch Area], a 20 x 20 dot spacing will be automatically
designated, which is most suitable for the touch panel.

Select a desired grid pattern in Spacing and click on the button.
Then, the selected grid pattern will be reflected to the current screen and will
also be displayed as the 6th selection of the Grid Tool Bar’s grid pattern
selection list.

€ Grid Spacing List

Clicking on the button changes Grid Spacing List’s highlighted set
value to Spacing’s set value and registers it.

The grid patterns registered here will be displayed on the Grid Tool Bar’s
grid pattern selection list box. A grid pattern selected from the grid pattern
selection list box will be reflected to the current screen.
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2.9 Efficient Drawing Technmiques

& Start Point

Grid/Snap Settings

E Display

D Shap

Grid Spacing List

2)40% 40
3816
416X 16
532X 2

=
BBoton {ITop | XY [@ |

vizey 5

D Touch Ares

Spacing

Grid Shift Start Point=—=
x F1H

Style-
% Dot
3 Line

& Style

Chapter 2 - Base Screens

Select grid pattern display style from “Dot” and “Line”.

<When selecting Dot:>

<When selecting Line:>
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@ Screen Property Settings ]

Here, the screen display’s environment is set up, which effects both the
method used to draw screens and displaying the Part and Tag addresses.
The user’s work environment can be modified whenever necessary, helping
to reduce the time required for drawing.

Select the pull down menu [Option]’s [Screen Property] command.

B Setting Screen Property - [Display]

The display state (displayed or not) of the items such as object Fill, Window
Mark, Window Part, Tag Mark, and setting information on Tags and Parts
can be selected. Check the box of the items to be displayed. When a box is
not checked, that item will not be displayed.

The settings on this screen will be applied to all the screens. Properties
cannot be set up for individual screens.

Screen Property

Display |Color || Display Area |

I Fil Paint
D tultiple open with next/prey
ﬂ Dizplay in Load Screen Object
Load Screen Double Click
{%) Change Attibute #29 Edit Screen

] o bk,
T window Parts
ﬂ Tag Mark

Infarmation O
[ ﬂ Tag Name Information Data Size

I Partz 1D
) 15 [
ﬂ Device Addiess &) Nomal L Smal

D tove Tagname Separately
H Used Hairline Cursor

” a8 ||| Cancel Hl Help

%te; The display state of ID numbers, Tag Names, Addresses, and Tag Marks can

also be changed via the [Option] tool bar icons.

oFill

When creating a screen, the drawing can be controlled so that any Fills used
will either be displayed or not. If the “Fill” check box is not checked, all
Fills are not shown. Using this feature will help you to speed up screen
redrawing time, and thus speed up screen creation.
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When the “Fill” check box is not checked, the actual screen
! shown on the GP unit may differ from the screen shown on your
Important PC_ To be sure the display is correct, check the “Fill” check box

ON at least once, to verify the screen, before sending screen
data to the GP.

®Fill Point

When this feature is selected, specified Fill points will appear with an “X”
mark, which is especially useful when selecting Fill points.
It the Fill Points are not displayed, Fill cannot be performed while editing.

%te: The X (cursor position) mark’s color can be designated in the system’s
[Color] area.

@ Multiple Open with Next/Prev

When selecting [Previous Screen]/[Next Screen] from the [Screen] menu, or

opening a screen with the Open Screen switch [« ] »], specify whether the
next screen is opened with the currently active screen open or after that
active screen is closed. Up to 20 screens may be opened continuously.

@ Display in Load Screen Object
You can specify whether tag and part addresses, ID numbers, tag names, and

tag marks on a screen which has been called up using the [Load Screen]
command are displayed or hidden.

@ Load Screen Double Click
Specify an edit method for editing a screen that has been called up on

another screen where the [Load Screen] command was executed, or for
editing a screen on the Screen List.

If [Change Attribute] is specified, the Load Screen dialog box will be
opened, enabling you to select a screen to be called up (screen number).

If [Edit Screen] is specified, the screen that has been called up will be
opened, allowing you to edit the data.

€ Window Mark

Designates the window mark display state, i.e. displayed or not displayed.
The window mark shows an area that has been registered as a window.

3.7 Window Display: Window(U) Screen and
Base(B) Screen

@ Display in Window Part Screen

Designate whether the contents of the window part placed on the Base
screen will be displayed or hidden.
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€ Tag Mark

2.9 Efficient Drawing Techniques

Designates whether or not the Tag Mark is displayed while a screen is being
drawn. Tag Marks show the point or area specified for a Tag. However, a/A/
D-tag marks and G/g-tag’s Pie/Half-Pie/Meter Tag marks will always be

displayed, no matter what this setting is.

<Example>

A-tag, a-tag (Type depends C-tag

on border settings)

d-tags (display depends on %
and the data display’s ON/OFF
settings)

//

””””””” E, K, N,
and S-
'''' tags
G-tag F-tag
g-tag
o M ' M-tag
n-tag — e
P-tag (display dependson H,J,andL,l k,T,and R-tag
the designated display and W-tags t-tags
format and Tag mark)
X-tag
Wico0: Tag 2
e R T
....... ' Lo Lo U-
_____ BN o
SRR SN
| 4
L L
L O e T
L Q-
vtag— . tag
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& Tag Name

Designates whether or not the Tag Name is displayed while a screen is being
drawn.

®Parts ID

Designates whether or not a Part’s ID number is displayed on the Base
screen.

& Device Address

Designates whether or not Part and Tag Addresses are displayed on the Base
screen. Part Addresses appear below the ID number, and on Tags, below the
Tag Name.

& Information Data Size

Selects the character size displayed from Standard (half size) and Minimized
(1/4 size) for ID No., Tag names, and Address.

€ Move Tagname Separately

Whether or not the Tag Name and Address display position is also moved
when Tag Marks are moved is designated during screen creation. If this
function is selected, when Tag Marks are moved, Tag Names and Addresses
will be not moved.

& Used Hairline Cursor

Changes the arrow cursor to the hairline cursor.
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B Setting Screen Property - [Color]

Select the Grid, Fill Point, and Screen Background colors here. When the
drawn image data’s and system’s colors are the same, the screens will be
hard to see. Here, these colors can be changed to remedy that.

Screen Property |

rDispIayl Color | Display Area |

Giid Calor )
Fill Point Color I I T

Secreen Background Pattern D

fo MEEDEECCNE
g MEEDEECCNE

Ok ” Cancel || Help

@ Grid Color
Selects the grid point’s color.

@ Fill Point Color
Fill Points designate the point where a fill will begin; this setting determines
the color of the fill point.

@ Screen Background

Select the Base screen’s background color; the color selected here is also
displayed on the GP.

If any background color is specified for the screen to be

7 U

important loaded, no on-screen object will be displayed on the GP unit.

To load a screen whose background color was specified,
specify the loading position at the center of the screen.
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B Setting Screen Property - [Display Area]

Select a GP unit with a lower level of resolution than the current one.

If the screen display area is different between GP units with different resolu-
tion levels, part of the screen may become invalid. With this function, you
can confirm the screen area that can be displayed on a different resolution
GP unit beforehand.

Screen Property

.Displa_l,l " Calor ) Display Area ]

Il ep570

x|

"] GParo/270

|I ak. I| Cancel || Help

<List of Resolutions>

Display Area Size M odels with the Same Resolution
GP570 GP-570, GP-571, GP-870, GP-577R, GP-2401H, GP-2400,
GP-2401, GP-2500, GP-2501
GP470 GP-470, GP-477R
GP-H70, GP-270, GP-370, GP-377, GP-377R, GP-2301H,
GP3702270 GP-2300, GP-2301

@ Preview Screen ]

With this feature, you can confirm how an image will appear on the GP unit.
This image will differ depending on each GP display device type.
Select the [Preview] from the [View].

Select the
type of \ iew - [B?:Untitled1] =
display used —

Raw NMaterial
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@ Screen Data List ]

The currently displayed screen’s object locations and setting attributes are
listed in the Screen Data List.

B Screen Data List

An example of the Screen Data List is shown below.

I Screen Data

Displays the object
placed on the

L_0aad oooodad
k_0000 0000 0ooood

T_0000 0000040 currently displayed
T5_001 000000 000000 screen
SG_001 0000

Designates the
type of the object
to be displayed in

Cﬂ Partz E Tags @ Ohjects >/ the Screen Data
Edits the object List
selected from \H Changeli | “ Delets | Deletes the object

the Screen Data

. =] selected from the
; Link Select o Change Order .
List L Link Selec i Screen Data List

Highlights an Changes the order
object selected on of drawing objects
the screen.

B Screen Data Display

The designated type of object(s) data is displayed. If a grouped object
contains at least one object whose type has been designated, it is displayed
as an grouped object.

The Screen Data List displays the following information:

Drawing .........c....... Type and coordinates of a drawing object

Tag oo, Tag Name and Address

Part......ccocevvvinnnnns ID Number and Address

Grouped object ...... Grouped object’s coordinates and each grouped object’s
information

%{e; D-Scripts are displayed as tags. Each D-Script shows ID and description
information.

M Selecting an Object

The object selected from the list will be displayed with handles (i.e. se-
lected) in the Screen Editor. To select multiple objects from the list, Left-
drag them, or hold the or key down and click on desired ones.

€ Link Select

Normally, when any object is selected with the Screen Editor, it will not be
displayed on the list. If the check box for [Link Select] is marked, an object
selected with the Screen Editor will also be selected (highlighted) on the list.
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W Editing an Object
To edit an object, select it from the list and click on the button; or
simply double-click on the object.
If the object is D-Script, D-Script Editor will be actuated.

Clicking on the[Delete] button deletes the selected object.

€ Change Order

Objects are displayed on the list in the order where they have been drawn. If
the order of objects on the list is changed, the overlapping order of drawn
objects and the executing order of tags and parts can also be changed.

€ Copying
Any object on the list can be copied by pressing the +[C ] key, or pasted

by pressing the [Ctrl|+ [V |keys. Multiple objects can be copied at a time by
selecting them.
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@ Part Reference List

The settings for each Part placed on the currently edited screen are listed
here, for each Part type. Part settings can also be changed on the Part

Reference List.

Usage Pattern

When either modifying or deleting...

Select After selection, or the
[View] — [Parts List] — desired — either modify or —
Part delete the Part key

An example of the Part Reference List on a screen is shown below.

Shows a list of
the Parts on the

Reflection of device comment
The device comment corresponding to an

entered device address overwrites the Descrip-
tion field.

Changes Part’s
settings

Deletes the
selected Part

currently

selected Copies a part

screen. Simply

click on the Pastes a part

desired Part Stores the
Parts list
information as

d) a CSV file.

Use this scroll bar
to view all the data
on along screen

Closes the current screen.

(The key can also be

used)

%te; The tab width for each item can be adjusted by placing the mouse pointer on
the border between items and then dragging it.

W Editing Items on the Part Reference List

Part setting data can be changed directly on the Part Reference List.

Click on the left-most number of a Part to be changed, and it will be high-
lighted; then, click on the button, and the Part’s Dialog box will
appear and its settings can be changed.

Setting items, such as the Description and Address areas, can be changed via
the Part Reference List. Also, items displayed in gray can be changed in the
dialog box by double-clicking on the inside of their border.

|I [ Part 1D | Description [Data Addiess Dizp... [CharSize
(1 [wo_om|f |Dooz1 5 Bx16
|

\
Can be edited directly Can be edited by
double-clicking
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For the labels and messages of more than one line, use “\\” as the carriage
return.

RESET | 4 g fee——
sUTTON] < |.rH esety\Button

B Deleting Items from the Part Reference List

Parts can be deleted directly from the Part Reference List.
Click in the middle of a Part to be deleted, and it will be highlighted. Then,

click on the button, and a dialog box will appear. Clicking on the
button will delete the Part from the Part Reference List. To close

the box without deleting the Part, click on the button. When
multiple Parts are selected, all the Parts will be deleted by clicking on the

button, and by clicking on the button, the box will be

closed.

Confirm Delete

g Are pou zure pou want o delete: BS_0017Y

[Eoves || vesan || We || Meal || Cancel

B Copying a Part on the Parts List
Any part can be copied on the parts list.

Select the left-most number for the part being copied by clicking on that
number. The selected part will be highlighted. After this selection, click on

the button and then the button. The part will be copied to

the bottom line of the list.

B Reflecting a Device Comment on the Parts List

The device comment corresponding to an entered device address can be
entered on the parts list by clicking on a specified button. This can be done
in either of the following two ways:

1. Select the address setting field and click on the [Apply De-
vice Comment] button.

The device comment corresponding to the selected address will be
reflected in the Description field.

2. Select a part by its line and click on the [Apply Device Com-
ment] button.

If there are multiple address setting items for that part, the descrip-
tion corresponding to the address specified in the [Address Table
for Automatic Input of Device comment] will be reflected in the
Description field.

2.4.7 ® Reflection of Device Comments
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B Exporting a CSV File
The Parts list information can be saved as a CSV file.

You can also select whether the currently selected page (tab)’s information
will be exported or the entire page will be exported.
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@ Tag List ]

Tags and their setting attributes (type of data) specified on the current screen
or in a Project File can be listed; the setting attributes can also be changed
on the Tag List. The Tag List will be displayed separately for Local Setting
(Tags specified for each screen) and for Data Sampling Settings specified
commonly for all the screens. When using a Handy-type GP (GP-H70/
GP2000H series) unit, the Global function keys will also be displayed. The
Tag List for Local Setting and Tag data setup for each screen will be dis-

played.
Usage Pattern When editing or deleting...
[LOCBJ] Select Edit
[View] - [TaglList] - or - Ta - 0o - or
; g
[Data Sampling] Delete the key

The following is the Tag list (local) screen example.
The edit method of this list is the same as that of the Parts list.
SEOTIEIK 2.9.5 Part Reference List

Lists all the Tags used on the currently open screen.
Select the desired Tag to list its type of data

I Opens the
Using Device ~_]> 7 selected Tag
Comment \@Aaa ..... Conment for edltlng
Here, the device T T Tooms T (=]
' e ” Deletes the
comment that - =zl selected Ta
COI’reSpondS to 4 [n000 |||Molo Test R | g
an deVice ad' Copies Tag
dress is auto-
matically written ey Pastes Tag
in the Descrip- Moves Tag
tion field. one position
higher on the
list

Click on| Cise 1 Moves T";lg

to close the Tag Ce=1 [ O] Ioorxe‘:(:)sr: ;ﬁg

List screen. list

Pressing the If Tag has been grouped, an asterisk will

key will also close appear here.

the screen AT, 2.4.12 Group/Ungroup
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<Individual Tag List Screen>

]

Tag List

[AI_| ATag [CTen |6 Ts0] nts0)

s ey

Moritor Wor.._ | No.ofMo.._ | DisplayFo.. | Text Scieen... | Test Goieen .. | Blank Lin.. | DisplaySt.. |
[t [Dieet [t [ [on [1 [

Delete

= . — Saves the Tag
H Listin a CSV file

LI o
e A
AL

Scrolls the
display left, right,
up and down
when the Tag List
is bigger than the
screen size

%Q‘é’l - The tab width for each item can be adjusted by positioning the mouse
pointer on the border between items and then dragging it.

- For Handy-type GP (GP-H70/GP2000H Series) unit, the Tag names speci-
fied via the Local function keys will become “OP_* ***” gr “f*_* ***»,
thereby allowing you to distinguish in the Tag List whether the Tag was set
up via the Local function keys or on the screen.

2.10.1 Function Keys

B Changing the Tag Setting Order

The Tags will function in the order that they have been set up (the order
displayed on all the pages of the Tag List) on the GP screen. To change this
order, click on either the [ Meveue | Or [MeveDawn| key. When multiple Tags are
grouped, that group will be moved up or down.

B Exporting a CSV File
The Parts list information can be saved as a CSV file.

You can also select whether the currently selected page (tab)’s information
will be exported or the entire page will be exported.

2.9.5 Part Reference List @ Exporting a CSV File
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@ Cross Reference List ]

The Cross Reference List feature is useful when displaying the current
address condition of Tags and other items. Here, the exact address used for
each Tag can be checked.

Cross reference will be displayed for local settings (each screen’s Tags, D-
scripts, and Parts), and data sampling and global D-scripts registered for all
the screens. If you use the Handy-type GP (GP-H70/GP2000H Series) unit,
the global function key settings will also be displayed.

The Global Cross Reference List feature does not sort the settings by func-
tion and screen; it displays the current address conditions of the entire
Project file (including the GP system) in a list.

%te: - Since, to display the global cross reference, address information for all the
1 screen will be acquired, it can take a long period of time.

- The global cross reference does not display the condition of addresses that
have been designated via [GP System Settings].

- After changing the GP model (GP type), addresses specific to the previous
GP model (type) may be displayed. (For example, when changing GP-H70/
GP2000H Series to the other model, this may occur.)

B Cross Reference (Local, Data Sampling, Global D-script)

Usage Pattern [Local]
or
[Data Sam-

pling] Select

[Cross Refer- either .
- or - - Confirm

. or
ence List] (Global D- gg;%i?é the[Esclkey
Script]
or
[Extended SIO
Script]

[View] -

An example of the Cross Reference List dialog box (in the case of Local) is
as shown below.

Cross Reference List [ Local ]

Select whether to Bit Address | word Address | | Click to change the

display by Bit : _ . Display Start Ad-
ress ags arts Addigss.,,

Address or Word S0 ]|KT_uguuu ]|P l [oates.] dress

Address

Selects the Address
Display condition

Addresses=
9 Used
8l
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B Global Cross Reference

The global cross reference has two display methods, i.e. list display same as
the standard cross reference and address map display. This feature enables
you to go to the screen that uses the address you want to edit, to convert
addresses in one operation, and to make a reference to an address.

¢ - Limitations exist regarding the display of the following addresses with the

global cross reference that was designated when the GP System was set up.
(To set up the GP system settings, select from the Project
Manager menu, and configure the settings in the [GP System Settings]
dialog box.)

- The "Alarm Trigger Count Write's Start Address' designated in the [Q-

Tag Setting] dialog box on the [Extended Settings] tab (by clicking on the

™ GTagsetings. | button) is not displayed.

- The [Watch Dog] address designated on the [Extended Settings] tab will not

be displayed when the "Time"" is set to "0 seconds.

- As for the [System Start Address] designated on the [Mode Settings] tab,

only the designated System Start Address will be displayed regardless of the
total number of words used in the system area and the reading area size.

Usage Pattern

List
[Utility] [Global Cross [ or ]
yi- Reference] - —  Start address search.
[Map]
Select either Word or Confirm —. or
~ Bit Address. - = [Esc Jkey to exit

— edit address

Convert Addresses... | 1O

change addresses
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The following is the overview for the global cross reference screens.

€ List Display

For local settings, which screen is used, and for global settings, function
type will be displayed, respectively.

Selects whether setting conditions are dis-
played for Bit Addresses or for Word Addresses.

\ Global Cross Reference List

Bit Address |\word Addre

=)

[Address

[Screen 1=l

#0000

Logging Filing Data Sampling B1

| settese

00001 B1B2B4

00004

Global Dscript, B1.BZ B4

Hoooo Bl

oo Bl

ooz B4

o3 B4

{8 Lsed

Changes the display
start address to be
displayed.

12 al

®00105
E]._] “ Corvert Addresses

Selects the range of
Addresses to be
displayed.

Click to select the
screen in which the
address you want

Click to convert the addresses in

one operation. MEIEEK 4.2.4
Converting Addresses and Device Codes

€ Address Map Display

When selecting Word Address, the table cells from Word Address Bits 0 to
15 (for 32 bit device, from 0 to 32) will all be filled. When selecting Bit
Address, only bit cells currently used will be filled.

Selects whether —— =

setting condi-
tions are dis-
played for Bit
Addresses or for
Word Addresses.

I Y O
.

]

|
I Y O
I Y O

to edit is used, or
go directly to the
desired screen.

. Displays the Bit
location.

Click to select
the screen in
which the ad-
dress you want

Click to convert the addresses in

one operation. MEIEEK 4.2.4
Converting Addresses and Device

Codes

to edit is used, or
go directly to the
desired screen.
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€ Changing Addresses

You may move to the drawing screen of the specified address from the
global cross reference, or change addresses.

On the global cross reference list, double-click on the column of the address

you wish to change. Or, click on the button to open the [Start
Address] dialog box, specify the address before the change, and click on the

|T button.

Global Crozs Reference List

Bit Address [‘word Address |

[Address [Screen ” Seldbess..
00000 N EB1
by . Addresses=
Double-click 89 Used
2

Open Screen...

Con et Addresses...

-

il

T

]\
Address
e |

Specify the address.

%@ When selecting an address designated on the Base screen, Trend Graph
screen, Keypad screen, Video screen or Window screen, open the screen by

double-clicking on the address or by clicking on the button

after selecting the desired address.

When the specified address is used only on one screen, the screen will be
displayed directly. When the specified address is used on two or more
screens, the [Open Screen] dialog box appears. Select the desired screen

(two or more screens can be selected) and click on the button.

Open Screen [Address:X00101)

pen
L
loze

=)
e

Screen Type:

]Base Scoreen I~ | ]T

A

The Global Cross Reference dialog box closes when the drawing screen
opens.
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€ Address Block Conversion

The addresses listed on the Global Cross Reference dialog box (all ad-
dresses in the Project and GP system addresses, excluding the addresses
registered as symbols) can be converted into different addresses in one

operation simply by clicking on the button.
SEEOTTTIK 4.2.4 Converting Addresses and Device Codes

The Global Cross Reference display is automatically updated after the
Address Block Conversion operation.

%te; * Among the tags and parts, the ones corresponding to both bit addresses and
2 word addresses are cross-referenced with both of those addresses on the
Cross Reference List even if they were placed by specifying their bit ad-
dresses.

Example: A tag (part) placed at bit address, X0000F is displayed as word
address, X00000.

* In the case of the Handy-type GP (GP-H70/GP2000H Series) unit, tag
names on the setting list can be used to distinguish tags added with local
function keys from ones added on screens. The tags added with local func-
tion keys are named as “OP_* ***” gr “f*_* ***»

2.10.1 Function Keys

B Changing Display Addresses

When [Used] is selected on the cross reference or global cross reference list
display, the addresses that have been used for the Tags, Parts, and Extended
SIO Scripts in the currently opened screen or Project (including the GP
system) are displayed. When selecting “All Addresses”, all the addresses
beginning with the Start Address will be displayed. To change the Start
Address, click on the button, and the Dialog box shown below will
appear. Set the Start Address and click on the button, and the
display will show from that address on.

Start Address _

Start Address e

Enter the Start —{—F<ooom

Address
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For the global cross reference’s address map display, the map display start
address can be designated when toggling Bit and Word display.

When clicking on [ward sddress | OF | Bit &ddress |, the following dialog box will
appear. After selecting Bit or Word, designate the start address. Then, click
on the button and the cross reference display will start from the
designated start address.

Start Address .
= word 123 Bit

Start Address

Enter an ——{D00000 .
Address
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@ Load Screen List ]

The Load Screen List will be displayed on the currently edited screen. With
this list, you can check the setting attributes of a screen to be loaded and
also can change its loading location.

Usage Pattern When editing or deleting...
-Elnse
Vi Load Screen Select a screen Edit or or
[View] - List — to be loaded — Delete ~— -
Esc

General Load Screen Summary List

Lists all the screens loaded on the currently open screen. Select the
desired screen to show its setting attributes.

Load Screen List

_ Base ]) Changes Load
Click on to close Screen List
the Load Screen Settings
List screen. [ [Scr..|[Postion [Position v [Titl= e
Pressing the|Esc ER | i Staisics ||| bomrd ||
key will also ER EN | li6Z [Hama__| T Deletes a Load
close the screen Screen List

B Editing via the Load Screen List

Screen settings can be changed using the Load Screen List.

Clicking on the left-most number of a screen to be changed will select
(highlight) it. Then, clicking on the [Edit] button will bring up the [Load
Screen] dialog box or the currently called-up screen, allowing you to edit the
screen. The procedure for calling up and then editing a screen varies de-
pending on the settings in the [Load Screen Double Click].

2.9.2 B Setting Screen Property - [Display]
Any coordinate setting can be changed directly via the Load Screen List.
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B Deleting from the Load Screen List
Screens can be deleted from the Load Screen List.

Clicking on the left-most number of a screen to be changed will select
(highlight) it. To delete multiple Load Screen Lists simultaneously, simply

drag the cursor to select the screen numbers. Then, click on the
button, and the dialog box will appear to confirm the command. If you click

on button, the screen will be deleted. To cancel the request, click
on the button. When selecting multiple screens, click on the

to delete all of them, and click on to cancel any dele-

tions.

Confirm Delete

Mo || Moal || Cancel
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@ Display of Screen Level Change Structure ]

The nesting of Load Screens that have been set up on the currently edited
screen is displayed. In this way, a multiple nesting condition can be viewed.

2.2.10 Load Screens M Nesting

Select the [View] menu - [Load Screen Nesting Display] command.

Load Screen Mesting [<]

Each screen will be displayed via the following symbols:

Screen Type Symbol
Base screen B
Mark screen M
Trend Graph screen T
Keypad screen K
Image screen I
Image screen - CF card I(CF)
Window screen U

2-286 GP-PRO/PB IlI for Windows Ver. 6.3 Operation Manual



2.10 Creating Handy-type GP Screen Chapter 2 - Base Screens

m Creating Handy-type GP Screen

The following screens are for the GP-H70/GP2301H and GP2401H units.

Wh . th G P Screen  Edit View Option Qraw Tags Pats Special Library Wwindow Help

H70/ePoso P ERE
B i e| [1)20x 20

series unit T3 : 7

Creates an
Operation
Switch

Function Keys setting area

When using the GP-
2401H series unit

am

H
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@ Function Keys ]

There are Function Keys on each side and you can set up each one as a Tag
(T-tag, t-tag, k-tag) for touch input. GP-H70/GP-2301H series has six
Function Keys and GP-2401H series has eight keys on each side.

These Function Keys can be specified for Local Use or Global Use. With
the Local Function Key Setup, the Function Keys can only be used by the
designated screen. With the Global Function Key Setup, the Function Keys can
be commonly used by all screens.

The number of Tags that can be registered on a GP panel as Global Function
Keys is limited to a total of 24 T, t and k-tags.

The following Tags together with other Tags designated on the screen can be
used for a single screen’s Local Function Keys (except the Tags desingated
for Function Keys).

GP-H70 series 1128

GP2000H series :384

Registering a single t-tag as a Global Function Key, however, requires 2
Tags.

If a Function Key is set up for both Global and Local use, then the Tags
specified as Global will be performed first.

All Tags registered as Function Keys cannot use the AUX output or Reverse
Video features.

B Function Key Settings
An example of the Function Key Setting screen is shown below.

Registers

Function Key Setup additional
Function Key -= OF Fun.Ction Key
Settings
: ~- " Delte reg|st§red
Key Settings Function Key
registored
registered
i Function Key
Setting attribute
data
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The Local Function Key Setting procedure is described. An example of using the
GPH70L/GPH70S/GP2301HL/GP2301HS is as follows.

PROCEDURE

REMARKS

(1)Double-click on any of the Function Keys displayed.

When using the GPH70L/GPH70S/GP2301HL/GP2301HS series

(2)Click on the [Function Key Settings] screen’s

button.

Function Key -» OF

| Deke

Cloze

 Hep

(3)Click on the Tag Name to be used.

Switch [T tag)

Selector Sw [t tag]

ke

Fevboard [k tag]

| ....... Fo I | Help ]

(4)Enter the Tag setting data. After all the attributes

have been entered, click on the button to

register the entered data.

T Tag Setiing
[ GeneralInfo. | Mods | options |

Tag Name: T

Mode: Bit
buldresses: X00000
Aetion Bit Set

Description:

Sereen Level Change Direction:

AU Dutput

N

When using the GP-2401H series
unit, there are eight Function Keys
including the Operation switch on
each side .

Multiple Tags can be assigned to a
Function Key; however, there is a
limit to the number that can be used.

For details of each
Tag’s setting data, refer to Tag Ref-

erence Manual, Chapter 2 Active
Image Functions.
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PROCEDURE

REmMARKS

(5)Click on the button to quit the Function

Key registration.
Function Key - OF . DiSp'ayS the
registered
| el

tem

E oF-7 o000

Cloze

W Setting Up Global Function Keys

To register another item, DO NOT
quit here, rather start again from
step (2).

The Global Function Key Setting procedure is described. An example of using the

GP-H70/GP-2301H series is as follows.

PROCEDURE

REMARKS

(1)Click on the [Special] menu’s [Global Fn Key].

(2)Double-click on any of the Function Keys displayed.

| H70 Global Function Key Settings B3|
o 1 C A
F7 "R
F10 s
F11 C o
Fa] [ |

When using the GP-H70/GP-2301H series

(3)Click on the button.

Function Key - OF

S
| Edy

Cloze

g
g
¥

| Hep

Before this selection, open any
Base screen.

When using the GP-2401H series
unit, there are eight Function Keys
including the Operation switch on
each side .
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PROCEDURE REMARKS

(4)Click on the Tag Name to be used.

Select Tag Function |

Switch [T tag)

Feyboard [k tag)

Selector Swt tag)

(5)Enter the Tag setting data. After all the attributes | Multiple Tags can be assigned to a

have been entered, click on the button to | Function Key, however, there is a
register the entered data, limit to the maximum number.

T Tag Setting <] For details of each
( General o, | ode | Dptons | Tag’s setting data, refer to Tag Ref-
Tag Name: T erence Manual Chapter 2 Active
Descrptirs ] Image Function.
bdode: Bit
Addresses: #o00ao
Actior Bit Set
Scieen Level Change Direction:
Fieverse Yideo:
Buzzer On
Al Output:
— =
(6)Click on the button to quit the Function Key | To perform the registration continu-
registration. ously, DO NOT quit here, start from
step (3) again.

Function Key -> OF

P _ —Displays the
OP-T Qo000 add reglstered

tem

Cloge

R

B Notes for the Function Keys

If changing your GP type from GP-2401H series (16 Function Keys) to GP-
H70/GP-2301H series (12 Function Keys)/ST series (6 Function Keys) or vice
versa, some keys may be shifted from the designated place due to the difference
of Function Keys.
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@ Setting Up the Operation Switch ]

This section describes the procedures for setting up the Operation Switches
supported by the GP-H70/GP2000H series.

The features of the Operation Switch are as follows:

(1) An Operation Switch can be used as a Function Switch.

(2) An Operation Switch can be used to enable Inputs from the touch panel
and Function Keys.

For details of feature (1), see the setup procedures in Section 2.9.1 "Function
Keys."

Feature (2) is activated only when the Operation Switch is enabled. The
procedure for enabling the Operation Switches is described below. If the
Operation Switches are disabled, only feature (1) is available.

Usage Pattern

[Screen/
Setup]

[Extended Check the box to activate

- [GP Setu p] - SettlngS] Ed "Operation sSw -

or

- or to close the dialog box

%f . - The function of the Operation Switch can be *enabled" or "'disabled™ in the
GP’s OFF-LINE mode. Refer to GP-H70 Series User's Manual/GP2000H
Series User's Manual.

B Setting Up the Operation Switches with the GP-H70
@ The Position of the switches

The GP-H70 has two Operation Switches; one on the front face and one on
the rear face.
<Front View> <Rear View>

Front Face Operation Switch Rear Face Operation Switch
@ Default Settings of the switches

According to the default settings of the GP-H70, both Operation Switches
are enabled with the dialog box below.

Handy Settings

‘The "Operation SW” is checked by default.
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?\ - If the Operation Switches are enabled, do not hold down both the front

ole Operation Switch and rear Operation Switch simultaneously when per-
forming touch input. Doing so disables touch input. Make touch input while
holding down only one of the switches.

W Setting Up the Operation Switches with the GP2000H

@ Positions of the switches

The GP2000H has one Operation Switch on the front.
<Front View>

Operation Switch

@ Default Setting of the switch

According to the default settings of the GP2000H, the Operation Switch is
disabled. When the GP is operated under the default settings, the inputs
from the touch panel and Function Keys are enabled.

Handy Settings

The “Operation SW” is unchecked by default

%te' - The GP2000H and the GP-H70 differ in the number of Operation Switches
i and the default settings of the switches. Note this difference when switching
from the GP-H70 series to the GP2000H model.

MW Settings for Using the GP2000H Series in GP-H70 Standard
Mode

This setting allows you to use the switch located on the rear of the
GP2000H series as an Operation Switch. Change the hardware settings of
the GP2000H and select "GP-H70 Standard Mode."

For detailed procedures on setting up the hardware, refer to
the GP2000H Series User's Manual.

To ensure that inputs from the touch panel and Function Keys are entered
only when the Operation Switches are being pressed, change the default
setting and select the "Enable™ setting option of the Operation Switch.

?\l . The switch located on the rear of the GP2000H can be pressed down in two
0 positions. Pressing down the switch firmly to the second position disables
the touch inputs. Be sure to press down the switch to the first position only.
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@ Vibration Function

This function activates the internal motor of the GP to generate a vibration.
This is a global function for all screens. Up to sixteen Global Vibration
settings can be set up within a single Project File.

0%’ - Only the GP2000H series supports the Vibration Function.

Usage Pattern

[Special] -

[Global

Vibration] -

Add or
Edit or -
Delete

to complete the setting

Displays the
Monitor Ad-
dress and

Descriptions of

the registered
Global Vibra-

tion settings in

a list.

Below is a brief description of the Global Vibration Screen.

Global Yibration®

" Address

]' Dezcription

»00000

00000

00000

Daaooo

Cancel

Kal

© o Edit Z
" Copy

&dd

Register a new
Global Vibration.

Modify the settings of
Global Vibration.

Copy a Global
Vibration.

Paste the Global

' Basts
. Delete
 Help

Vibration that was
copied.

Delete the registered
Global Vibration.
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B Setting Up Global Vibration with the Bit Address

This section briefly describes the Global Vibration Screen when the "Bit
Address" is being designated for the monitoring function.

Select the Global ¥ibration S etting
address to be p—
monitored. Seting |
D ezcription | Enter a
Enter the bit description
address for \Q Eit £ ward as necessary.
activating the _
'bration Bit address
v ' o |
Enter the Trigger
vibration B L9190 |_— Designate the
COhditionS. ] duration Of
|- %ibration pattem . .
the vibration.
Sdeer;i It:)]ne / % Continuous 2 Intereal (Ava”able
mpOde for the “Yibration time(Auto aff time] range:dl to 60
. . seconds
vibration. )
]:] Buzz
\‘\ Enable/Disable
the buzzer.
|' ark ” Cancel || Help |
¢ Mode
Select either the Bit Address or Word Address for the device to be moni-
tored.
& Address
Enter the Bit Address used to trigger the Global Vibration here.
@ Trigger Type

Designate the condition that triggers the vibration. Select "0 to 1" to trigger
the vibration when the bit makes the 0-to-1 transition; select "1 to 0" for the
opposite condition.

@ Vibration Pattern

Select either Continuous or Interval mode for the vibration pattern.

- Continuous: The vibration continues for the period specified under the
"Vibration time™ option without interruption.

- Interval: The vibration repeatedly activates for 0.5 seconds followed by
a 0.5 second pause for the period specified in the "Vibration time"

option.
n
Example: !\ 3 seconds /!
Vibration time: 3 seconds '

Continuous Vibration
Intermittent | visration Vibration Vibration !
[
ntermittent ntermitten ntermittent
| | | N I

AN AN AN

| I
N A 1
| o5 | o5 | o5 | o5 | o5 | o5 |
1 1 1 1 1 1 1
| seconds | seconds | seconds | seconds | seconds | seconds |
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@ Vibration time (Auto OFF time)
Specifies the duration of time after the vibration has been triggered.

The available range is from 1 to 60 seconds. The default setting is 10 sec-
onds.

& Buzzer

When this option is enabled, the buzzer sounds according to the selected
Vibration Pattern.

The buzzer will not sound if "Touch Buzzer Sound” is disabled in [System
Setup] under the Project Manager's [J¥E® Sl window, even when the
"Buzzer" function is enabled here.
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B Setting Up Global Vibration with the Word Address

This section briefly describes the Global Vibration Screen when the "Word
Address" is being designated for the monitoring function.

Select the
address to be
monitored.

Enter the

word address
for activating
the vibration.

Enter the
vibration
conditions.

Select the
operation
mode for the
vibration.

€ Mode

Global Vibration Setting
" Setting ] o Enter .a .
Description deSCprtlon
as necessary.
2 Bit 5 iord
Word Address
[
Alarm rang D i t th
) - esignate the
Iin m g
duration of
Max the vibration.
(Available
L~ Wibrati It
prEenpetemn range: 1 to 60
25 Continuous 3 Interval secon d S)

Wibration timefAuto off time)

]:] Buzz

|I oK. I| Cancel H

Help

Enable/Disable
the buzzer.

Select either the Bit Address or Word Address for the device to be moni-

tored.
& Address

Enter the Word Address used to trigger the Global Vibration here.

€ Alarm Range

The vibration is triggered when the value of the word address being moni-
tored exceeds the specified range. The Word Address is 16 bit, unsigned.

@ Vibration Pattern
Select either Continuous or Interval mode for the vibration pattern.

- Continuous: The vibration continues for the period specified under the
"Vibration Period" option without interruption.

- Interval: The vibration repeatedly activates for 0.5 seconds followed by
a 0.5 second pause for the period specified in the "Vibration Time"

option.

Example:

Vibration time: 3 seconds

| 3 seconds |

= =
Continuous Vibration

1 1

- |

Intermittent | vioration Vibration Vibration \

[

ntermittent ntermitten ntermittent

| | | I | N I

~ AN AN AN AN ~1

05 | o5 | o5 | o5 | o5 | 05 |

1

|

1 1 1 1 1
seconds | seconds | seconds | seconds | seconds | seconds
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@ Vibration time (Auto OFF time)
Specifies the duration of time after the vibration has been triggered.

The available range is from 1 to 60 seconds. The default setting is 10 sec-
onds.

& Buzzer

When this option is enabled, the buzzer sounds according to the selected
Vibration Pattern.

The buzzer will not sound if "Touch Buzzer Sound” is disabled in [System
Setup] under the Project Manager's window, even when the
"Buzzer" function is enabled here.

B Vibration Modes

Operation examples of vibration*! are shown below.

1) The vibration of the GP unit is triggered according to the settings when
the specified Condition is satisfied*?2,

Satisfied|

Vibration Condition
Not satisfied!

Vibration Vibration

| |
i i
2) The vibration is not triggered a second time even if the Vibration
Condition is satisfied again while the vibration is ON.

Satisfied l

Vibration Condition
Not satisfied:

Vibration Vibration

*1:The vibration continues for the period specified in the "Vibration time"
option in the [Global Vibration Settings] dialog box. The vibration is triggered
when the Vibration Condition is satisfied regardless of the period required for
the vibration to be completed, automatically stopping after the specified pe-
riod has elapsed.

*2:7To trigger two consecutive vibration responses, hold the Trigger OFF time
(the state in which the Vibration Condition is not satisfied) for the longer of
the following two periods: the communication cycle time or the tag scan time.
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3) The vibration in response to Vibration Condition (2) is triggered after the
vibration in response to Vibration Condition (1) ends.

Satisfied I
Vibration Condition 1

Not satisfied

Satisfied!
Vibration Conditon 2 |

Not satisfied!

Vibration Vibration 1 s Vibration 2

4) If Vibration Condition (2) is not satisfied, no vibration is triggered after
the vibration in response to Vibration Condition (1) ends

San'sﬁed| !
Vibration Condition 1 | |
!
|
|

Not satisfied |

I
I
Vibration Conditon 2

Not satisfied |

Vibration Vibration 1
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2.10 Creating Handy-type GP Screen

If two or more Vibration Conditions are satisfied at one time, vibrations are
triggered in the sequence specified in the settings. However, note that the
vibration may not be activated in the sequence specified with the GP-PRO/
PB 111, as activation depends on the timing of the communication readouts
and internal monitoring.

W Setting Up the Global Vibration Function

The Global Vibration Function setting procedure is described below.

PROCEDURE

REMARKS

(2) In the Screen Editor, select [Global Vibration] from
the [Special] menu.

(2) Click the button, and set up the Global Vi-

bration function.

Global ¥ibration™

"Address ] Description

Kl

sl ol

s

Cancel

A

o
=

Doy
' Paste

| Dekle

" Help

(3) [Setting up the Global Vibration with a Bit Address]

Enter the required options, and click[ ox |

Global Vibration Setting

£ 60 Bl

‘word Address

(B [ 2=

Yibration pattern

%) Continuous 20 Interval
Yibration timefduto off tine]

10 ;_1

T Buzz

" DK%_I | Cancel H

Help
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PROCEDURE

REMARKS

[Setting up the Globa

| Vibration with a Word Address]

Enter the required options, and click .

Global Vibration Setting

word Addiess

Alsm rangs

Wibration pattern

%) Continuous £ Interval

Yibration timeffuto off time)

I Buzz

L_UK%_] Cancel Help

(4) Review the details of the settings in the Global

Vibration window, and click to close the

dialog box.

Global ¥ibration™

“Address | Description

X00000 00000

(00000 Do00ao0

IEN]

Clicking the button displays the

following dialog

Changes will be
Do vow want to

box.

ozt iF pou cancel.
cancel?

Click &7
dialog box
made.

Click to

dialog box.

| to close the [Global Vibration]
without saving the changes you have

return to the [Global Vibration]

Click to complete the setup operation.

Up to sixteen Global Vibratio set-
tings can be set up within a single
Project.

When two or more trigger condi-
tions for the Global Vibration set-
tings are satisfied at one time, vi-
brations are executed in the se-
guence registered in the Global Vi-
bration settings. However, note that
internal conditions may prevent the
vibrations from being generated in
the specified sequence.
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» Creating ST Series Screen

| Be sure to read the following section prior to using your ST Series unit. |

The following screens explain the ST400, ST401 and ST402 (hereafter called
"ST") units.

I B?: Untitledl

(ST Edit Screen) Function Key
Setting Area
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@ Function Keys ]

The panel contains 6 function keys. Use these keys to perform touch input tag (T,
tand k tag) settings.

There are two types of function key tag settings: local function key settings, and
global function key settings. Local function keys operate only in the screen in
which they have been set up. However, global function keys operate on all
screens in which they have been set up.

No. of Tags that can be set using Function Keys

Local up to 384

(Total number of all tags on a single screen, howewer,
does not include tags set on function keys.)

Global 24

(Single project) (Total number of T-tag, t-tag™ and k-tags.)

(for asingle screen)

When performing local function key and global function key settings simulta-
neously, global function key tag settings will be performed first.

Tags set using function keys cannot be used to perform AUX output or reverse
display.

B Function Key Settings

- Registers newly

Registers newly
Function Keyp -> F1 key settings
F1-T_00C0 Touch Key 1

| Deletes regis-
tered function
Bl key settings

Close Edits registered

function key
setting contents

ik

Displays registered function
keys in list form.

*1 Asingle t-tag is counted as 2 regular tags.
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MW Setting up Local Function Keys

The Local function key setting procedure is explained below.

PROCEDURE REMARKS

(1) Double-click the function key you want to set up.

Il B?2: Untitled1

@Click[_2a_]

Function Key -» F1

o

:

o |
o]

W

:

(3)Click the tag you want to set for the function key. Multiple Tags can be assigned to a

T — Singl_e F_unction Key; however, there
___________________________________________________________ is a limit to the number that can be
Switch (T tag) h used.

Selector Swit tag)

Feyboard [k tag)

|| Cancel ]“ Help |

(4)After performing all item settings, click [ ok . For details regarding individual tag

settings, Tag Refer-
Tilm; D= ] — ence Manual, Chapter 2, Active
- roT— Image Functions

ALY Output

[ concel | Help
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PROCEDURE

REMARKS

(5)Click to register your function key setting.

Function ey -» F1
FL-T_0000 Touch Key 1

Function Keyp Setup

To continue setting up function keys,
repeat from step 2.

Displays the

registered

item

W Setting up the Global Function Key
The Global function key setting procedure is explained below.

PROCEDURE REMARKS
(1)Select [Special (C)] menu's [Global Function Key (G)] | Before this selection, open any Base
feature. screen.
(2)Click the function key you want to set up.
Global Function Key Settings
e
= |
|
= |
[~ ]
“ Claze | “ Help |
(3)Click :
Function Fey -> F1
, Delete
Edit
[ B
(4)Click the tag you want to set for the function key. k tag [Operation Mode] FEP settings
 — cannot be used, due to ST hardware
| S specifications
Selector Sw [t tag]
Keyboard [k tag]
= Help
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REMARKS

PROCEDURE
(5)After performing all tag settings, click | o« .
e [
Tag Name: 7 [ooo0_|
Deseiption o]
[tae | mee

(6)Click to register your function key setting.

Function Key -> F1

F1-T_0000 Touch Key 1 T

\%

im
=3

1

Displays the
registered
item

B Function Key Usage Notes

In addition to ST units, function keys can also be used on Handy-type GP
units. For details regarding Handy-type GP unit function keys,

2.10.1 Function Keys.

The ST is designed to provide 6 function keys. When changing the GP type
unit selection to a Handy-type GP unit, function key positions may change
due to the difference in number of function keys. However, this does not
occur if the GP type in use before the change was GP-H70 or GP-2301H

series.

Even though multiple tags can be set
up within asingle function key, there
is a limit to the maximum number of
tags.

For details regarding individual tag

settings, Tag Refer-
ence Manual, Chapter 2, Active
Image Functions.

To continue setting up function keys,
repeat from step 2.

When using ST unit function keys, the following [k-tag] — [Mode] area
features, even if set, will not operate.
- <Cancel> for Logging Setting
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@ Restrictions |

Functions usable with GP2000 series units can also be used with ST unitsand ST
units closely follow GP-2301L units. In this manual, please read the word "GP"
("GP2000" or "GP2301L" <same function limits>) as "ST".

However, ST units have certain restrictions owing to hardware specification
differences with GP-2301L units. Be sure to understand this restriction informa-
tion thoroughly before using your ST unit.

%te; - Functions not available with your ST unit are described in the [GEN-
= ERAL GP RESTRICTIONS] section. Please be sure to read this section.

B Touch Panel

According to ST hardware specifications, the minimum size touch area is 40X40
(dots).

@ Direct Touch via Q Tag Alarm/ File Item Display Device/ Logging Display
Device

Due to the ST Series unit specifications, the ST unit’s touch panel can not be
operated when using the following functions.

Q-tag alarm summary direct selection
File item display's direct selection of filing data
Logging display's direct edit of logging data
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@ Grid/Snap

If you choose an ST unit for your project's GP type (ST400/ST401/ST402), the
grid's initial setting will be 40 x 40, not 20 x 20.

Grid/Snap Settings

¥ Display Spamng—'_
) Batom 3 Top | ®3m [0 |

E snep T [3-199] 40 ":

Grid Spacing List:

E Touch Area

=Gnd Shift Start Point
w [En ’%
v [ JE] [ s |

Style
% Dot
123 Line

] [Ceee | [ Hee |

For information about use of the Grid/Snap features, Opera-
tion Manual 2.9.1 Grid/Snap
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B Extended Serial I/F

This feature's settings will vary depending on the type of ST400 Series unit you
areusing.

@ Serial I/F Switchover

This feature's usage and communication restrictions will vary depending on the
type of ST400 Series unit you are using. See the following table for details.

Chapter 2 - Base Screens

Communication Types
Series o Model [ Model .
Built-in I/F No I/F I/F Revision
Name Name | Code ) ]
Switchover | Switchover
Extend SIO
s1a00| STA00- itgrt‘g?;? Protocol Al
AG41-24V RS-492 RS-422 revisions
Serial I/F (2-wire/4-wire)
(Dsub 9-pin)
ST401- Standard Extend SIO Al
ST401 AGAL-24V Protocol Protocol revisions
ST400 RS-232C RS-232C
Series ~COMLS
Standard
Serial IIF Protocol
(Dsub 9-pin) MPI
ST402- Not
Extended | ST402 <COM2> [Not available™ :
AGA41-24V I
Serial I/F G Extend SIO compatible
(Dsub 9-pin) Protocol
RS-422
(2-wire/4-wire)

*1 Even though this feature can be set, it cannot be used.

For details about the Serial I/F Switchover feature, 428
Changing Extend SIO Type

ote:’

- ST series unit OFFLINE screens cannot be used to set the Serial Inter-

face Switch feature. This feature must be set via the editor software and
the project data then transferred to the ST Series unit.

B No Built-in CF Card Interface

The ST unit's design does not include a CF Card interface. As a result, CF Card-
related features cannot be used.
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@ Security Feature ]

Security levels can now be assigned to individual Base or Window screens, based
on the User-designated contents of the data. The following explanation describes
the settings used for the security and password features.

/

m - The security feature is available only with ST Series units.

Important

B Overview

Security levels can now be assigned to individual Base or Window screens.
For example, if the new screen's security level is higher than that of the current
screen, you will need to enter a password in order to change to the new screen.

In the following diagram, entering the correct password allows access to screens
with a security level of 5 or lower, without having to reenter a password. (Security
Level Status: Level 5)

When changing from the current security level status to a screen that has either the
same or a lower security level, no password entry is required.

This type of easy-to-use password-based screen data control allows you to
guarantee the safety of your important project data.

| When changing screens |

Security Level Status

Level 0 ) Password entry Security Level Status
cve Connected device window appears Level 5
changes screen 0 —— :
S ﬁ ; BaDEG Password is
Menu [S st COrrect =S
) ; q Protected |3
Screen |5 MHHJH =)
o s u vl gy i 2 B Screen o
. ST screen touch o

changes screen

Security Level 0 Password entry

=

Press [ESC] key to cancel*1
(returns to Menu Screen)

Security Level 5

*1 When canceling the screen change from a Device/PLC, use the Password Cancel
Alert Bit, and return to the original (above: Menu screen) using the Device/PLC.
For information regarding the Password Cancel Alert Bit, 2114
Password Settings 4 Notification Bit of Password Cancel
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Even in the cases shown below, if the new screen to be changed to has a higher
level of security, you must enter the correct password in order to view the new
screen.

Displaying a window registered on a Base (B) screen, Window (U) screen
(when using a U-tag™ 2", a Window Part™, or a Global Window"®)

Changing to an Alarm screen's sub-screen (A-tag, Q-tag)
Device/PLC control request for a screen change.
Screen change using a Function Switch.

Forced reset (Using either 3-point touch on the unit's display) /Touch upper
left corner of screen within 10 seconds of power ON or a Function Switch to
change to an OFFLINE screen.

Initial Base Screen display.™

*1 Be sure not to use the U-tag's [High Speed] feature in the [Designated Window]
tab, since it may not operate correctly.

*2 The security level for awindow that is registered on a Base (B) screen comes from
the base screen where the window is registered.

*3 When you cancel password entry for a Window (U) screen, the control address
used for the window's U-tag, Window Part, or Global Window display, is automati-
cally cleared. Also, the indirectly designated window number and display position
are also automatically cleared.

*4 The correct password MUST be entered. This screen cannot be cancelled using
[ESC] key.

2-312 GP-PRO/PB Il for Windows Ver. 6.3 Operation Manual



Chapter 2 - Base Screens 2.11 Creating ST Series Screen

@ Security Levels

A total of 16 settings are available - 0 to 15. "0" designates that no security is
set for a given screen. Levels 1 to 15 designate the level of security, from low
to high, with 15 being the highest level. For level setting information,

2.11.4 Password Settings

Security level settings for a Base (B), Window (U) screen can be set when the
screen is saved, or when that screen's name is changed. (See below)

When changing the security levels of the multiple screens at the same time, use
the [Security Level List] dialog box.

For usage details, 2.11.5 Security Level List

Save As .
To modify a
Project File: b arufactuning Spstem ]T password click
SeeenTyper  Base Screen ﬁcance% on the "Password
Screen: | Setup" button to
Enter the —GECU,.@ Level ]—:” Passwmd%tupr C{ill up that
desired J dialog box.
. Maintenance
securit Description: )

y Displays the
evel il e screen's current
(O to 15) 1 Order Accepted Security level

setting.
Hep |

<When saving a screen and assigning a name>

%{e; - Be sure to check/select the [Password Settings] screen's [Use Security
X level] setting. If this setting is not checked, this screen's security feature
is disabled/displayed.

The initial security level setting for all Base (B) and Window (U) screensis "0".

A

] - Thenitial security level setting for all Base (B) and Window (U)
,,/,,p;ﬂa,,, screens of projects created using versions of GP-PRO/PBIII for
Windows Ver. 6.2 or earlier is "0"

If a project created using this Security feature is saved using
Ver. 6.2 or earlier, all security level settings will be reset to "0".
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@ Password Settings

This screen allows you to set a screen's security level and password.

Chapter 2 - Base Screens

]

Usage Pattern

[Screen/Setup] - [Security Setting] - [Password Settings] -

(Check the "Use Security

— level" checkbox to
enable this feature.)

Enter the desired
level's password and
enter any [Extend]
settings.

or

B Password Setting

Password Settings

Faszword Setting ] Extend]

Enables/Disables
the security
feature.

Selecting this will
require the entry
of the Level 15
password when
switching to
OFFLINE mode.

Low  LewelDl
Levell2
Levell3
Levelld
Levell5
LevellE
Levell?
Lewelld
Levelld
LevellO
Levelll
Levell2
Levell2
Levell4

High LevellS

ﬂ Specify Pagzword Level 15 when switching to offline

” [iT3 IH Canicel H| Help

Password must be
1to 8 single-byte
characters. (If both
upper-case and
lower-case char-
acters are used,
the password must
be entered using
the exact same
case characters.)

%[e; - Password entry for screen security can only be performed via the [Pass-
2l word Setting] dialog box.

@ Use Security level

Clicking/selecting this feature enables the security level(s) in the project.

@ Security Level and Password

A total of 16 settings are available - 0 to 15. "0" designates that no security is set

for a given screen. Levels 1 to 15 designate the level of security, from low to high,
with 15 being the highest level. Only the required levels need to be set passwords.
All the levels do not need to be set the passwords.

%@ - The same password cannot be used on more than one level.

- Spaces and symbols cannot be used.

- A password cannot contain all blank spaces.

2-314

GP-PRO/PB Il for Windows Ver. 6.3 Operation Manual



Chapter 2 - Base Screens 2.11 Creating ST Series Screen

@ Specify Password Level 15 when switching to offline

When you change screens in OFFLINE mode, the password entry window will
appear on the ST display and request the security level 15 password.

When you change back to online mode, the security status level will change back
to "0", indicating no password is required.

If you choose [System Settings] from the [GP Setup] dialog box and enter a
[Common Password] that is used when switching between OFFLINE and online
modes, after entering the Level 15 password, this common password's entry
screen will appear. (See below)

B Extend Features

When this is clicked/
selected, only if a
request for screen
change is received
from a connected
device and that
request is cancelled,
will the designated
bit turn ON.

Pazsword Settings

|[Password Setting]| Extend |

= Mutification Bit for Pagswand Cancel

L

00000 =

Auta Clear Time ]5 /'Fﬂ min

=Fasgword Enter KepBoard

Default S etting
”7 %) Mumeric K.eyBoard 178 Test KeyBoard

When this is clicked/
selected, displays the
requested screen's
security level in the
password entry
window.

ﬂ Request Level Display

If the ST is not
operated or a
screen change is
not performed
within the desig-
nated period of
time, the ST
unit's security
level status will
automatically
change to "0".

Designates the

|| ak. ||| Cancel ||| Help

default type of
keyboard used

to enter the
password.

GP-PRO/PB 11l for Windows Ver. 6.3
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& Notification Bit for Password Cancel

When the [Use Notification Bit] setting is checked, and the password entry
window called up by the Device/PLC unit's screen change is cancelled via press-

ing the [ESC] key, the designated password cancel notification bit turns ON. (See
below)

As shown above, while the password entry window is open the System Data
Area has two values for the control/recognition of screen numbers - the Display
Screen No. and the Change Screen No. When using this feature, please set up
your Device/PLC so that it checks if the [Notification Bit for Password Cancel] is
ON, and ifitis, will return from the [Change Screen No.] to the [Display Screen
No.] If the original screen number is returned, the password entry window will
automatically close. For more information about Direct Access/ Memory Link

Access System Data Area, Device/PLC Connection
Manual

%te: - This feature is designed only for systems where control is performed via
2]  the Device/PLC. Therefore, even if a Function SW/T-tag/D script is used

to directly change an ST unit screen, the [Notification Bit for Password
Cancel] cannot be used.

- If this feature is not used, and the Device/PLC unit requests a screen
change, manually pressing the [ESC] key will not close the screen.
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& Auto Clear Time

This feature sets the length of time (1-60 min.) required before the security level
status returns to "0", assuming no ST unit operations/ screen changes are per-
formed.

If"0" is entered for the min. value, the security level status will not be automatically
cleared.

@ Security Control Address

When the Auto Clear Time feature is used, the Security Level Control Address'
Security Level Clear bit turns ON.

LS9300 Security Level Control
LS9301"™ Security Level Status
LS9302"t Request Security Level Status

*1 Read only.

<Security Level Control>

15 01 00 bit

LS9300

v

Bit 0: Security Level Clear bit

When the bit changes from [0] - [1], Security Level Clear is performed.

<Security Level Status>
This feature stores the value of the current security level, and indicates
the maximum security level that requires no password to enter.

<Request Security Level Status>
Stores the security level of the screen to be displayed next.

@ Password Entry Window

This feature automatically displays the following window when the ST unit's
security level status changes from the current level to a higher level. You then
directly enter the password set in the [Password Setting] tab. Enter the correct
password, and press [ENT] to call up the next screen.

Password entered is displayed
using "*" characters.

Shows the security
level of the
screen/window to
be changed to

pa Ilfifﬁrliﬁlw

Switches between
upper and lower
case

(Roman character keyboard) (Numeric keyboard)
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%te:
A\

Chapter 2 - Base Screens

- If the password entered is incorrect, an error message "Incorrect Pass-

word" will appear in the window. Also, the ST unit's buzzer will sound.
Pressing the [ESC] key will cancel the next screen display, return to the
original screen as well as cancel the buzzer and error message.

- If the password entry window does not appear, but an error and the

message [Password window cannot be displayed] appears in lower part of
the ST unit's screen, close one of the local windows being called up on
the ST and perform the screen change again. The password entry window
will then appear. Only 2 local windows can be displayed at a time.

- This window cannot be modified.
- Passwords cannot be entered using the Device/PLC unit.

- Passwords cannot be entered using the Bar-Code Reader.

@ Password Enter KeyBoard
- Defaut Settings

You can designate the default password entry keyboard as being either an
alphabet or a numeric character keyboard.

- Request Level Display

When this feature is enabled, the security level of the screen being called up next
is displayed in the Password Entry window. This feature can only be set via this
checkbox. It cannot be set using the ST unit.
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2.11 Creating ST Series Screen

B Entering Password Setting and Extend Tab Settings

PROCEDURE

REMARKS

(1)Select the Project Manager [Screen/Setup] menu
[Security Settings] area [Password Settings].

(2)In the [Password Setting] tab, click on [Use Security
level] to enable this setting.
This will activate the data entry areas.

Password Settings

Password Setting | Extend |

Low  Levelll J ||

(3)Enter a password for the desired level(s) (1 to 8
characters).
To set the highest level of security for the ST unit's
OFFLINE screens, click the [Specify Password Level
15 when switching to offline].

[Passmard Seting | Exend

¥ Use Secuity level

Low  Leveim  Jasbbecdd
evell2

Le

Levell3
Levelnd
Levells
Levell§
Levell?
Levelng
Le
Le
Le
Le
Le
Le
Le

evelld

evell)
evelll
vell2

vell3
evelld
evell5 [abedsyz0

Hich

[ $pecy Password Level 15 when swiching to afffne

o | concel | Help

(4) If necessary, click on the [Extend] tab and enter the
desired settings there.
When all settings are completed, click to

enter the settings, or to delete all the newly

entered settings.

assword Settings
Fassword Setting]| Extend ]

Bitfor Password C
i Natification Bié

(o000 =]

Ao Clear Time 5 =] e

rPassword Enter KeyB oard:

Diefaul Setings
’( %) Numeric KeyBoard 1) Text KeyBoard ‘

1 Request Level Displap

3 Cancel Help

Be sure to click the [Use Security
level] setting for any projects using
the security feature.

Be careful when entering your
password - the program recognizes
upper and lower case letters.

If the [Specify Password Level 15
when switching to offline] box is
checked, be sure to check that the
Level 15 password is entered.

Setting this item to "0" will cancel the
Auto Clear feature.
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@ Security Level List ]

GP-PRO/PBIII for Windows Ver. 6.3 allows you to create a convenient list of all
the base screens and windows that are assigned security levels. This is useful
when changing each screen's Security Level or editing the screen’s Password.
You can also change the security level of multiple screens at the same time.

%te: - Before using this feature, be sure to check that the [Security Settings]
feature's [Use Security level] setting is enabled.

Usage Pattern

[Screen/Setup] - [Security Settings] — [Security Level List] -

If necessary, modify or

— Check Security Level — any ofthe passwords -

used to close.
W Security Level List
Each screen's Screen Title Changes thelist's
security level display format
» Security Level List
ShOWS Base — Screen No Security Level s
(B) and i
. dOW @ScreenNo
win | gé g Ee\ease Schrdule ) gSecurity Level
screens only B ] Vimenoned T
BY 1] Azsembly
11 0 Wamini IW:}
Used to modify a
screen's password
& | | Settings -jumps to
[Password Set-
[ oed ] tings] dialog box
Securty Level Chnage 1] E| HelpH]
4
Used to enter a change in the Clicking allows you to change
level of any screen listed. the security level of the se-
Level can be from 0 to 15. lected screen to a new level.
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2.11 Creating ST Series Screen

B Editing a Security Level or Password via the Security Level

List

PROCEDURE

REMARKS

(1)Select the Project Manager's [Screen/Setup] menu’'s
[Security Settings] area's [Security Level List].

(2) To edit/change a screen’s security level, select the
screen (multiple screens can be selected), enter the
desired level in the [Security Level Change] and then

click on the button.

The change will be reflected in the List.

183 Screen Mo
3 Secuity Level

Ui 0 Wanin i Password Setting...

=«
e |

4

Secuity Level Chnage |0 =

(3) To change the screen’s password, click on [Password
Setting] button.
The screen changes to the [Password Setting] dialog
box. For information about Password entry,

2.11.4 Password Settings

(4)When all settings are completed, click to

enter the settings, or to delete all the newly

entered settings.

Be sure to click the [Screen/Settings]
area's [Password Setting] window's
[Use Security level] setting for any
projects using the security feature.

The Security Level List can be listed
and edited even when saved asagiven
name or changed the screen's title.

When a screen is opened, its security
level can be listed, however, it cannot
be edited.
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@ Security Settings - Printing Setting Information ]

You can use a printer to print out your project's security settings and check the
information. Chapter 9 Printing

Usage Pattern

[Project Manager] - [Print] - Projectinformation -

or
Click on

Enable [Security Settings List] — Click to printout.

W Settings
Click on the item to select it, and click .

Print
Frcject Infarmaion | 5 ceen |
=Froject Infomatior

H General Informetion Secunty Settings List

Tl Sereen List Diil..

T Adam List Dol

T windows List

| GP Settings List

10| Data Sampling Settings List Uiz

Il Handy/ST Global Settings List Dl

I Filing Diata List

L) Dat it

H Data Logging Settings List

1 Global D-Seript List

| EXT 510 Script List

10| D-Geript Function List

14| Sound Settings List

T Symmbel List
Tl Glabal Cross Reference List
U B anuity Setings Lisk
] Time Schedule Functipn List

“ i3 Hl Cancel Hl Apply |H Help

Check mark means selected.
B Printout Examples

The following is a sample of the printout from this feature.

Security Settings List

U Secmylevel i
Password
Levell wekbeedd
Levell

Leveld
Leveld

Level§
Levelf
Level?
Leveld
Leveld
Leveldd
Levelll
Lewelit
Levell}
Levellt
Levell§ -

§pecity Passoord Levells ohen s witching ) fhEfline

¢ ancel Use Bir
st Rotification Bit i

Use Bit: Addmss -

Atwo (learTime(Pan) 5

Passoord Inpik. X ey Boand
D efanit S etings Rumes KeyBoazd
R equest Level Display i

%[e; - Viewing or printing out the [Screen List] enables you to check the secu-
rity level set for each Base (B) and window (U) screen. (When Security
feature is enabled.)
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@ Time Schedule ]

This feature will reset, or set, bits or words according to a pre-set date/time
schedule.

) /|\ - The Time Schedule feature is available only with ST Series
/mp:rtant units.

Usage Pattern

Select schedule in [Time
Schedule Function List]

-

[Screen/Setup] — [Time schedule] -

Edit/Copy/Paste/Clear or

— -
the schedule to close.

B Overview

This feature will reset or set bits or words according to a pre-set date/time
schedule. If this feature is set to activate the control addresses used for Filing
Data (Recipes), or D-Script, these features will then operate on the designated

day/date.
[Example]
09:00:00 17:00:00
S = S Finish S
— tart | Work | =) _>
S Screen |3 Screen | =
@) © <

Log the
work data

Transfer
Recipe data

%[e; - Time Schedule settings cannot be entered via the ST unit's OFFLINE
2l screens. These settings can only be entered via the editor software's
setting menu.
Allows you to
update/edit the
settings used for
any Time Schedule
entries

[Fation MEration Addrd] Tyee | Setting Addjart TimEnd Time| Tay =] H Edit

Bit Set |X00000 Direct |---—- 0% :00 :00(07 :00 :00| 3un ,Man, Tus,Wed,, TIL_|

= FT

Word 5e4D00D00 TndirectDOoo0n  |-—---  |—---  |—--

Bit Set [X00000 Birect |---— (0% :00 :00| L& :00 :00[Man-Fr1

| Copies the Time
Schedule
Pastes the copied
schedule

af wf o~

Clears the selected
schedule data

%[e; - A single project may have up to 32 Time Schedule items.
2l
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address to

If the Operation End value
Mode has been set

@ Entering Time Schedule Settings ]
B Time Schedule Settings

Simply double-click on the Time Schedule Function List's left-side item list (1, 2,
3, etc.) or click once on the row to select the itemand clickon| es.  |tocall
up the Time Schedule Function dialog box.

The following features become available.

When this feature is

Selects the Opeiation Seftings | Time Gettings | enabh_?q, as Soor-] as the
. ST unit's power is turned
operation mode. ON, the range of the
Dperation Mode %"7 ’ - g .
Depending on —__| schedule is recognized.
the Operation [T~ Opessionacidess Jo0000 [ If the ST unit's power is
MOde SeIeCtedy ﬂSatm’End Time Operation when Power iz switched on. turned ON dU“ng (InSIde)
designates the e Seting the scheduled range, the

start time/operation will
be performed.

If the ST unit's power is
turned ON outside of the
scheduled range, the
end time/operation will

9 Direct £33 Indirect
Cﬂ Codes/ @Dec  LJBCD £ HeQ

Start Yalug 1 ':1,'._

to Word Setl16 or —— be performed.
Word. Set3?, this 7%_usénngbwperawmﬁ Designates the word write
area s activated. N E— value's sign and data
This area allows \ format.
you to directly enter o | = |k re | '
data for the start Y Enter the value written to
and finish write \ the address when the
If the Prohibit Enter the value schedule starts. If the
Operation Bitis ON,  written to the [Time Settings] tab's End
the schedule/ address when Operation is not enabled
operation is not the schedule (checked), you cannot
performed. finishes. enter data in this area.

@ Operation Mode

When entering the settings for an item in the Time Schedule Function List, the
operation mode settings must be selected. These settings include, [Bit Set], [Bit
Reset], [Word Set16] (16-bit write), and [Word Set32] (32-bit write).

Operation example 1: Bit Set

When [Bit Set] is selected, the following operations are performed:

Operation example 1: Bit Set Start Time End Time
Start Time :09:00:00 ! ! !
End Time :17:00:00 ON ' : )
|
OFF I i I
|

09:00:00 12:00:00 17:00:00
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Operation example 2: Bit Reset
When [Bit Reset] is selected, the following operations are performed:

Operation example 2: Bit Reset Start Time End Time
Start Time :09:00:00 [ [ .
End Time :17:00:00  ON : | |
-] |
|
OFF :
|
|

09:00:00 12:00:00 17:00:00

Operation example 3: Word Set

Selecting [Word Set] performs the following operations.
This mode's selections include 16 bit and 32 bit.

Operation Mode : Word Set Start Time End Time
Device Address  : D0100
Start Write Value : 10
End Write Value :0

Start Time :00:00:00 P00 10 D100 | 0
End Time £ 17:00:00
l | >
09:00:00 17:00:00
@ Operation Address

Designates the address used to control the schedule.

@ Start/End Time Operation when Power is switched on.

When this feature is enabled, as soon as the ST unit's power is turned ON, the
range of the schedule's start and finish times is recognized. If the ST unit's power
is turned ON during (inside) the scheduled range, the start time/operation will be
automatically performed. If the ST unit's power is turned ON outside of the
scheduled range, the end time/operation will be automatically performed.

%te: - If this feature is disabled, and power is turned ON inside the schedule
i range, but the start time has not already been passed, the start time/
operation is not automatically performed. However, the end time/opera-
tion will automatically be performed.

- If the end time/operation is not set in the schedule, this feature will not
be performed.
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€ Word Settings

These settings are active only when the Operation Mode is set to [Word Set16]
(16-bit write) or [Word Set32] (32-bit write).

Direct

Designates the word write value's sign and data format. If [Dec] and
[Code+/-] are selected, negative values can be set.

The [End value] is enabled only when the [Extend] tab's [End Day Operation
Setting] is checked.

Indirect
Designates the address used to store the Start time and End time values.

@ Prohibit Operation Bit

When this feature is selected, at the beginning of the schedule, the designated
value will be read out from the Prohibit Operation bit's address. If the Prohibit
Operation Bit is ON, the schedule/operation is not performed.

B Time Settings

The following explanation describes the settings in the Time Schedule Function's
[Time Settings] tab.

@ Direct
Directly designates the start/end time.

Operation Settings || Time Settings 1

+—Enabled when the Time

(Ij)(lar;(;tr!');tes BRIt Schedule will span 2 or
1] Dy Saltnge more days

the start/end I

time 0 E] e [ Fat ] secons

O sun T Mo [ Tue [ wed 1| The A [0 St

=End;

1| End Dperation Sets the Start tlme and

@ T\me@ Part @Secumﬁ the Start Day

2 Bun 9 o D) Tue O Wk O The DRI D oa

Sets the End time and the
End Day

ok ]| Tancel | Heb
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€ End Day Operation Setting
<When enabled>
Can be set if the Time Schedule spans 2 or more days.
Only one day can be set for the start day.

Only one day needs to be set for the end day. [End Operation] is automatically
enabled.

Enter the Start and End times.
%{% - Start and End times cannot be the same time on the same day.

<When disabled>

A schedule that is 1 day (Start and End times are within 24 hours) can be en-
tered.

Multiple Start days can be selected.
Be sure to click on [End Operation] when setting the End time.

%@1 - Be sure to select one or more start days.
- Start and End times cannot be the same time.

- The Time Schedule (mentioned here) is for one day only, so if the End
time is entered as being before the Start time, the End time will be
performed on the next day.

E.g.) Start Day : Monday

Start Time: 22:00:00
End Time :01:00:00

Mon. Tue.

I I‘ I 0 -
22:00:00 01:00:00
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@ Indirect
Indirectly designates the Time Setting data in the Time Setting Address.

Time Schedule Function
[ Operation Settings || Time Settings |
M indirect
Ind'rectly / Time Setting Address %F
designates the [ Cartal Bom0n
address used to Sistus puos; T~ _
Sto re t|me Operation Made Dooaoz DeSIQnates the
setting data. Stat Time(Day) B address used to
Stait TimeTie] Dinnnd store time setting
Start Time[Part) DO000S data.
Add resses used Start TimelSecond) DO000E
for Storlng tlme End Time[Day] Doooo7
S ettl n g d ata End Time(Time] oo
End Time[Part) Lioooog
End Time|Second] Dooo1o
|| ok | H Cancel ‘ “ Help

@ Time Setting Address
Designates the addresses used to store time settings data read out from a Device/

PLC.

Address+0 Control
Address+1 Status
Address+2 Operation Mode
Address+3 Start Time (Day)
Address+4 Start Time (Time)
Address+5 Start Time (Part)
Address+6 Start Time (Second)
Address+7 End Time (Day)
Address+8 End Time (Time)
Address+9 End Time (Part)
Address+10 End Time (Second)

<Control> (Device/PLC - ST)

When the Time Read Request bit's 0 — 1 change (rise) is detected, the Opera-
tion Mode, Start Time, and End Time are read out.

15 01 00 (bit)
Reserved o)

Bit00 : Time Read Request Bit (0: No action, 1: Perform Time Read)
Bit 01-15: Reserved (Be sure the set value is fixed to "0".)

%fe.' - Data is not read out regularly, from the Time Setting Address operation
= mode (address +2) to the End Time (sec.)(address +10). When reflecting
Time Setting Data changes in the ST unit, be sure to set the Control bit
(address +0) from 0" to ""1".
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<Status> (ST - Device/PLC)

After the Control's time data readout is completed, the ST unit will turn the Time
Read Completion Bit ON (0 - 1). If the time data entered is incorrect, simulta-
neously the Error Alert Bit will turn ON (0 — 1).

15 02 01 00 (bit)
Reserved 0 0
Bit 00 : Time Read Completion Bit (0: Either Time Read is being

performed or had not yet been performed, 1: Time Data
Read Completed)

Bit 01 : Error Alert Bit (0: Time data is being replaced with
correct data. 1: Time data contains an error.)

Bit 02- Bit 15 : Reserved (Be sure the set value is fixed to "0".)

%te: - Once the Time Read Completion bit's rise (trigger) is recognized by the
A Device/PLC, be sure to turn the Control Time Read Request bit OFF
(1 - 0). Once this bit is turned OFF, the Status's Time Read Comple-
tion bit and the Error Alert bit will automatically and simultaneously be
turned OFF (1 - 0). (See below)

Time Read Request Bit
(Device/PLC -> ST)

Time Read Completion Bit
(ST -> Device/PLC) ; 40 i

Error Alert Bit D %)
(ST -> Device/PLC) : |

Data Read : -
(Device/PLC ->ST) — | |__lime DataRead
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%te:
NS

Chapter 2 - Base Screens

<Operation Mode>

Set if the End Operation and the End Day Operation Settings are enabled/
disabled. However, regardless of the End Operation status (enabled/disabled),
the indirectly designated time data (Time Setting address's total 11 Word) is all
read out.

15 02 01 00 (bit)
Reserved @) 0]

Bit 00 : End Time Action Setting (0: None, 1: Used)

Bit 01 : Day Setting Mode (0:None, 1: Used)

Bit 02 - Bit 15 : Reserved (Be sure the set value is fixed to "0".)

<Start/End Time (Day)> (Device/PLC - ST)
Designates the day used as a trigger for the Start/End action.

15 07 06 05 04 03 02 01 00 (bit)
Reserved Sat. | Fri.| Thu.| Wed.|Tues.| Mon.| Sun.
Bit 00 : Sunday (0: None, 1: Designate)
Bit 01 : Monday (0: None, 1: Designate)
Bit 02 : Tuesday (0: None, 1: Designate)
Bit 03 : Wednesday(0: None, 1: Designate)
Bit 04 : Thursday (0: None, 1: Designate)
Bit 05 : Friday (0: None, 1: Designate)
Bit 06 : Saturday (O: None, 1: Designate)

Bit 07 - Bit 15 : Reserved (Be sure the set value is fixed to "0".)

<Start/End Time>

Here, you enter the time values used for the Start and End operations.
The following time setting example is used.

- The setting/not setting of the End Time will depend on the Operation
Mode (address +2) setting. Also, the End Time Action Setting (bit 00)
available will depend on the Day Setting Mode (bit 01) used. The follow-
ing chart shows what combinations/selections are available.

Day Setting Mode Used Not Used
End Time Action Setting Used Used | Not Used
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[Setting Example 1]
Operation Date : Tuesday, Thursday (within 24 hours)
Start Time :9:30:00
EndTime : None
15 02 01 00 bit
Address+2
(Operation Mode) 010
15 07 06 05 04 03 02 01 00 bit

Address+3

(Start Time - Day) 0j0j1j0f1j0]0

15 00 bit Enterany
Address+4 value from
(Start Time - Hour) 9 0to 23in
Binary™
15 00 bit
Address+5
(Start Time - Minute) 30 Enter any
value from
15 00 bit | 0to59in
Address+6 0 Binary™

(Start Time - Second)

%te; - Ifa ™0™ (Not Used) is entered in the Day Setting Mode, the End Time
(Day/Hour/Minute/Second ) data will be read but it will be ignored.

*1 BCD input cannot be used. If the value is entered is outside of the allowed range,
the unit may not operate correctly.
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[Setting Example 2]
Operation Date : Monday to Friday
Start Time :9:30:00
EndTime :18:00:00
15 02 01 00 bhit
Address+2
(Operation Mode) 11
15 07 06 05 04 03 02 01 00 bhit
Address+3
(Start Time - Day) 0/0/0/0]1]0]0
15 00 bit Enterany
Address+4 value from
(Start Time - Hour) 9 0to 23in
Binary™
15 00 bit
Address+5
(Start Time - Minute) 30 Enlter ?ny
value from
15 00 bit | 0to59in
Address_,+6 0 Binary™
(Start Time - Second)
15 07 06 05 04 03 02 01 00 bhit
Address+7
(End Time - Day) 0/1{0j0/0]0]0
15 00 bit Enterany
Address+8 value from
(End Time - Hour) 18 0to 23in
Binary™
15 00 bit
Address+9
(End Time - Minute) 0 Enter any
value from
15 00 bit | 0to59in
Address+10 Binary"
(End Time - Second) 0

%{e; - Ifa ™1™ (Used) is entered in the Day Setting Mode, be sure to enter all
Start and End time (Day, Hour, Minute, Second) information. However, if
2 or more of the Start/End time (Day) bits turns ON simultaneously, an
error will occur.

*1 BCD input cannot be used. If the value is entered is outside of the allowed range,
the unit may not operate correctly.
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B Usage Restrictions

The Time Schedule features are "one-shot" operations. In other words, when
the Start time is reached, the designated device address is written to just once.

The write operation is not repeated.
Operator turns OFF

Operation : Bit Set Start Time End Time
Start Time: 08:00:00

End Time :08:20:00 ON _ _ __

OFF — - - - - - *

07:50:00  08:00:00 08:10:00 08:20:00

When changing ST Time Settings, the range of the schedule's start and finish
times is recognized. If the edited item is inside the scheduled range, the start
time/operation will be automatically performed. If the edited item is outside of
the scheduled range, the end time/operation will be automatically performed.

%te: - If the end time/operation is not set, the schedule's range cannot be
= confirmed and this feature will not be performed.

If the Start Time Operation is completed and then becomes a "Power Out"
condition, the schedule's range will be recognized and the End operation will

be performed at the End Time.
Power Out

Operation : Bit Set Start Time End Time
Start Tlme: 12:00:00 \| Operate
End Time :12:20:00 ON - _ _ _ | — N N

OFF — - - - - — |- - - - ]

11:50:00  12:00:00 12:10:00 12:20:00

If the Time Setting is designated as indirect, only the Time Setting Address
Control's (Address +0) will be read out with High Speed. Up to 32 Time
Schedule settings can be entered, however, if all Time Settings are all desig-
nated as indirect, 32 Control addresses (address +0) will need to be continu-
ously read out and the ST unit's overall performance may be effected.

When "Indirect™ is used, the Time Setting address control's (address +0)
normal readout speed is once every 500ms.

When the Control Address bit 00 (Time Read Request Bit) changes from 0 to
1, a delay of up to 500ms may occur before the Time Status (address +1) and
onwards data is read out.

Also, when multiple Control (address +0) bit 00 (Time Read Request Bit)
simultaneously change from 0 to 1, in order that operations can be started in
the order set, a delay may occur before an operation is performed.

The Word Write Value setting's Start/Stop Write Value's indirect setting, and
the Prohibit Operation bit monitoring are read only once, at the beginning of
the Time Schedule. Since regular readout is not possible, there may be a slight
data communication delay that causes the designated operation’s Start Time to
not be performed at exactly the Second setting entered.
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@ Time Schedule Data Printout ]

You can also print out detailed schedule information from the Time Schedule
Function List. For printout details, S TI7TTTIr IR Chapter 9 Printing

Usage Pattern

[Project Manager] — [Print] — ProjectInformation -

or Time Schedule . .
Click on Function List to printout.

W Settings
Click on "Time Schedule Function List" and click to printout the data.

Print
(F Pt ot 2]

= Project Informatio
1 General Information

I Sereen List
ﬂ Al List
ﬂ “window List
| GP Settings List
ﬂ Data Sampling Settings List
ﬂ Handy/ST Global Settings List
| Fiing Drata List
I et TraakerList
L Data Logging Settings List
I Gilobal D-Script List
I EXT SI0 Seript List
) D-Seript Function List
ﬂ Sound Settings List
I Symbol List
I Global Cross Reference List
T Secuity Settings List
1] ifime Gcheduls Funcion Cist

Time Schedule Function List

g
t

g
E

g
t

g
E

O ||| Concel ||| épob ||| Heb

Checked indicates selected.
B Sample Printout
Click on "Time Schedule Function List" and click to printout the data.

Time Schedile Function List

Bol

0 pexstion M ode Bit Set
0 peration & ddress Xoowoo
Type T imet
Time Setting Addmss —
Staxt Time g0
EndTime oo
Day St onToe W edTuFuse
W riee Mode -
Start W alue -
End Yale -
Prohibit 0 perstion Bit -
Power 0n on
Rol

0 pexstion M ode W ord Seelf
0 pexstion A ddress Daga0n
Type Indizect
Time Seming Addmss Daga0n
St Time -
EndTime -
Day j—

Wl rite M ode Dec
Start ¥ alue o

End Vale o
Prohibit 0pemtion Bit j—
Power 0n on
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» DXF Conversion

7 U
Important

This feature allows you to convert DXF (Drawing Interchange File) file data
into Base screen data, and to convert Base screen data into DXF file data.
(A DXEF file is on Auto Cad® drawing file)

DXF filenames must be alphanumeric.

DXF can be used for the Release 12 program. If a newer
version’s data is used, that data will not be converted.

When each object’s coordinates are converted, errors may
occur, thereby slightly changing them.

Once a DXF file data is converted into Base screen data, even if
the Base screen is again converted back into the original DXF
file, or vice-versa, the resulting data my be unusable.

When converting data, be sure that the screen’s width and
height ratio will be the same for both the Base screen and the
DXF file (Screen size settings: $LIMMAX, $LIMMIN). If this ratio
is different, after data is converted, object locations or shapes
will also be different from the original.

@ Conversion from DXF File to Base Screen (DXF — PRW) ]

DXEF file data is converted into Base screen data.

s ~~
| GP-PRO/
DXF file |:> |:> PBIIl Base
‘\‘«—«_« Qgieen

Convert

B Requirements and Restrictions when Converting Data

(DXF - PRW)
e Grouped objects (Blocks) can be nested up to 10 layers (levels deep).

» The DXF file data format is ASCII. Both “CR LF” and “LF” can be used
as line feed characters and will be converted correctly.

« During conversion, when the resulting output file’s size reaches
16Kbytes, the conversion will quit, and subsequent data will not be
converted.

* Three dimensional data cannot be converted.

» Ifthe X,Y coordinate screen boundaries ($LIMMIN, $LIMMAX) are not
set up correctly in the DXF file, after the data created in the DXF file is
converted into Base screen data, it may go beyond the Base screen’s
display area.
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» After DXF file data is converted into Base screen data, the DXF file
name is used as the Base screen’s description.

* When a layer’s attribute has been turned OFF, that layer’s data will not be
converted, and only ON layer data will be converted into Base screen
data.

* Fill and Oval/Arc data cannot be converted.

W Option (DXF —» PRW)

Here, select and enter the color and size used when converting data. Ac-
cording to the specified DXF and Base screen size, data will be relatively
magnified or minimized when converted.

Option [ DXF -» PRW ] [x]y DXF size _
| Selects a DXF file

Convert Color —_| .
Size

Data is converted as
colored =Convert 0=F Size
%3 Use SLIMMIN $LIMMAX

£ Use SEXTMIN SEXTMAR

Screen Size | =Corvert GP Size

Designates the 173 BA0x450
screen size used # £ BADRA00

after conversion y 13 3204240

£ 800:600

|I ak. I| Cancel || Help |

& Convert Color

When this box is checked, DXF file data is converted as colored. When this
box is not checked, DXF file data is converted as monochrome.

BmColor Conversion (DXF — PRW)

& Convert DXF Size

The DXF file data conversion range is selected.

When “Use SLIMMIN, $SLIMMAX” is selected, data in the DXF file’s
maximum screen area (X,Y coordinate screen boundaries) will be converted.
When “Use SEXTMIN, SEXTMAX” is selected, only data in the DXF file’s
object area will be converted.

& Convert GP Size

The Project File screen size (GP screen size) used after conversion is speci-
fied.
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B Color Conversion (DXF - PRW)

When the [Option] dialog box’s [Convert Color Data] check box is checked,
the DXF file’s color data will be converted as follows:

DXF File Color No. Base Screen

1 (red), 1X (red-based) Red

2 (yellow), 5X (yellow-based) Yellow

3 (green), 9X (green-based) Green

4 (light blue), 13X (light blue-based) Lightblue

5 (blue), 17X (blue-based) Blue

6 (purple), 21X (purple-based) Purple

7 (white) White

Other colors White

The background color will be converted into Black.
B Line Type Conversion (DXF - PRW)

Each DXF file’s line type will be converted as follows:

DXF File Base Screen
CONTINUOUS Solid line
DASHED - ——~- Broken line
HIDDEN - - =~ Broken line
CENTER — - — Adot-dash-line
PHANTOM — - - — Two dot-dash-line
Other — Solid line

The user defined line types will be converted into solid lines.
B Object Conversion (DXF - PRW)

The DXF file’s objects will be converted as follows.
Colors and line types will be converted as shown above. Tiling patterns will
be converted into solid Fill.

DXF File Base Screen
LINE Straight line
POINT (dot) Straight line (The start and end are the
same point)
CIRCLE Regular circle
ARC Arc
TRACE (thick line) Filled polygon
SOLID (filled object) Filled polygon
TEXT (characters and signs) Text
DIMENSION (dimension indicator) Straight line
. . : Conversion breaks down complex
INSERT t bject ) - .
(inserting object) objects into component parts (objects)
ATTRIB (attribute) Qonvgrsmn breaks down complex
objects into component parts (objects)
POLYLINE(polyline/donut-shaped/ - A
ovalipolygonfrectangle) Continuous straight line
VERTEX Vertex coorqutes qf a continuous
straight line

Objects other than the above will not be converted.
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Each object’s elements, other than colors and line types, will be converted as
follows:

€ POINT (dot)
* A dot’s pattern will be converted into “0” (point), and its display size will
be converted into “0,0”.
« A dot will be converted to a straight line, with the start and end coordi-
nates at the same point.

@ TEXT (characters and signs)

» A rrotation angle will be converted into an angle closer to 90°, 180°, 270°,
or 360°. (in 90° units)

» The character size will be converted into a size closer to either 1, 2, 4, or
8 x magnification.

» Special characters that will be converted are %%d (°), %%c (@), and
%%p (£).

* When text contains more than 100 characters, it will be divided every
100 characters into records of data and then converted.

» When more than 100 character text is divided into records of data, groups
of overflowing characters after the first 100 characters will be dislocated
toward the right bottom for a few dots.

» Tilting angles, character fonts, and character spacing will not be con-
verted.

» Text will be converted based on the ASCII code; therefore, the character
style (Standard, Bigfont, etc.) or font file settings will be ignored.

*  When text with half-sized and full-sized characters mixed in vertical
lines is converted, the half-sized characters will be centered.

€ DIMENSION (Dimension Indicator)
» During conversion, the breaking down of a grouped object (Block) is

performed by referring to the Block’s sections, which indicate the Block’s
component parts (objects). However, dots will not be converted.

@ INSERT (Inserting Object)

» A grouped object defined in the Block section will be broken down into
each drawing object and converted.

» Up to 10 layers of nested data will be converted. However, since all the
data will be converted into a single layer on a single screen, the objects
over the limit (file capacity) will not be converted.

» Although the rotating angles, and the number of lines and columns can be
converted (lines and columns of the objects over the limit will not be
converted), their ratio (scaling) will not be converted.

» The grouped object created in Layer “0” will be converted based on the
inserted layer’s colors and line types, however, a grouped object created
in an other layer level will not be converted based on the inserted layer’s
colors and line types. In this case, if BYBLOCK is specified to the
grouped object, the inserted layer’s colors and line types will be used.

» Simulated object sectioning (hatching) data cannot be converted, since,
when the Block section’s hatching data pattern is converted into each
drawing object, that data size can exceed the GP file capacity.

 [f another file’s grouped object has been inserted or another file is re-
ferred, that grouped object will not be converted.

€ ATTRIB (attribute)

ATTRIB (attribute) data is part of INSERT data.
o Attribute data will be converted in the same manner as TEXT conversion.
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€ POLYLINE (polyline/donut-shaped/oval/polygon/rectangle)

» POLYLINE data will be converted connecting the following VERTEX’s
coordinates with a continuous straight line. Only data whose polyline flag
is either “0 (default)”, “1 (closed polyline)”, “2 (adding the fit curve
vertex)”, or “4 (adding the spline curve vertex)” will be converted.

* When the number of vertices exceeds 100, data will be divided every 100
vertices and converted.

* When the converted data’s coordinates are repeated at the same point, the
following coordinates will be omitted.

» When a polyline has curved sections, they will not be converted. There-
fore, donut-shaped lines and curved polylines will be converted into
continuous straight lines, connecting each coordinate point.

€ VERTEX

Top coordinates of a polyline.
* A polyline’s width will not be converted.

B Converting DXF File Data to Base Screen Data

PROCEDURE REMARKS

(1) Select the pull down menu [Utility]’s [Convert DXF
] command.

(2) Click on the | D=F-FRW | putton.

‘\"'J DXF<->PRW Converter |

(3) Designate the source (DXF file) and the destination| To designate a folder, click on the
(Project File), and enter the Base screen number. button.

\Proaram Files\Pro-face\ProPB | [E oied
o
Proisct File: [C:*PROGR&M FILESSPROFACEP | 5olont
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PROCEDURE

REMARKS

(4) Click on the button and enter the conver-

sion conditions.
File Convert [ DXF -> PRW )

From:

To
Project File: [C:\PROGRAM FILES\PRO FACEWR

J

Comet | [ Caed | [ Hep |

(5) After all the attributes have been entered, click on

the button to registered the entered data.

Dption [ DXF - PRV |

Convert Color
Convert DiF Size
15 Use $LIMMIN_SLIMMER
£ Use SEXTHINSEXT MAX

Convert GP Size:

£29 B40x480

d 1 6404400
v £ 320:240

) 8004600

(6) Click on the button to start conversion.

File Convert [ DXF -> PRW |

From:
DxF File:

C:4Program Files\Pro-face\ProPB 3w | |15 giect

Ta:

Froject File: [C\PROGRAM FILES\PRO-FACEVE || 6 ofect

" Option

(7) After the conversion is completed, click on the
button. The [DXF<->PRW Converter] dia-
log box will reappear.

File Convert [ DXF > PRW )

From:
[F File; JC *Pragram F\Ies\F‘lo-lace\F‘mPBMi‘ Select

To

Project il [CPROGAAH FILES\PAD FACEY® ‘
Saisenlo; B

JEump\ele

FReadng DXF [340ine]

Corvverting (1003

wiiting Screen [30objects)

Complete

‘ Convert | | Cancel 1 | Help |

(8) Click on the button to quit.

# DXF<->PRW Converter |

DAF - PR

PR -» DRF

W Option (DXF
~ PRW)

If the designated screen number al-
ready exists, a prompt will appear,
asking whether the new number
should overwrite the old number.
When the button is clicked
on, the new number will overwrite
the old one, and when the
button is clicked on, the new num-
ber will not overwrite the old one.

Overwrite

Thiz screen already exists!

Do you want to overaite?

To convert another DXF file, DO
NOT cancel here; rather, start from
step (3) again.
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@ Conversion from Base Screen to DXF File (PRW — DXF) ]

Base screen data is converted into DXF file (Drawing Interchange File) data.

~ P
GP-PRO/ |
PBIIl Base |:> |:> DXF file

\.screen e

Convert

Can be used for

CAD software for a
personal computer,
such as AUTO-CAD

B Requirements and Restrictions when Converting Data
(PRW - DXF)

* Only Base screens can be converted.

* Image screens called up on the Base screen will not be converted.

» Tag data will not be converted, so for example, M-tag’s Marks will not be
displayed after conversion.

* When text is converted, the character size and position may differ from
the original due to font type difference and errors created during conver-
sion.

» Since Load Mark will be converted into a simple straight line (i.e. no
width), if it has been magnified, it will be displayed differently from the
original after it is converted.

/|\ If you try to convert afilled polygon that has four peaks, one of

,,/,,p:,,a,,, which introverts, into a DXF file, this polygon will not be con-

verted properly.
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W Option (PRW - DXF)

Here, select and enter color and size data used when performing data con-

version.
Screen Size R Dption { PRW -> DXF |
DeSIgnateS the GP =Convert Screen Size—————y
screen size after conver- "
sion !
=Canvert DXF Sizeem—m—m—m——— P t St t
£ BA0,450 arts ate
. o m £ 540,400

DXF size ; £ 20240 Selects and enters the Part
Designates the DXF £7 3004600 State when converted
screen size when Base [Foe e
screen data is converted gu pa
into DXF file data 10

o1

" [n]:8 H Cancel H Help |

@ Convert Screen Size
The screen size of a GP unit specified in the Project File.

& Convert DXF Size

The DXF file size used after data is converted using data conversion is
selected. The default values are the same as the Screen Size values men-
tioned above.

@ Parts State
Bit ....... When Part display states (ON/OFF) are specified, that Part will be
converted for each display state.

Word .. Picture Display and Message Display will be converted with the
display state specified here.

W Color Conversion (PRW - DXF)

Base screen’s drawing data colors will be converted as follows:

Base Screen DXF File Color No.
Black 250 (gray)
Blue 5 (blue)
Green 3 (green)
Light blue 4 (light blue)
Red 1 (red)
Purple 6 (purple)
Yellow 2 (yellow)
White 7 (white)

The blink settings will not be converted.
With a 64 color GP unit, colors on the color palette will be converted as

follows:
Black Blue Black Black Blue Blue Green Green
Light blue | Light blue Green Light blue Black Black Blue Blue
Black Black Blue Blue Green Green Light blue | Light blue
Green Green Light blue | Light blue Red Red Purple Purple
Red Red Purple Purple Yellow Yellow White White
Yellow Yellow White White Red Purple Red Red
Purple Purple Yellow Yellow White White Yellow White
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B Line Type Conversion (PRW - DXF)

Base screen’s line types will be converted as follows:

Base Screen DXF File

1-dot solid line CONTINUOUS
————— 1-dot broken line DASHED
== 1-dot one-dot-dash line CENTER
— - - — 1-dot two-dot-dash line PHANTOM
m—)-(0Ot SOlid line CONTINUOUS
= == = )-dot broken line DASHED
= = = 2-dot one-dot-dash line CENTER
- = = 2-dot two-dot-dash line PHANTOM
m—— 3-0t SOlid line CONTINUOUS
s 5-(0t SOlid line CONTINUOUS

2.12 DXF Conversion

The line thickness will be converted in the same thickness for all the lines,
regardless of the line types.

B Object Conversion (PRW - DXF)

Base screen’s drawing data will be converted as follows.

Colors and line types will be converted as shown in the previous page’s
table. The background colors will not be converted. Tiling patterns will be
converted into solid Fill.

Base Screen DXF File

Stra_|ght _Ilne/Contlnuous LINE/POLYLINE
straight line
Square/Filled Square POLYLINE/SOLID
Regular Circle/Filled | o201 FiciReLE + SOLID
Regular Circle
Oval/Filled Oval POLYLINE/POLYLINE + SOLID
Arc/Pie ARC/ARC + POLYLINE
Division Collection of lines
Filled Polygon SOLID or POLYLINE

Broken down into each Part
Load Screen object and converted
Text TEXT
Load Mark POLYLINE
P Broken down into each part and

art
converted

Data other than the above will not be converted.

@ Straight line/Continuous straight line

» When the number of coordinates is “2”, a straight line or continuous
straight line will be converted into LINE. If this number is other than 2, it
will be converted into POLYLINE.

* When a line has an arrow at one end, a solid filled triangle will be drawn
at the end coordinates, and when a line has arrows at both ends, solid
filled triangles will be drawn at both ends.

@ Square/Filled Square

* Any line will be converted into POLYLINE.
» Any Fill will be converted into SOLID.
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@ Regular Circle/Filled Regular Circle

* Filled regular circle’s border will be converted into CIRCLE and its
filling will be converted into SOLID.

@ Oval/Filled Oval
* Any lines will be converted into POLYLINE.
 Filled oval’s border will be converted into CIRCLE and its filling will be
converted into SOLID.

& Arc/Pie
 Pie’s straight line section will be converted into POLYLINE.
@ Divisions
» When the divisions are marked on a straight axis, their coordinates will
be calculated based on their start and end coordinates, direction, and the
number of divisions, and will be converted into LINE.
* When the divisions are marked on an arc axis, their coordinates will be
calculated based on their start and end angles, external circle’s radius,

internal circle’s radius, number of divisions, and will be converted into
LINE.

@ Filled Polygon
e Fill will be converted into SOLID. However, if the number of vertices is
more than 5, Fill will not be converted and only its trace will be con-
verted into POLYLINE (CONTINUOUS).

@ Load Screen
» The screen will be retrieved from its attributes, and screen number and if
it exists, and each drawing data will be converted.
» The called up screen’s data will be converted in the same layer as other
drawing data.
* Only Base, Keypad, and Trend Graph screens will be converted.

& TEXT

« Characters written horizontally will be converted into BIGFONT. Those
written vertically will be converted into TATEGAKI (vertical type of
BIGFONT).

» 1/4-sized characters will be all converted into half-sized characters.

» Half-sized (1/4-sized) characters written horizontally will be converted
with a relative scale of 1/2 in the X direction, and other size characters
will be converted with a relative scale of 1.

« Both half and full-sized characters written vertically will be converted
with a scale of 1 for their height and width. Therefore, the half-sized
characters will become the same size as the full-sized characters.

e Character types of “Bold” and “Raised” will not be converted.

* Due to font difference and other elements, text will be different from the
Base screen, after conversion.

& Load Mark
* The Mark screen will be retrieved from the screen number, if that screen
exists, the dot pattern will be converted into POLYLINE (CONTINUOUS).

@ Part
« Each Part’s data will be converted into drawing data.
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2.12 DXF Conversion

B Converting Base Screen Data to DXF File Data

PROCEDURE

REMARKS

(1)Select the pull down menu [Utility]’s [DXF Conver-
sion] command.

(2)Click on the | FRW-DxF | button.

®4 DXF<->PRW Converter |3

" DHF > PRW

(3) Designate the source (Project File) and Base screen
number and designate the destination (DXF file).

File Convert [ PRW -> DXF )

Fram:
Fioject File: J\F'HDF‘BW’IN\database\noname.tmp || Select ]

Screen Mo B J1 |

T DF Filer JC:\F‘logram FiIes\F‘lo-face\ProF‘BS’\v\u"i||'§$
J
|. Corvwert } | Cancel ] | Help }

(4) Click on the button and enter the conver-
sion conditions.

File Convert [ PRW -> DXF )

Fram:
Project File: J\F'HDF’BW’IN\database\noname.tmp ” Select ]

Soreen Moo B J1 |

To D<F File: JC:\Plogram FiIes\Plo-face\ProF’BMi| Select]
]
© Corvert } | Cancel ] | Help

To designate a folder, click on the

button.
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PROCEDURE REMARKS

(5) After all the attributes have been entered, click on W Option (PRW

the button to registered the entered data. | — DXF)

Option [ PRW -> DXF )

= Convert Screen Size

:

v

~Convert DF Sz
£ 540we0

o QE"D:QDD

M £ 320:240

£ B004600

Patls Stelem—
Bit word 4State Lamp

£ 01 fciin
g0 1 ER
310
2

N (]

(6) Click on the button to start conversion. If the designated DXF file name
File Convert { PAW -> DXF | already exists, a prompt will

Fom appear, asking whether the new
Project F||a:J\PHDF’BW\N\dalabasa\noname tmp” Select name Sh0u|d Overwrlte the Old
Scieen Mo B _

DF F"B:JC:\F‘loglam Filez\Pro-faceyPraPB 3w nam_e. When the bu‘t_ton
is clicked on, the new name will

] _ overwrite the old one, and when

the button is clicked on,

the new name will not overwrite
|I Corvert } | Cancel ] | Help the Old One

To

(7) After the conversion is CompletEd, click on the To convert another Base screen,

button. The File Convert (GP — DXF) dia- | DO NOT stop here; rather, start
log box will reappear. again from step (3).

File Convert [ PARW -» DXF )

From:
Project File: J\F‘H OPEWIN'databasshnoname. tmp ” Select ]

D5¢F File: JE “Program FilesWProface\FoPB 3w H Select ]

To

JCDmpIete

Fieading Screen [15objects)

Caonverting [100%)

‘ériting DFF [958lne)

Complete

""Eaﬁﬁér'tm""‘il | Cancel ] | Help

(8) Click on the button to quit.

“"‘J DXF<->PRW Converter |

DxF -» PRW

" PRW > DNF

) Help
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B DRAWING APPLICATIONS - CREATING and USING SCREENS

G P-PRO/PB 111 for Windows provides various screens for specific
purposes (for example: for creating marks and messages), in
addition to the Base screens which are the fundamental screen used for all
drawing modes. Other screens can then be loaded onto Base screens as
libraries. Also, you can load them directly onto the GP series panel using

specified tags.
This chapter describes the procedure for creating these screens and their
applications.
31 Creating a Mark: the Mark Screen
3.2 ... Creating a Trend Graph: the Trend Graph Screen
33 Creating a Keypad: the Keypad Screen
34 Text Input: the Text Screen
35 . Creating an Image: the Image Screen
3B Video Data Display (V Screen)
BT i, Window Display: Window (U) Screen

and Base (B) Screen



3.1 Creating a Mark: the Mark Screen Chapter 3 - Drawing

Creating a Mark: the Mark Screen

Create a mark (dot pattern) on a “Mark” screen. Using the [Draw] menu -
[Load Mark] command, you can load the created mark onto a Base screen,
“Tend Graph” screen or “Keyboard” screen. Also, you can animate the
created Mark screen by specifying the M-tag.

Usage Pattern

Draw a mark
by turningon/

off each dot.
Click on to open a Mark screen.

Save the Mark

[Screen] - [New]
or screen.

General description of the Mark screen:

Editing
Tool Bar PEEELEENEER k
) eEmEmE e o | _~ Mar .

Drawing B drawing
Tool Bar tl area of 48 x

. Origin | 48 dots.
Indicates the g This area is
size of the ]

] composed
mark loaded 51 of 6 (verti-
on the base 8 cal)x 6
screen (1 x 1) E (horizontal)

&l blocks

(Each
block: 8 x 8
Displays the dots)
current
cursor A2 [c[BlaE[c[6[9]R] IR kL[ UMM [B[e[RS [T] [Ghl O]V M|
23 72027 || Ready 18 (L] iz

coordinates,
based on the

origin (0, 0) Screen capacity

B Drawing Tools

The Drawing Tool Bar icons and their corresponding drawing objects are as

follows:
Icon Drawing Tool Description
Dot Specify the ON/OFF status of each dot by clicking on each
0
dot or dragging the mouse within a specified area.
L Specifythe start and end points of a line and draw a line by
ne

clicking on desired points.

Square (Rectangle) Draw a square or rectangle by clicking and dragging to the

Filled square  |desired size on a diagonal axis.
(Filled rectangle)

Circle/Oval Draw a circle or oval by clicking and dragging to the desired

Filled circle size on a diagonal axis.
(Filled oval)

gifslicliclEla

3-2

GP-PRO/PB I11 for Windows Ver. 6.3 Operation Manual



Chapter 3 - Drawing

3.1 Creating a Mark: the Mark Screen

Icon Drawing Tool

Description

[¢a] Fill

Fill in an area with a desired color by clicking in the area
(enclosed within lines and shapes).

E Text

Enter the text to be displayed in the mark drawing area.

Call Up Mark

Library

Selecta Mark from the Mark Library

i Register Mark
= Library

Register a created Mark as a Mark Library.

W Editing Tools

The Editing Tool Bar icons and their corresponding functions are as follows:

Icon Editing Tool Description
Used to delete an entire Mark screen and store itin the
E Cut clipboard*1. Using the [Paste] command, you can then paste
the Mark screen onto another screen.
Used to copythe data of the selected Mark screen in the
Copy .
: clipboard.
e Past Used to paste the data temporarily stored in the clipboard
aste .
@ onto a desired place.
5 Duplicate Used to duplicate a Mark screen’s specified area.
@ Delete Used to delete a mark.
— Used to cancel the command executed immediately before,
ey Undo . .
and return to the previous condition. (Undo)
— Used to redo the command canceled with the [Undo]
(o | Redo
[ command. (Redo)
Used to move the dot pattern synmetrically relative to the
% Mirror X vertical axis. The symmetry axis is the vertical line that divides
' the screen into two equal sections.
_ Used to move the dot pattern symmetrically relative to the
Ap Mirror Y horizontal axis. The symmetry axis is the horizontal line that
divides the screen into two equal sections.
@ Turn . Used to turn the mark counterclockwise by 90°.
L= counterclockwise
Turn clockwise  [Used to turn the mark clockwise 90°.
I+ Reverse Used to reverse the white/black area of a mark.
Transparent/ It no dOtS are turned ON Ina blOCk (8 X 8 dOtS), thIS bIOCk
Background color [becomes transparent.

*1 When the [Copy] or [Cut] command is used, the copied or cut data is temporarily

stored in the clipboard.

When you use the [Paste] command, the data stored in the clipboard are pasted to

the selected position.
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3.1 Creating a Mark: the Mark Screen Chapter 3 - Drawing

B Mark Drawing Area Structure

The mark drawing area has the following structure. When you edit a mark,
you can use this for your reference.

—— |+ Rotation Center Point

Origin\ %
mN
+

+4+—|— -

Mirror ¥ Axis

Mirror X Axis

@ Drawing a Mark ]

When drawing a mark you can use GP-PRO/PBIII for Windows’ standard
drawing functions. Here, the procedures for using each function are described.

B Drawing with Dots

You can draw a mark by turning ON/OFF each dot. When you click the left
mouse button in the mark drawing area, each dot turns ON (white). When
you click the right mouse button in the mark drawing area, each dot turns
OFF (black).

A mark is created with dots, and displayed in a block (8 x 8 dots). If at least
one dot is turned ON in a block, the whole block is displayed when the
Mark screen is loaded onto a Base screen. In this status, the ON dots are
displayed in the current display color (Fg), and the OFF dots are displayed in
the background color (Bg).

A A
< This dot is ON.
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Chapter 3 - Drawing

B Freehand Drawing

3.1 Creating a Mark: the Mark Screen

PROCEDURE

REMARKS

(1)Select the [Draw] menu - [Dot] command, or click on

the icon.

(2)Draw a mark by clicking on each dot or by dragging
the mouse in the mark drawing area.

GP-PRO/PB Ill for Windows Ver. 6.3 Operation Manual
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3.1 Creating a Mark: the Mark Screen

B Drawing a Line

Chapter 3 - Drawing

PROCEDURE

REMARKS

(1) Select the [Draw] menu - [Line] command, or click

on the icon.

(2) Click on a start point in the mark drawing area and

drag the mouse.

(3) Click the end point in the mark drawing area. If you press and hold the key

A line is defined.

in step (2), you can draw a line at
an angle of 0°, 45°, and 90°.

3-6
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Chapter 3 - Drawing

3.1 Creating a Mark: the Mark Screen

B Drawing a Square (Rectangle) or Filled Square (Filled Rectangle)

PROCEDURE

REMARKS

(1) Select the [Draw] menu - [Square/Rectangle] or
[Filled Square/Rectangle] command, or click on the

or icon.

(2) Click on a point (a) and drag the mouse on a diago
nal axis in the mark drawing area.

+
"

(3) Click on the end point (b).
A square or rectangle is defined.

|IENENCEEEEEEEEEEEEEEEEE

I

o

If you press and hold the key
in step (2), you can draw a square.

GP-PRO/PB Ill for Windows Ver. 6.3 Operation Manual
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3.1 Creating a Mark: the Mark Screen

Chapter 3 - Drawing

B Drawing Circle (Oval) or Filled Circle (Filled Oval)

PROCEDURE

REMARKS

(1)Select the [Draw] menu - [Circle/Oval] or [Filled

Circle/Filled Oval] command, or

icon.

(2) Click on a point (a) and drag the mouse on a diago
nal axis in the mark drawing area.

click on the [ ] or

(3) Click on the end point (b).
A circle or oval is defined.

If you press and hold the[Ctrl]key in
step (2), you can draw a circle.

3-8
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Chapter 3 - Drawing 3.1 Creating a Mark: the Mark Screen

B Filling a Mark

PROCEDURE

REMARKS

(1)Select the [Draw] menu - [Fill] command, or click on

the icon.

(2)Click inside the area to be filled.
The specified area will be filled.

If you click on a line, the filling
mode cannot be executed. Be sure
to click inside a completely en-
closed area, if you do not, the en-
tire mark screen may be filled.

GP-PRO/PB I1I for Windows Ver. 6.3 Operation Manual
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3.1 Creating a Mark: the Mark Screen

B Entering Text

Chapter 3 - Drawing

The “Text” mode allows you to enter text on a Mark screen.

PROCEDURE

REMARKS

(1)Select the [Draw] menu - [Text] command, or click

on the icon.

(2)Enter character(s) and select either 8 x 16 dot font or
Windows font.

Text

B

—
£ windaws Font

K, H Cancel H Help ]

(3)To use the Windows font, click on the and
click on the button.

Font: Font style:
Brial Black Regular

B Comic 5ans M5

AaBbYyZz

Script:
Western id

(4)Click on the button.

An outline corresponding to the entered character(s) will
appear.

Fat ] O88Fm
Josial Black |

| I

m " Cancel ) Help
D
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Chapter 3 - Drawing 3.1 Creating a Mark: the Mark Screen

PROCEDURE

REMARKS

(5)Move the box to the desired position where the char-
acter pattern will be displayed.
The character pattern is displayed in the position where
you click. A Mark can be created using this pattern.

If you move the character pattern
to a position where another char-
acter pattern has already been cre-
ated, the new pattern will overwrite
the existing pattern, and the exist-
ing pattern will be deleted.

GP-PRO/PB I1I for Windows Ver. 6.3 Operation Manual
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3.1 Creating a Mark: the Mark Screen

Chapter 3 - Drawing

E Special Mark Characters ]

B Creating Special Characters on a Mark screen

A

Important

When the European character set has been selected, you can register (create)
any kind of the special character you wish. These special characters are
handled by Mark screens M8001 to M8128, so up to 128 special characters
can be created. The data (characters) on these "special” screens are can then
be inserted into any text string, using special reference codes. For example,
to call up Mark screen M8001's special character, we need to input the
corresponding reference code 80h, and to call up screen M8002, we would
enter 81h, etc. However, since these codes are in Hex format, and in GP-
PRO/PBIII 's text input mode we can only enter decimal data, we need to
use the Hex code's decimal equivalent, shown on the table on page 138.

When any kind of character is "registered” on Mark screens M8001 to
M8128, the GP will interpret it as a "special” character. Thus, when the GP
encounters one of the abovementioned special reference codes, it automati-
cally searches for the corresponding Mark file. If the file exists (i.e. has been
registered and sent to the GP), it replaces its default GP character with the
special character Mark.

This feature is useful when you need to change the GP's default character
font addresses to match those used by your PC's OS.

» The number of special characters that can be used is limited to
the number of Mark tags available, i.e 128.

* When creating a special character Mark screen, start from
point 0,0 (Base point) and use only two 8x8 dot squares.

Base Point —— 1

B Displaying (Calling up) a Special Character

The method for displaying a registered special character is as follows.

PROCEDURE REMARKS

The character "ll11" , previously registered in

Mark screen M8010, will be displayed on the

GP.

(1) Open the Base screen where you want to display
the special character, and click on the [#]icon.

@] [E1 A A EIE

A

L]

K
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Chapter 3 - Drawing

3.1 Creating a Mark: the Mark Screen

PROCEDURE REMARKS
(2) Hold down the [Alt] key and use your PC’s
numeric keypad inputting the ASCII code that
corresponds to the desired Mark screen. m
The (ASCII) character code that corresponds to Imp;ﬂam

screen M8010 is 89h, however here, since the code
entered must be decimal, enter the corresponding
Input code, 235. This should cause the character "e"
to appear.

(One application of this special character could be
to place it after the text "GP-PRO/PB". In that case,
simply enter "GP-PRO/PB" followed immediately
by the Input code)

(3) After placing this text on the Base screen, saving
the screen, and then sending the data (i.e. the
Base screen and the Mark file) to the GP, instead
of the ""&" character, the Mark screen's "1™
will appear.

A
y/

The character displayed,
since it is only for reference,
will be different from the
desired "ll1". After the Base
screen and the Mark file are
sent to the GP, the correct
character will be
automatically displayed.

|\ Characters used by the GP may sometimes differ from those
,,,,p;,,a,,, used by GP-PRO/PB Il for Windows. Please be sure to check all
characters after they are sent to the GP.

If the corresponding Mark file is not sent with the Base screen

to the GP, the GP will substitute one of its reqular characters.

(Ox80 to OxFF)

Special characters can not be rotated.

B Character (Reference) Codes

The GP displays characters from the chart shown here. (Code Page 850 character codes)

5]

< |
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3.1 Creating a Mark: the Mark Screen Chapter 3 - Drawing

B Hex/Decimal Corresponding Character Codes
When inputting reference codes for special Mark screens, use the chart below.

Mark Char Code Input Code Char Code Input Code Char Code Input Code
Screen | code Page 850 | (ALT+code) | Code Page 850 | (ALT+code) | Code Page 850 | (ALT+code)
M8001 80h 0199 BOh 0130 EOh 0211
M8002 81h 0252 B1lh 0131 Elh 0223
M8003 82h 0233 B2h 0132 E2h 0212
M8004 83h 0226 B3h 0133 E3h 0210
M8005 84h 0228 B4h 0134 E4h 0245
M8006 85h 0224 B5h 0193 E5h 0213
M8007 86h 0229 B6h 0194 E6h 0181
M8008 87h 0231 B7h 0192 E7h 0254
M8009 88h 0234 B8h 0169 E8h 0222
M8010 89h 0235 B9h 0135 E9h 0218

8Ah 0232 BAh 0136 EAh 0219
. 8Bh 0239 BBh 0137 EBh 0217
. 8Ch 0238 BCh 0138 ECh 0253
R 8Dh 0236 BDh 0162 EDh 0221

8Eh 0196 BEh 0165 EEh 0175

8Fh 0197 BFh 0139 EFh 0180

90h 0201 COh 0140 FOh 0173

91h 0230 Cih 0141 F1lh 0177

92h 0198 C2h 0142 F2h 0159

93h 0244 C3h 0143 F3h 0190

94h 0246 C4h 0144 F4h 0182

95h 0242 C5h 0145 F5h 0167

96h 0251 C6h 0227 F6h 0215

97h 0249 C7h 0195 F7h 0184

98h 0255 C8h 0146 F8h 0176

99h 0214 C9h 0147 F9h 0168

9Ah 0220 CAh 0148 FAh 0183

9Bh 0248 CBh 0149 FBh 0185

9Ch 0163 CCh 0150 FCh 0179

9Dh 0216 CDh 0151 FDh 0178

9Eh 0128 CEh 0152 FEh 0247

9Fh 0129 CFh 0164 FFh 0160

AOh 0225 DOh 0240

Alh 0237 D1h 0208

A2h 0243 D2h 0202

A3h 0250 D3h 0203

Adh 0241 D4h 0200

A5h 0209 D5h 0153

A6h 0170 D6h 0205

A7h 0186 D7h 0206

A8h 0191 D8h 0207

A9h 0174 D9h 0154

AAh 0172 DAh 0155

ABh 0189 DBh 0156

ACh 0188 DCh 0157

ADh 0161 DDh 0166

AEh 0171 DEh 0204

AFh 0187 DFh 0158
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Chapter 3 - Drawing 3.1 Creating a Mark: the Mark Screen

@ Editing a Mark ]

To edit a mark, you can use the following editing functions. This section
describes the operating procedure for each function.

B Cutting a Mark
The “Cut” command deletes the data of the selected screen and stores it in the clip-
board™. (The deleted screen can be moved to another screen, but cannot be moved
to the original screen.) The “Cut” command can be executed for the entire screen.

PROCEDURE REMARKS

(1) Select the original Mark screen to be cut.
This description assumes that several screens have al-
ready been opened.

(2) Select the [Edit] menu - [Cut] command, or click on To delete the Mark screen, perform

the [ icon to store the Mark data in the Clipboard. | steps (1) and (2) only.
Data of the original data screen will be cut.

[@@M?: Untitled @\! @\!

*1 When the [Copy] or [Cut] command is executed, the copied or cut data are temporarily
stored in the clipboard.
When you execute the [Paste] command, the data stored in the clipboard will be pasted
to the selected position.

GP-PRO/